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A-1 Conventions used in this document
This section sets out the conventions used throughout this document.
References to files

References to the name of an existing file on system hard-disk, to a file extension, to the
name of a directory, to the name of an executable file, or to the literal description of a file’s
contents are shown in red italics. For example, /MATERIAL refers to the /MATERIAL
directory.
References to keys

Key references use Caps and green italics surrounded by the symbols <>. For example: <A>
refers to the key “a”. A combination of keys is shown separated by the symbol “+”. For
example: <Ctrl>+<A> means pressing the keys “control” and “a” at the same time.
Additional keys and mouse buttons are shown below:
<Ctrl> = Control key.
<Shift> = Shift key.
<Alt> = Alt key.
<Space> = Space bar.
<LeftClick> = Click with the left mouse button.
<RightClick> = Click with the right mouse button.
<CenterClick> = Click with the middle mouse button.
<Drag> = Drag with the mouse.
References to documents

References to other chapters within this documentation or to other documents is shown in
blue and underlined.
For example, References to keys, refers to the previous chapter.
References to menus, panels and buttons

References to menu options, panels and panel buttons are shown in grey, and the menu or
panel navigation route is shown with the symbol "->"
Some buttons have their name superimposed and others have an icon. All Mamba icons have
an associated name (these names can be superimposed on the icons via the middle mouse
button). These options are named in the same way in this document.
Mamba SGO has different types of buttons: command, drop down, state and multi state.
Drop down and multi state buttons show all their options between square brackets and the
selected option between normal brackets .
When dealing with a state button (it may be on or off), the state is also indicated in
brackets.
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References to literals

References to Mamba's interface parameters or to literals related to the application, are
highlighted in blue-green italics.
For example, Join refers to an option called "Join" in the software interface.
Parameter Description

In descriptions of effect parameters, a short description of default values is shown. For
example, the following value:
[25 (0 /100)]
The syntax should be interpreted as follows:
[Default (Minimum / Maximum)]
Square brackets "[]" show the start and end of the parameter description.
The first numbers
case, 25).

those outside the round brackets

show the default value (in this

Some of the default values are animated. These default values use a colon ":" to separate
the initial value from the final value.
For example, for the Grade parameter of a wipe: [0:100 (0 / 100.000)]
When values are separated by a semicolon ";", this indicates that the parameter has a set
of associated values, and each default value is differentiated from the following one by this
symbol (such as RGB values, and spatial coordinates).
For example, the description of the RGB parameters of the Solid effect values is: [0;0;0 (0
/100)]
The associated values in the description have a common valid range.
Round brackets "()" show the start and end of the range description valid for the
parameter. The forward slash "/" separates the first number (the minimum) from the second
(the maximum).
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B-1 Working environment
The basic concepts needed to understand Mamba’s working environment are described in
the following sections, together with the use of its basic elements.
The desktop and its tools

Once the user is identified by the system, Mamba shows the interface of the operating
system. This consists of a desktop where the tools are shown as icons.
The most important tools that appear in the user interface of Mamba are:
Mamba Setup
Mamba configuration, including the format of the image to be produced and the type
of video format to be used in the next session
Mamba
Access to Mamba.
Help
Mamba Documentation

Accessing Mamba

Mamba is the heart of the system. It is the space within which both editing and composition
take place. From within Mamba, the rest of the tools referred to here are accessed; thus it
is the environment in which the user will usually work.
The desktop icon

Autodetection of Layout for the work resolution

Mamba automatically detects the maximum resolution of the graphics card and adjusts the
"Layout" to this resolution.
The only variable that must be borne in mind whether to work with one or two monitors. In
both cases, Mamba automatically adjusts the "Layout". To choose between one or two
screens, go to Mamba Setup->Interface->Two Monitors [On,Off].
Mamba requires at least one monitor at 1920x1080, although two 24" monitors at 1920x1200
is recommended.
Another typical configuration to increase the workspace is to use two 30" monitors at
2560x1600. This configuration offers the following advantages:
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It gives more space in the Node Graph.
It allows working with HD_1080 images at 1:1 in the Visual Editor and even 2K
images at 1:1 the Paint tool.
However, the size of 30" monitors makes working in spaces using projectors difficult, so it is
not recommended in these cases.
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B-2 Selection of elements
A range of basic element selection operations exist in all Mamba’s tools. They are as
follows:
Simple selection
Left click the element to highlight the element.
Multiple selection
Left click and drag to defines a selection area. Release the mouse button to select all
the elements within the area.
Additive / subtractive selection
Allows the selection or de-selection of adjacent and non-adjacent elements in a
selective way. This type of selection behaves differently according to in which Mamba
panel it is done.
In the Project, Import and Media tab, it is possible to select adjacent elements
by clicking the first and then, holding <Shift, clicking the last. All elements
between will be selected. To select non-adjacent elements, click each element
individually while holding <Ctrl>. Elements can be de-selected in the same way,
by holding <Ctrl> and clicking.

In Node Graph the behavior is different. Here we use <Shift> to select or de-select
individual elements.
In the Parameters tab, <Shift> is also used for individually selecting parameters
(hold <Shift> down and click in each parameter required to be added to the
selection. This type of selection can be used to modify the value of various
parameters at the same time, using<Drag>+<central button> for example).
<Shift> is also used to add or remove keyframes in a selection in the curve of
the parameters.
Undo selection
Simply click in an empty space of the corresponding panel.
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B-3 Data fields
All the numerical values and timecodes are modifiable in the following ways:
Select either the whole number (by double-clicking on it) or only the digits to be
modified (by highlighting them with the mouse) and then writing in the new value.
Left click on the value and use the mouse-wheel to increase or decrease its value
progressively.
In the Parameters tab, simultaneously select numerous parameters by holding down
<Shift> and then use the previous method to modify them all at the same time.
This can also be done using the middle mouse button. This technique can be used,
for example, to modify the X or Y position of various layers simultaneously.
Left click on the value to be modified and drag the cursor up, down, left or right to
increase or decrease the value. This mode is extremely useful for adjusting effects
parameters, as the result of the modification is visible without having to release the
mouse button. (This mode can be deactivated if viewing is slow owing to its
complexity, in which case the effect will not be evaluated until the mouse button is
released or the tablet pen is lifted).
A similar method is to press the <Up> and <Down> arrows while keeping the cursor in
the field to be modified.
The method described in the previous point
<Shift>, and <Ctrl> which modifies the
hundreds respectively instead of the unit
decelerators when adjusting the parameters

can be used in combination with <Alt>,
first decimal place, the tens and the
value, thus acting as accelerators or
interactively:

° <Ctrl> + <Shift> : thousands.
° <Ctrl> : hundreds.
° <Shift> : tens.
° <Drag> : units.
° <Alt> : decimals.
° <Ctrl> + <Alt> : hundredths.
° <Shift> + <Alt> : thousandths.

The colors of the modifiable numerical values (on a black background) indicate the following:
Grey: a default value, or one that has not been modified.
Green: a value introduced by the user or a keyframe.
Light blue: a value interpolated between two keyframes.
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B-4 Mamba’s buttons
Mamba has four types of buttons:
Command buttons
These are the simplest buttons. Clicking, them or using their related hotkeys, runs a
command.
Dropdown buttons
These have a square icon to the left side. When clicked, a list with various options
drops down. The name superimposed in the button is always the same, regardless of
the option selected.
State buttons
These have two possible states activated by clicking them (or pressing the hotkeys).
Generally they are green when activated and gray when son deactivated .
Multistate buttons
These are buttons in which different variables for the same parameter can be chosen.
When clicked, a list with the possible variables appears. Once the variable is set, this
is superimposed in the button. These buttons have the name of the parameter green
and the name of the variable in white.
All Mamba buttons have their name or an icon superimposed over them. All Mamba icons
have an associated name (to see this associated name simply place the mouse cursor over
the icon and click the central mouse button).
Similarly, right-clicking over a panel button shows the associated Hotkey, (until the mouse
button is released).
Both methods show information about the button, but carry out no action.
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B-5 Keyboard Shortcuts (edition)
Mamba possesses a series of keyboard shortcuts in order to make the operator's workflow
easier to negotiate. They can be seen by hovering the cursor over the buttons of the
interface. The operator can personalize these shortcuts by editing them with the text editor
file hotkeys.cfg, found here: Mamba-ENV/etc/pixmap2/hotkeys.cfg. It is recommendable to
make a security copy of the original file should be default values be required at a
subsequent stage.
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B-6 Image formats and color spaces in Mamba
The audio-visual market offers a huge number of image formats. An introduction to their
main characteristics and an explanation of their use within Mamba follows. Some knowledge
of their features is key to achieving the most efficient and highest quality work in Mamba.
Preferred realtime formats: Mamba .JS y .DPX

Mamba is a high-performance system designed to work in real time, but the correct use of
the file and storage system formats explained below in order to achieve the best results.
Mamba can work directly with many standard image formats (TIFF, .Targa, Cineon, DPX,
AVI, Quicktime, MXF, MPEG4, etc.), without the need to convert them to Mamba's native
format (.js). To do so, simply double click in the Browser to create Mamba's format linked
to these media files.
However, many of these formats take time to process, and may be out of order (their
frames may not be organized consecutively on the disks, which slows reading).
For this reason, when playout in real time is required for a sequence derived from another
format or one which is not stored in the real time disks, it may be necessary to convert
them to .js format via a render process, or by using .dpx as described below.
When video is captured, it is recommendable to store it in the .js format; when it is not
necessary to maintain immediate compatibility with other applications it is also
recommended to use this format since:
Mamba's .js format
fragmentation

is

pre-assigned to

consecutive

disk blocks

and

avoids

Mamba's .js format is aligned to memory pages, improving performance
Mamba's .js format corresponds exactly to SDI video formats, so if the variant is
correctly chosen information is not lost, it is not necessary to convert color spaces
and the size of the file does not increase (and therefore neither does the related
process time) unnecessarily.
In the case of needing to work with other applications, it is recommended to work in "DPX"
format, since Mamba is also highly optimized to work in real time in this format (up to 4K if
adequate storage is available). However, follow the following recommendations:
For best results, DPX sequences should be arranged consecutively on the disks. To
do this, they should come from an un-fragmented locations, and the files should be
loaded in order via video capture, a render process, or by the command "rsync" (or
similar).
This "rsync" command permits the rapid copying of numbered sequences in their
numerical order, as the continuation of a previously interrupted copy. These
capabilities distinguish it from a simple copy via the graphic interface of any OS. If
possible, never use these systems for loading numbered files if they are needed to
worked on in real time, nor allow other users to copy files this way to storage via the
network, since in these cases, it is probable that an additional render process is
required to obtain an optimized sequence.
The recommended syntax for the command is:
rsync -Pav SourcePath TargetPath
Generally, the DPX format only provides real time performance in combination with
the "Storenext SNFS" filesystem. Mamba uses the API of this filesystem to carry out
high-performance specifically for this format, and it is not possible with other types
of filesystem.
The DPX format is only optimum for original RGB formats. It is not enough to convert
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YUV images to this format, as they may occupy up to twice the space and similarly
decrease performance. For example, the standard HDCAM SRW Stereo format
codifies two YUV 422 10bit streams, so its transcodification to DPX (RGB 444)
produces a great increase in the size of the file and process times.

Compression vs No compression

High-compression formats (MPEG, DVHDV, MPEG2, MPEG4, etc) are suitable for final
distribution of images to the consumer, but in general, if it can be avoided, they should not
be used to import images into a post-production system. These formats give rise to
problems when carrying out color corrections, chroma keys, and other effects, since they
provided very little information. Mamba provides tools to deal with these problems, but the
best results will always be obtained from material that is uncompressed, or if compressed,
with as little compression as possible.
In general, for video sources, the highest quality is obtained through SDI signal capture.
However, it is a common mistake to associate the terms SDI and "uncompressed". While SDI
signals do not use compression, the majority of VTRs use compression algorithms with a
subsequent (greater or lesser) loss of quality for image storage, although later they employ
uncompressed SDI signals for broadcast. Thus, in such cases, it it’s the compression ratio
used in each VTR that determines the final image quality and the information available for
post-production processing. For example, these ratios could range from the non-aggressive
2:1, as provided by Sony’s SR range of VTRs, to the destructive ratios of 40:1 found in HDV
devices.
If the highest possible quality is required, the following are the main ways of obtaining
images that have not suffered information loss as a result of compression:
In the case of using digital cameras, capture the signal directly from the camera
during filming, ie before it is stored in the VTR. Certain cameras have SDI or SDI dual
link outputs than can be used for this purpose. Generally, for this method, a system
like Mamba is needed at the recording location. Low compression VTRs, such as
HDCAM SR, are also an acceptable alternative.
In the case of using film cameras, use a telecine and connect it to Mamba directly
through the SDI output. A film scanner or a datacine can also be used to import .dpx
or .cin images they produce. This method produces the highest quality images,
although it is the slowest and most expensive.
Whether using compressed images or those derived from film, we are faced in postproduction with problems of noise: electronic noise in the case of compressed video and
grain in the case of film. Mamba is designed to deal with both cases, having a new Denoise
effect, which employs Optical Flow (Motion Estimation) techniques to eliminate both kinds
of noise wherever possible. However, it is not possible to fix problems in all shots using this
technique, so it should not be seen as a substitute for using cameras and VTRs of the
highest quality.
Users should be aware that although original noise or grain levels may be acceptable for the
viewer, the efficiency of many tools is improved if applied to a version processed with the
Denoise technique, such as motion tracking, chroma key, secondary vector selection in the
color corrector, etc.)
Once inserted into post-production, it is recommended to work without applying any kind of
compression. If, when completed, it is necessary to apply compression, it is unavailable in
the Render module of the Output tab.
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Color spaces

SGO Mamba allows the user to work in all the commonest post-production color spaces, and
it is important to be familiar with this topic to achieve the best results.
Although the system supports a variety of file formats, from this point on, this manual will
use Mamba’s native image format (".js”) as a reference in the explanations that follow, as it
is applicable to other file formats, depending on the color space employed.
The ".js" image format of Mamba is an uncompressed image format which allows direct
working and storage in the following color spaces:
YUV 4:2:2 at 8 bits per channel. (2 bytes per pixel).
YUV 4:2:2 a 10 bits per channel. (3 bytes per pixel, equivalent to RGB 4:4:4 linear at
8 bits).
YUV 4:4:4 at 10 bits per canal (3 bytes per pixel)
YUVA 4:4:4:4 at 10 bits per canal
RGB 4:4:4 linear at 8 bits per channel. (3 bytes per channel).
RGBA 4:4:4 linear at 8 bits per channel. (RGBA, 3 bytes per pixel, plus on extra byte
for the alpha channel).
RGB 4:4:4 linear at 10 bits per channel. (4 bytes per pixel).
RGB 4:4:4 logarithmic at 10 bits per channel. (4 bytes per pixel).
YUV 4:2:2 x 2 (8bit and 10bit): Stereo 3D format, equivalent to 2 8 bit or 10 bit
YUV 4:2:2 channels. The frames for each eye are interleaved, which improves the
performance of access to disk and both streams are maintained in a single file. In
Mamba they appear as a single clip, although both streams can be extracted
separately later.
In this manual, these complete names are not normally used, because of their length: they
are abbreviated to YUV, YUV10, RGB, RGBA, RGB10, YUV422x2, YUV422_10x2 respectively.
The storage of native .js format can be done in two ways:
Mamba .js is the default format for video capture (its variations are defined in
Mamba Setup->Video I/O for each preset), although at the moment of
capture it can be changed to another format in the VTR panel.
Render sequences imported in others formats to Mamba's .js format.
The characteristics of the native color spaces mentioned are described below. Detailed
knowledge of them allows us to obtain the best image quality and to work with the system
in the most efficient way.
YUV 4:2:2

The YUV standard (also known as "Video in components") uses the color space that is the
standard in all video systems, whether analogue or digital. Of all its variants widely used,
the digital YUV format 4:2:2 is the one that generally gives the highest quality when
bandwidth is limited, and for this reason it is the one most used in videos systems oriented
towards post-production.
The name “YUV” refers to the separation of the video signals into one component,
luminance (Y) and two color components (U and V). If the original signal is in the form of
analogue RGB (as is produced by most CCDs found in video cameras and telecines), the YUV
components are obtained by digitizing the analogue RGB signal in the following way:
The Y luminance component is obtained from the sum of the luminance of the three
RGB signals. As the luminance of the three colors are different, the following formula
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is used:
Y = 0.299R+0.587G+0.114B
The U and V components are obtained by subtracting the Y luminance from the B
(blue) and R (red) signals respectively, for which reason they are also known as "Cb"
and "Cr". The green component is implicit, as it can be obtained as the difference
between the U and V signals and the Y signal.
U = 0.493(B-Y)
V = 0.877(R-Y)
The expression 4:2:2 is to be interpreted as meaning "to obtain double the number of
luminance samples compared with those of the color components", as will be explained later.
Bearing in mind that video cameras (both SD and HD) and telecine systems use one or more
analogue CCDs sensitive to the Red, Green and Blue colors, and thus the original RGB signals
are analogue in origin, why has the YUV format been chosen as the standard digital video,
rather than use RGB directly?
The answer is because in order to digitize and store all the information available in the
original RGB analogue signals, a large bandwidth is required, which is not normally available
in camera and VTR storage systems. Thus it is necessary to use a more efficient system,
such as the YUV 4:2:2 format. The reason is that the human eye is much more sensitive to
small changes of luminance than it is to small color tone changes, so that this format takes
two luminance samples (Y) for each one of the color components (U and V), in order to
make better use of the available bandwidth. Many high-end VTRs (such as Sony Betacam
Digital and HDCAM, Panasonic D5 HD, etc.) record tapes in YUV 4:2:2 format.
Alternatively, some of these devices also have RGB input/output , although it should be
remembered that in these cases it is converted from/into YUV which is what is actually
stored on tape.
On the other hand, some high-end cameras and VTR do have the capability to record
directly in RGB format without compression or with a relatively gentle compression; examples
are HDCAM-SR, Redcode R3D, Arri raw D20 / D21 / Alexa, Phantom, SI2K, and the cine
scanners.
Each format is studied in more detail below.
The digital YUV 4:2:2 format of 8 bits per channel contains two bytes for each pixel of the
image:
The first byte represents the luminance (Y), and provides a different sample for
each pixel.
The second byte is the color component U of the even pixels and V of the odd ones.
To reconstruct the color of each pixel that of the adjacent pixel is taken as the
missing color component.
As a consequence of the above point, this format has half the chromatic resolution
in the horizontal direction.
This does not mean that two adjacent pixels will never be equal, as only one of the
UV components is shared with another pixel, whereas the other color component
and the luminance component will always be different.
Since the color components are shared between alternate pixels, an important
collateral effect is that the resolution of the working format used with YUV 4:2:2
should have an even number of pixels in each line. This should also be remembered
when producing images in other formats that may be later imported into Mamba in
YUV 4:2:2 format.
The 10 bits per channel YUV 4:2:2 format is stored in Mamba by means of an additional
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byte, resulting in a total of 3 bytes per pixel.
As a rule, when using Mamba with video images captured via single SDI link, it is best to
work in YUV format, as this YUV 8 bit format is the one stored on the tapes, so it makes no
sense to convert to other formats unless necessary. For example, the conversion to YUV 10
bit or RGB implies a 50% increase in storage space and nearly double the render times,
without gaining any more detail than on the original tape.
Note that this refers only to the transmission and storage of image, not their processing. In
normal circumstances, Mamba will always process images at their highest quality format
(RGB 4:4:4 at 16bit per channel or even HDR) in order to avoid the possible degeneration or
information loss.
Similarly, clips of different formats can be mixed in the same composition (YUV, linear RGB,
RGB 10 bits logarithmic, etc.), and Mamba will make the necessary conversions
transparently, for the user to see. In either case, the final output depends on the following
considerations:
If the video output is activated, Mamba will convert the final result in the video
output to the format selected in Mamba Setup->Video I/O.
If a render process is being carried out, a choice can be made as to whether to
store the images in YUV or RGB format. This will depend on the format required for
the final product; for example, if we are considering a later transfer to HDCAM VTR,
YUV8 is normally used, and if we need to transfer to dual link SRW HDCAM or deliver
file sequences in RGB formats, then we use RGB10 format.
Illegal colors and out-of-range workflows

If images are being viewed on a computer graphics monitor, Mamba converts the result to
RGB format (converting from YUV to RGB if necessary), since such monitors can only use
RGB. This type of conversion is carried out internally without any user intervention, but it is
necessary to bear them in mind because the two RGB/YUV versions may show visual
differences, and some colors can only be represented in the YUV video output.
For example, images captured YUV that have information that is out-of-range for RGB can
only be seen in their entirety in the YUV video output, eg, in RGB, maximum luminance can
only be obtained for the color white (with RGB components at their maximum value), while in
YUV format, both the “Y” luminance component and another color component may be at
their maximum value, resulting in a color brightness displaying total luminosity and color
saturation, which would be impossible in RGB. These kinds of situation are usually referred to
as “illegal color” in RGB.
Another conflictive situation concerns out-of-range YUV signals. The standard YUV format
(rule CCIR_709) reserves values less than 16 and greater than 234 (out of a total of 255)
for the superimposition of super white and super black in televisions and for other control
information. However, some HD cameras intended for film production usually use gamma
curves that exceed these values in order the register more information (especially in the
area of highlights).
In such cases, a loss of information will be noted if the image is captured in standard YUV or
RGB formats. The solution to this issue is to activate Mamba Setup->Video I/O->Use
Extended Range before capture in order to store out-of-range information too, and
afterwards to activate the HDR mode in the color corrector in Mamba. Thus, out-of-range
work can be done without problem, and with the help of Mamba’s vectorscope and wave
form the user can decide to normalize the image or leave it out-of-range and transfer it to
video as it is.
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Linear RGB 4:4:4 8 bits

This format uses 3 bytes for each pixel (one byte for each channel of RGB color). Being
linear means that, in contrast to a logarithmic format, the amplitude of the original signal is
represented by a directly proportional value. For example, "200" represents 100 times the
intensity of a value of "2".
The term 4:4:4 indicates that the same number of samples is taken from the 3 original RGB
signals.
The use of this format is recommended in the following cases:
This format is mostly used in graphics software applications because computer
monitors function in linear RGB, and it is easier to devise algorithms that use this
format (very few applications are capable of working with YUV or logarithmic RGB).
For this reason, in general its use is recommended when the final objective is to
export images to other software applications or multimedia production.
Linear RGBA 4:4:4:4 8 bits

This format is similar to the previous one, but it has an additional alpha channel to contain
the composition mask, storing a total of 4 bytes per pixel. RGBA should be used in these
cases:
When importing images containing an alpha channel (typically .tga files).
When wishing to render an effect while conserving the alpha channel in the final
clip.
Note: The YUV format does not have an alpha channel, although an alternative method can
be used: the mask can be stored in a separate YUV clip, and then the External Key effect
used to associate both clips and produce an RGBA output to use in the composition.
Logarithmic RGB 4:4:4 10 bits

This format is not linear like the previous ones, as its stored values represent a logarithmic
curve that is used to compress the information corresponding to shadows and bright lights.
The logarithmic system allows simultaneous representation of luminance levels that are
close in shadow and very different in lit areas, while maintaining the capacity of
representing the midtones in a similar fashion to a linear format.
To store this format efficiently, 10 bits per channel have to be used, so that a total of 4
bytes per pixel are stored.
Note: The RGB 10 bit logarithm format can also be used to save images with linear gamma
curves but in 10 bit, as the archive format is identical. The only difference is in how the
images were originally codified (ie, which gamma curve was used). In general, logarithmic
gamma curves are maintained when the final version of the images will pass through a cine
film projector, whilst it will be converted to linear when the final product will be video. In all
cases, the format per se will not change, and for this reason when references is made to
this, the only mode found will be RGB10.
Mamba can import RGB 10bit format from SDI dual link captures, DPX or Cineon files, and Tiff
16bit, which are normally generated in one of the following ways:
With a film scanner: the emulsion of film negative has a wide dynamic range, and
under certain conditions, details in areas of extreme illumination (lights and shadows)
can be detected. High quality film scanners digitize in Cineon or DPX format which
conserved these details.
Via a high-definition video camera with a wide dynamic range: Sony F23, Arri D-20,
Arri D21, Alexa, Red One, Red Epic, Phantom, Weisscam, etc.
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Using 3D and effect applications. These applications can offer a greater dynamic
range when rendering 10bit log formats such as DPX or Cineon. Generally, when
working in film formats, 3D sequences for effects can be called up in these formats.
For these purposes, Mamba can also import the 16bit Tiff format Tiff, although this is
less efficient in terms of speed and disc space than DPX.
Note: given the large storage and processing requirements for these formats they
should never be used indiscriminately, as there will be few cases in which they will
give significantly better results than linear RGB 8 bits.
HDR

It is also possible to work with "HDR" formats (.exr and .hdr) which are formats with a wide
dynamic range (16bits per channel) and which can also handle out-of-range values (above
100% and even negative colors).
These out-of-range areas offer extra information that is not seen but which can be
recovered when necessary, typically using the color corrector (Color Grade effect) in HDR
mode.
Note: The majority of effects can also treat these images in transparent way, since they
work in 16bit, but the Color Grade color corrector is especially designed to allow us to
select the range we want to use.
Mamba works internally in 16bit format with HDR floating point. For example, a specific
effect can darken an image, pushing the detail of the shadows towards negative values and
avoiding the loss of this information. Thus a posterior effect (for example, glint) can recover
this information without problem.
Mamba does not have its own specific file format for codifying more than 10bits per
channel, since these formats are very specific to each device. Instead, Mamba supports
natively the most well-known formats of this type such as .exr, .hdr, Tiff16bit, DPX12bit,
R3D, J2K (JPEG2000) etc.
XYZ

The XYZ color space allows a wider range of colors than RGB and YUV, being able to codify
all the colors visible to the human eye. Thus it is useful for doing a master with all the
available color information, from which diverse present and future formats can be derived.
Furthermore, there is currently a strong tendency to use this space as reference in Digital
Cinema.
To export to this format, we use the RGB to XYZ effect, and normally run a render to Tiff16
(for DCM) or J2K (for posterior encapsulating in DCP), the most common standard formats
for this color space.
The default parameters of the XYZ effect meet the standards for digital cine (DCI) so we do
not normally need to modify them. However, on some occasions, it may be desirable to
calibrate a projection room to compensate for its differences from the standard. In these
cases, a calibration test is run in the projection room to obtain the parameters that should
be applied to the effect. Thus a very precise calibration for said room is achieved, while the
images produced in this way will be valid for projection in said space.
Transformations between linear and logarithmic colour spaces

In general, for the correct viewing of logarithmic images on a linear device, a LUT3D should
be applied, as these LUT allow for the correct calibration of the different devices (monitors
or digital projectors) involved through to the final positive.
When converting color spaces between linear and logarithmic, the following specialized tools
are available:
The Cineon Correct/Export effects uses the Kodak standard Cineon for converting
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from logarithm*(1) space to linear and vice versa, with the ability to compress
highlights into a linear range without losing detail (the parameter Softclip). This
Softclip parameter protects the information of bright lighting when passed to a linear
color space.
The effects LogCorrect and LogExport offer inverse conversions from logarithmic to
linear (LogCorrect) and from linear to logarithmic (LogExport), according to the
mathematic "logarithm" function (and so without following the Cineon standard).
Generally it is less efficient as it does not have the Softclip function, but will have to
be used when the client or other related applications require this conversion formula.

These effects are recommended when temporary conversion from logarithmic to linear is
required in order to compose images that have been produced in different color spaces (for
example, linear 3D images) or to insert certain effects that work better in linear color space.
If exactly the same parameter values are used for two of these complementary effects, the
final output will have the same gamma curves as the original.
(*1): The main difference between both pairs of effects is that the effects LogCorrect and
LogExport carry out a standard logarithmic conversion (the luma value elevated to the
gamma function defined by its parameters), while Cineon Correct/Export use a more
complex and specific formula created by Kodak and which describes more exactly the
behavior of the cine negative (the standard Cineon cannot strictly be defined as a
logarithmic function, although owing to its similarity, it is often colloquially described thus).
In general, when dealing with cine images, use of Cineon Correct/Export is recommended,
since this also makes available the SoftClip function; LogCorrect and LogExport are only
recommended when a standard logarithmic conversion is expressly requested by the client,
or for compatibility with other application that do not support the Cineon standard.
For the sake of simplicity in the following explanations, the term "logarithmic" will be used to
refer equally to both types of conversion, although as mentioned they are not exactly alike.
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C-1 Mamba Setup configuration parameters

When it has started up, use the tool Mamba Setup to configure the system. The different
configuration parameters of the application are specified here.
Many of the configuration parameters of this tool must be specified before starting up SGO
Mamba: if any are modified, it is necessary to exit and restart the application for the
changes to be recognized.
There are other configuration parameters that typically require modification and can be
changed from within Mamba without needing to close it; they are usually located in the
Setup tab (TimeSpace Editor->Dashboard->Edit->Setup).
Finally, certain configuration parameters are not usually modified, and by default are hidden,
although they can be activated via the General->Expert Mode button, which makes them
accessible the on next start-up of the mConfig application. (These parameters are intended
for expert use and are hardly used; some are not detailed in this document. Their
modification is only recommended after consultation with SGO’s technical department.)
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C-2 General

This area allows modification of different general parameters of the application.

General

Standard Preset
This option allows the simultaneous configuration of all other options, starting from a
series of predefined configurations (Presets). By default, presets for different video
formats, such as PAL, NTSC, 1080_24p, etc. are included, but the user can specify
new presets in order to save sets of values which are often used, whether or not they
anything to do with standard video format.
Delete Current Format... deletes the active preset from the disk permanently and it
disappears from the menu.
Note: The default presets installed by the system cannot be deleted.
The second option of this menu is Create New Format... . This option permits the
creation of a new preset. When run, the system asks for the name of the new preset
to be created. The current configuration data, indicated with an asterisk * ”, will be
saved in a preset with this name. When a preset is selected, all the parameters
marked with an * after their name will be changed to the new value defined by the
selected preset. Parameters that do not have the symbol * after their name do not
depend on the format, so they remain the same when changing from one preset to
another.
The next option is Delete Current Preset.... This allows deletion of the active preset.
To modify an existing preset, select the preset to be modified, change the values and
press the Save Preset button.
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Important note: If the values of a preset have been changed and then another one
is selected, the system will show a message to this effect, asking whether the current
preset should be saved before changing the next, since if we do not, any changes will
be lost. If we exit by clicking OK without having clicked Save Preset, the changes
made will not be saved with the current preset, although they will be in effect for the
following work sessions in Mamba, until the presets are changed again.
Autosave time (secs)
[300 (10 / 10.000)]
This defines the frequency (in seconds) with which the system makes an automatic
save of the environment (the archive has the same name, ending in _auto.env). In
this way, in the case of system failure, the last automatically generated backup can
be reloaded.
Note: In certain systems the process of autosave can require the temporary
disconnection of the video output, and in these cases the video monitor image will
disappear for a short time. This is not of particular importance, as Mamba never allows
this to happen during playback or video capture.
Expert mode
[False (True / False)]
If this is activated, then the next time the tool is started up infrequently used
parameters will also be loaded; it is recommended that they are only modified after
consultation with Mamba’s technical department.
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C-3 File Paths
Specifies the work directories that SGO Mamba will use. These fields can be written directly
or can be selected graphically using the selection button accompanying each one (this
latter method is recommended as it helps prevent errors).

File Paths

Project directory
Default value: C:/MATERIAL/WORK.
Range: text field that indicates a folder in which the user has write permissions.
Description: folder that stores Mamba projects. New projects generated are stored
here.
Keep tutorials project
[False (True / False)]
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If this is activated, when changing the location of a projects (Projects Directory), a
link to the project "tutorials", included with the SGO Mamba distribution package, will
be created in the new location. It is recommendable to keep this, since future
versions will try to install useful examples, specifically relating to updates, in this
project.
Audio-> Audio Tools Output
Default Value: C:/MATERIAL.
Range: text field that indicates a folder in which the user has write permissions.
Folder that stores files created via audio tools of SGO Mamba,in Dashboard>Audio.
There is also a directory of the audio files (files.aiff y .wav) stored in versions of
Mamba prior to 6.5. These files are generated when clips are captured with audio or
when rendering with audio.
Select DCP MOVIES Directory
Default Value: C:/MATERIAL/DELIVERY/DI.
Range: text field that indicates a folder in which the user has write permissions.
Directory where files and folders created by the export of DCP packets are stored. It
also serves as an obsolete directory to make projects prior to SGO Mamba v6.5, in
which Movie files make reference to this directory, compatible.
Change Render Setup Directory
Default Value: C/MATERIAL/WORK.
Range: text field that indicates a folder in which the user has write permissions.
Description: directory that stores Render Setup presets. These files may be shared
between various SGO Mamba users in a network. This link is available viaDashboard>Output->Render.
Predefined storage paths (Path Builder)

Path Builder is a tool that allows the user to define target directories for render processes
of any type. Once defined here, these different types appear as available in the Output tab
(Dashboard->Output->Render). These render targets allow the automatic construction
of complex directory and name paths, using different useful information such as the name of
the render, the file name of the original media, etc.
It is recommendable the the filesystem chosen is "SNFS", since Mamba especially optimized
for this type of filesystem, as it is the only one that offers realtime performance with DPX
2K formats and higher. When this is not possible (on laptops and training systems), use at
least an "XFS" filesystem. Other types of filesystem offer performance that is much lower
than those mentioned.
The window Path Builder contains documentation explaining its use.
PATH BUILDER - Manage storage paths
Button that opens a new window of Path Builder.
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Def. Paths
Data field for information showing the target names defined via Path Builder.
Media Folder Policy
Options for indicating the overwrite behavior of media type files that the SGO Mamba
will create before carrying out a render.
Path Builder

Path List
List of all the defined and created directory paths in use.
File format
Options that allow the definition of the image format to be associated with the
directory path:
Xfs.dev
Uncompressed .js Mamba clips.
Movie.dev
Movie-type clips, sequences of compressed images in a single file.
Disk.dev
Image-type clips, sequences of numerically ordered images.
Sound.dev
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Audio-type clips, .aiff or .wav files.
Symbolic Name
Data field that allows the definition of the names with which the path will be viewed in
Mamba's interface, within the Target menu (TimeSpace Editor->Dashboard>Output->Render).
Basic fields
This series of buttons allows the construction of a master model according to which
created files will be named.
Each directory is represented by the name defined by the user (Symbolic Name) with
an underscore (_) used as a separator. Direct editing is permitted in Storage Path
following this syntax, although care is recommended for safety when using the
buttons.
Base folder. Button that opens a new system explorer window, in order to select
the location of the directory.
[project](Project Name)
[renderName](Render Name)
[segmentIndex](Render Segment Index). Render script number, defined by Edit
Marks.
[tapeName] (Source clip name). Original name of the processed media file (if
there are several, the name of the first to be evaluated is used).
[frameIndex%5](Frame number with padding). Numbering of the frames with
padding.
[frameIndex](Frame number with no padding). Numbering of the frames without
padding.
[ext]. File extension.
Stereo 3D
[eye?labelLeft.laberRight](3D Stereo eye). Defines the eye
chosen in Output.

assigned when

Label for left eye: Left as default, although this can be edited.
Label for right eye: Right as default, although this can be edited.
Other fields
/ (barra), - (guión), _ (guión bajo). Punctuation marks used for improving reading
of the fields defined in the file names to be processed.
[envName](Environment Name). Mamba environment name.
[resolutionX]. Horizontal resolution of the file to be exported.
[resolutionY] Vertical resolution of the file to be exported.
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Storage Path
Data field containing the file model as defined by the user, in nominal syntax values.
Create new path
Creates a new directory path, once the model master is created. The new path
appears in Path List.
Remove selected path
Removes the path selected in Path List.
Update changes to selected path
Applies changes to the path selected in Path List.
Close
Closes the Path Builder window.

Example: Each user needs to adapt a structure and organization for each working
situation; an example of the construction of a path and where it will store a render is shown
below.
Storage Path: In Base folder we choose the folder in which files are saved, /MATERIAL.
Then with the buttons available in Path Builder, we construct the path which will be as
follows:
/MATERIAL/[project]/[renderName]/[eye?Left:Right].[ext]
We define a Symbolic Name as my_path and the File format as Movie.dev.
We open the name test project and in the Output we chose render for Movies, an AVI
format, and our path in Target -> my_path. We name the file to be rendered as myrender
and select in Stereo 3D Mode -> Left Eye Only. We chose the render in Foreground or
Background and the where the file will be found (abbreviated for greater ease):

/MATERIAL
/test
/myrender
/left.avi

This naming syntax allows us to have in a single personalized path, a target for each
project, render name and even define which eye pertains to the file, without needing to
create a relative path for each project.
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Cache files and proxies

Cache Eye
[NO_STEREO (NO_STEREO / LEFT / RIGHT /BOTH)]
Indicates the image or eye to be rendered as the cache when working with stereo
images.
Cache Base Folder
Range: text field indicating a directory in which the user has write permissions.
Description: directory which stores the media created by the cache function.
Cache syntax
Range: text field indicating a syntax similar to Path Builder for defining cache folders.
Cache Device
Range: non-editable field in which the final result constructed with the previous fields
for the cache directory is viewed.
Sequence Proxie dir
Range: text field indicating a directory in which the user has write permissions.
Description: directory which stores the media created by the proxies of sequences of
numbered image files.
VectorParin Temporal Directory
Default value: C:/TEMP.
Range: text field indicating a directory in which the user has write permissions.
Directory for storing the temporary files of the cache of the VectorPaint effect. For
HD or cine projects it is recommendable to redirect them to the fastest available
storage. If the cache is activated (Visual Editor->Dashboard->Paint->Setup>Cache(Use)) the VectorPaint effect stores every modified frame here, so they do
not need to be redrawn each time they are evaluated.
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C-4 Master Format
This area allows modification of the different parameters relating to the image format in
which we wish the application to work, both internally and as output via the video card.

SGO Mamba can work with input images whose format differs from that defined in this
section. What is defined here is the output format, ie, the image format that ALL effects will
produce, both in playback and when rendering (Master Format, in the upper section) and
also the configuration of the output of the video board.
In the case that the output format defined in the first section (Master Format) of this tab
does not coincide with the format to which the video board (in the central area Video board
format), then the parameters of the section Multimastering will be applied to convert to
the correct video format as the last step of the process of the monitor output, without any
of these parameters affecting the render processes.
For example, if we have defined a format of HD 1920x1080 here, we can load 2K images,
which will be processed and rendered in HD, even while using PAL or NTSC monitors to view
the content of the video output. In this example, a render will always produce 1920x1080
images.
Take note that SGO Mamba has some effects that allow the loading of the whole image,
even if it has a different size, but that it will always produce its output image in the format
defined in this section: specifically, the effects Framing, Color Grade and Comp3D have
parameters for defining how this conversion should be carried out. The rest of the effects
simply crop to the center of the image corresponding to the size defined in this section.
Furthermore, it must be remembered that the same environment can be opened in a
different resolution in each session. So, to continue the previous example, in the next
session we can select a de PAL preset (Render Format XY = 720x576) to open SGO Mamba
and produce a render with PAL dimensions.
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C-5 Codecs

Parameters for controlling the render processes applicable to some supported compression
formats. These are typically the codecs MPEG2, Flash-FLV, and MPEG4, although in these
render formats there is also a "Custom" identifier for using codecs installed by the user.
Note: Some user-installed codecs are not included with the Mamba distribution because
they are subject to patents that exclude their use in certain cases. For example, the codec
h264 is not usually included in Linux distributions, although the user can install it if the
licence requirements can be met. Consult Mamba@sgo.es for more details about this kind of
codec.
Metadata variables for R3D files are also included, which can be forces to be used to
overwrite those provided in the file as default, which is the values used by the camera in
filming.
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FFMPEG Codecs

Video bitrate
Video bitrate that the render formats that have definable audio bitrate (usually FLV,
MPEG2, MPEG4, and CUSTOM) will use. The higher the bitrate the better quality the
image will have; the file will also be larger file.
Note: If, when reducing this parameter, there is an observable reduction in image
quality, consider reducing the output resolution instead of the bitrate, as the global
result will improve considerably. It is also recommendable to try increasing the
parameter before reducing the Bitrate.
Note: For material recorded with poor quality or badly maintained cameras, the results
from the available bitrate can be improved by applying a Denoise effect. On the other
hand, for material deriving form graphics or animation systems, the opposite may be
recommendable, and subtly adding noise or dithering, or even blur for images with
hard edges, may be desirable. These techniques produce significant improvements in
terms of making the best of he available bitrate.
Audio bitrate
Audio bitrate that the render formats that have definable audio bitrate (usually FLV,
MPEG2, MPEG4, and CUSTOM) will use. The higher the bitrate the better quality the
image will have; the file will also be larger file.
GOP Size
Distance between 2 keyframes in compressed formats that support GOP (usually FLV,
MPEG2, MPEG4, and CUSTOM ).
A GOP Size set at 1 produces a file that is easily edited in other applications, because
all the frames are a keyframe (compression only occurring between frames). Values
other than 1 define the number of consecutive frames for which only significant
differences from the previous frame will be represented, taking better advantage of
the available bitrate but losing the possibility of navigating to (or close to) a specific
frame in other applications. Very high values may cause the opposite effect to that
desired, and worsen image quality. A value of 5 is usually a good starting point.
Intall additional ffmpeg user codecs
Allows the installation of external codecs that are not provided by default in Mamba,
as well as versions and profiles of existing codecs sucha s MOV and MXF. To carry out
the installation, the codecs should be compressed in .tar, .gz o .tgz, and be valid for
the version of Linux being used.
Uninstall ffmepg user codecs
Restores the codecs library to its original parameters, eliminating codecs installed
manually by the user.
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RED

The following parameters define the default behaviour when importing R3D files. They can
later be changed from within Mamba individually for each file, via the effect R3DParams
(TimeSpace Editor->Dashboard->Fx->Mamba->Color->R3DParams)..
The variables that appear can be defined in the RED camera, and in Mamba we can decide if
we want to use the value defined by the camera operator, force the variable to a standard
value, or give it a value defined by the user.
RED cameras record sensor information in the most optimized way possible, independently of
the values assigned by the operator for these settings. These values only influence the
previsualization that the camera provides, but do not modify the data provided by the
sensor which are saved independently in the R3D file. Thus values are only metadata that
accompany the image file, and so can be changed later without losing information.
Variable
Name of the variable that defines a parameter provided by the metadata of the R3D
file.
Value
Current value for the selected variable. This can be changed to a value set by the
user.
Description
Description of the variable and its possible values.
Force Value
If forced, all R3D clips will use this value by default. If not activated, the value
defined by the camera operator will be used.
Forced
List of variables that are currently forced to a value.
Unforced
List of variables that are not forced to any value (and will therefore use the values
defined by the camera operator).
Force all variables (R3D metadata will not be used at all)
Forces all variables to the values defined for them (or their recommended default
values if they have not been changed by the user).
Do not force any variable (only R3D metadata will be used)
Does not force any value, using metadata of the R3D file for all of them.
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Reduce factor
[2 (1 / 2 / 4/ 8)]
Factor of reduction of when carrying out a Debayer process, as compared with
nominal resolution of the Bayer matrix.
RED cameras do not provide pixel map in their file format but rather the original image
must be reconstructed from various premises; RED cameras use a Bayer matrix in their
sensor, which is to say that each original pixel only provides one color component
(red, green or blue). Also, part of the original detail is lost when compressed to the
JPEG2000 format, and also as a result of the noise signal of the electronics of the
camera itself. As a result of all of this, the image must be reconstructed from
mathematical approximations, and ReduceFactor is the value that gives us the relation
between the number of elements of the Bayer sensor and the number of RGB pixels of
the final image.
The recommended factor is generally a value of 2 (an image shot in R3D-4K format in
Bayer color space will produce a 2K image in the final space of the three color
components per pixel).
It is sometimes possible to obtain a useful resolution by applying a value of 1 (at the
cost of increasing render process time by 4 times), although normally this only
produces additional noise. A way of comparing both versions is to compare the result
in 4K with the 2K version rescaled to 4K (with maximum quality of 15Taps). This way
we can compare and choose the version that gives the best quality.
A common error is to think it is necessary to use a value of 1 to obtain the highest
quality, even if the final format is 4K or greater. In the majority of cases, there is no
difference between using a value for ReduceFactor of 1 or 2, and in many cases the
version resulting from a value of 2 will be of better quality, as it will have less noise
than when the ReduceFactor=1. Nose reduction is especially important in 3D Stereo
formats, where it must be considered over other aspects. A value of 1 must only be
used rarely, in cases where it has been checked that it produces no increase in noise.
Values of 4 and 8 lose quality and are only recommended for versions in SD (PAL/
NTSC) format and for dailies.
Optimize
This field shows recommendation according to selected values for different parameters
in MambaSetup.
Refresh optimization recommendations for R3D files
If we have changed parameters of Mamba Setup, the updates the recommendations.
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C-6 Performance Options
This area allows the modification of different parameters related to render processes. Its
window is shown below:

Max Cache Memory
[2048 (0 / 8000)].
The maximum amount of system cache memory to be used by the software. This
amount of RAM is used to keep the latest images read by Mamba available for any
purpose, avoiding the need to re-read them from disc whenever possible.
Another possible use is when sufficient reading speed is not available to view the
format being used in realtime. If sufficient memory is available we can increase this
value so that the whole shot being worked upon can fit into the cache, so that it can
be viewed in realtime.
Furthermore, in cases of system instability, owing to lack of memory, this is one of the
first parameters that should be reduced to the minimum.
Playout Ring Buffer
[40 (10 / 128)]
Number of frames stored in the buffer of the video output.
During video playback, the system tries to process the frames faster than realtime to
have a security buffer to absorb I/O or processing peaks, up to this value, maintaining
it at the same if possible. This allows for a buffer of images for maintaining realtime
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when otherwise it would not be possible, because of peaks in CPU or input/output to
disc.
If this value is too high, RAM will be wasted. If it is too low, realtime may be lost. The
default value is usually sufficient, although if unexplained Lost Sync errors are
observed it should be increased.
The number of available processed frames in this buffer is represented by the
character "+" at the top of the TimeSpace monitor.
Play Buffer Threshold
[400 (25 / 128)]
Mamba has a guaranteed playback mode called PlayBuffer (a Play icon with a B, in the
Shuttle of the TimeSpace). In this mode, before starting playback the number of
frames defined in this field are processed, so that when playback starts, a security
buffer is available to help manage complex situations, or to carry out playback of
certain clips for which sufficient performance is not available in realtime.
Note: Material transferred to tape will always use this play mode (PlayBuffer).
Note: The default value is set automatically when opening mConfig for the first time,
depending on the amount of memory available; it may not coincide with the value
indicated in this manual.
Hardware Rendering
[True (True / False)]
Activates or deactivates the acceleration of hardware (GPU) during render processes.
When active, most effects are processed directly in memory of the graphics card
using its GPU, which greatly accelerates the process. The amount of graphic memory
needed depends on the resolution of the image format, on the number of Inputs of the
most complex effect and on the resolution of the graphic mode of the interface
(adding together both monitors, if there re two), so the limits to which it is possible to
render by hardware depend on each different case.
Note: Many effects currently only work if this parameter is activated, so it should only
be deactivated for troubleshooting the graphics system under the guidance of the
technical support team.
Hw. render in monitors
[True (True / False)]
Activates or deactivates the acceleration of hardware (GPU) in the evaluation of the
TimeSpace monitors and render processes. It should only be deactivated for very old
graphics cards or if they originate manufacturers other than Nvidia, in cases of
observing that effects either produce incorrect results or do not work at all.
Create Proxy Previews
[False (True / False)]
Indicates whether proxies should be created when capturing a video clip. If
deactivated, the proxies will have to be created each time they are required (and
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they will not be saved to disc), thus consuming greater disc bandwidth, so it is
recommendable to activate this option whenever sufficient disc space is available, and
especially in the case of using shared storage between several systems.
Low Res. Ratio
[2 (2 / 4 / 8 / 16 / 32)]
Factor of reduction of the preview images or Proxies in low resolution, and of playback
in low resolution (Mamba Setup->Interface->Playback Resolution). For example,
if we have PAL (720x576) and we set a value of 2, the proxies will have a resolution of
360x288.
Proxy versions may be obtained in various ways:
Automatically
when
capturing
>CreateProxyPreviews).

video

(MambaSetup->VideoI/O-

During a render if Proxy Image (TimeSpace Editor->Dashboard->Output>Render->Proxy Image) mode is activated.
If a render is carried out to create proxies via the command Redo Proxy
(TimeSpace Editor->Dashboard->Output->Render->Redo Proxy).
These low resolution versions are used in the monitors and the Visual Editor if the
Proxy in Monitor Display is active.
In these modes, when they are not saved to disc, they are produced on-the-fly in the
RAM memory and are then discarded. Proxies allow more rapid access to disc or
processing of images, but at the cost of temporary loss of image quality.
The creation of proxies is described in more detail in the chapter about the tab Output
.
Parallel CPU Cores
[2 (2 / 64)]
Number of system processor cores that we wish to use (this requires SGO Mamba
licensing, according to the number of processors). It is recommendable to set the
total number of cores of the workstation, although this can be reduced if we wish to
reserve cores for other simultaneous applications.
Encode Threads (j2k...)
[24 (2 / 64)]
Number of parallel render processes intended to process certain complex codecs (such
as j2k and VC-3).
The most common use is for creating DCP. It is recommendable to set this value at
the same as Parallel CPU Cores.
Read from multiple disks
[False (True / False)]
Activates or deactivates the reading of sequences of files from different storage
discs. It allows the doubling of I/O Threads, for sequences from different discs to be
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read simultaneously. However, it should be deactivated if the sequences are in the
same disc, as it slows the operation if configured to search on other discs.
I/O Threads
Indicates the number of parallel processes for decoding sequences of images of
formats such as DPX and R3D. Normally this should coincide with Pipe Units. When
there are 2 streams located in different discs, it is recommendable to double the
number of Pipe Units.
Pipe Units HighRes
[8 (1 / 16)]
Indicates the number of consecutive images of a clip that are read or written in each
simple read/write operation. It is used to optimize input/output to disc.
Important note: this parameter affects the reading of all images, not only those
contained in the realtime storage buffer, but also those that have been referenced via
links to other locations.
Its value especially affects those effects that use several clips at the same time,
such as Mix & Wipes and others, and also the shared storage environments, so in
these cases it is much better to read several frames of each clip in each disc
operation. This reduces the seek time of the discs.
In the specific case of the DPX format, the value of SNFS->Threads is used to carry
out its parallel reading, so this must be defined in the relevant section.
Furthermore it is recommendable to leave the value at the minimum (1) when dealing
with especially large formats (such as 8K) whose buffers may use large quantities of
memory, and also for smaller formats that, owing to the equipment in use, will not
provide realtime processing under any circumstances, as this will free memory space
and, also allow playback speed to be more or less constant, instead of by frame
packets of the defined size.
Pipe Units LowRes
[8 (1 / 32)]
Has the same meaning as the previous section, with the difference that it is for
reading proxies in LowRes mode.
Render Units
[5 (1 / 16)]
Indicates the number of frames that are processed simultaneously and in parallel
during a render process. Generally, it is recommended to set a value similar to the
number of CPUs available, to optimize the processing of formats that can be done on
parallel, such as R3D. However, this uses more memory, so when working with very
high resolution images, or little RAM is available it may be necessary to reduce this
value.
This parameter does not affect Totem-type render nodes which have their own
equivalent parameter TOTEM->cluster Render Units. It does affect Batch Render
types.
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Backload Buffers
[True (True / False)]
Allows the complete deactivation of all the image buffers. This should only be
deactivated for extremely large formats that use too much RAM, given that it will
impede realtime playback of the image.
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C-7 Interface
This area allows modification of the different parameters relating to the user interface
configuration. The window is shown below:

Interface

Double Buffer
[False (True / False)]
Activates/deactivates the use of double buffer in the graphics monitors of the
interface. It is important to activate this parameter when the playbacks need to be
seen in the graphics monitor instead of in the video output, if there is sufficient
memory in the graphics card to maintain a double buffer.
If it is not activated, during playbacks to the graphics monitor, the scan line may be
visible, which might be annoying.
When activated, the images are not drawn directly in the graphics monitor, but are
drawn first in a virtual buffer, which is instantly seen as it coincides with the change
in vertical synchronism of the monitor. Thanks to this, the playback to the graphics
monitor will be cleaner and free from scan artifacts.
This parameter only affects playbacks made in the graphics monitor, and not to
playbacks sent to the video output.
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Playback Resolution
[RES_HIGH (RES_HIGH , RES_DYNAMIC , RES_LOW)]
Sets the default mode for playbacks in TimeSpace, either in high resolution (RES_HIGH
) or in low resolution proxy mode (RES_LOW). The mode RES_DYNAMIC effects
playback in low resolution but toggles to high resolution when playback is stopped,
which is useful for formats that cannot be processed in real time but which we want
to set in full definition in pause mode.
Note: When switching to low resolution, firstly, the low resolution files that make up
the proxies of the image are looked for, and if they are not available, high resolution
images are read, and on-the-fly proxies are obtained, and then the rest of the effects
are processed in low resolution.
Live Video by default
[False (True / False)]
Sets the SDI video output as default when opening Mamba.
Two Monitors
[False (True / False)]
Activates the two monitor layout. If activated, Mamba will use one monitor for the
editing interface (Node Graph) and the other for the composition interface (Visual
Editor).
Note: In general only “side by side” monitors are supported. In special cases, a
monitor may be configured on top of another, but it is recommendable to consult
Mamba@sgo.es, since this requires a highly specialized X-Windows configuration (to
allow the cursor to move from one screen to the other vertically rather than
horizontally, and other details).
Monitor Gamma
[1.0 (0,5 / 2)]
Sets the gamma value of the graphics monitor. Common values are 1.7 to 1.0 for CRT
and LCD, although generally this depends on each monitor and lighting conditions in
the physical workspace.
In any case, this parameter only affects the interface and never the render of the
images or the SDI reference output.
Once set, press the button Load New Gamma, which lies just below the number, for it
to take effect.
Rank Mode, British Style
Rotates the color trackballs of the Color Grade effect to appear as they would for
British colorists' standard use.
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Tablet Device options

Tablet Max. Press
Maximum value for pressure on the graphics tablet.
Tablet Min. Press
Minimum value for pressure on the graphics tablet.
Min. Move Threshold
Minimum value below which the pen is considered not to be moving, to avoid
vibrations.
Title Options

Use Unicode
[False (True / False)]
Defines whether Unicode is used as character codification. It should be activated if it
is necessary to use non-western characters, such as in Asia alphabets.
Default Font
Editable text field which shows the route for the character type to be used by default
in a working session in Mamba.
Use Input Method
[False (True / False)]
Activate this for characters which need input from multiple keyboards for creating a
single symbol, for example when using various Asian languages.
Font Size Default
[10 (0 / 50)]
Defines the default size of the text in a working session in Mamba
Render Interface

Render to Video
[False (True / False)]
If active, the render produced by Mamba is also directly sent to the video output.
This parameter must be deactivated carefully as the workstation needs to receive
correct video synchros (or at least the functioning of internal synchros), or the render
process will be interrupted or may not even begin. The main use is for monitoring the
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progress of a render from any location connected to the same video patch.
Render to Graphics
[True (True / False)]
If active, the images produced during a render are shown in the graphics monitor.
Otherwise, only a small window showing the progress of the render will be shown.
Default render name
[True (True / False)]
Defines the default name that appears in the field Auto Name (TimeSpace Editor>Dashboard->Output->Render->Render Name), to which will be added a
numerical counter (this counter appears in the panel of the render as an informative
title).
Save before render
[True (True / False)]
If active, (recommended), Mamba saves the environment before starting a render
process. It can be deactivated for very large environments if the time required for this
operation becomes excessive.
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C-8 License

Licence

Lic. Expire warning
[10 (1 / 15)]
Number of days warning the system gives before expiry of a temporary user's licence
is due.
The remaining parameters refer to obtaining a licence and are self-explanatory:
To request an SGO Mamba licence, install the software and then provide the following
information to your system provider:
Exact version of the software for which the licence is required.
Workstation model and CPU number.
Videoboard model (SD/HD) and its additional options.
If Tangent Device correction surfaces are available.
Maximum render resolution permitted.
The LMdata codes and Mac Address, provided in this section of the mConfig.
Once the activation codes have been received, follow the instructions provided in this
window to activate the software.
Note: Changes to the system hardware after the application for the licence may invalidate
it.
Expiration
Data field that shows the expiry date of thee licence.
LMData
Data field that shows the LMData code.
This field can be selected and copied to another application (such as an email) using
the central mouse button.
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Mac Addr.
Data field that shows the MAC address.
This field can be copied like the LMData.
Open License File
Allows the MambaV5.dat file to be opened: this field contains the activation code for
the licence. Thus it is possible to renew the licence via mConfig, without needing to
replace the old archive.
The MambaV5.dat file is found at: /var/flexlm/MambaV5.dat.
Change License File
Allows the file that will create the licence to be changed without needing to rename or
modify other licences.
Restart License Server
Allows reconnection with the licence server.
Online Mistika licence request
If the Mistika licence expires outside the period of technical support offered by SGO, a
temporary licence can be requested online.

SGO Mamba 2.0.1 © 2014 SGO

D
The Interface

59

The Interface

D-1 Starting up Mamba
To start SGO Mamba, simply double-click the following icon on the desktop:
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D-2 The interface structure
The main interface of SGO Mamba works with two modes which are complementary and
interactive: the the Node Graph Editor and the Visual Editor.

There are four dependent submodes of the Visual Editor: the Tracking Editor, the Warper
Editor, the Paint Editor and the Title Editor.

SGO Mamba 2.0.1 © 2014 SGO

The Interface

61

The Node Graph mode is used basically for working in the Node Graph, to load clips and
effects into it and link and structure them for composing. The Node Graph is where the
project is constructed, and the Visual Editor mode provides access to parameters and
manipulators that are used to compose and adjust effects assigned in the Node Graph. By
means of dedicated tools, the Visual Editor is the interface used for detailed work and
polishing the project.
In all cases, both modes, Node Graph and Visual Editor, are available simultaneously at all
times to work on the project.
SGO Mamba works with a minimum resolution of 1920 x 1200 pixels and the use of two
monitors is recommended in order to be able to take full advantage of the possible
interaction between the two main modes. The activation of dual monitor use is done via
Mamba Setup (Mamba Setup->Interface->Two Monitors).
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D-3 TimeSpace Editor
Ref. Mamba: TimeSpace Editor
This mode is used for constructing the edit and administrating the position and behavior of
the nodes applying specific tools. In other words, in the TimeSpace Editor the whole of the
Mamba is organized.

The Dashboard is the main control panel that contains access to the majority of commands
and tools in Mamba.

Dashboard

Ref. Mamba: TimeSpace Editor->Dashboard

In the Dashboard area, it is possible to access the majority of commands and tools in
Mamba. These commands are organized by categories according to their use.
Access to these categories is possible via the selection of the corresponding tabs. These
groups of tabs are called Main Tabs.
The Main Tabs are horizontally aligned in the upper part of the Dashboard and provide direct
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access, being activated with a left-click of the mouse.
Some tabs (such as FX) contain subcategories grouped according to the function carried
out by the commands in the main category. These subcategories also provide direct access,
via the tabs Options Tabs.
Project

Ref. Mamba: TimeSpace Editor->Dashboard->Project

The Project tab allows the search in the directory that contains the Mamba projects.
The creation and elimination of projects is administered from this tab. It also defines the
parameters for carrying out security (or back-up) copies of the data.
C ommands

Projects List
This list contains all the projects that in the root work directory; it is defined in
Mamba Setup (Mamba Setup->FilePaths->Projects).
Current Project
The information box Current Project allows the current project to be viewed.
Project Actions

Enter Project
Defines as active project that which corresponds to the selected directory.
Mamba uses the active project as default location for all the file loading and saving
operations, although with the tabs Import and Media the file system can be navigated
in order to import or load files from any accessible directory.
By default, Mamba creates a project named PDEFAULT during installation. This project
can always be deleted by the user if so desired.
New Project
Creates a new project and the subdirectory structure necessary to support it.
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When the project is created, it is automatically made the active project.
Delete Project
Deletes the active project, with all its directories, contents and the media to which its
clips refer.
When this button is pressed, it is necessary to confirm that deletion of the entire
project is intended, as the metadata and source files that pertain to this project are
deleted as well (the .js files whose names begin with the project name).

Import

Ref. Mamba: TimeSpace Editor->Dashboard->Import

The Import tab is shown in the Dashboard as a parallel browser to the Media tab.
The Browser of the Import tab is recommended for browsing and importing media from
directories that do not pertain to the active project.
This folder browser is opened via the directory tree and allows navigation through any folder
that is visible to the OS in order to import or re-link image or audio files.
By means of this tab (and differently from Media) it is possible to maintain the navigation
position in the directory although we have changed tab or mode in Mamba. For example,
this is very useful for setting a folder of the local network and doing multiple imports of files
one after the other. The Media tab keeps the folder of the project as its default position.
Browser

The Browser is the administration interface for projects, navigation, selection, loading and
saving clips and files.
For specific tasks, this panel should interact with different panels, especially with the
Source Monitor, which is explained in detail later in this document.
Directories structure:

Mamba projects consist of standard directory structures, where files are organized so as to
be visible in any operating system.
In addition, all Mamba metadata files are in plain text (ASCII) that can be interpreted by any
text processor.
Other systems use encrypted databases, or require special applications to be able to share
their projects. On the other hand, Mamba’s projects are totally transparent to other
systems, and can share metadata without the need to acquire additional applications,
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allowing other developers to work with this data to create their own project routines. These
characteristics make Mamba as the most open system of all software products in its
category.
When creating a project, Mamba generates a standard directory structure, which can
partially redefined by the user:

be

The user must designate a unique directory to contain all the projects. Initially, Mamba
creates the /home/Mamba/WORK directory as the project directory, but the user can
modify it later in Mamba Setup (Mamba Setup->File Paths->Projects).
The user can modify this at any time if the directory has been moved, or if projects that
exist elsewhere are required to boot with Mamba.
Within this projects directory (WORK), each project that is created generates a basic
directory with the same name as the project, and all the subdirectories that it contains are
considered part of it.
In the design of this structure, the following tools provided by Mamba should be borne in
mind:
The Browser distinguishes between each type of file by writing their names in different
colored letters, as well as placing a distinctive icon to their left.
The Browser permits files to be sorted by different criteria: alphabetical order, type of file,
date, input and output timecode, video tape source, media size on disk, length, format, etc.
This means that it is not necessary to design the subdirectory structure to organize the
files on these lines, but that it should be used in a more abstract sense, to represent the
meaning of each element of the environment (for example, directories could be created to
divide the clips according the shooting location, and then subdivided again by the scene or
effect to which they pertain).
It is not usually necessary to create subdirectories to store the subclips (.sub) that are
generated in the Browser or the TimeSpace, since the subclips have file names that begin
with the same name as its master clip but are displayed with a different color. It is
therefore sufficient to sort the Browser by field name, and thus a very useful list will be
obtained in which each master clip will be shown followed by its subclips in a different color.

When a new backup to video is created, Mamba generates a subdirectory for the new
backup, in which the following files are saved:
An environment (.env) containing all the clips of the project that coincide with
the current resolution specified in Mamba’s configuration, which must be
loaded in the TimeSpace to be transferred to video with the VTR tab.
A disk cleanup file (.cln) which, when double-clicked, runs a process to delete
the media from all the clips included in the backup.
A restore file (.res) for each clip of the project that contained media when the
backup was created. These files are similar to normal clips, but their In/Out
Points refer to the location of the clip in the video tape that will contain the
backup.
Note: remember that in backups to video only clips captured on video and those derived
from Mamba renders with be included. To backup other files, use the tool Sequencer (
Sequencer->Backup).
All the project metadata that the user will use are stored in this directory:
All image and audio clips of the project (.clp). Remember that these files do not
contain current images, but rather metadata for referencing the current image and
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audio files stored elsewhere. These reference clips are created when capturing or
importing.
The remote clips (linked clips) are generated when image or audio sequences in
external formats (.tga, .dpx, .wav, .tiff, .cineon, etc.) are imported. These clips
have the .lnk. extension.
This type of clip is also created when importing a Mamba image source file (.js) that
pertains to another project, in order to be able to indicate that its management in
terms of backups, deletion, etc. does not in principal to the current project.
Work carried out in TimeSpace, both editing and compositions (.env files).
The clips that are saved from within Mamba, such as subclips (.sub files) effects (.fx
files) and groups (.grp files).
The subdirectories created by the user to organize his clips.
The RENDER directory is located within the DATA directory.
Each time a render is run, this directory is used to save both the scripts generated by this
action (.rnd) and the clips resulting from the process (.clp). These files are organized in
subfolders, each one containing the results of each render operation. (including all the
segments that are put in order in the same operation).
The render scripts can be reloaded in TimeSpace to repeat a render process, and its
parameters or duration can be modified if necessary. The structure of a render script (.rnd
files) is identical to that of a group (.grp files).
within the DATA we can create as many the subdirectories as we wish and these can
contain new levels of subdirectory if desired. This allows us to create the structure that is
best suited to the project in hand.
It may often be necessary to save a local copy of small user files such as EDL's, logos,
isolated images that need to be saved in a folder that pertains to the project's structure,
in order to keep the work well-organized.
It is recommended to use this default folder in order to copy small files to be imported and
even create the subfolders considered necessary.
When dealing with sequences of large files, the system allows importation via direct linking
to sequences found in any directory that is accessible to the OS, and so they should not be
placed here, but rather in locations that have sufficient storage and the appropriate
features for the chosen format.
This directory stores:
Files that the user can save voluntarily from different interfaces, such as
tracking files (.trk), warping files (.msh) and vectorial shapes (.shp) amongst
others.
Groups .grp that have been saved manually.
Compressed .grpz type groups that have been exported manually.
This directory stores files for the internal use of Mamba’s effects, such as Metadata
generated by some effects and plugins (it is essential for the animated mesh of Warper, the
vectors created in VectorPaint, and the texts in Title).
As the groups and environments saved so not contain this data, when copying them to
another system, use the button Packaging Group to create a .grpz group which will contain
this data.
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Directory exploration commands:

Home
Returns to the current project directory.
Up
Moves up one directory level.
Refresh
Updates the viewing of the browser.
Current
Specifies the directory selected as the current one, viewing its contents only. This
gives more space and simplifies file location. The equivalent is double-clicking on a
directory.
Directory Path
This field specifies the access route to the directory being viewed.
This field can be edited, and any path that exists in the file system may be entered so
as to view files of any project, including directories located in other project
workstations connected to the network.
If a nonexistent path is entered, the field will be written in red letters, indicating the
error in writing the path.
After entering the desired path, it should be confirmed by pressing <Enter>.
On the left, a dropdown button displays the history of the access routes explored by
the Browser in the current session of Mamba, facilitating navigation between the last
directories explored.
File administration commands:

New
Creates a new user directory within the DATA directory. The user can organize his
clips in this new directory, moving them there or creating them directly in it.
After pressing this button, the name of the directory should be entered and its
creation confirmed.
Cut
Moves the files selected to the clipboard.
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Copy
Copies the files selected to the clipboard.
Paste
Pastes a copy of the content of the clipboard.
Remove
File deletion command.
This command deletes a directory with all its contents, which will be viewed in a
confirmation list. For this reason this tools has confirmation windows containing a
description of the files to be deleted.
Each type of file is differentiated in the deletion confirmation list, and the deletion of
each type of file can be activated or deactivated.
Clip links (.lnk), subclips (.sub), groups (.grp), renders (.rnd) or environments (.env)
refer indirectly to the media being used.
Image clips (.clp), as with the mixed audio and video clips generated in a capture,
have different deletion options as they refer directly to a media file (the system will
ask before deletion).
Master Clips
Permanently deletes both the referenced media and the metadata of selected clips; it
is impossible to recuperate the data to recapture the clip after this command is run.
High Res. Deletes the image media of selected clips.
Low Res. Deletes the media of the proxy assigned to selected clips.
Audio Media. Deletes the audio media associated to selected clips.
Note: It is not possible from within Mamba to delete only the metadata of a clip and
keep the media on disk without reference. This prevents the user deleting files
mistakenly, and avoids the existence of un-referenced media.
The Low Res delete option is very useful on critical occasions in order to free storage
space, as is the deletion of media of clips, which can be recovered by Metadata, and
the media recaptured or processed again in the workflow where the media derives
from at a later time.
Other files related to Mamba
Deleted other types of file that are not media with the .js extension but pertain to the
Mamba environment, eg, render groups (.grp), render scripts (.rnd) and output
formats Movie and Images.
Directories and files NOT related to Mamba
Deleted folders and files that do not pertain to the Mamba environment , eg,
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directories where renders are stored.
Linked Clips and their links to media
Deletes files the with .lnk extension and the references to media they contain.
Environments
Deletes files with .env extension.
File viewing commands:

Files in the Browser can be viewed in three different ways, although some characteristics
are common to all three modes.
To identify the types of files with ease, the letters of each file type have an identifying
color code:
Directories are white.
Clips (.clp) are mid-green.
Subclips (.sub) are yellow.
Links (.lnk) are cyan.
Environments (.env) are blue.
Autosave files (.auto) are orange.
Groups (.grp) are light green.
Audio media files (.aiff) are rose-colored
Files that in importable–data formats such as EDL, text files, tracking files,
grids, and image formats (.tiff, .tga, etc) are light gray.
Vectorial forms (.shp) are orange.
Renders (.rnd) are magenta.
Mamba’s media files (.js) are violet.
Mamba’s private files (.dat) are red.
Files not recognized by Mamba are dark gray.
To select any type of file, left-click with the mouse.
To specify a visible directory as the current one, it should be selected, followed by running
the Current function or double-left-clicking on the directory name.
If the number of files viewed is greater than the panel size, the view can be scrolled with
the vertical offset bar of the Browser, or by pressing the right mouse button on the panel
and pushing the view vertically.
It is also possible to maximize the vertical size of the Browser, making simultaneous viewing
of a large number of files possible. The maximize button is in the top right-hand corner of
the panel. To return the panel to its original size, press the same button again.
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The contents of a directory can also be viewed without needing to explore it, by expanding
its contents from the icon to the left of its name. Left clicking the directory shows the
contents of the directory expanded. To collapse the directory, press the same button
again.

Directory expansion permits simultaneous exploring of several directories, which also
simplifies the moving of files between the folders of a single project. To move one or several
clips between different folders, follow the steps below:
1. Select the files to be moved.
2. Run the command Cut to cut the files from the original directory.
3. Select the folder where the cut files are to go.
4. Run the command Paste to locate the files in the new directory.
Note: If any other function is used during the process, the files will not be moved from their
original directory.
In addition to being able to distinguish files by their names, and the type of file by color,
additional data that can be displayed in the browser, depending on the display mode
activated.
The three Browser view modes are:
Show Names
File viewing mode that shows the file name and the color code. This mode is the most
basic, but it permits viewing of a large number of files at the same time.
Show Icons
File viewing mode that shows the file name and the color code, plus a small icon
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showing the default frame in the case of an image clip, and an icon that identifies the
file type. This mode is the most useful for finding material visually.
Show Details
File viewing mode that shows the file name and the color code, a small icon showing
the file type, and a series of adjustable data columns that show the file details.
These columns are useful for changing the criteria of the sort order.
Note: Many types of file do not have all the information necessary to complete each
data column, which in these cases does not show any. In this mode, it is possible
navigate between files by using <Arrow Up> and <Arrow Down>.
The data columns show the following file details:

Name: File name
Tracks: Image or audio tracks assigned for this clip. Only the clip files (.clp)
will show data in this column. They will show if video is assigned to them (V),
and the number of audio channels (A).
Length: Length of the clip.
Start: Timecode of the start of the clip, both for captured clips and imported
DPX file sequences.
End: Timecode of the end of the clip, both for captured clips and
DPX file sequences.

imported

TC Aux 1 and TC Aux 2: Auxiliary timecode of the clip, as in the case of .R3D
files.
Size: File size: specifies the space occupied on disk. Clips will show file size of
their media, if they have any.
Date: Date of creation or last modification of the file.
Tape Header: Internal name of the file that supports some formats (como .
dpx).
Path: File path.
File Name: File name.
Format: File format of the clip media.
Comment: User comments on the clip, inputted in the capture panel.
The data columns have a button header with a name that identifies each data type.
The active column button specifies the vertical sort order of the files. Pressing any of
these buttons with the left mouse button specifies an ascending alphanumeric sort
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order starting with the data of the selected column, and if pressed again with the
same column activated, the sort order changes to descending.
In the margin to the right side of the columns button is the column width manipulator.
To adjust the width of the column, right click the manipulator and drag it to the
required width.

Left, Right
To the right of the dropdown Show there are two buttons with arrows pointing left
and right. These move the column view to the left or right, closing and opening the
columns from the left, thus facilitating viewing of columns that are not visible due to a
possible lack of space in the window.
File Commands:

Import commands only work for supported file formats. For more information, consult the
chapter compatible Formats.
Import
Links the selected file by creating a clip of type link which is kept referenced to this
media. This command can also be run by double-clicking any image or audio file.
In Mamba, it is possible to create link-type clips (.lnk), that refer to image and audio
files that are not necessarily found in the real-time storage of the workstation. In the
link clip, the original location in the network is indicated (subsequently, the decision to
make a render in order to bring it to real-time storage can be made).
In the case of image files, if Mamba detects more files with the same name and
continuous numbering as the selected file, the dialog box permits the following
options:

Link single image only
Creates a clip for each image selected file.
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Link as interlaced sequence
Creates an interlaced video clip for each sequence of the selection that is numbered
consecutively.
Link as progressive sequence
Creates an progressive image clip for each sequence of the selection that is numbered
consecutively.
This method permits the selection of multiple files to be imported en masse (keeping
<Shift> depressed during the selection). In this case, they should all be of a similar
format (all audio or all image, and should also be the same file format).
Import All Sequences
Allows the linking of all existing image sequences in an external directory tree with just
one click tree. To do so, select them (or the directory that contains them) and click
this button.
This operation creates link-type files (with the extension .lnk) in a new folder within
the DATA directory of the project, and also incorporates them into the current edit. A
window may appear indicating the progress of the task, depending on the number of
files to be imported.
Import All Movies
Allows the linking of the Movie-type files in the current folder in a single operation
without needing to select them. This operation creates link-type files (with the
extension .lnk) in a new folder within the DATA directory of the project, and also
incorporates them into the current edit. A window may appear indicating the progress
of the task, depending on the number of files to be imported.
Note: Before conforming an EDL against numbered files or Movies, it will usually be
necessary to use these commands, since the conforms against these files is based on
clips that have already been imported.
Import Setup

Import All Setup

Allows the definition of how names and metadata are created, for obtaining the clip
names and make the Conform easier. A generic file path is shown, and directory
nodes, names and extensions desired for the new clips named can be can be created.
Once defined, click Ok and import the files.
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Link Media As
[Progressive (Progressive / Interlaced)]
Defines whether the media is progressive or interlaced.
Organize
[All Links in One Folder (All Links in One Folder / Replicate the Folder Tree)]
Allows either the organization of all the sequences to be created in the /DATA
directory in the same folder, or replicates the folder tree of the selected folder, with
each sequence in its corresponding level in /DATA.
Tools

Relink
Allows the relinking of files that have previously been imported that appear offline. To
do so, select the clip in the TimeSpace and click Relink. A window appears with the
path defined for the clip selected in the TimeSpace (the filepath is refreshed by
clicking another clip in the TimeSpace) and selecting the new folder via the Browser in
the Import tab.
Source

Load in Source
Loads the selected clip in the Source Monitor.
This function is implicit when selecting a clip, although certain types of file with
complex evaluation are not automatically loaded, in order to reduce loading times, as
it is necessary to calculate the processes that they may contain. For these types of
file (.env, .grp and .rnd), this function should be used, or double-left-click on it.
Save from Source
Saves the contents of the Source Monitor to a file in the Browser.
The duration of the file generated will be defined by the value of the input and output
points in the Source Monitor.
The purpose of this function is to export a whole clip or part of one of any type in
separate files, and facilitate distinguishing rapidly between project files, making
possible their later reuse in the same or in any other project, and even from another
workstation.
The type of file created will vary according to the type of clip loaded in the Source
Monitor.
The types of file that can be saved in the Source Monitor in accordance with their
type of clip contents are listed below:
A single image or audio clip, or mixed clip (.clp): saved in a subclip file (.sub)
in the Browser, in order to distinguish them by their name or to divide a clip
into several parts. To load a single image or audio clip, or a mixed clip in the
Source Monitor, any clip can be selected in the Browser, or copy a clip from
the TimeSpace with the function Copy.
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Note: the file name of the subclip will be specified automatically, using two
different criteria depending on its origin: if the clip comes from the TimeSpace
with a modified name (which can be modified from the tab Attributes ), this
name will be repeated. If the clip comes from the Browser, a numerical
extension will be added to the original name of the clip to be automatically
incremented to avoid overwriting another subclip. Example: MyClip_001.sub.
Various clips whose file type is irrelevant, an effect clip or a group clip: to
load a group in the Source Monitor, first select a group clip of various clips of
any type in the TimeSpace, and then run the function Copy of the Edit tab.
Then press Save and a group file (.grp) will be saved in the OUTPUT folder of
the current project, which will contain all the clips loaded to the Source
Monitor. The name of the file must be specified the user in the dialog box
that appears.
An importable image, audio or movie type file: saved in a link file (.lnk),
containing a clip directly related to the selected file in the Browser and
viewed in the Source Monitor. When an image file is selected from within a
numbered sequence, the Source Monitor will load the entire sequence. The
user can create a link to the entire sequence or to the selected frame only,
and choose this option in the same dialog window that will ask for the name
of the link.
Note: In principle, the link file name will be automatically proposed based on
the original name of the selected file, although the user can modify this name
or choose another.
Note: When the Source Monitor views a multiple selection in the Browser, a
single link file will be created including the entire selection.
Using double-click with files:

Most file types are capable of running functions when they are double-clicked in the
Browser.
These have the .clp, .cln, .grp, .env extensions, and any kind of image or sound file can be
imported into Mamba.

When double-clicking an image or audio file that is compatible with Mamba, a
dialog box opens to create a linked clip indicating said file, and then it will be
loaded into the TimeSpace at the cursor's position in TimeSpace.
Exporting Mamba groups (.grp files):

In certain situations when working collaboratively, it may be necessary to transfer part of a
job to another Mamba workstation that does not share storage with the current one in use,
for example when working with rotoscopes done with small systems that then have to be
taken to the main system.
To achieve this, group files group (.grp) can contain part of the contents (or even a
complete environment). But these groups cannot always be transported as they are to
other Mamba systems, since the metadata files associated with some effects and plugins
(such as vectors drawn in VectorPaint, vectored texts in Title, and mesh animations in
Warper) are found in separate .dat files in the project's PRIVATE directory.
The Creating Group button allows the user to resolve this problem as follows:
1. Save a group .grp (select the group, press Copy and then Browser>Creating Group).
2. The group will appear in the OUTPUT folder in the Browser. Next, select it
and press Packaging Group.
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3. Step 2 creates a compressed export group (.grpz file) which contains the
original group and all the related .dat files. This file can be transported to
another system, and then imported by double-clicking on it in the Browser.
Note: images and media files used in the group are not included; if required, they should be
copied or recaptured separately in the new system. For more complex cases, use the tool
Sequencer, which allows recompiling the project with the files media it use.
C ompatible formats

Note: Some of these formats may require not to be included in the basic version of Mamba
and may require additional Mamba modules or licences respective and pertaining to to said
file format.
The following is a reference list of media formats that SGO Mamba is able to read and
import.
Audio Interchange (.aiff)
Waveform Audio (.wav)
Wave64 (.w64)
Audio Interchange Compressed (.aifc)
Text (.txt) (in the Title manipulator)
EDL Text (.edl)
Digital Picture Exchange: DPX 8bits /DPX 10bits / DPX 16 bits in all variants (.
dpx)
Cineon (.cin)
Generic Picture (.pic)
Bitmap (.bmp)
Joint Photographic Experts Group (.jpg)
QuickTime PICT Image (.pict)
Targa (.tga)
Vista Targa Bitmap (.vst)
Flexible Image Transport (.fit)
YUV Encoded (.yuv)
RGB Bitmap (.rgb)
Tagged Image File (.tif)
Portable Network Graphic (.png)
PIX Bitmap(.pix)
Graphical Interchange Format (.gif)
Photoshop Document (.psd)
Maxwell Render (.mxi)
JPEG 2000 (.j2k)
Moving Picture Experts Group (.mpg)
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IRIX Movie (.mv)
Audio Video Interleave (.avi)
Material Exchange Format (.mxf)
Quicktime (.mov)
Redcode Media (.r3d)
Ogg Vorbis Compressed Audio (.ogg)
Ogg Vorbis Video (.ogv)
High Dynamic-range (.vr2)
Vision Research Phantom (.cine)
ARRI RAW (.ari)
Sony RAW (contained in .mxf)
HDR High Dynamic Range(.hdr, .exr)
Apple ProRes 444 (.mov)
Apple ProRes 422 (.mov)
WEISSCAM RAW (.fhg)
CineForm 2D y Estereo (.mxf)
AVC-Intra (contained in .mxf)
MXF VC-3 in all its progressive and interlaced variants (.mxf)
DV25 / DV50 / DV100 / DVCPRO-HD (.mxf)
Flash Video (.flv)
Compressed Movies MPEG1, MPEG2, MPEG4, H264 (.mov, .avi, .mxf)
Uncompressed Movies (.mov, .mxf, .avi)
Canon Raw (.rmf)
Embedded 48khz Audio in movies (.mov, .mxf, .avi, .r3d).
Note: Timecode is supported for .mov, .mxf, .dpx, and .r3d formats and for numbered
sequences which it is implicit in the numbered part of the file name.
Note: Long gop-type Movies can be read but playback must be from the first frame or they
must be rendered to other formats, since otherwise the intraframes ("iframe") cannot locate
a specific frame without reading the previous ones.
Note: Some formats contain Bayer type matrixes which must be decodified with the
Debayer effect (they can be imported but not viewed correctly until this is done). This is
the case of formats derived from Phantom and Weisscam cameras. Others have their own
effects decodifiers, such as Arri D20/D21/Alexa (ArriParams) and RED cameras (R3DParams),
Sony F65, F55, F5 (SonyRawParams) and Phantom (PhantomParams).
Note: this type of format is constantly being developed, so this list may differ by the time
of publication: please read the Release Notes for the latest available update.
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Media

Ref. Mamba: TimeSpace Editor->Dashboard->Media

The Media tab opens a parallel browser to the tab Import in the Dashboard.
. It is useful for administering files within the active project.
By default, this browser opens in the Home directory of the Mamba project. It allows
exploration of any directory visible to the operating system via the navigation commands.
For more information about these commands, consult the chapter Browser of the Import
tab.

C ommands

Time space.

Open
Loads in the TimeSpace the selected file in the Browser. When loading clips, they will
be placed at the TimeSpace cursor position.
Note: Files that can be loaded in the TimeSpace can be clips or environments. Clips
of any type are added to the current TimeSpace. The environments (.env) are loaded
to the TimeSpace, replacing all the contents of the TimeSpace with the clips
contained in the selected environment.
Double-clicking any clip or environment file will add it to the TimeSpace.
It is also possible to use this function with clips in a more powerful way, to establish
the clip position that we are loading:
Left click on the clip to be loaded, while holding down <Alt>.
With <Alt> still down, click on the TimeSpace in the position where the file is to be
placed.
Save.
Saves the contents of the current TimeSpace in an environment file (.env files). If the
TimeSpace is being saved for the first time, a dialog box will automatically open in
order to name the environment.
Save As
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Saves the contents of the current TimeSpace in an environment file (.env), opening a
new dialog box to permit naming it.
New TimeSpace
Closes the TimeSpace in use and opens a new one, in white.
Misc

Packaging Group
Creates a compressed file (.grpz) from the group file (.grp) selected in the Browser.
This compressed file is saved in the directory OUTPUT of the project. The group file
generated now contains the related associated files (.dat) and are ready for later
transfer to other systems in sub-folders.
The decompression and importation of the file .grpz to the active Mamba project is
done via direct selection with double left clicking in the Browser.
Creating Group
Creates a group file (.grp). The name of the file must be defined by the user in a small
dialog window that the system provides. This file is saved in the directory OUTPUT of
the project.
Note: The group to be exported to the Browser must previously be loaded in the
Source Monitor via the command Copy.
Source

Load
Loads the selected clip in the Source Monitor.
This function is implicit in selecting a clip via the mouse, although certain types of file
with complex evaluation are not loaded automatically, to avoid the waiting time
needed to calculate what effects they may contain. For these kinds of file (.env, .grp
and .rnd), it is necessary to use this function.
This way, if we are looking for one of these complex files we can view their content in
the Source Monitor one by one before deciding which we wish to load. Once in the
Source Monitor, we are allowed to load it as a new group via the same buttons
normally used for loading clips.
Save
Saves the contents of the Source Monitor to a file in the Browser.
The duration of the file generated will be defined by the value of the input and output
points in the Source Monitor.
The purpose of this function is to be able to export a part of the TimeSpace in
separate files, from pieces of clips (subclips) or groups with clips and effects, making
possible their re-use fro the same or any other project at a later time, and even from
another workstation.
The type of file created will vary according to the type of clip loaded in the Source
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Monitor.
The types of file that can be saved in the Source Monitor in accordance with their
type of clip contents are listed below:
A single image or audio clip, or mixed clip (.clp): saved in a subclip file (.sub) in the
Browser, in order to distinguish them by their name or to divide a clip into several
parts. To load a single image or audio clip, or a mixed clip in the Source Monitor, any
clip can be selected in the Browser, or copy a clip from the TimeSpace with the
function Copy.
Note: the file name of the subclip will be specified automatically, using two different
criteria depending on its origin: if the clip comes from the TimeSpace with a modified
name (which can be modified from the tab Attributes), this name will be repeated. If
the clip comes from the Browser, a numerical extension will be added to the original
name of the clip to be automatically incremented to avoid overwriting another
subclip. Example: MyClip_001.sub.
Various clips whose file type is irrelevant, an effect clip or a group clip: to load a
group in the Source Monitor, first select a group clip of various clips of any type in
the TimeSpace, and then run the function Copy. Then press Save and a group file (.
grp) will be saved in the OUTPUT folder of the current project, which will contain all
the clips loaded to the Source Monitor. The name of the file must be specified the
user in the dialog box that appears.
An importable image, audio or movie type file: saved in a link file (.lnk), containing a
clip directly related to the selected file in the Browser and viewed in the Source
Monitor. When an image file is selected from within a numbered sequence, the
Source Monitor will load the entire sequence. The user can create a link to the
entire sequence or to the selected frame only, and choose this option in the same
dialog window that will ask for the name of the link.
Note: In principle, the link file name will be automatically proposed based on the
original name of the selected file, although the user can modify this name or choose
another.
Note: When the Source Monitor views a multiple selection in the Browser, a single
link file will be created including the entire selection.
FX

Ref. Mamba: TimeSpace Editor->Dashboard->FX
Information abut the functioning of the effects in Mamba are explained in detail in the
chapter Mamba FX.
C urves

Ref. Mamba: TimeSpace Editor->Dashboard->Curves
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This panel shows and edits the parameter values of any effect clip, Timewarp group or
audio clip selected in the TimeSpace.
All the parameters of clips in Mamba can be animated in time using editable animation
curves in the Keyframe Graph area.
To set many of Mamba’s effect parameters, manipulators can be used that interactively
specify several parameters at the same time.
C urves

In the Curves area, the curves of the visible exported parameters are viewed and edited.
The curves are viewed on a provisional grid, and are composed of different elements, which
can be directly edited.
A horizontal ruler marked in frames appears in the top margin of the grid, where a vertical
guide or dial moves to indicate the current frame. This guide corresponds to the current
frame defined by Current Frame, the active frame of the clip and to the Keyframe Slider of
the Visual Editor mode.

Note: a frame after the last one (after last) can be selected with the dial of this panel.
This box specifies a value in the clip Out Point timecode, thus enabling parameter animation
to be sustained up to the second field of a video sequence.
To navigate within the curve views, drag them with the right mouse button.
The components of a curve are:

Control point (Keyframe)
Control points can have or not have tangents, and can be of different classes. These points
can be manipulated directly or in blocks.
Curves
Interpolation between keyframes calculates intermediate values to draw curves. Any
number of control points can added to these curves.
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Direct editing method:

The selected curve is shown in cyan, and its control points in green. The tangents to the
points are drawn in white. The points or curves that are not selected are drawn in white.
To modify the position of a point or its tangent, select it with the left mouse button.
To select a curve, double-click on one of the curve control points. After selecting it drag it
with the left mouse button.
A selection block can be created to specify a multiple selection, by drawing a rectangular
area that selects all the points within it. To specify a block, left click the mouse on the
background and draw the rectangle by dragging the cursor over the control points to be
selected. This multiple selection can be moved to another position.

To add a control point to a curve, left click the button on the curve while holding down
<Alt>. This technique can also be used to draw a freehand animation curve, since until
<Alt> is released more control points can be added at the positions where the left button is
clicked.
To remove a control point, left click the point to be removed while holding <Ctrl> down.

Viewing options:

This window has a series of commands for adjusting the viewing of the curve with in order
to be able to carry out evaluation and editing of the animation conveniently and accurately.

Max
Expands the Parameters area to full screen. To return it to its normal size, press this
button again.
Zoom X
Zooms the view of the curves in the horizontal axis.
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Zoom Y
Zooms the view of the curves in the vertical axis.
Zoom Reset
Resets the zoom to view all the curves of the effect.
Zoom Fit
Resets the zoom to view the selected curve to the maximum possible size.
C urves Tabs

The area Curves Tabs is composed of five subpanels grouped according to their functions.
Points:

A subpanel that has functions for specifying the type of control point.

Smooth
Specifies the selected point as a smooth interpolation control point.
Sharp
Specifies the selected point as a hard interpolation control point.
Smooth Tangents
Specifies the selected point as a connected tangents control point. The input and
output tangents are connected, therefore when one is moved the other is as well.
Tangents are very useful for creating animations of complex parameters.
Sharp Tangents
Specifies the selected point as an independent tangents control point. The input and
output tangents are independent, and therefore they can be specified separately.
Tangents are very useful for creating animations of complex parameters.
Constant
Establishes that the curve from the selected point to the following control point is a
constant value. If, after the point marked as a constant, there are no control points,
the constant value extends to the end of the curve.
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Curve:

A subpanel that has the functions that affect the whole selected curve.

Hide
Hides the selected curve.
Note: the curve can be selected by clicking in the parameter name in the Value
section, or several curves can be selected at the same time from a folder. When the
curve is hidden, the name and the value of the parameter will be shown as
semitransparent.
Reveal
Reveals the selected curves that are hidden.
Reverse
Reverses the selected curve in the horizontal axis.
Flip
Flips the selected curve in the vertical axis.
Fit
Fits the duration of the curve to the total duration of the effect.
Note: the duration of the curve is calculated from the first to the last control point.
Filter
Filters the selected curve, by smoothing sudden differences between frames.
Note: This filter adds a control point in each frame of the curve.
Flat Tang
Resets the selected control point tangents to flat values. This way, flat tangents
that represent acceleration or deceleration of the animation of a parameter are
specified.
Note: For this command to function, the selected control points must have tangents
before applying the command.
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Block:

A subpanel that has functions that affect the control points selection block.

Duplicate
Duplicates the control points selected by the selection block, and moves them to the
dial.
Move
Moves the control points selected by the selection block to the dial.
Time:

Transport functions of the panel dial.

Go To Head
Positions the dial in the head of the clip.
Go To Tail
Positions the dial in the tail frame of the clip.
Previous Frame
Moves the dial to the previous frame.
Next Frame
Moves the dial to the next frame.
Previous CP
Moves the dial to the previously found control point.
Next CP
Moves the dial to the next control point found.
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Scale:

A subpanel that has functions for scaling curves.
For these functions to work optimally, a selection block must first be defined.
After specifying the selection block, press one of the Scale buttons and drag the cursor
while holding down the left mouse button, and moving it in either of the two possible
directions.

ScaleH / ScaleV
Moves the selected control points in the horizontal and vertical axes.
ScaleL(eft) / ScaleR(ight) / Scale U(p) / ScaleD(own)
Modify the size of the selection, taking as the center of the scale the margin in the
opposite direction to that of selection block.
For example, using ScaleR, if scaling is done towards the right, the distance between
the control points towards the right increases. If scaling is done towards the left, the
distance between the control points is reduced, and they will meet in the in the
margin where scale axis is found. If the scale axis is exceeded, the positions of the
control points are inverted.
Scale0
Carries out a vertical scaling of the selection, taking zero as the scale center, ignoring
the lower margin of the selection block. If the scaling axis is exceeded, the relative
positions of the control points are inverted.
C ontrols

Ref. Mamba: TimeSpace Editor->Dashboard->Controls
Activates the viewing of the editing general parameters of each of the nodes. These
parameters depend on the nodes that are selected, and therefore do not always have the
same functionality.

This also allows the deactivation of the viewing panel in Curves.
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Description

This panel is composed of the following sections:
Parameters Folders
List of folders that contain the parameters of the effect. These folders must be "exported"
for their parameters to editable from their values or curves.
Values
Area of values of exported parameters, as editable numerical fields.
Parameters Tabs
Contain commands that affect the values of the parameters and of the animation curves.

Parameters Folders

The system of parameter folders is very useful for the user, allowing the explicit selection of
parameters to be edited or viewed simultaneously.
Sometimes, if the whole hierarchy of folders is opened at the same time, we may find a
large number of parameters (depending on the type of effect). To avoid an overdose of
information, the folder system allows us to work in the following way:
All the parameter folders have a label and, on its right, a button for exporting the
parameters contained within (export button). When parameters are exported, they can be
edited via the sections Values or Keyframes Graph.
Once its parameters have been exported, the folder shows a visual link drawn to the
exported parameters.
To activate and deactivate this state button, left click over it.

SGO Mamba 2.0.1 © 2014 SGO

88

The Interface

Note: effects possess a default export rule: if the number of parameters of an effect is
superior to that which can be viewed at the same time in the size of the panel, they will not
be automatically exported.
A folder may contain subfolders or not. These subfolders may or may not contain more
subfolders. Folders that contain subfolders are identified with a state button (collapse
button), which is seen at the side of the folder. Folders that do not have this button do not
contain folders. When left-clicked, this button expands the content of the folder showing a
list of its subfolders.
Folders that contain subfolders also have an export button, which exports all the
parameters of its subfolders.
The first folder of an effect is called Master Folder and its label is the name of the effect.
Folders of following levels, when exported, have a identifying label over the exported
parameters in the Value section, indicating the name of the folder. If a folder in a following
level is exported, the label viewed is still that of the second level, since normally the third
level of a folder is an RGB color or a coordinate.
If the list of folders cannot be viewed simultaneously, the list can be shown vertically, by
clicking and dragging with the right mouse button. It is also possible to expand the panel
vertically with the function Max (TimeSpace Editor->Dashboard->Curves->Max)..

A folder can be collapsed although it contains a subfolder with exported parameters. This
collapsed folder is shown by a button to the right of the collapse button, which can be leftclicked to halt the exportation of the subfolder.
Similarly, a folder (collapsed or not) with exported parameters may, via its export button,
temporarily export all the parameters of all its subfolders and later, via the same button,
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undo this exportation without affecting the permanent exportation previously defined for its
subfolders.
This is useful for temporarily viewing all the parameters (exporting the Master Folder) and to
return to the previous export without altering it.
Example of use:

Opens folders to locate the parameters of interest and exports them by clicking the button
on the right (export button).

On closing all the first level folders, the central area now only contains the exported
parameters.

Continuing exporting other parameters, for example, it can be seen that the position and
color of light 1 have been exported, whereas only the color of light 2 has been exported..
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Values

In this section, exported parameters are viewed and numerically edited.
Each parameter is shown with its name, which can be selected to apply functions that
affect the current value and the entire parameter curve. To select it, click on it with the
left mouse button.
To select several parameters at the same time, select each with the left mouse button
while pressing <Shift> or by selecting the folder that contains the parameter from the
Parameters Folder section.
The parameters will be viewed with a maximum of three columns simultaneously, and
sometimes two, depending on the set of parameters of the selected effect. If the number of
parameters to be viewed within the height of the panel, the view be dragged by clicking the
right mouse button.
At the right of each parameter, the value of the parameter in the current frame is shown.
This field can be edited, and the numbers have a color code, that shows the state of the
value of the parameter in the current frame.

The possible states of a value are: default value (gray), keyframe value (green) and
interpolated value (cyan).
The default value is the one assigned when the effect is added to the TimeSpace.
The Keyframe value indicates that the value was specified by the user, by editing this
number, or with a manipulator. The keyframe value is also shown in the of the parameter
curve as a control point.
The interpolated value is that calculated from the extrapolation or interpolation of the
Keyframe values.
The values can be specified in this section in the three following ways:
By editing the value as in a text processor. First double-left-click on the
numerical value to be modified. From this moment, the new value can be
written in, and to validate it click <Enter>.
Triple-left-clicking selects all the numerical value, and thus it can be replaced
directly with the new value.
By increasing the value dynamically, left-clicking the mouse on the number and
dragging it vertically or horizontally. By dragging vertically upwards, the value
is increased, and by dragging downwards it is decreased in case that we
have. If dragged horizontally left it decreases
and dragged right it is
increased.
By increasing the value step by step, left-clicking on the number with the
mouse and then pressing <Up> and <Down>.
Note: Both methods of incrementation work using unit whole numbers. To work with
increments of hundreds, tens or tenths (first decimal place) hold down <Ctrl>, <Shift> and
<Alt> respectively at the same time.
Various values can be modified at the same time. To do so, select the labels of the values
to be modified (<LeftClick> + <Shift>) and click with the central mouse button in any of
these. All the values selected will be modified together.
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Parameters Tabs

The Parameters Tabs area is composed of six subpanels (grouped according to their
functions) and one values box: Current Frame.
Current Frame is an editable field which indicates current frame number. This field can be
dynamically altered, by left-clicking and dragging the value up and down.
Edit:

Undo
Undoes the last modification made to the parameters.
Redo
Redoes the last undone modification.
Insert Point
Inserts a keyframe (or control point) in the current frame with the current value into
the selected parameter It is possible to select several parameters at the same time
from the folder list and insert a keyframe with the current value in all these curves at
the same time.
Neutral Point
Inserts a keyframe (or control point) in the current frame with the default value into
the selected parameter It is possible to select several parameters at the same time
from the folder list and insert a keyframe with the default value in all these curves at
the same time.
Remove Point
Removes the keyframe (or control point) in the current frame from the selected
parameter. It is possible to select several parameters at the same time from the folder
list and remove the keyframe from the current frame of all these curves at the same
time.
Remove Selected
Removes the selection.
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If one or several control points are selected from the Curves,this eliminates the
selected control points.
If one or several control points are selected from the Values section, the entire curves
will be removed, leaving curves with their default value in their place.

Clipboard:

Copy Frame
Copies to memory the parameter/s value/s of the current frame.
Copy Curve
Makes a copy of the curve of the selected parameter in the clipboard; several
parameters can be selected at the same time from the folder list.
Note: Several parameter curves can be copied at the same time, by selecting them
from a parameter folder, and then pasting the entire set of parameters into another
folder.
Paste
Pastes a copy of the curve in clipboard into the selected parameter.
Note: a curve can be pasted into any other parameter, even into another effect
different from the original one, although the curve in clipboard may sometimes have
illegal values for the parameter where it is pasted.
Paste Select
Pastes a copy of the values in the clipboard in the selected parameter/s of a specified
frame.
Layer:

This has functions that affect whole folders or layers of parameters, but are only applicable
to certain effects and transitions that can use these functions, such as Comp3D, Radial
Wave, Multiple Mix and Wipes.
In these cases, each clip will have a different associated folder or layer. By default, these
effects show a single folder for the first input clip when opened for the first time. If more
Inputs have been included in the effect, more folders or layers must be added manually.
For example, if the movement of seven clips is to be animated, it is not necessary to apply
seven Comp3D effects, since the same result will be achieved with a single Comp3D of
seven layers, which apart from saving visual space, takes advantage of the curves of
previously specified layers to generate the following ones (if so required).
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For ease of identification of the folders or layers added by the user, it is possible to rename
each one by double-clicking its label in the list. The label will turn black, allowing the user to
write the desired name.
This is only necessary when the same effect is applied to an indeterminate (and therefore
unpredictable because of the effect) number of clips and is not applicable to an effect that
needs several inputs. For example, the Blue Screen effect needs one foreground inputs,
one background inputs and optionally an inputs with a clean background. These inputs are
predictable by the effect and it is only necessary to include them in their range, and it is
not necessary to use the command Add Layer.

Add Layer
Adds a folder or layer of a set of parameters for a new input clip to the effect.
Add Light
Adds a light source parameter set folder, only available for the Comp3D effect.
Duplicate Folder
Duplicates the selected folder or layer.
Remove Layer
Eliminates the selected folder or layer, and removes it from the list of parameters.
Note: the layer created by default cannot be eliminated, as the effect needs at least
one layer or folder.
Propagate:

Selected
Copies the selected parameter/s of the clip viewed in the Parameters panel and
pastes - or propagates - it/them to other clips that are selected. To make the
selection, select the rest of the clips to which propagation is required and add this to
the selection with <Shift>, choosing the parameter/s to be propagated.
Note: This selection mode can be combined with either of the other two to be able to
define more accurately to which clips the parameters are propagated. If none of the
three is active, All objects is active by default.
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All Objects
Copies the selected parameter/s of the clip viewed in the Parameters panel and
pastes them in all the effect clips with the same type of effect selected, thus
propagating the parameter to all the clips of the same class found in the TimeSpace.
This function may affect many clips at the same time, and so a confirmation window
automatically opens before executing the command.
Perform Propagate
Carries out the propagation of the selected parameters to the corresponding clips
according to the selections made in the previous buttons.
Math:

This subpanel specifies curve animations for the selected parameter, combining
mathematical functions or using animation curves of other parameters as a reference to
generate a new curve.

To create the function, first select the parameter with which to work, then edit the
function in the field and press <Enter>. The expression will be automatically converted to a
curve. The function will continue to be available for future modifications.
In order to create functions mathematical operations, constants and references to other
animation curves can be combined with a syntax.
A list of these expressions that can be combined is shown below:
Mathematical Functions
sin(x): Returns the sine of x in radians.
cos(x): Returns the cosine of x in radians.
tan(x): Returns the tangent of x in radians.
asin(x): Returns the arcsine of x in radians.
acos(x): Returns the arcsine of x in radians.
atan(x): Returns the arctangent of x in radians.
atan2(x,and): Returns the angle of the arc whose tangent is x/and in radians.
exp(x): Returns the value of e to the xth power.
log(x): Returns the natural logarithm of x.
log10(x): Returns the logarithm to base 10 of x.
sqr(x): Returns the square of X.
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sqrt(x): Returns the square root of x.
abs(x): Returns the absolute value of x.
rand(x): Returns a random number between 0 and x.
round(x): Rounds the value of x to the nearest whole number.
trunc(x): Returns a whole number from x by removing its decimals.
min(x,and): Returns the lower of two values x and and.
max(x,and): Returns the higher of two values x and and.
Constants
pi: 3.1415927.
Binary Operations
+: Add.
-: Subtract.
*: Multiply.
/: Divide.
%: Returns the remainder (modulus) after a number is divided.
^: Raises to the power of.
References to curves of other parameters
The syntax does not allow access to the name of another parameter in the function.
However, its curve can be obtained by using another method, which consists of
selecting the parameter curves to be referenced in the function, copying them with
Copy and using the keyword clipboard (or cb) to reference them. The referenced
curves will be used to create the new curve when <Enter> is pressed, but it is not
linked to them for future changes. This means that the generated keyframes can be
modified manually later if required, as functions are only evaluated when <Enter> is
pressed and any modifications made will not be destroyed until the formula is
evaluated again
clipboard(i,t): Gives the value of the curve i at the instant of time t. The curve must
be in the memory, which is achieved with the Cut or Copy commands of this panel. All
the curves that were selected when Copy was run will be in memory, the index i
specifies which of them are referred to following their original selection order.
cb(i,t): is an abbreviated name for the same option.
t: represents time. This time value will have a range between 0 and the duration of
the effect.
Here are some examples:
cb(1,t) + cb(2,t): Uses two curves to create a third with the sum of the two.
cb(1,t) * 2.0: Scales the curve value to double.
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cb(1, 100 - t): Inverts the curve in time (100 frames).
Note: It is important to leave spaces on either sides of the operators. Otherwise a
syntax error may occur.
Setup:

Constraint X
Restricts movement of control points in the horizontal axis.
Constraint Y
Restricts movement of control points in the vertical axis.
Limit X
Restricts movement of the control points by keeping them within the horizontal limit of
the effect. The horizontal limit specifies the total duration of the edited clip.
Limit Y
Restricts movement of the control points by keeping them within the vertical limit of
the effect. The vertical limit specifies the range of valid values for the parameter.
Snap X
Restricts the movement of the control points to the horizontal intervals indicated by
the frames.
Note: When changing the duration of an effect, the control points may remain in
positions that do not coincide with any frame. These control points cannot be edited
in the Values area or the manipulators when this option is activated. However, the
control points can be selected in the Curves section and then moved. With this option
activated, each control point will be placed in the nearest frame.
Auto Key
Activates the automatic mode for generating keyframes.
If activated, a keyframe is automatically inserted in the active frame each time we
modify a value.
If deactivated, this mode establishes that any modification done from the fields of
values moves the whole curve.
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Attributes

Ref. Mamba: TimeSpace Editor->Dashboard->Edit->Attributes

The Attributes tab shows all the available information on the selected clip in the TimeSpace
. It also permits modifying some of the selected clip's values.
C lip Name

Name
The name of the clip. This name can be modified if this field is edited and confirmed
with <Enter>.
Editing this field does not make any change to the stored clip name, thus avoiding
inconsistencies with references to the same existing clip in other edits. Only the
selected clip changes its name in theTimeSpace, without affecting other copies of the
same clip even in the same TimeSpace. This can be useful to identify certain clips,
especially group clips.
Fields

The definition of the Fields attribute is indicated at the moment of capture or render.
Interlaced
Indicates whether the clip has the interlaced attribute.
Progressive
Indicates whether the clip has the progressive.
Note: The state of fields of the clips must be defined by the user. This allows the
incongruence that a clip, although it has fields, does not have the interlaced attribute, for
example.
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Timeline

This group shows the timecode values of the input and output of the clip defined in the
edit.
In
Position of the TimeSpace where the head of the clip is situated. This value can be
edited, moving the clip by its head without modifying its duration.
Out
Position of the TimeSpace where the tail of the clip is located. This value can be
edited, moving the clip by its tail without modifying its duration.
Duration
Duration of the clip in the TimeSpace. This value can be edited, modifying the
duration of the clip by its tail.

Trim Remnant

Head; Tail
Shows the number of remaining frames not being used by the clip in the TimeSpace.
The higher the value, the shorter the clip duration. Negative values are possible,
shown in red, indicating repetition of the head or tail frame of the clip.
Clips can be edited from this numerical field, by modifying their head of tail.
Note: Timewarp group and effect clips do not have a fixed duration, so in these cases the
field cannot be edited.
Source Info

Folder that contains read-only fields with information regarding the media of the selected
clip. Only image and audio clips can show information in the fields of this folder.
In; Out
If the material was captured with timecode information, this shows the start and end
of capture timecodes relative to the original tape.
This field is useful for working with lists of timecodes written in a previous preview,
permitting the user to confirm that the used clip coincides with the timecodes one in
the list.
Note: Clips captured in Start Free mode, or generated by a render, will have a
timecode that is restarted from zero. Group clips, link clips and effects do not have
original timecodes either.
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Duration
Shows the total duration of the clip media.
Tape Name
Number of audio tracks in the clip.
Audio Channels
Number of audio tracks in the clip.
Image File
Shows the name of the image media to which the clip refers.
Proxy File
Shows the name of the media to which the clip refers for the proxy image resolution.
Format
Shows information about format of the image.
Audio File
Shows the name of the sound media to which the clip refers.
C omments

Editable numbered information field that shows the original comments of the clip that have
been added.
In addition to the user comments, comments generated automatically by Mamba can exist.
Such is the case of clips coming from conforming an EDL against a numbered sequence.
Mamba uses this field to store the original information of the EDL line corresponding to the
clip.
Editing this field has no effect on the stored clip comments, avoiding inconsistencies with
the references to the same existing clip in other environments. Only the selected clip
changes its comments in the TimeSpace, without affecting other copies of the same clip
even in the same TimeSpace.
SetUp

Ref. Mamba: TimeSpace Editor->Dashboard->SetUp
This tab is part of the configuration of Mamba. It contains those configuration values that
can be changed without needing to reboot the application for them to take effect.
The rest of the configuration values are set via Mamba Setup and it is necessary to restart
Mamba to apply these changes.
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The commands and configuration values of the panel are grouped according to their
functionality.
Save

Auto Save
Activates automatic saving of the TimeSpace. The time interval is defined in the
parameter Autosave Time in Mamba Setup->General->Autosave Time (secs). The
auto-saved environment will have the name of the active TimeSpace, with the
addition of the ending ".auto".
C urve Animation

Specifies how animations made in Curves behave when the project's duration changes (this
value is changed in Length).
Extend
The curve and its Keyframes do not adapt to the indicated duration, ie, the Keyframes
maintain their position regardless of changes in the length of the project (longer or
shorter). If a Keyframe is found outside the duration indicated, it is deleted.
Stretch
The curve and its Keyframes adapt proportionally to the indicated duration, so their
position is altered, according to whether the project duration is extended or reduced.
Interface

General viewing options for the interface.
Hide Texts
Hides the texts of the names of the buttons. The name of any button can be checked
by clicking on it with the middle mouse button. It can be deactivated while learning
how to use Mamba to help memorize the functionality of each button. However, it is
recommendable to reactivate this function later, in order to reduce the tiredness
caused by the involuntary reading of these texts.
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Text Shadows
Option for adding shadows to the texts on the interface to increase their visibility.
Text Saturation
Sets the saturation of the interface texts.
Text Opacity
Sets the transparency/opacity of the interface texts.
Background Luma
Sets the brightness of the interface background.
Saturation
Sets the saturation of the interface colors.
Output

Ref. Mamba: TimeSpace Editor->Dashboard->Output

The Output tab gives control of the output modes (delivery) of the Mamba project.
This tab is divided into five groups: Render, Export EDL, Export EDL2, DCP and Totem.
The commands of the group Render allow the processing of a selected item selected (a clip,
group or effect). It is also used to obtain clips in Mamba native format (.js) derived from
clips with source material in others formats (tga, tiff, cineon, etc.) and vice versa.
The group DCP contains the fields necessary for preparing export in Digital Cinema Package
format.

Render

From this tab, the Render scripts (files with extension .rnd) and process instructions are
created that can be run immediately or left for later use, and that when processed will
create clips with new media. These new clips will always be placed in the RENDER folder of
the current project.
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Many of Mamba’s effects can be evaluated by the active monitor in real-time, without the
need to store the result of its evaluation on disk.
However, many very complex processes, or even the accumulation of many simple ones,
cannot be evaluated in real-time by the monitor.
In this case, it is better to create a new clip that has media with the result of this
evaluation and read the result of a processed flow directly from disk. The procedure that
generates this new media file is called a Render process.
A render process is also required in order to export to certain file formats that have been
requested.
Mamba’s render, besides being able to create new media, automatically stores the orders
used for its creation. These orders are called Render Scripts, and have an identical
structure to a group of clips. Mamba’s scripts are stored with the .rnd extension, in the
DATA/RENDER folder of the current project, together with the clips generated by the render
of these scripts.
Both render scripts (.rnd) and generated clips (.clp) are stored in independent folders within
the RENDER directory of the current project.
Channels:

Image
Activates the evaluation and storage of the image track for the created clip (channels
RGB or YUV). If off, only audio render will be possible.
Audio
Activates the storage in a new audio media the result of the mix of the audio tracks
included in the render.
In this case, the clip generated will have in its data details the resulting audio tracks,
just as they are evaluated when using active monitor.
Note: the number of audio tracks will correspond to the audio output configuration
defined in Output Audio Channels (TimeSpace Editor->Dashboard->Audio->Setup>Audio Channel Number->Output Audio Channels).
The new audio media created will be stored:
in the directory defined in Mamba Setup with extension .aiff, if the Audio In
Movie button is off;
within the image media file itself as an associated audio stream, if the button
Audio In Movie is on (except for .mxf, files, as explained in the following section).
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Audio In Movie
This causes the audio to be stored within the clip instead of separately. This is only
available for Movie family formats.
To maintain compatibility of files, the configuration value must be present in Output
Audio Channels (TimeSpace Editor->Dashboard->Audio->Setup->Audio Channel
Number->Output Audio Channels) since many applications can only read files
Movie type files with two audio channels.
In the specific case of Flash .flv format, it is necessary to define the sample rate at
44Khz in the Audio->Setup panel. To do so, deactivate MambaSetup->VideoIO>UseVideoBoard
Not all Movie formats support audio.
Mamba supports audio embedded for Quicktime.
Media in MXF format generated by Mamba are stored in order to maintain compatibility
with Editing systems. When exporting in this format, an MXF image file is created with
timecode on one side, and both MXF audio files and tracks that have been configured
by another and stored in the same render destination. As MXF audio files have the
same identifier at their head as the MXF image files, when loaded in an Editing system,
they should be related.
Audio With Movie
Causes the audio to be stored in the same directory as the image clip, but in a
separate .aiff file. This is only available for formats in the Movie family format.
.rnd With Media
Stores a copy of the render script generated in the same directory as the original
media. This makes possible conforming processes in other Mistika systems at a later
time, since this way the work and processes applied are stored together with the
original media, and do not depend on the project. Thus, when arriving at a new
system all the media can be directly linked and conformed against the .rnd scripts
(note: effects which require additional files (Morph, Paint, Title) also require the
project to be available, since they store additional data in the PRIVATE folder).
For more details about the use of this button, consult Example of a global workflow.
Export to Nuke: .nk With Media
Allows the exporting of basic geometric corrections (in the folder Balance Geometry,
modified with the tool Match Geometry) of the Stereo3D effect carried out on stereo
images as the equivalent set of nodes for Nuke, that can be opened without difficulty
and modified using that software.
Setup:

The Setup panel in the tab Output gives the user the option of saving common export
presets. Clicking in the first field shows a list of different presets created (as DEFAULT,
because as no preset will be defined).
Each time one of these presets is loaded, the other fields in the Output tab will
automatically load the parameters defined in this preset.
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Save
Saves the options selected in any given moment in the preset defined in the list of
presets.
Save As
Saves the options selected in any given moment in the preset defined in the list of
presets with the option of renaming.
Delete
Eliminates the selected preset.

Full Res Image:

Specifies the high resolution image format for the media of the new clip generated.
These image formats are divided into three families, with the additional option of not
selecting any of them:
Mamba
Mamba's .js format is an especially designed image format for working without
compression and in real time. Its use is similar to that of Movie-type files, but as well
as greater speed, it allows high-quality formats (RGB 10bit) and stereo pairs
(2xYUV422) which is not possible with traditional formats like Movie.
The file formats are selected via the dropdown button Format:
YUV (4:2:2) in 8 bits (YUV422 8b), as well as it double stream variant (if
Stereo3D is active)
YUV (4:2:2) in 10 bits (YUV422 10b), as well as it double stream variant (if
Stereo3D is active)
RGB (4:4:4) in 8 bits (RGB 8b)
RGB (4:4:4) in 10 bits (RGB 10b)
RGB (4:4:4:4) in 8 bits with alpha channel ((RGBA 8b)
Note: Some other formats are also quick, but if we do not need to maintain
compatibility with other applications it is recommendable to use Mamba's .js format,
since:
In Mamba's .js format, data is aligned with memory pages and can be
transferred quickly via the system buses.
This format is also preassigned in consecutive disk blocks, which also improves
performance and avoids fragmentation of the disks.
In the case of needing similar speed but with a format that is more compatible
with other systems, use DPX, since this format can offer similar performance
to Mamba if and when it is used with a “SNFS” type filesystem and that care is
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taken not to write other sequences while renders are being done (simultaneous
copying processes should not be carried out, but this is not a problem is the
render is to .js format).
For more information on the variations of this format (YUV, RGB, etc) see the section
on color spaces in the chapter Basic Concepts.
The dropdown Target allows the selection of the directory where the files are saved,
with the defined destinations shown in Mamba Setup->File Paths.
The option Default.Mamba_Media establishes that material created will be stored in
MATERIAL/Mamba_MEDIA/[project[]/Mamba_JS/. This default value can be modified in
Mamba Setup (Mamba Setup->File Paths-).
Movie
Movie type files are sequences of images stored in a single .file which could include
audio and timecodes (in the case of .mov and.mxf files).
The formats of Movie files supported for writing are selected via the dropdown Format
:
AVI RGB Uncompressed 10 Bit (Avi RGB)
AVI RGB Uncompressed 10 Bit with alpha channel (Avi RGBA)
AVI DV25 (Avi DV25)
AVI DVCPRO50 (Avi DV50)
AVI UYVY Uncompressed (Avi UYVY )
AVI MPEG-1 (AVI Mpeg1)
AVI MPEG-2 (AVI Mpeg2)
AVI MPEG-4 (AVI Mpeg4)
AVI Custom Settings (Avi Custom)
MPEG Transport Stream Custom Settings (MPEG .ts Custom)
Quicktime RGB Uncompressed 10 Bit (Mov RGB)
Quicktime UYVY Uncompressed (Mov UYVY )
Quicktime DV25 (Mov DV25)
Quicktime MPEG-4 (Mov Mpeg4)
Quicktime Prores 444 with Alpha
Flash Video Custom Settings (FLV Custom)
Quicktime Custom Settings (Mov Custom)
MXF Custom Settings (MXF Custom)
MXF VC-3 Low Resolution
MXF VC-3 Hi Resolution
XAVC (especially recommended for UHD)
This type of format is constantly being developed so it is possible that the list may
have changed since the publication of this document; please see "Release Notes" for
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the latest updates.
Note: Mamba supports writing timecode and audio both in the format MXF and in
Quicktime.
To specify personalized configurations (Custom Settings) edit the file Movie.dev in
Mamba-ENV/etc/devices/Movie.dev.
Remember that most Movie type formats imply compression and loss of quality (except
those marked Uncompressed), so they should not be used for later post-production
processes.
The dropdown Target allows the selection of the directory where the files are saved.
The option Default.Mamba_Media establishes that material created will be stored in
MATERIAL/Mamba_MEDIA/[project[]/MOVIES/. This default value can be modified in
Mamba Setup (Mamba Setup->File Paths).
Images
This type of file provides numerically ordered image sequences.
The formats of image files supported for writing are selected via dropdown Format:
DPX RGB 10b
DPX RGB 8b
DPX RGBA 8b
Cineon RGB 10b
J2K 2k@24 RGB 12b
J2K 2k@24S RGB 12b
J2K 2k@48 RGB 12b
J2K 2k@48S RGB 12b
J2K 2k@60 RGB 12b
J2K 2k@60S RGB 12b
J2K 4k@24 RGB 12b
J2K RGB 12b
TIFF RGB 8b
TIFF RGBA 8b
TIFF RGB 16b
TIFF RGBA 16b
TGA raw RGB 8b
TGA raw RGBA 8b
TGA rle RGB 8b
TGA rle RGBA 8b
SGI RGB 8b
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SGI RGBA 8b
JFIF(jpg) RGB 8b
BMP(win) RGB 8b
BMP(win) RGBA 8b
PNG RGB 8b
PNG RGBA 8b
Photoshop RGB 8b
Photoshop RGBA 8b
Alias pix RGB 8b
GIF RGB 8b
SoftImage RGB 8b
SoftImage RGBA 8b
RAW YUV422 8b
EXR RGB Half
EXR RGBA Half
Note: Mamba can read many other numbered formats not cited in this list, which only
refers to the supported formats for writing in a render.
The dropdown Target allows the selection of the directory where the files are saved.
The option Default.Mamba_Media establishes that material created will be stored in
MATERIAL/Mamba_MEDIA/[project[]/SEQUENCES/. This default value can be modified
in Mamba Setup (Mamba Setup->File Paths-).
None
This button prevents the render of the high resolution version. It will only process
proxy resolution and/or audio.
Regardless of the chosen format, the dropdown Target allows the selection of different
directories for saving generated media.
These files should be previously defined in Mamba Setup, via Path Builder (Mamba Setup>File Paths). For more information about how to create buttons, see the chapter on
Mamba Setup (mConfig).
Proxy Image:

Specifies the low resolution image format of the media for the proxies of the new clip
generated.
Low resolution has the same image formats as high resolution and also the None option. The
size of the low resolution is specified in Mamba Setup->Render Format->Low Res. Ratio
.
The proxies are used when RecordMonitor is in Proxy or Dynamic mode (if they have not
been created, they are done so on-the-fly in RAM during playback).
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Sound File:

The dropdown button Target allows the selection of different directories for saving audio
media generated by export processes (if the function Audio is active).
These folders must be previously defined in Mamba Setup, via the Path Builder (Mamba
Setup->File Paths). For more information on how to create he buttons, see Mamba Setup
(mConfig).
Render Resolution and Framing:

When the Active button is active, this dropdown menu allows the configuration of the
output resolution via similar parameters to those of the Framing tab in Visual Editor.
This parameter is especially useful when needing to create different resolutions for deliveries
other than the resolution of the project. Thanks to this menu, it is possible to do so directly
in the Output tab without needing to reconfigure these values, applying new effects in the
TimeSpace or Visual Editor.
Mamba always produces images in the working format (mConfig->RenderFormat) before they
pass through this output filter, so generally these options should not be used in order to
increase resolution, but rather to produce smaller versions.
For more information on the use of these parameters, see the chapter dedicated to the
Framing tab.
Render Fields Mode:

Progressive
Activates the processing in progressive sweep format (render by frames).
This option must be activated if the resulting clip is to be used in progressive formats
such as HD24p, cine formats or multimedia formats for viewing in RGB graphics
monitors .
Interlaced
Activates render in interlaced sweep format (render by fields). This option is
recommended for processing images that come from interlaced video formats (PAL/
NTSC 1080_25i, 1080_30i, etc).
It is also possible to evaluate processes that evolve by fields on clips that noninterlaced clips (such as type-face movement, to enable their reading on video), if
and when the final viewing mode is a monitor or interlaced.
This mode should not be used unnecessarily, as render times reach nearly double that
of when it is deactivated.
In any case, render by fields should only be used if the result is to be transferred to
video in an interlaced format, whether the original clips are interlaced or not
Render 3:2 Pulldown Mode:

Pulldown allows two-directional conversion between video clips interlaced at 30fps or
29.97fps and cine or HD format clips at 24p (24fps progressive or 23.97fps progressive).
Note: In order to simplify the explanation, on occasions reference is made to "NTSC" and
"cine", although the same is applicable to other formats of similar structure in terms of frame
rate and interlaced / progressive format).
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Sequences derived from standard cine and HD 24p formats have 24 frames per second in
progressive (not interlaced). To convert them to PAL (or HD 25fps) formats no modification
is usually made in the duration, since 24fps is a very similar value to the 25 frames per
second of PAL video signal and normally there is no perceptible change playing them back a
frame per second quicker.
In these cases, it is usually enough to apply a de-interlace effect to convert them from PAL
to cine or from interlaced to convert them from cine to PAL, and similarly the corresponding
audio conversions. For more information about the interlace/de-interlace effects, consult
the information about the Fields group of effects ( TimeSpace Editor->Dashboard->Fx>Mamba->Fields).
However, the formats NTSC and HD60i, for example, use 30 interlaced frames per second
(and so 60 fields per second).
If a cine sequence (24fps) needs to be converted to NTSC, this sequence at 24fps must be
stretched to last 6 frames more per second (30 frames in total). This cannot simply be done
by repeating some frames, as it will be too visually obvious. This conversion is usually done
via a process called "3:2 Pulldown".
The "pulldown" consists of dividing each original progressive frame into two fields (one with
odd-numbered lines and one with even-numbered lines) in order to obtain 48 fields per
second (2x24fps). These resulting 48 fields need to cover the 60 fields per second
corresponding to an NTSC second. This is done by repeating a field when necessary (first at
three frames, that two frames later, then after three frames again, and so on, alternating
the field that is repeated between odd and even, from which process the names "3:2" and
"2:3" come.)
This system achieves an acceptable visual effect for playback, but must be applied at the
end of the post-production, otherwise the material that undergoes this process can cause
problems in editing and post production:
When a 3:2 Pulldown is carried out, NTSC or HD_30i frames may be generated
in which each field pertains to a different original frame, and if this coincides
with a change of shot (which should be always avoided, although material
received is not always as may be desired) there will then be two fields with
very different information in the same frame, which will produce an undesirable
flash effect when viewed. This can also occur if an offline edit is to be made
for later editing of a film reel, since if we have material that has undergone a
3:2 Pulldown process, the cut points may be ambiguous in the frames that
have one field of each shot. Another problem related to the same case is when
applying effects, since in those frames with fields of different shots it is not
normally desirable to apply the same effect to both fields.
The quality of effects can suffer, since the original images do not have fields,
and if a 3:2 pulldown process has been applied and the clip is marked as being
interlaced, Mamba is forced to work with fields when it should be working with
frames.
In addition, render times with the frame process are twice as fast as with the
field process.
If there are several clips that have undergone a 3:2 pulldown process and
they have to be combined in the same effect, there is a risk of their becoming
desynchronized, ie, that they are placed in such a way that the fields added
to each of these clips do not coincide in time.
For all of this, it is best to apply the option Pulldown Remove before working with NTSC or
HD60i material that derives from a telecine, or that has undergone a 3:2 Pulldown. It is
recommended to carry out this conversion even it is required that the material is delivered
at 30fps (and to a carry out this process again as a last step).
On the other hand, if a 3:2 Pulldown has been undone, we can obtain more faithful
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playbacks by changing the playback speed to 24 fps. This can be modified via Mamba Setup
selecting 24fps format (Mamba Setup->General->Standard Preset) and observing
playback in an un-interlaced monitor.
While the clip is not modified or edited, the 3:2 Pulldown process is 100% reversible via the
button Pulldown Remove (equivalent to the 2:3 Pulldown process).
Render 3:2 Pulldown Mode defines the Pulldown and field discrimination.
Pulldown Insert
Carries out a 3:2 Pulldown to a cine clip, adding fields to the sequence so that it
coincides with the duration that it must have in NTSC.
Pulldown Remove
Carries out the reverse process to an NTSC clip, eliminating the fields that were
inserted during a prior 3:2 Pulldown.
To eliminate the Pulldown correctly, it is necessary to locate the active monitor mark
active in the first frame without fields that the sequence has.
Only Even Frames
For the creation of the new clip, only even-numbered images will be considered. Thus
the resulting new clip will have half the duration of the one processed.
Only Odd Frames
For the creation of the new clip, only odd-numbered images will be considered. Thus
the resulting new clip will have half the duration of the one processed.
Processing only alternate frames may be done for various reasons:
One is to create versions of clips at half the frame rate, to be used in high-speed cameras.
For example, we can work with masters at 48fps and produce versions a at 24fps for offline
systems. These cases are detected by Mistika when conforming, so the EDL can be done at
half the speed, to be able to work in the offline system in standard formats.
Another use may be to separate interleaved streams in a stereo clip.
If none of these buttons is active, all the frames of the clips are processed.
Sequence Render Options:

Delete Sequence Before Render
Activates the deleting, before the render, of all the media contained in the folder to
be overwritten, although all the contained files are to be overwritten.
First Frame Index
Defines the numeric value of the first frame of the sequence of images to be rendered.
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Render Stereo 3D Mode:

Stereo 3D Mode
This dropdown button allows definition of which type stereoscopic clip will be processed
according to the viewing mode.
No Stereo 3D
The resulting processed clip will not be stereoscopic.
Left Eye Only
The resulting processed clip will correspond to the image to be interpreted by the
viewer's left eye.
Right Eye Only
The resulting processed clip will correspond to the image to be interpreted by the
viewer's right eye.
Dual YUV422
The result will be a single clip whose content will correspond to a stereoscopic pair
(left and right eye). This format allows render to be done for both eyes at the same
time, and also optimizes the storage to disk, as both eyes are stored in consecutive
blocks (as they will later be read). This requires Mamba .js YUV422 archives to be
selected as render format.
Anaglyph
The resulting processed clip will correspond to the viewing mode for color anaglyph
glasses, red for the left eye and cyan for the right eye.
Line Interlaced
The information from the stereoscopic pair will be shared in interlaced vertical lines
within the same frame.
Note: Do not confuse the term Line Interlaced with Field Interlaced. The Line
Interlaced process can be applied to a clip with interlaced fields as well as to an uninterlaced one.
Side By Side
The resulting processed clip will correspond to the viewing mode that scales to half
the resolution of the stereoscopic pair, to locate both images side by side.
Note: Many devices recognize this mode, in order be activated automatically by their
own system.
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Render Name:

Specifies the render name script (.rnd), which will also be the name of the new clip (.clp).
Auto Name
The practical purpose of the Auto Name button is to be able to launch render
processes from the TimeSpace with the same name as the previous one but ending in
a new number to avoid the need to open the render modules to write it. This use can
makes the work of carrying out many render processes much easier. It also helps
avoid errors of overwriting files.
When the Auto Name button is active, two boxes are enabled: a text field and a
numerical field.
text field
In this box, the name of the render script is defined.
numerical field
This field is increased by one with each render process with the same name that is
done. Thus, it automatically avoids the problem of the names of successive render
processes coinciding, which would produce jumps in the numerical sequence.
User Name
When this button is active, a text field is enabled in which the name of the render
script can be defined manually by the user.
This command also offers another practical use: replacing the previous render of a clip
by carrying out another with the same name. To do so, select a clip or group from the
TimeSpace and run the Get Clip Name command to copy the name of the clip
selected in the User Name text field.
This command also has another practical use: the substitution of the previous render
of a clip when a new one with same name is produced. When a clip or group is
selected from TimeSpace, the name is copied in the User Name text field.
Via this tool, it is possible to run the processing of a sequence time and time again,
overwriting the previous render, thus avoiding accumulation of multiple versions in disk
space. The new render maintains the name and replaces the previous one in the same
the disk space.
Also, errors when writing names are thus avoided. It is common that a user has to
produce successive versions of a clip that is being used in another TimeSpace by
another user. For the render of each new version to be updated automatically in the
second TimeSpace it is essential that they have exactly the same name, so that this
tool can make the process easier and help avoid errors.
Note: Mamba allows to clips to be overwritten, updating all the instances of their media in
the TimeSpace by overwriting them. If a name of clip already used is specified, a window
will open with an overwriting warning. In these cases take care never to use a name that is
also that of a clip necessary for the render, since Mamba will destroy it media file before
starting the new render processes.
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Virtual Slate:

During the render process, Mamba 6 allows the creation of superimposed metadata
information (Virtual Slate) that can be used as reference in other post-production processes
.
When Burnon Virt. Slate is activated, the fields that specify the information that will be
seen superimposed on the image are activated.
The information superimposed on the image is specified in the file Mamba-ENV/shared/
VirtualSlate/Layouts.xml and can be edited by the user in order to change its position and
appearance to include/exclude specific metadata fields.
Slate 1 / Slate 2
Clip_w_TC. The information superimposed corresponds to the name of the clip and and
current timecode.
TC_Only. The information superimposed corresponds only to the current timecode.
During
First frame. The information only appears in the first frame of the sequence.
First 5 frames. The information only appears in the first five frames of the sequence.
All frames. The information appears in the whole sequence.
Do Render:

Foreground
Creates the render script (.rnd) and the resulting new clip, staring the render task in
the Foreground.
The new clip is created as a file .clp in the RENDER,folder and, depending on the
format,a copy of the clip will be placed in the TimeSpace, in the range or selected clip
from which it was generated.
The render in the Foreground is run at high priority, and practically all interactivity
with the interface is inhibited until the render process is ended, using all the existing
resources and finishing the process in the minimum time.
Foreground rendering also has the advantage that the images being created can be
seen in a window (if the option Mamba Setup->Render Options->Render To
Graphics is activated).
Background
Creates the render script (.rnd) and the resulting new clip, and starts the render task
in the Background.
The new clip is created as a file clp in the RENDER folder and, depending on the
format, a copy of the clip will be placed in the TimeSpace, in the range or selected
clip from which it was generated.
The render in the Background is run at low priority, and a high level of interactivity
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can be maintained, which permits users to continue working with the interface while
the render is calculated in the background.
Write Script Only
Creates and saves the render script (.rnd) but without creating the new clip or
starting the render process.
Note: this script can be run later from a command line (see explanation below) or from
another workstation. However, remember that all the format and target parameters
defined when creating the script will be used, not those specified at the start of the
render.
Render scripts can also be opened as if they were normal environments, since they
contain the same information as well as the render parameters. In fact, this can serve
as a last resource if the original environment has been lost due to errors when saving
or a system crash.
Redo Proxy
Reevaluates the proxies of the selected image. This function allows the creation of
new proxies in order to select multiple image clips.
Note: It may be the case that an image clip possesses media for its proxy resolution
that does not correspond to its high-res media, owing, for example, to only
overwriting the high-res with a new render, or by changing the proxy size from Mamba
Setup. This function allows the user to refresh the proxy resolution.
Remember that Mamba allows the capture of images without generating low res
proxies ad hoc (this is optional), in which case, the user can generate
then
subsequently using this option. Generating these proxies helps playbacks of effect in
low res (although more disk space is used), and if these proxies do not exist, they
need to be created ad hoc during playbacks in this mode, which may slow them down
significantly, especially when they are large images, such as those derived from cine
or HDTV formats.
It is also convenient to generate them when storage is shared with other
workstations, in order not to produce excessive and unnecessary traffic. It is also
possible to defines a disk with a different target to that which contains the high res.
images in order to store the proxies via Mamba Setup (Mamba Setup->File Paths>File Paths->Sequence Proxies Dir), for example to defines a local disk local for
them and thus not interfere with other stations that need to read high res images in
real time.
In the same workstation, one Foreground render and another in the Background can
simultaneously be run, but no more.
In any case, bear in mind that render processes consume a great deal of graphics
card resources
(if Mamba Setup->Render Options->Performance Options>Hardware Rendering is activated, which is the most common), and if use of these
resources reaches capacity, incorrect images may be produced, or even stopped.
Extremely complex cases for the hardware being used can cause problems (shown as
black or strange images, or even the original images with no changes at all), in which
case the following measures are recommended:
Reduce to minimum (1) the value of Render Units in Mamba Setup (Mamba
Setup->Render Options->Performance Options->Render Units).
If this is not sufficient, exit Mamba and run the render from a command line, as
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explained below.
If this still does not resolve the problem, it is probable that the system does
not have an Nvidia graphics card with sufficient memory, so the Hardware
Rendering mode in Mamba Setup (Mamba Setup->Render Options>Performance Options->Hardware Rendering) should be deactivated.
The render process opens a progress window that is described below:

Priority
Process priority, which can be Foreground or Background.
Name
Name of the generated clip.
Length
Total number of frames to be processed.
Done
Percentage of the current process completed.
Elapsed
Time elapsed since the start of the process.
Remaining
Estimated time remaining to finish the process.
Note: this time is estimated in proportions of the elapsed time, so that the estimated
time may be incorrect if the process varies in complexity.
Progress Bar
Indicates graphically the percentage of the current process completed in relation to
the total number of frames to be processed.

SGO Mamba 2.0.1 © 2014 SGO

116

The Interface

Cancel
Button to stop the render process.
Note: this button stops the render, but does not remove the clip that was being
produced, in case it is required. The media of the new clip will be viewed correctly up
to the frame where the render was canceled. However, for formats .js or "movie" the
clip will occupy the same amount of space as if it were complete. If this occupies
more space than is desirable, run another render to extract the useful part and delete
the original.
Script to run after the render:

This dropdown button is the option that provides Mamba the possibility at the end of render
to execute the previously configured script.
The idea is to provide users with the means to detect the conclusion of render, with no
need for their physical presence, since they are informed that render has finished, or equally
to be able to run other tasks that are pending its conclusion (some examples of use are
given later).
The configuration is
RenderEndScript.cfg

simple.

First

add into

the

file: $HOME/Mamba-ENV/etc/setup/

the names of the scripts to be sent when the render has finished.
Then the script itself must be in the directory: $HOME/Mamba-ENV/bin/scripts
The script must have run permission.
To run a specific script at the end of a capture session, simply select it from the dropdown
that shows the names of the configured scripts.
When the render is finished, it will automatically name the script, with two parameters
[Status] and [Name], that have been specified for use.
Below are described some of the scripts that are provided with the software. As well as the
function they have, they also serve as examples for users with programming know-how.
mail_After
A simple tool that sends a mail to the user when the render has finished, informing
them of the result. The email address is configures in Mamba Setup (Mamba Setup>Utils->After Scripts Data->After script mail addr.).
matchOrigStruct_after
Modifies the directory structure and names of the files produced by the render to
mimic the structure of the original directories and the names and numbering of the
original files. This is only useful for render processes to numbered formats (typically
to DPX).
The main use for this tool is to allow the integration with other applications or
workflows. This way, Mamba can be used to process the images from a directory tree
and obtain an identical tree, so that other applications or workflows can continue
working in a transparent manner with the new tree, without causing interference.
From this point on, the depth of directories also defined Mamba Setup (Mamba
Setup->Utils->After Scripts Data->matchOrigStruct nodes) will be replicated.
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Render mode Segments By TC must also be activated, since if not, only one clip
without timecodes can be obtained.
It is recommendable that both the original structure and the new files generated by
the render process share the same disk. If not, the script need to move the rendered
files physically to the others disks, with the consequent additional processing time.

Flush Mamba Image Cache:

Mamba keeps a cache in RAM with the last images read from disk, to avoid having to read
them again if they are needed. However, occasionally it might be desirable to Flush Mamba
Image Cache to force Mistake to read them again.
For example, during a background render, the clip that is being rendered can be worked on,
although the process has not finished. However, if the monitor is passed over areas that are
still not calculated, incorrect frames can remain in the cache when trying to view it and this
button must be clicked to refresh them.
In general, if the media of clips that are being used in the TimeSpace is externally modified,
it may be necessary to use Flush Mamba Image Cache to refresh the changes. This is the
case, for example, if the media of a clip is modified from another Mamba workstation with
shared storage, or if the .tga files referenced by a remote clip are modified from another
application.
Syntax for render script definition:

Within the text field of the command User Name it is possible to define more specifically
certain variables when processing a clip or group.
By means of these definitions, the destination, the names and the numbering of files
numbered images (Images) is possible.
To do so, there is a special syntax:
Clipname:StartNumber:Basename%0digits.extension
The section :StartNumber is optional, and can be used to defines an initial frame number.
%0digits defines the position of the number of the frame and its "lead zeros", that is, it
defines how many digits the frame numbers should have.
Given the complexity of this syntax it is easy to make mistakes, so it is recommendable to
use the predefined targets in Mamba Setup (Mamba Setup->File Paths) instead of
writing the targets in this field using the syntax. In any case, an example of use follows:
If we write as the clip name: Clipname:20000:/ROLLS/roll1/shotname%06d.dpx
files called Clipname.rnd and a clip called Clipname.clp will be created, as normal, but also:
the numbering of obtained frames begins at 20000.
The images are stored in the folder: /ROLLS/roll1.
The images are
called:
shotname020002.dpx, etc.

shotname020000.dpx,

shotname020001.dpx,

If the creation of proxies (Proxy Image), is also requested, these files will be located in the
same place with the prefix "L_": L_shotname020000.dpx, L_shotname020001.dpx,
L_shotname020002.dpx, etc.
Unlike normal renders, the target folder is not deleted before doing the render (unless it is
empty), since this could be problematic. In these cases a warning message will appear.
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A folder will not be created if it does not already exist. It is the user's responsibility to
create and manage it.

Running render from a command-line Shell:

Mamba allows the render script to be run in the background from any Unix-Shell. Enter
these commands to run a render from a console:
Mamba –r RenderScript
"RenderScript" is the name of the render script, but without the extension .rnd.
Note: before beginning the render, be sure that Mamba configured to work ion the same
project in which the script was generated. This can be done via the commands of the
Project tab (TimeSpace Editor->Dashboard->Project) or by modifying the content of
the file Mamba-ENV/Mamba_PRJ. Otherwise, the script will not be found and the process will
end, showing an error to that effect.
Remember that all the parameters related to the target format (image format and size) will
be those defined at the moment of creating the script, and not those that exist when
running the command.
However, the location of the source images will be those defined in Mamba Setup (Mamba
Setup->File Paths) when the render is run. This allows the render to be done on another
workstation that has the source images somewhere else, or even repeat a render after
making a backup, deleting the clips and restoring the backup in another Mamba station with
other storage paths.
Render files are stored in the RENDER subdirectory of the current project, and are always
created when a render is started. To create this file without doing a render and to be able
to run it later with the command explained, use the option Write Script Only (TimeSpace
Editor->Dashboard->Output->Render->Do Render->Write Script Only).
If several render processes have to run consecutively, a unix script that contains all the
commands can be written.
For example, if the render scripts render1.rnd, render2.rnd and render3.rnd; have been
saved and the three renders need to be run consecutively:
1. First use a text editor to write a new script:
kate MyScript
2. Include the following lines in the file:
Mamba –r render1
Mamba –r render2
Mamba –r render3
3. Save the script and convert it to an executable file with:
chmod a+x MyScript
4. Finally run the script:
./MyScript
Progress information will be displayed in the console, including the current frame and the
time taken for each packet of frames. The size of these packets is defined in Mamba
Setup (Mamba Setup->Render Options->Performance Options->Render Units).
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DC P

The Digital Cinema Package (DCP) module of Mamba is found in this tab.
The main function of this tool is to create DCPs for their use in projecting material, dailies,
tests and general post-production.
This module can function independently of the TimeSpace. It is for this reason that it is not
necessary to specify any environment in particular if the contents of the DCP have already
been prepared.
The DCPs generated by Mamba can be shown in projections rooms with homologous DCP
projectors.
The supported formats and image resolutions are:
2K 24 fps
2K 48 fps
4K 24 fps
2K Stereo 3D (24S, 48S y 60S)
The audio formats supported are WAVE (.wav) and AIFF (.aiff) 24 bits per sample, 48 kHz.
If the material contained in the DCP derives from Mamba, it is recommendable to prepare
this material in the following way:
Specify the color space Given that the color space in the DCPs is XYZ, as a first step,
convert the material to be exported using the effect RGB to XYZ (TimeSpace Editor>Dashboard->Fx->Mamba->Color->RGB to XYZ). It is recommendable to apply RGB to
XYZ without modifying its parameters default, unless following instructions for the specific
calibration of the projection room.
Specify the image format and padding Image clips must be in JPEG 2000 format (.j2k)
before they can be used by the DCP module. Therefore it is recommendable to process the
clips converted to XYZ directly in this format (TimeSpace Editor->Dashboard->Output>Render->Full Res Image->Images).
The supported .j2k are:
2k scope 2048x858
2k flat 1998x1080
2k full container 2048x1080
4k scope 4096x1716
4k flat 3996x2160
4k full container 4096x2160
Stereo3D formats require the selection of one of the j2k presets terminating in S (stereo);
three options are available: 24S for 24fps projects, 48S for 48fps projects and 60S for 60fps
projects.
The DCP module requires the sequenced numbering ("padding") of the j2k files always to
start with 1 (one). For example: NAME.000001.j2k, NAME.000002.j2k, NAME.000003.j2k, etc.
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Prepare the audio files In order to create a DCP, an audio file must be provided even if the
packet does not contain sound.
In any case, one audio channel will always be included per channel, and must have the
same duration as the image. For example, for a 5.1 configuration, five separate audio
channels must be assigned.
To do this, use the tool Router in the Audio tab (TimeSpace Editor->Dashboard->Audio)
. Via this tool, it is possible to select each audio channel independently and export them as
mono audio tracks.
Finally, with the image and sounds files prepared, specify their location in the fields Video
Paths and audio Paths of this module.
At the moment of generating the DCP packet, a new directory will be created in /MATERIAL/
MOVIES/DCP/PROJECT_NAME/DCP_LONG_NAME. In the place of PROJECT_NAME will be the
name of the current project; DCP_LONG_NAME is the name of the DCP created. For delivery
compatible DCI disc, the directory DCP_LONG_NAME should be copied to the root directory
of a disc with ext3 format.
When generating the DCP packet, a new folder is created in the path defined in
Compressed Movies (by default, /MATERIAL/MOVIES, giving us /MATERIAL/MOVIES/DCP/
PROJECT_NAME/DCP_LONG_NAME in which PROJECT_NAME is the el name of the current
project and DCP_LONG_NAME is the name of the DCP created. For delivery in DCI compatible
disc, the directory DCP_LONG_NAME must be copied to the root folder of a disc with ext3
format.
Subtitle files When adding subtitle files to the DCP, be aware that they may derive from
two sources based on two different standards. In the tab MXF Creation it is possible to
choose between the standards INTEROP and SMPTE. In the first case, the subtitles must be
in .xml and the image files in PNG; in the case of SMPTE, .xml is used with the font of the
subtitles (.ttf).
Mode of DCP creation The tab DCP contains 4 panels that allow the creation of the packet
in a scaled and ordered way. The panels are ordered from left to right, with the aim of going
step by step, starting with the panel DCP Name on the left, and ending with KDM Creation
on the right, for an encrypted DCP.
DCP Name:

The definition fields of the panel DCP Name are a series of options for the correct naming of
a DCP packet according to the syntax defined by the "Digital Cinema Naming Convention",
created by the production studios and the Inter-Society Digital Cinema Forum.
Name
Specifies the name of the DCP file.
Content
Specifies the type of content of the packet:
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FTR (Feature)
TLR (Trailer)
RTG (Rating Tag)
TSR (Teaser)
POL (Policy Trailer)
PSA (Public Service Announcement)
ADV (Advertisement)
SHR (Short)
XSN (Transitional)
TST (Test)
C. Version
Specifies the version of the contents of the packet.
Content Type (2D / 3D)
Specifies whether the contents of the packet is 2D or 3D.
Ratio
Specifies the aspect ratio of the contents of the packet.
F - Flat (1.85:1)
S - Scope (2.39:1)
F - Full Container (1.90:1)
Language
Specifies the language of the audio of the contents of the packet.
Subtitles
Specifies the language of the subtitles of the contents of the packet.
Territory
Specifies the geographical area where the contents will be shown.
Ratings
Specifies the type of audience classification of the contents of the packet.
AE (Exempt from classification)
G (General audiences)
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M (Recommended for mature audiences)
M5 (Viewers over 15)
PG (Parents Strongly Cautioned)
R (Restricted)
Audio
Specifies the audio system for which the contents of the packet is intended.
51 (5.1). (Note: the similarity of the nomenclature should not be confused with
standard Dolby 5.1. This number refers to the separate channels without
recoding)
20 (Stereo)
XX (un-specified)
Resolution
Specifies the image resolution of the contents of the packet.
2K (2048x858, 1998x1080, 2048x1080; according to the aspect ratio)
4K (4096x1716, 3996x2160, 4096x2160; according to the aspect ratio)
48 (2K at 48 fps)
Note: In order to export a packet in Stereo 3D format with 2K resolution the option
48 must be selected.
Studio
Specifies the studio where the content of DCP was created. The list of studios can be
modified in the file de Mamba-ENV/config/listStudios.cfg with any text editor.
Year
Specifies the year the DCP packet was created.
Month
Specifies the month the DCP packet was created.
Day
Specifies the day the DCP packet was created.
Facilities
Specifies the company or facility where the content of DCP was created. The list of
companies can be modified in the file de Mamba-ENV/config/listFacilities.cfg with any
text editor.
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3D Specs
Specifies whether the content of the packet has ghostbusting.
i3D-gb (with ghostbusting, to be shown in theaters with Dolby 3D)
i3D-ngb (without ghostbusting, to be shown in theaters with Real D)
i3D (the content has been corrected, so ghostbusting is not relevant)
DCP Types
Specifies whether the DCP contains the whole of the material or just a part of it,
being complementary with another DCP.
OV (Original Version)
VF (Version File)
File Version
Specifies the number of the version of the DCP file.
Set DCP Folder Name
Creates the DCP folder with the name based on the parameters defined and following
the syntax established by the "Digital Cinema Naming Convention".
MXF Creation:

The MXF Creation panel allows us to select the media being created that the DCP will
contain. This process is the hardest, but only has to be done once per version (of media
and/or audio), since to do so the following two steps are separate so the same media can
be used with different metadata.
To activate the selection of the media of each of the groups, select the corresponding
button (VIDEO, AUDIO or SUBs).
VIDEO

Central Eye Path
Access path for the main image. When dealing with stereo pairs, this will correspond
to the left eye.
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Right Eye Path
Access path for the image of the right eye, when dealing with stereo contents.
AUDIO

Left Audio Path
Access path for the left audio channel.
Right Audio Path
Access path for the right audio channel.
Left SAudio Path
Access path for the secondary left audio channel.
Right SAudio Path
Access path for the secondary right audio channel.
Central SAudio Path
Access path for the central audio channel.
LFE Left SAudio Path
Access path for the LFE (Low Frequency Effects) audio channel.
Subs
Route path to the subtitle files. The .xml file must be in the same directory as the
PNG (image files of the subtitles) or text (.ttf).
Generate MXFs

DCP Type
Indicates the font- type that will be used for the creation of the TCP (INTEROP or
SMPTE).
Crypt MXFs
Encrypts the MXFs so they can only be used with a decrypting password specific to
each projector.
Generate MXFs
Starts the process of generating the media of the DCP (MXFs).
Framerate
Allows the selection of the framerate of the resulting MXF. It is highly advisable to

SGO Mamba 2.0.1 © 2014 SGO

125

The Interface

bear this in mind before rendering J2K to avoid possible bitrate problems.
Add to reel num.
Adds specified media to the selected reel.
Reset Fields
Resets the fields of the routes marked for the media.
XML Creation:

The XML Creation tab is responsible for creating the necessary files of metadada of the DCP
(XMLs).
Select Reel
Selects the reel to which the DCP is to be added. The XML must be newly generated
in order to load the new reference within the XML of the folder of the DCP.
Load Video MXF
Loads the path of the video media defined in the previous panel.
Load Audio MXF
Loads the path of the audio media defined in the previous panel.
Load Subs MXF
Loads the path of the subtitles defined in the previous panel.
Specify XML name
Names the XML data files contained in the DCP.
Cert list
Certificates for digital signatures of the XML files.
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Generate XMLs
Creates the XMLs of the DCP.
KDM Creation:

Panel for creating the information file necessary for projectors to playback the media if
encrypted.
Validate from

Year
Year from which the de-encrypting of the DCP will be valid.
Month
Month from which the de-encrypting of the DCP will be valid.
Day
Day from which the de-encrypting of the DCP will be valid.
Hour
Hour from which the de-encrypting of the DCP will be valid.
Minute
Minute from which the de-encrypting of the DCP will be valid.
Validate to

Year
Year from which the de-encrypting of the DCP will be invalid.
Month
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Month from which the de-encrypting of the DCP will be invalid.
Day
Day from which the de-encrypting of the DCP will be invalid.
Hour
Hour from which the de-encrypting of the DCP will be invalid.
Minute
Minute from which the de-encrypting of the DCP will be invalid.
Dest Name KDM
Name of the KDM. It is named automatically according to the parameters previously
defined, although this is editable.
Certs list
Certificates for digital signature.
Pem Cetificate
Certificates for projector for which the DCP is intended.
Generate KDM
Generates the KDM de-encrypting file.
Node Graph Editor

The Node Graph Editor is the main tool de composition of Mamba. As its name indicates, it is
based on nodes and the interaction between themselves via links and effects.
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When compositing, we will generally deal with two types de workflow: one based on layers
and the other based on nodes. While layers offer greater control when working with
animation and Motion Graphics, when compositing,a node-based system is much faster and
accurate.
A node editor allows us to organize the various elements of the final image independently,
link and interact with them as we wish, without being concerned that one node may affect
others, as would happen with a layer-based system.
A node editor also offers us a very graphic and clear perspective of our composition,
reducing the possibility of repeating graphic elements when using multiple inputs and
outputs for each of the nodes.
The Node Graph Editor of Mamba is made up of two elements: Workspace and Toolbar.
Workspace: this is the main work area of the editor. It offers total flexibility for
positioning, moving, selecting, linking and eliminating nodes as we wish.
Toolbar: this is a tool set associated to the Node Graph Editor (for more information see
TimeSpace->Node Graph Editor->Toolbar).
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Types of nodes

Mamba has three major types of node:

Source Nodes

These exist in their own right, as a source of content to which we apply the different
effects of Mamba. They can be video clips, such as Solid, Fractal, Circle, Title... (all which
pertain to FX-><%PRODUCT% FX>->Generate, except Stripe).

FX Nodes

These are the majority of nodes, and as their name states, the carry out some kind of
effect on the content nodes being used (for more information about the different effects
see FX->Mamba FX).
Multi-input Nodes:
Within FX Nodes there is a wide variety of multi-input nodes, with Comp3D standing out as
being the main composition nodes for Mamba. The particularity of these nodes is that they
allow multiple simultaneous connections, which may present problems with regard to the
order of the inputs. In order to resolve this situation, this type of node automatically
creates inputs each time nodes are linked to them. An example is shown below:
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This example shows 3 nodes connected to a Comp3D in the desired order. If we later
discover that the order is incorrect for whatever reason, we can disconnect the three
nodes from the Comp3D. Mamba automatically creates the three inputs in the Comp3D node
so that when we connect again, we can do so in the order required without causing a
change in the order of the inputs in Comp3D itself.

Connect Nodes

These are found in FX->Mamba FX->Compose, and are used to manually connect one
node to others at the same time, since by default in Mamba, nodes do not have various
outputs, and so they have to be created using this type of link.

Toolbar

The Node Graph Editor incorporates a tool bar for carrying out basic operation with nodes.
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Organization of nodes

These buttons carry out operations for organizing the node tree.

Graph Reload
Refreshes the node tree when changes have not been processed visually.
Center View
Positions the node tree in the center of the Workspace.
Reset Layout
Organizes the nodes automatically in the Workspace.
Reset Subtree
Works like Reset Layout, but organizing the nodes preceding the selected node.
Set Root Node
Allows the user to indicate which node is in the uppermost position in the composition.
Display Links
If activated, allows the viewing of links as a node that can be manipulated, or as a normal
link, if deactivated.
Basic operations with nodes

These buttons carry out basic operation with nodes:

From left to right the buttons will cut, copy, paste and delete the selected nodes.
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Groups of nodes

With these buttons we can carry out operations with grouped nodes simultaneously:

Group
Allows the grouping of selected nodes into a single node in order to organize the
composition. To view the content of the group click over any node in the group while
holding down CTRL+SHIFT.
Ungroup
Ungroups previously created groups of nodes.
Timewarp
Allows the editing of the speed of the nodes contained in the group. This editing is carried
out in the Visual Editor.
Reverse
Reverses the direction of playback of the selected clips.
Time and Trim

With these commands we can change the duration and trim the selected clip.

Length
The number of frames of a clip is established automatically when it is imported to the Node
Graph Editor, but this number can be increased or decreased manually using this field. If we
increase the number of frames, the video clip will be reproduced more slowly; fewer frames
increases the speed.
Trim
With this command we establish where changes in the number of frames will happen, either
at the Head or Tail of the clip.
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Viewing nodes

With these commands we can select viewing different options of the node tree.

Root on

Selects from four possibilities the position of the output icon of the link of each of the
nodes: left, right, top and bottom. The default position is at the top of the node.

Icons

Allows the previewing of the content of a node by means of an image inserted into the node
itself. This is not a realtime preview, so a video clip cannot be played in this mode; the first
frame of the clip will be seen.
We can select the preview to be only in the Source Nodes, or in all.
Zoom

With these four buttons we can select the level of zoom desired in the Workspace, and
center the view in the selected node tree.
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Keyboard commands

In the Node Graph Editor we can carry out certain operations from the keyboard:
<CTRL+SHIFT>: allows us to develop a previously created group and view its content .
<CTRL+ALT>: allows us to rotate a node tree in the direction we wish, using the selected
node as the axis.
<CTRL>: allows us to move the selected node together with its subtree.
<ALT>: allows us to duplicate the selected node/s. If the command is run over the output
icon of the node, a Link is generated (see Link)
<SHIFT>: allows us to select various nodes manually.
<DEL>: allows us to eliminate the selected node/s.
Basic functions

The basic general function of the Node Graph Editor is as follows:
A video clip is imported to our project. This clip appears as a content node in the
Workspace of the editor. The duration of the clip establishes the duration of the
composition, although this can be changed manually in Frames (Node Graph Editor >Toolbar->Frame). If the node does not appear in the Workspace, click Graph Reload (
Node Graph Editor ->Toolbar->Graph Reload)
From here we can connect effects and link nodes in two ways: automatically or manually.
The automatic mode consists of selecting the source to which the new node which we
insert into the Node Graph Editor is to be connected. By this method, the new node
connects automatically to the selected node. If we select several nodes at the same time
and then add a new node, all the selected nodes will connect to the new node, although it
is not a multi-input node, and it will affect only the last node connected (ie the highest
number in the input icon). If the selection is complex, and we select a node which is already
connected at the same time as a second independent node, the new node will only connect
to the free node, ignoring the connected node. If we wish to link the already connected
node to the newly created node, we need to use Connect or manually create a link with
<ALT>.
The manual mode consists of inserting the nodes in the composer without having previously
selected any element. The nodes will then appear in the editor independently, allowing them
to be connected manually. To do so, simply click and drag the gray circle on the left of
each node to the node to which we want to connect it.
This operation can obviously NOT be done between Source Nodes, as the material would
overlap. If we wish to combine different clips and material, we have to use nodes that allow
multiple input, of which the best example is effect Comp3D (FX->Mamba->FX>Compose->Comp 3D), which allows us to compose these graphic elements in a 3D
environment (see Comp 3D).
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D-4 Visual Editor
Ref. Mamba: Visual Editor
This mode is used to compose layers and to work interactively with all types of effects. In
other words, all the material organized and derived from the Node Graph Editor is finished
and polished in the Visual Editor. The Visual Editor is the means of expression for the VFX
artist.

To access this mode, double left click on an effect clip.
The Visual Editor is formed by three complementary areas: Canvas, Dashboard and
Parameters.
The Canvas is the area where the result of the processes applied to the selected effect
clip, and allows us to work on it via interactive manipulators.
The Dashboard is the main control panel which has the interfaces that interact with the
visual manipulators, such as the management of motion trackers, the color correction
spheres, the composing manipulators in 3D, etc. Depending on the type of effect applied,
the permitted manipulation modes will appear active, and those not allowed will appear
semitransparent, and cannot be selected.
In the Parameters area, the values of parameters of any selected clip or group can be
viewed and edited.
The Back button allows the activation or return to the Node Graph Editor mode.
In double monitor configurations, there will be the panels corresponding to the Node Graph
Editor mode in one monitor and that corresponding to the Visual Editor mode in the other.
Visual Editor: double click on the effect to be worked on.
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Canvas

Ref. Mamba: Visual Editor->Canvas

The Canvas has an image area with an evaluation zone and inactivate zones. A manipulator
can be placed in any part of the image area, but only the result of the effect will be
viewed.
Note: the evaluation zone coincides with the image aspect ratio specified in Mamba Setup.
If the resolution configured in MambaMamba Setup cannot be viewed because it exceeds
the size of the Visual Editor, the default zoom value by will be automatically specified so
that the entire evaluated image will be viewed. For example, in the case of HDTV, the
default image zoom is ½; the image can be enlarged at any time to see the true resolution.
Below the area of the image are the tools specific to Canvas.

Toggles

Ref. Mamba: Visual Editor->Canvas->Toggles
The Toggles set of buttons contains a series of controls for the visual evaluation and
manipulation of the clip.

Scopes

With these Toggles it is possible to activate up to four monitors in order to evaluate an
image via vectorscope-type graphics, waveform monitors or RGB, YUV and Luma histograms.
In the case of the evaluation of a stereo clip, the active Scope differentiates the signal
from each eye with the colors red an cyan.

SGO Mamba 2.0.1 © 2014 SGO

The Interface

137

Mode
This dropdown button defines the type of monitor the evaluation of the image will use.
Vectorscope
Vectorscope mode which shows a statistic of colors present in the image. In the
center of the circle are the unsaturated colors, and around the edge are the
saturated colors. Vectorscope has orientative boxes that represent the position of the
primary and secondary colors in their maximum saturation.
Wform RGB
RGB waveform mode showing brightness levels in three columns corresponding to each
channel, Red, Green and Blue.
Wform RGB Overlap
RGB + Luma waveform mode, superimposing the luminance graphic to the brightness
level of the three channels separately: Red, Green & Blue.
Wform YUV
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YUV waveform mode showing brightness levels in three columns corresponding to each
component, Luminance (Y), Red minus Luminance (R-Y=U) and Blue minus Luminance
(B-Y=V).
Wform Luma
Classic waveform mode showing brightness levels.
Histo RGB
RGB histogram mode which shows the statistic of number of pixels according to their
value for each channel: Red, Green and Blue.
Histo YUV
YUV histogram mode which shows the statistic of number of pixels according to their
value for each component: Luminance (Y) , Red minus Luminance (R-Y=U) and Blue
minus Luminance (B-Y=V).
Histo Luma
Histogram mode which shows the statistic of the number of pixels according to their
Luminance value.
Stereo Channel
Dropdown button that sets whether the evaluation graphics of the monitor correspond
to Left Eye, Right Eye or to both eyes of a stereoscopic image (Both Eyes).
Brightness
Graphic brightness control. This button should be clicked and dragged to the edges:
to the left reduces brightness, to the right increases it.
It is also possible to control graphic brightness by left-clicking on the graphic and
dragging to the edges.
Zoom In
Enlarges the graphic in the monitor.
Zoom Out
Reduces the graphic in the monitor.
Panning
Once the graphic view is enlarged, this repositions it by right-clicking and dragging
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Snapshot

Snapshot is a useful tool for comparing color corrections of different clips, helping balance
colors in different shots.

To create a snapshot, simply run Snapshot Current from its dedicated interface or select a
poster frame from within the image strip of the Storyboard, via the command Snapshot
Selected. These commands save an image in a memory that can be viewed in the full or
split screen.
To see the snapshot in fullscreen, run Show Snapshot (it will mark at the foot of the
Snapshot image indicate that a capture is being viewed).
If we wish to share the Snapshot with the clip active on a split screen, use one of the three
following modes: Show Split (the last viewing configuration used), Preset Split Wipe (a
generic split screen view) and Preset Split SBS (Side By Side viewing in order to have both
images whole). To modify the dividing line of the Snapshot, use the Wipe Position and Wipe
Angle tools (with the tool Draw Outline we can view the edge that indicates which image is
the snapshot). The relative sizes of the two images being compared can also be modified
with Snap Position, Snap Zoom (for the memorized image) and Live Position and Live Zoom
(for the image being worked upon).

Zoom C ontrols

Ref. Mamba: Visual Editor->Canvas->Zoom Controls

Zoom In
Enlarges the view of the evaluated image in the Canvas.
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Zoom Out
Reduces the view of the evaluated image in the Canvas.
The most convenient method for adjusting horizontal zoom is usually the mouse wheel,
since it is linked to the hotkeys <Up> and <Down>.
Panning: Once the image is zoomed, reposition it by left clicking the mouse on the
image and holding down <Alt> and <Ctrl> whilst dragging the cursor.
Note: The enlargement, reduction or repositioning of the image is only visible in the
Canvas, and not in the video output.
Zoom Center
Repositions the evaluation area of the Canvas in its central position, independently of
value the of zoom or the position defined with the right mouse button.
Zoom Reset
Restores the default zoom factor and centers the evaluated image in the panel.
Keyframe Slider

Ref. Mamba: Visual Editor->Canvas->Keyframe Slider

The Keyframe Slider is a offset control for the duration of the effect selected.
The ruler represents the totality of the duration of the clip and is especially useful for
evaluating the position of the keyframes in an animation.
This slider has a manipulator with the number of the active frame of the effect. This
manipulator should be left clicked, and then dragged horizontally
To move the manipulator frame by frame, left-click at the sides of the manipulator.
The Keyframe Slider controls offer the possibility of carrying out dynamic color corrections
(using all the manipulators of Color Grade) without needing to use the Curves tool or
defines the values in Parameters.
Dynamic color correction is defined by one input point and one output point. These points
generate a correction range represented by a green bar. The duration of this correction
range can modified by moving the input and output points selecting them with <Ctrl>+
<LeftClick>.
Key In
Sets the input keyframe for the color correction. It is represented by a green triangle.
Key Out
Sets the output keyframe for the color correction. It is represented by a red triangle.
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Neutral Key
Inserts a keyframe in the current frame with the default values of the color corrector.
Note: The aim of this command is to remove the values applied to the input or output
point of the dynamic correction. To do this, it is only necessary to position it in any
previous or later frame in range of the dynamic correction.
Delete Key
Eliminates the keyframe found in the current frame within the range of the dynamic
correction.
AutoKey
Activates the no-animation mode of parameters.
If activated, this mode establishes that any modification carried out from the fields of
values will displace the curve in its totality.
If deactivated, a keyframe is automatically inserted in the active frame each time we
modify a value.
After Last
Specifies the active frame to be located in the frame after the end of the effect (the
clip Out Point). This allows parameters to be edited with the manipulators in a frame
after the last one, thus making it possible to maintain a parameter animated up to the
second field of a video sequence.
Feedback
Activates constant updating of the evaluation. When this option is turned off, the
image is only evaluated when a manipulator is released or the dragging of a value from
the Parameters area is stopped, but it will not be evaluated during modification.
If deactivated, the Keyframe Slider will also cease to update the image until a frame
is released.
When the effects are complex, it is advisable to deactivate this option, to avoid
delays due to constant evaluation during the modifications.
Quick Access

Ref. Mamba: Visual Editor->Canvas->Quick Access
The Quick Access button bar provides direct access to a series of frequently used
commands and tools that are common to the different working modes in Mamba.

These commands are divided into groups according to their functions.
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C omposer Shuttle

Functions for playback and evaluation of the Visual Editor.

Go To Start
Moves the Visual Editor back to the first frame of the selected clip.
Prev Key
Moves the evaluation back to the first frame with a keyframe.
Play Backwards
Activates playback of the Visual Editor in reverse for the duration of the clip selected.
Stop
Stops playback of the Visual Editor in the duration of the clip selected.
Play
Activates playback of the Visual Editor in the duration of the clip selected.
Next Key
Moves the evaluation forward to the next frame with a keyframe.
Go To End
Moves the Visual Editor forward to the last frame of the selected clip.
Play All
Activates playback without pausing at the end of the clip that is loaded into the
Visual Editor. When stopped manually, the current clip is loaded.
Loop
Activates continuous looped playback of the selected clip.
Full Screen
Display the image of the Visual Editor to full screen.
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Options

These affect these viewing mode the evaluated images.

View
Sets the channels of the image viewed in the evaluation of the Visual Editor.
RGB
Shows the RGB channels of the image.
R
Shows the red channel of the image.
G
Shows the green channel of the image.
B
Shows the blue channel of the image.
Alpha
Shows the alpha channel alpha in grayscale.
RGBxA
Shows the alpha channel multiplied by the channels of the image.
This option does not affect how the image is composed although it allows us to
evaluate visually how the image would be when pre-multiplied by its alpha channel and
composed on a black background. This evaluation is especially useful in effects which
have the parameter "Premultiply" activated.
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Res
Controls the evaluation resolution of the Visual Editor, which allows us to choose
between better image quality or more interactivity when making changes.
Proxy
Sets the evaluation of the Visual Editor in low resolution (resolutionProxy).
Dynamic
Sets the evaluation in dynamic mode, automatically switching between low resolution
during the editing of a parameter and returning to high resolution when releasing its
manipulator or stopping dragging the value from Parameters.
This also activates the switch to low resolution while dragging the Time Slider
Full
Sets the evaluation of the Visual Editor in high resolution.

Fullscreen mode

In Fullscreen mode, activated via the Composer Shuttle, we can access a series of
commands by double-right-clicking the mouse.

Resolution
Controls the evaluation resolution of the Visual Editor, allowing us to choose between
better image quality and greater interactivity when making changes.
Proxy
Sets the Visual Editor evaluation mode as low resolution or Proxy.
Dynamic
Sets the evaluation mode as dynamic, switching automatically between low resolution
when a parameter is being edited and high resolution when the manipulator is released
or when the values from Parameters are no longer dragged.
This also activates the change to low resolution while the Time Slider is being
dragged.
Full
Sets the Visual Editor evaluation mode as high resolution.
Show Alpha
Shows the alpha channel of the clip.
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Save Image
Allows the capture and saving, in image format, of the frame of the clip being viewed.
Viewing Commands
The following commands can be selected simultaneously if required.
Safe X
Establishes a safe editing area in the X-axis.
Grid X
Generates lines in the X-axis that divide the image into columns.
Safe Y
Establishes a safe editing area in the Y-axis.
Grid Y
Generates lines in the Y-axis that divide the image into rows.
Playback commands
Begin (Ctrl+Home)
Locates the playback cursor at the start of the clip.
Prev Frame (Left)
Moves the playback monitor one frame back.
Play Backwards
Plays the clip backwards.
Play Forward
Plays the clip forwards.
Next Frame
Moves the playback monitor one frame forward.
End
Locates the playback cursor at the end of the clip.
Menu commands

Menu
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Activates viewing of the menu in fullscreen mode.
Minimize
Deactivates fullscreen viewing mode.
Zoom commands

Zoom In
Makes the graphic in the monitor bigger.
Zoom Out
Makes the graphic in the monitor smaller.
Zoom Center
Relocates the evaluation area of the Canvas in its central position, regardless of the
value of zoom or the position set by the right mouse button.
Zoom Reset
Restores the default value of the and the center position of the image evaluated in
the panel.
Move Win
Allows the viewing window to be moved in fullscreen mode.
Dashboard

Ref. Mamba: Visual Editor->Dashboard
The Dashboard area contains various interactive manipulation interfaces whose application
modifies the parameters of effects and the behavior of clips. It also contains evaluation
tools and submodes pertaining to some effects.

Depending on the effect parameters selected, different manipulation modes will be available.
The tabs (Manipulators Tab) that are not available for the selected effect will deactivate,
and only those available will be shown.
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The manipulation modes of the Dashboard are organized according to their functions and
are accessed via the Manipulators Tab:
Set Color
Specifies the color values for different manipulators in effects with color parameters.
They can also be specified by selecting an image color.
Pick Key
Specifies ranges of tolerance and transparency (softness) of the mask being edited,
which can be specified in the image or from a manipulator in the graphical histogram.
Framing
In effects that possess cut (Crop) parameters, the values of these parameters are
defined via manipulators on the image assigned to each side of the frame. This tab
also contains tools to assist the user in the calculation of standard letterbox-type
aspects and masks.
Stereo3D
Tab with manipulators dedicated to work on stereoscopic images. To use these tools,
it is necessary activate the stereo mode (Use Stereo Mode) in the Quick Access bar.
2D
In effects with XY position parameters, this specifies the two-dimensional position by
using a cross-hair image manipulator that can be dragged over the image.
Comp3D
This is used exclusively by the Comp3D effect and specifies the three-dimensional
position and rotation of each layer by using manipulators on the image, as well as
camera views, lights, and other functionalities associated with this effect.
Color Grade
Specifies the values of an RGB color correction via a manipulation interface based on
knobs, balls and rings structured in successive layers or nodes called vectors.
Shapes
Interface for generating and modifying vectorial forms (Shapes) that modify the alpha
channel of the selected clip.
Paint
Access to the submode Paint Editor. This tool contains manipulators that pertain to
the effect VectorPaint.
Title
Access to the submode Title Editor. This tool contains commands that pertain to the
effect Title.
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Warper
Access to the submode Warper Editor. This tool contains manipulators that pertain to
the effect Warper.
Tracking
Access to the submode Tracking Editor. This tool extracts information about
movement of an image to be applied to two-dimensional parameters of any effect.
This mode is always accessible independently of a clip of an image or type of effect
selected.
Set C olor

Ref. Mamba: Visual Editor->Dashboard->Set Color
This manipulator is accessible from all the effects with color parameters, and is shown in
Red, Green and Blue, as also in Hue, Saturation and Lightness.
Some effects have more than one set of color parameters. To work correctly with these
effects, it is necessary to choose explicitly one of their folders with color parameters, by
selecting the folder from the folder list with the left mouse button. On the other hand, if the
selected effect has only one set of color values, the manipulator will always work with this
set without having to select it.
The manipulators of this mode are viewed in the Dashboard.
The color selector will initially show the color values that the parameter being edited has at
that moment:

The Sliders viewed in the manipulator show the value of the color component at each
moment.
The user can specify the active color with the following different procedures:
Pick Color
Select the current color from an image pixel. To use this button, press and drag it
with the left mouse button, and without releasing it until the pixel whose color we
wish to obtain as been reached.
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WYSWYG (What You See Is What You Get)
Specifies that the background of each unedited slider changes its color interactively,
which helps the user to position the slider on the color waned.
RGB Sliders
Controls that specify a color by its percentage red, green and blue. The value of each
channel is shown at the right of each slider, expressed as an editable 8 bit numerical
value (256 levels).
HSL sliders
Controls that specify a color by its percentage tone, saturation and value.
Color Wheel
color wheel that specifies the saturation (radius vector) and the hue (vector angle),
together with a vertical slider that controls the color value.
Color Store
Library where the user can save or load colors. To save the active color, click on an
open library cell. To load a color to the library, click on one of the saved colors.
The library also has two small buttons:
Delete
Eliminates the selected color.
Pack
Orders the boxes of colors used.
The Set Color manipulators can be used for different purposes:
Specify a color.
In certain effects, specify levels of black and white, or carry out a white
balance (for more information, see the chapter Color Grade).
Note: For the Color Key effect, select the crop colors in the image with successive left
mouse button clicks on the image, without needing to use the sliders or the Pick Color
button.
Pick Key

Ref. Mamba: Visual Editor->Dashboard->Pick Key
This specifies the values of the Toler and Soft parameters for the selected effect.
These parameters specify the transparency/opacity values of the generated mask,
generating a decreasing slope of opacity between the values specified by the Toler and
Soft parameters, which is interpreted as the hardness or softness of a specified mask.
The user can choose either of the two following methods to specify these parameters.
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The user can choose either of the two following methods to specify these parameters.
From the Histogram panel
This Histogram represents the number of pixels (Y axis) in the image for each possible tonal
value used by the effect (X axis), and has two marks to manipulate the range of values to
be used to create the mask. All the pixels with tonal values to the right of the Soft mark will
produce a totally transparent mask, while values to the left of the Toler mark will produce a
totally opaque mask. Values between the two marks specify the values for semitransparency, decreasing from left to right.
From the image
Where values can be directly selected on the image, click first on one of the two buttons
on the panel (buttons Pick Transparent and Pick Solid) and then select any value on the
Visual Editor image by left clicking and dragging, which selects the average value of the
pixels included in the block.
Framing

Ref. Mamba: Visual Editor->Dashboard->Framing
This tab contains the parameters for rescale and crop (functions also known as “Pan &
Scan”) if the clip to be corrected has a different resolution to that of the job, these
parameters allow reframing of the material for the correction.

SGO Mamba 2.0.1 © 2014 SGO

151

The Interface

The tools of the Framing tab defines the values of the parameters of the folders Crop and
Rescale
These functions can scale the original resolution, thus avoiding use of an additional effect
for this task.
C anvas

In the Canvas, this manipulator has four dotted lines drawn on the image that represent the
position of each cut margin of the effect.
These manipulators can be individually specified by dragging them with the left mouse
button. The crop can also be transformed using the corners and the rectangle can even be
moved by left clicking in the center.
Dashboard

In this manipulation mode, the Dashboard has a button panel to assist the user with the
crop expressed according to aspect relation of values expressed in current pixels.
Rescale:

Rescale Apply
Activates/deactivates the rescale and crop function.
Quality
[Bilinear (Nearest/Bilinear/3 Taps/Bicubic/5 to 15 Taps)]
In the dropdown parameter list, the available qualities are ordered from lowest to
highest from top to bottom. It is recommendable to specify the lowest quality that
gives visible improvements, as the higher the quality specified, the more calculation
time required.
Auto Resize:

Fit X; Fit Y
Automatic rescale commands that adjust the original resolution of the image to values
defined by the horizontal or vertical resolution of the Mamba project, maintaining the
aspect ratio.

Set Crop:

This group contains buttons that apply preconfigurations for cuts that are adjusted to
norms used in the audiovisual industry.
The text field Apply Custom allows the application of value defined by the user.
Source Size:

Source Size X
Shows the horizontal resolution of the original image.
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Source Size Y
Shows the vertical resolution of the original image.
Source Ratio
Shows the value of relation of the aspect ratio of the original image
Note: These numerical fields are not editable.
Result Size:

Result Size X
Shows the horizontal resolution of the resulting output image.
Result Size Y
Shows the vertical resolution of the resulting output image.
Result Ratio
Shows the value of relation of the aspect ratio of the resulting output image.
Note: These numerical fields are not editable.
User Crop in Pixels:

Left; Right; Up; Down
Sets cropping for an image form its four margins, drawing in black the exterior area to
be cropped and cropping the alpha channel.
Lock Ratio
If this state button is active, the XY relation of the aspect ratio is maintained.
Reset
Command that restores the crop to its original values.

User Resize and Offset in Pixels:

Scale X; Y
Defines the rescale value in pixels of the output image.
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Offset X; Y
Specifies a two-dimensional offset output image, expressed in percentage units.
Lock Result Ratio
If this state button is active, when rescaling a image, the XY relation of the "aspect
ratio" is maintained according to the value shown in the box Result Ratio.
Lock Current Ratio
If this state button is active, when rescaling a image, the XY relation of the "aspect
ratio" is maintained according to the values set in Scale X and Scale Y.
Reset
Command which restores the rescaling to its original values.

Stereo3D

Ref. Mamba: Visual Editor->Dashboard->Stereo3D
This set of manipulators is especially designed for stereoscopic effects.

This Manipulator Tab is activated by selecting the group Stereo3D.
For a detailed description of this panel, read the chapter on Stereo3D.
2D

Ref. Mamba: Visual Editor->Dashboard->2D
In effects with XY position parameters, this specifies the two-dimensional position by using
an image manipulator that can be dragged over the image.
Some effects have more than one set of two-dimensional position parameters. To work with
these effects correctly, one of its folders with two-dimensional parameters must be
explicitly chosen, by selecting the folder from the folder list with the left mouse button.
However, if the selected effect only has one set of two-dimensional values, the manipulator
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will always work with it without needing it to be selected.
The manipulator appears on the image as a cross that specifies the two-dimensional
position. This manipulator can also be placed in the inactive area of the Visual Editor.
C omp3D

Ref. Mamba: Visual Editor->Dashboard->Comp3D
This specifies a three-dimensional position for the all components of the Comp3D effect.

This manipulation mode has manipulation options and different types of manipulators that
are controlled from the Canvas and from the Dashboard.
C anvas Manipulators

The types of visual manipulator shown below correspond to each object type existing in
three-dimensional space, and are as follows:

Layer
Manipulates a selected layer. The layer can be moved, rotated or scaled in one or all
its axes from its manipulator.
Note: A layer is effect input that can be manipulated. The input specified as the
background (if it exists) cannot be manipulated. Thus, if Options->Background of
the Comp3D effect is activated, the first input will be the background, which cannot
be altered.
It is also important to remember that the successive inputs added to the range of this
effect require Folder->Add Folder to be run to add a new parameter folder to the
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Comp3D effect, before they can be changes with the manipulators. For more
information see the chapter Comp3D.
Axis
Manipulates the selected global axis. All the layers can be changed at the same time
with this manipulator in relation to this axis: moving, rotating or scaling the
manipulator in one or all its axes.
Note: the effect has two global axes that can be selected. The transformations of
these axes move all the layers of the effect at the same time, but not the lights nor
the camera. For more information see the chapter Comp3D.
Light
Manipulates the selected light. For each type of light there is a manipulator different.
The Directional light can be rotated, the Point light can be positioned and the Spot
light can be positioned and rotated.
Note: The lights cannot be scaled. However, the target of the Spot type light can be
moved away from its origin with scaling. For this type of light, the position of the
target is specified in the manipulator by the end of the arrow. For more information on
the behavior of each type of light, see the chapter Comp3D.
Camera
Manipulates the camera. The camera position and rotation in X and Y can be changed
with this manipulator.
Note: The camera manipulator is visible except in the view from its own camera. The
manipulator shows the rotation in its Z axis, and also the visual field of the camera,
but these parameters cannot be modified with the manipulator. Their values can,
however, be modified dynamically in the the Parameters tab. The camera cannot be
scaled, but the camera target can be moved away from its origin with the scaling. The
position of the camera target is specified in its manipulator by the rectangular plane of
the pyramid. For more information on the behavior of the camera, see the chapter
Comp3D.
Floor
Guide grid that represents a floor, situated at the level of the bottom line of the image
as it appears by default.
Global Axis / Transform Axis
All the manipulators have one element in common: the transform axis of the object.
This axis responds to direct manipulation orders.
Direct manipulation can be done by selecting the axis directly with the left mouse
button, and dragging it in any direction.
Depending on the keys pressed, manipulation can accomplish move, rotate and scale
as detailed below:
Move
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Left-click directly on the axis, and drag it to a new position. The movement of the
axis will be relative to the projection of the current view.
Rotate
Left-click on the axis while holding down <Alt> and drag the cursor in any direction.
The movement of the cursor will rotate the selected object depending on the direction
moved, emulating a spherical rotation in all the axes.
Scale based on the horizontal movement of the mouse
Right-click on the axis while holding down <Ctrl> and drag the cursor horizontally.
The object will be enlarged in all its axes by dragging the cursor to the right, and
reduced by dragging to the left. This method of scaling is the easiest and most
intuitive to use.
Scale by defining a scaling radius
Left-click on the axis while holding down <Ctrl> and drag the cursor towards the
center or the edge of the object. The object will be scaled in all its axes depending on
the distance of the cursor from the center of the object.
This method of scaling is somewhat less intuitive until the user is accustomed to it,
although it is much more flexible, since the scaling is done in relation to the distance
of the cursor from the center (local axes) of the object: This allows the user:
To make very fine adjustments, clicking on a point away from the center of
the object (represented by the local axes) and dragging it. The object will
move very slowly.
To make more aggressive adjustments (large changes with little cursor
movement), clicking on a point near the center and dragging it, either towards
or away from the center.
For example, this method is very useful when "navigating" in an image with a high
Zoom factor, and that therefore needs both fine and rough adjustment at different
moments.
On the other hand, both scaling modes can be combined with <Shift> to force
restrictions to certain axes, as described in the Axis Constraint section.
Note: if one of the manipulation buttons is activated, direct manipulation will be
inhibited.
This axis is composed of lines and arcs:

The red line represents the horizontal axis (X) of the object.
The green line represents the vertical axis (Y) of the object.
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The blue line represents the depth axis (Z) of the object.
The red arc represents the plane opposite the horizontal axis (-X) of the
object.
The green arc represents the plane opposite the vertical axis (-Y) of the
object.
The blue arc represents the plane opposite the depth axis (-Z) of the object.
These lines and arc can be activated to restrict the direct transformation of an object to
one of its axes or planes, pressing the combination of move, rotate or scale, the <Shift>
key being accurately used to select the axis or arc to be restricted.
Dashboard Manipulators
Manip Axis:

Buttons that specify the editing mode of the manipulator of the selected object.
Move
Movement manipulation mode. Movement of the axis will be relative to the projection
of the current view, except when a constrain function is activated.
Rotate
Rotation manipulation mode. Movement of the cursor will rotate the selected object
depending on the direction in which it is moved, simulating a spherical rotation in all
the axes, except when a constrain function is activated.
Size
Size manipulation mode. The object will be scaled in all its axes depending on the
distance of the cursor from the center of the object, except when a constrain
function is activated.
Pivot
Pivot point manipulation mode. The pivot point is a three-dimensional coordinate
relative to the layer, which is taken as the center of the layer in order to make
changes to sizes and rotations.
Manip Cam / View:

When a view is edited (group View), direct editing keys can also be used. A view reacts
differently to an axis, and its manipulation options also vary:
Free Transform
<LeftClick> directly on the image, and drag it to a new position. This transformation
moves the position of the view, and its objective at the same time, in a similar way to
a lateral camera travel.
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Orbit
<LeftClick> on the image while holding down <Alt> and drag the cursor in any
direction. This transformation rotates the camera around the objective.
Dolly
<LeftClick> on the image while holding down <Ctrl> and drag the cursor up or down.
This transformation moves the camera nearer to or further from the objective.
Rotate
<LeftClick> on the image while holding down <Alt> and <Shift> at the same time,
and drag the cursor in any direction. This transformation rotates the target around
the camera, in a similar way to a camera header movement.
Note: if one of the manipulation buttons mode is activated, direct manipulation is inhibited.
Axis Constrain:

Buttons that specify a transformation restriction in the selected axis.
X; Y; Z; YZ; XZ; XY
Restrict the defined transformation by the manipulation mode to the axis/axes
activated.
View:

Dropdown whose controls defines the active viewing angle.
Camera
Camera view. This is the view evaluated when a render is run.
Note: the other views are guides only, and are not considered in the evaluation of a
render.
Persp
Auxiliary view that can be edited. Its default value shows a panoramic view of the
three-dimensional environment.
Front; Back; Left; Right; Top; Bottom
Auxiliary editable views. Its default values correspond to the view direction of its
name.
Note: Editing the view can disorder all views, and any can be returned to its default
values with the View Reset function.
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View Reset
Returns the view to its default value.
Note: Camera is the only view that can be animated. When this function is used, a
keyframe with the default values will be added to the current frame.
All the views can be edited via the Manip Cam/View manipulators. The buttons of the Axis
Constrain group do not influence the editing of a view.
Free Transform
Movement manipulation mode. Movement of the view will be lateral to the projection
of the current view, simulating a lateral camera travel.
Rotate
Rotation manipulation mode. Movement of the cursor will rotate the view depending on
the direction in which it is moved, simulating a camera header movement.
Dolly
Approximation manipulation mode. Movement of the view will be perpendicular to the
projection of the current view, simulating a dolly camera travel.
Note: this movement moves the camera position towards the target. If the camera
overshoots it, it will invert its direction.
Orbit
Orbit manipulation mode. Movement of the cursor will rotate the view depending on
the direction in which it is moved, simulating an orbital travel around the camera
objective.
Note: to change the orbit center, the target must be edited. For more information,
see the chapter Comp3D.
Display:

This controls the appearance of different types of manipulators on the image.
Layers
Activates view of the layer manipulators.
Axis
Activates view of the global axes manipulators.
Lights
Activates view of the lights manipulators.
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Camera
Activates view of the camera manipulators.
Floor
Activates view of the floor grids.
Background
Activates view of the input specified as background.
Note: this function is only a viewing control, and does not modify the effect
parameters. The background can only be shown in the Camera view.
Hide Arcs
Hides arc manipulators view in all object axes.
Note: when the position of a arc interferes with the selection of an axis, this function
helps to select the axis, as the arcs are hidden.
Hide All
Hides view of all manipulators and elements of the 3D environment, showing only the
images.
Aspect:

Command for restoring size.
Resize 1:1
Command that applies values of Size necessary to return it to its original size the
selected layer, since by default the Comp3D effect (with background) rescales the
resolution of each file to the work resolution as specified in Mamba Setup
Selection:

Object selection mode.
Auto Select
Direct selection mode. With this mode, the user can select an object by left clicking
the mouse directly on its manipulator.
Note: objects are often superimposed in three-dimensional space, making direct
selection difficult. In these cases, we recommend selecting the desired object from
the folder list of the Parameters tab.
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C olor Grade

Ref. Mamba: Visual Editor->Dashboard->Color Grade
This set of manipulators is especially designed for RGB color correction effects, although
unlike RGBCorrect.

The Manipulator Tab is activated when selecting the color corrector Color Grade.
For a detailed description of this panel, see the chapter Color Grade.
Open FX

Ref. Mamba: Visual Editor->Dashboard->Open FX
This tab does not have options, but is a manipulation mode for viewing Open FX plugins in
the Visual Editor.
The OpenFX tab is only activated when selecting an Open FXPlugin effect.
For more information on Open FX manipulators, see the relevant documents accompanying
the purchased plugins or the manufacturers’ websites.
Multilayer

These manipulators allow the user to interact with EXR or Stereo3D in Spatial Key using
advanced effects (Spatial Key is also integrated within Color Grade; see Spatial Key for
more details)

There are two groups of manipulators:
Spatial Key:
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Pick object ID
Allows interactive selection of the object we wish to mask in the Canvas by using its
ID.
Pick Position
Allows interactive selection of the object/s we wish to mask in the Canvas by using its
position in the XYZ axes.
Pick Depth
Allows interactive selection of the object/s we wish to mask in the Canvas by using its
position in the Z axis.
Pick Direction
Allows interactive selection of the areas of light incidence in an EXR scene by using
the reflection of its diffuse component.

Layer Tools
Reload Layer Lists
Reloads the information layers of the EXR file being used, if they have not loaded
automatically.
Reload layer Lists - Stereo
Reloads the information layers of the Stereo3D clip being used, if they have not loaded
automatically.

Basic Function
The use of these automatic selection tools in Multilayer is the same for all. Starting with an
EXR or Stereo3D file, we choose the desired selection mode. Then, in the Canvas, click on
the object we cant to choose from with in in the image. Mamba automatically selects the
correct information layer to be able to carry out the required selection. Finally, we can finetune the resulting mask with the parameters of the Spatial Key effect, also found within the
effect Color Grade.
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Shapes

Ref. Mamba: Visual Editor->Dashboard->Shapes
This panel allows the creation and editing of animated vectorials (Shapes) which only affect
the alpha channel of the selected clip.

When the manipulation mode Shapes is activated, a special button panel with commands for
creating modifying, animating editing and setting attributes of shapes is seen. Also, in the
tab Parameters, the parameters corresponding to the selected shape are seen; these can
be defined in terms of position, rotation, and global size. These parameters can be edited
like any effect parameter, and can even apply tracking coordinates. Furthermore, it is
possible to use de offset or horizontal offset when working with stereo images, thus
avoiding the need to create a vectorial shape for each image.
Note: When creating shapes on an image with an original size different from the work
resolution in Mamba Setup, the image will be viewed as adjusted to be able to draw shapes
in any part of the original image. When viewed in a different resolution to that of the
current work, the word "Scaled" will be superimposed on the Canvas.
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C reate

Create Shape
When active, this mode indicates that a new shape is being created (rather than a
pre-existing one being edited).
To create a new shape, simply click this button and then left-click on Canvas to
create the first point of the shape. When left-clicking a new control point is created,
although while the button is held down, this control point can be dragged to the
desired position. Only when the left mouse button is released will the control point
defined in position. Consecutive clicks create the control points necessary to make
the desired shape; double-clicking exits the creation mode, finalizes the shape, and
returns to modification mode.
It is also possible to exit creation mode by clicking in an area that is not involved in
the creation or edition of shapes (eg, on the Keyframe Slider).
Note: from Version 7, Mamba will create each shape or set of shapes in the vector in
which we are working at any given time; thus we can create different layers of
shapes, each related to a vector. These cannot subsequently be redirected to a
different vector, but should rather be copied into the desired vector.
Insert Point
When active, this mode inserts control points on any vectorial line, permitting the
editing of a pre-existent shape.
Points Softness

Softness consists of a pair of tangents called Radials in each control point of the selected
shape. These define a gradient of opacity towards the exterior and interior of a shape.
Softness has exterior and interior limits, viewed as cyan-colored lines that join the ends of
the radial tangents.
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The radial tangents can be edited like any other tangent or via the Width and Offset
manipulators.
Width
Knob-type button: softness can easily be set with this button by dragging to the edges,
increasing/decreasing the length of the radial tangents of the selected control points,
proportionally to both the internal and external radials.

Offset
Knob-type button: softness can easily be positioned towards the interior or exterior of
the shape with this button by dragging to the edges, increasing/decreasing the length
of the radial tangents of the selected control points, inversely proportional to both the
internal and external radials.
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Points Mode

Default creation modes that define the shape to be created or to modify one already
created (ie previously selected).
Smooth
The shape created to be formed by B-Splines. Since tangents have less control than
Bezier splines, manipulation and work with B-Splines is easier. Furthermore, the
precision of B-Splines is usually sufficient when adjusting a shape.
Sharp
Eliminates the tangents of the selected control points. If dealing with a shape, this is
transformed into a polygon.
Connected Tang
The shape created will be formed by Bezier splines, whose nodes can be edited
communally.
Independent Tang
The shape created will be formed by Bezier splines, whose nodes can be edited
independently.
Points Reset

Dropdown that allows the return to default values for the tangents or radials of a control
point.
Tangents
Assigns default values to the tangents of the selected control points, without
changing the radials.
Radials
Assigns default values to the radials of the selected control points, without changing
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the radials.
Radials Angle
Assigns default values only to the angles of the control points, without changing the
tangents or the length of the radials of the selected control points.
Reset All
Returns default values of the tangents or radials of a control point.
Shape Priority

This tab allows each shape of a specified layer or vector to be moved or have its priority
changed. The shapes will have a numerical identification, showing the depth or order of the
shape (this is especially important when carrying out boolean operations) in a given vector.
Move Up
Assigns a higher priority to
automatically be reassigned.

the

selected shape.

The

remaining

shapes

will

Move Down
Assigns a lower priority to the selected shape. The remaining shapes will automatically
be reassigned.
Animation

Commands for controlling the animation of shapes.
Auto Key
Automatic local keyframe creation mode with each modification of the shape control
point position.
Add Key
Adds a local keyframe to all the control points of the selected shape.
Note: even if only one control point of a shape is selected, a local keyframe is added
to all it control points.
Prev
Moves the Keyframe Slider back to the previous local keyframe of the selected shape.

Next
Moves the Keyframe Slider forward to the next local keyframe of the selected shape.
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Delete Key
Deletes the keyframe in the current frame of the selected shape.
Edit

Commands for editing shapes used to delete and move shapes from one effect to another.
Delete
Deletes the selected control points.
Note: to delete a shape completely, first select all the points of the shape by doubleclicking or using a multiple selection rectangle.
Cut All
Moves all the shapes of the selected clip to the memory, or clipboard.
Copy All
Copies in the memory all the shapes of the selected clip.
Cut Selected
Moves the selected shapes to the memory.
Copy Selected
Copies all the selected shapes in the memory.
Paste
Pastes a copy of the shapes in the memory in the selected clip.
Effect Input Alpha

Dropdown button that modifies the behaviour of the alpha channel of the edited clip.
Keep
Keeps all the original information of the alpha channel of the edited clip.
Invert
Inverts the original values of the alpha channel of the edited clip.
Clear
Eliminates all the original information of the alpha channel of the edited clip, leaving a
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totally transparent mask.
Fill
Eliminates all the original information of the alpha channel of the edited clip, leaving a
totally opaque mask.
Shape C ombine

Shapes added to the current clip will be applied on the alpha channel through one of the
four following application modes. The following image of a DVD player is an example to show
the operation of each mode:
The idea is to trim the DVD player, and also the screen of the player. To do this, one green
mask and one black mask will be extracted. Both masks need to be improved, to do which,
for each one, a shape with its different application modes is used.

Add
Adds the area of shape to the original mask.
Therefore, this is ideal for improving the filling of the shape of the player, since the
original silhouette of the extracted green mask has gaps that can be filled with
shapes.

Intersect
Restricts the area of the mask to the intersection between the area of the shape and
the shape of the original mask.
Therefore, it is ideal for eliminating everything that it is not part of the shape of the
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player, since the original silhouette of the extracted green mask includes a-required
objects, such as the revolving base, cables and hands. Simply eliminate from the mask
the a-required objects by tracing around the object that is to be preserved..

Add Inverted
Adds opacity to the original mask outside the area of defined shape.
Therefore it is ideal for adding opacity to anything outside the area of the player
screen, since the extracted black mask includes shadows that are not part of the
screen and must be eliminated. Everything that is outside the new shape can be
defined as opaque by simply tracing around the area of the screen.

Subtract
Reduces opacity of the original mask within the area of the shape defined.
Therefore, it is ideal for eliminating the applied tracking crosses applied within the
screen that have been left opaque in the mask extracted by black. This way, holes
can be made in the mask, adding shapes that defines transparent zones within the
mask.
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Vector Layer

Field indicating to which vector the set of shapes viewed at a given moment are
associated.
Vector Layer
Within the free vectors of RGBCorrect or in the tab Select of Color Grade, multiple
shapes can be worked with, indicating in which Vector of the color corrector a
specific shape will appear.
Note: Unlike previous versions of Mamba, where windows (or shapes) were redirected
from this button to the various vectors, now is it shown simply as information. from
Version 7, shapes are associated to vectors only when done so from the said vector.
This means that each time a vector is changed, only the shapes associated with that
vector are shown onscreen; this way it is possible to construct and organize simply all
the shapes that are used, since only those of the vector being operated are shown.

Default Shape Softnes Width

Numerical field where the value Softness is defined.
Default Softness
Defines the default value of the gradient of opacity of the visible shape, once
created.
Paint

Ref. Mamba: Visual Editor->Dashboard->Paint
This Manipulator Tab allows access to the submode Paint Editor.
Paint Editor is an interface especially designed to work with the VectorPaint effect. Thus
this tab is activated when applying this effect in the TimeSpace.
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For a detailed description of this submode, read the section Paint Editor of the VectorPaint
effect.
Title

Ref. Mamba: Visual Editor->Dashboard->Title
This Manipulator Tab allows access to the submode Title Editor.
Title Editor is an interface especially designed to work with the Title effect. Thus this tab is
activated when applying this effect in the TimeSpace.
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For a detailed description of this submode, read the section Title Editor of the Title effect.
Warper

Ref. Mamba: Visual Editor->Dashboard->Warper
This Manipulator Tab allows access to the submode Warper Editor.
Warper Editor is an interface especially designed to work with the Warper effect. Thus this
tab is activated when applying this effect in the TimeSpace.
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For a detailed description of this submode, read the section Warper Editor of the Warper
effect.
Tracking

Ref. Mamba: Visual Editor->Dashboard->Tracking
This Manipulator Tab allows access to the submode Tracking Editor.

Tracking Editor

Motion Tracking manipulation mode, that allows the moving of a pixel pattern selected via
an image sequence, creating animation curves that can be used to stabilize the movement
of an image, to compose new layers in movement or to apply the path obtained to any
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effect with two-dimensional positioning parameters.
This mode has two types of control:
Manipulators that appear superimposed on the image in the area of the Canvas and
manipulators that are controlled via the Dashboard of the Tracking Editor.
Canvas:

These manipulators can be used to specify the pattern to be tracked, specify a search
area, view the path of the tracked movement, modify the position of this path, visually
specify a offset between the search pattern and the path obtained and view segments that
join several tracked points.
The manipulator that specifies the search pattern is called “tracker”.

The tracker is a rectangular area, shown as a dotted blue line, which can be positioned in
any part of the screen, by left-clicking inside it dragging it to any other position. The size of
the tracker can also be changed via its size manipulators (the small squares found in the
top right and bottom left corners).
The tracker contains the pattern or set of pixels that the tool will try to recognize in the
images that compose the sequence. The tracker content is commonly called “tracking
point”.
The criteria used for choosing a good search pattern must follow certain principles:
The pattern should be present in the entire range of frames where the search
will be run (for example, do not select a pattern that will not be visible in
subsequent frames due to disappearing from shot or of being hidden).
The pattern should be an area of the image that can be clearly distinguished
(for example, part of a smooth wall is not a good tracking point, , since one
part of a smooth wall can be identical to another; a nail in the wall is a good
tracking point).
The smaller the pattern, the faster the search.
Lines are not good tracking points, since their parts may be identical and the
tracker may slip.
If the sampled area is confusing or has insufficient contrast, the tracking
result can be improved by applying a previous color correction, to provide the
maximum contrast in the details to be tracked and eliminate unnecessary
information.
If there is noise in the image, before doing motion tracking, the Denoise
(TimeSpace Editor->Dashboard->Fx->Mamba->Denoise) effect can be
applied to improve the quality of the patterns to be tracked.
It may also be useful to try the Channels (TimeSpace Editor->Dashboard>Fx->Mamba->Boolean->Channels) effect to eliminate the channels with
most noise, since in many occasions noise comes more from some channels
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than other.
The following image is an example of search pattern selection and of the path obtained.

The Path consists of the linear union of the positions where the search pattern is found in
each frame of the sequence. These straight lines are linear interpolations between the
positions of each frame tracked by the process. These segments can be clearly
distinguished in the path as they are drawn alternately in light blue and orange.
The path obtained by the tracker will be applied to the original center of the tracker, called
Target, which is shown as an orange circle at the center of the tracker.

The user can add any number of required trackers at any time, which will be identified by a
number or name accompanied by a letter T, and will appear at the bottom of each tracker
rectangle.
To optimize the search pattern, a search zone can be specified. This zone is a second
rectangular area, similar to the tracker, but with the size manipulators in the opposite
corners.
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This zone specifies the search zone of the next frame, and it can be moved by left clicking
on it, although bear in mind that the tracker may be inside it and it is not necessary to
press on the tracker itself. When the tracker is moved, the search zone moves with it,
maintaining its relative position. The Search Zone accelerates the tracking process, since it
restricts the search to a small part of the image, and not the entire image, as occurs if this
zone is not specified.
The smaller the search zone, the faster the tracking, but bear in mind that this should
predict the zone where the search pattern will be found in the next frame. For this reason,
in the second image of the previous example, the search zone is moved to anticipate the
path direction shown by the tracker.
The search area prevents the tracker confusing between two similar patterns found in the
same frame.
The tracker Target is by default centered in the search pattern, although the latter can
later be moved outside the Target by pressing <Alt> at the same time as the tracker is
selected and dragged with the left mouse button.
A blue line is shown between the Target and the search pattern which indicates the tracker
offset.

The purpose of the Offset is to momentarily select another search pattern, but continue the
original path. This is useful when the chosen search pattern is temporarily hidden by a
figure, which is when another nearby pattern can be chosen and the movement of the new
pattern applied to the original Target, completing the path of the first pattern selected.
It is also possible to move the tracker and its path together, by selecting the tracker and
pressing <Ctrl> This method is also valid to achieve the purpose as the offset.
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A single tracking point will only provide two-dimensional movement information.
If rotation information is needed, it is necessary to work with a minimum of two trackers,
since the angle that determines the line joining these two points will be the rotation angle
obtained,
The same occurs if zoom or size information is needed. The zoom size or value is obtained
from the length of the line joining two trackers. This line is shown in yellow.

It is possible to add all the tracking points required, although only two tracking points are
needed to extract rotation or zoom. When working with more than two trackers, the
rotation or zoom value will be calculated as the average of all the join lines that exist.
When using many tracking points, the join lines form a shape which can be saved as an
animated vectorial shape that can then be loaded and used in the VectorPaint effect, in
which the shape can be modified and perfected, specifying tangents for each point, defining
attributes, etc. This process is useful for the creation of animated masks based on tracking
points.

When working with the CornerPin effect, there should be four tracking points, which can be
shown with their names at their corresponding corners. The foreground layer of the effect
will be deformed according to the square formed by the lines joining the four tracking points.
It is often convenient to specify the tracking points in the frame with the largest possible
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composing area is. In the following example, the tracking points were specified in the last
frame, and then dragged back in time.

The tracking search speed is much faster than real-time. Even viewing the sequence in the
interface monitor can reduce the tracking speed. For this reason, a mode exists in which
the sequence progress is not visible, thus utilizing the full speed of the tracking process.
To take advantage of all the tracking performance, it is important to select for the
evaluation of the original image without additional processes, since if images of other
effects are tracked they will also have to be evaluated, and this will slow down the search
of the tracking points.
Many effects, such as Comp3D, have many folders where the tracking coordinates can be
applied. To do this, first select one of the parameter folders by specifying the target of the
tracking coordinates, and then apply the tracking result.

All paths obtained by a tracker can be corrected, and even manually modified.
The tracking interface slider is used to select the current frame. Moving a tracker
immediately updates the current point of the path, specifying a new position for the
selected frames.
In frames with no specified positions, the tracker will move through the segments (linear
interpolation) that join the specified positions (frame position). When applying tracking to
the parameters of an effect, only the specified positions will create keyframes in the curves
formed by the two-dimensional coordinates. The type of interpolation of these keyframes
can be specified in the Parameters area.
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Dashboard:

The Dashboard of the Tracking Editor contains many functions, modes and viewing controls.
To the right of the Slider is the Back button to exit the Tracker Editor and return to Visual
Editor mode. No information is lost when exiting, since the position and trajectory of the
trackers is remembered for the following time this panel is accessed, but we need to exit
when we wish to work on others effects.
In the lower part is the message line (Message). This field gives us information about the
functions run from the panel or keyboard shortcuts.
This group brings together definable values numerical box or from the buttons Set In and Go
To which copy the value of the current frame defined by the Keyframe Slider. These values
define a range of time within a sequence, in which the search pattern is done.
The definition of this range works similarly to that of input and output points in a non-linear
editor.
The numerical fields From and To show the first and last frame of the search range. These
fields are editable and the values can be specified manually.
Set
Defines the value of the input or output point of the range taking as a reference the
active frame in the Slider.
Go To
Moves the Keyframe Slider to the frame defined in the numerical fields From or To.

Buttons for managing the trackers.
Add Tracker
Adds a new Tracker manipulator.
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Hide Tracker
Hides the path of the selected tracker, and is ignored by the commands of the Go
Forward button.
Remove Tracker
Removes the selected Tracker manipulator.
Reveal Tracker
Undoes the Hide function of the selected tracker.

Restores the values of the time range to the default, previously defined in Tracking Ranges,
allowing the tracker to act over the whole duration duration of the clip or until the user
decides to stop the analysis.
Mode that uses the tracker Search Zone instead of using the entire image.
Group of buttons that defines the application mode of the animation curves obtained by
tracking.
Position
Mode that applies the tracking result to the XY position parameters.
These coordinates are applicable to all effects that possess two-dimensional
parameters (position in X and Y), such as Comp3D, Title, Vector Paint, Noise, Fractal,
Circle, Wave, Radial Blur, Twirl, Bump, Refract (Distort), Flare.
If there is more than one tracking point, the movement coordinate will be the average
of all the tracking point positions.
The most usual use of this mode is to animate the position of an image layer so that it
moves in the same way as an element in another image, although its uses are very
varied.
Rotation
Mode that applies the tracking result to the rotation coordinates.
This information about rotation is applicable to all effects that possess a rotation
parameter in Z, angle or cycle, such asComp3D, Noise, Stripe, Radial Blur, Twirl, Liquid
Bump, Refract, Brush Stroke, Kaleido.
For this mode to work correctly, there must be a minimum of two tracking points. If
there are more than two points, the rotation information will be the average of all the
angles specified by the tracker join lines.
This is normally used to animate the rotation of a layer by making it coincide with the
rotation of an object present in the image.
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Size
Mode that applies the tracking result to the scale parameters. This information is
applicable to the Comp3D effect.
For this mode to work correctly, there must be a minimum of two tracking points. If
there are more than two points, the scale information will be the average of all the
lengths specified by the tracker join lines.
It is normally used to animate the scale of a layer by making it coincide with the
change of scale of an object present in the image.
Corner Pin
Mode that applies the coordinates of four tracking points as the result of the position
of the corners of a rectangle. This mode is used to fit in movement one image layer in
an area of another image defined by four points.
Group of buttons that work on the path of the selected tracker.
Cut
Moves the path of the selected tracker to the clipboard.
Copy
Copies the path of the selected tracker to the clipboard.
Paste
Pastes a copy of the path in the clipboard into the selected tracker.
Remove
Deletes the path of the selected tracker.
Load
Opens the selected points and paths of a tracking file (.trk) and adds them to the
current tracking.
Save
Saves the selected points and paths as a tracking file (.trk).
This group of buttons contains those that run tracking of the search pattern during the
sequence.
Go Forward
Runs the tracking of the search patterns in the direction of the frames after the
current one.
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Go Backward
Runs the tracking of the search patterns in the direction of the frames before the
current one.
Go Both
Runs the tracking of the search patterns in the direction of the frames before and
after the current one.
Stop
Stops the tracking of the search patterns.
Group of buttons that work on the points that form the path of the selected tracker.
Remove Point
Removes the tracker position in the current frame.
Remove Range
Removes the tracker positions in the range specified by From and To.
Remove Forward
Removes the tracker positions from the current frame to the end of the sequence.
Remove Backward
Removes the tracker positions from the beginning of the sequence of the current
frame.
Group of buttons that apply the tracking coordinates to the selected effect or parameter
folder.
Move
Applies the tracking information positively (copies the animation curve to the selected
parameter as it has been calculated).
Stabilize
Applies the tracking information negatively.
The applied movement is the inverse of that extracted from the sequence, and thus
stabilizes the movement of the original sequence, leaving the tracked search pattern
fixed at the center of the screen.
This process is very useful for stabilizing a sequence and hold it steady while working
with other effects such as VectorPaint or Warper, and the later returning to apply the
tracking coordinates positively and thus recover the original image movement.
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Smooth
Applies the tracking information to cancel only small abrupt movements in the selected
search pattern, thus smoothing them out.
This application command is ideal for removing small camera shakes, without removing
the selected movements.
Shape Mode
Activates the masks to be used to define tracking areas. Instead of using the usual
tracking points, the masks establish the areas where the tracking will be applied,
ignoring any outside the mask in question.
Enable Tracking
Activates tracking within the selected mask.
Populate On Start
Activates a search for tracking points when starting movement analysis. When a mask
is used to define a tracking zone, <%PRODUCT> will automatically movement points
throughout the clip in order to carry to said tracking.
Enable Pruning
Activates the deletion of tracking points that are outside the specified area of the
mask, so that points that lose their movement reference and could thus ruin the
tracking are automatically eliminated.
Populate Now
This functions in the same way as Populate On Start, except that <%PRODUCT> runs
the analysis when tracking begins, so that the user can see the movement points and
choose those that are unnecessary from the start.
Go Backward
Runs the tracking of the search patterns inside the shape in the direction of the
frames after the current one.
Go Forward
Runs the tracking of the search patterns inside the shape in the direction of the
frames before the current one.
Go Both
Runs the tracking of the search patterns inside the shape in the direction of the
frames before and after the current one.
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Reset Shapes
Reset all the shape trackings to default values.
Move
Mode that applies the tracking result to the XY position parameters of the shape.
Rotate
Mode that applies the tracking result to the rotation coordinates of the shape.
Size
Mode that applies the tracking result to the scale parameters of the shape.
Size XY
Mode that applies the tracking result to the XY scale parameters of the shape.
Round
Optimize the search and the application of the tracking for rounded elements.
Fine
Enable a mode of analysis and application of the tracking more accurate than the
normal one. This mode is designed for big tracking areas, and it uses a big resolution
for the search patterns, so it is slower. Any mask with an area of less than 10% of
the image uses by default this tracking mode.
History
This is the tracker progress tolerance value.
Small values specify that the search pattern is the one originally selected in the frame
in which tracking began. Large values specify that the search pattern is continually
updated with the current content in the following frames. Intermediate values cover a
tolerance range that mixes the original pattern with the image of the pattern found in
each frame.
For points that change their appearance during a sequence, a high History value
(such as the corner of a rectangle for example) is recommended; for points that do
not change their appearance much during a sequence, low values are better, thus
achieving a more exact result.
Safe Area
Specifies the percentage of the image area total where tracking will take place.
Outside this area, the tracker applies extrapolation values. In this way, collision of the
tracker with the image margins is avoided, keeping the linear path of the tracker when
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it goes out of frame.
Silent Tracking
Search mode which, by hiding playback of the frames that appear in the sequence,
allows tracking to be run faster.
Track
This dropdown button selects if the tracking mode will work on the original high
resolution images (Track Full Res) or over a proxy (Track Proxy).
Track Eye
This dropdown button allows the selection of which of the images that compose the
stereo pair the tracking will work on (Left or Right) or when not a clip of stereo images
No Stereo.
Scrub
This dropdown button selects if the viewing mode in the Keyframe Slider will evaluate
the original high resolution images (Scrub Full Res) or will evaluate a proxy (Scrub
Proxy).
Control buttons for viewing tracker components.
Show Trajectory
Activates the viewing of the trajectories of the trackers.
Show Shape
Activates viewing of the tracker join lines.
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E-1 Mamba FX

This chapter includes information about the functioning of the effects in Mamba, with
practical examples and tutorials.
Compose

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Compose

The Compose group includes composing effects and tools.
C omp3D

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Compose->Comp3D
Comp3D is Mamba’s main composition effect. It permits composition in a three-dimensional
multi-layer space, unlimited inputs respecting their alpha channels, specifying animations for
the camera, different light types, and three-dimensional deformations for each layer.
This effect has specialized manipulators, described in the chapter Visual Editor.
I/O

Inputs
Multi-input: A background as first layer (with optional alpha channel), and an
unlimited number of inputs (with image and optional alpha channel). The use of the
first input as background is optional, and it is possible to replace it with a transparent
alpha channel black background, via the parameter Backgr.
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Inputs
Image: Background image (optional) composed with the other inputs repositioned in
the three-dimensional scene.
Alpha: The addition of the masks repositioned in the three-dimensional scene.
Parameters
Options:

Folder that contains parameters for controlling evaluation options:
Quality
[Bilinear (Nearest / Bilinear / Bicubic )]
Defines the quality of the rescale filter.
In the parameter's dropdown there is a list of available qualities, from lowest to
highest quality downwards. It is recommendable to define the lowest quality that
obtains the best visible results, because the higher the quality, the greater calculation
time required.
Result Size as
[Input (Input / Project]
Defines the output resolution of the effect. Input sets the output resolution as the
same as the original resolution of the clip. Project sets the output resolution as the
same as the current resolution of the work in hand (mConfig->RenderFormat ).
Input is especially useful when a clip has a higher resolution than the project and this
resolution is desired for later application to other effects capable of working in its full
resolution and extracting greater detail than the working resolution.
Samples
[x1 (x1,x2,x3,x4,x8,x15,x24,x66)]
Number of samples of render processes. High values set a higher number of samples,
notably improving the resulting image quality and the Antialiasing, which is very visible
in the details of an image, the edges of composite layers and in layers that have been
reduced in distance or size. This parameter interacts with the parameter Shutter.
Shutter
[0 (0 / 360)]
Controls the shutter angle of the virtual camera, simulating the Motion blur produced
by an object in movement filmed on photographic film.
Simulating the behavior of a film camera shutter, this parameter creates render
samples in the positions between frames as a real shutter would show. If the value is
at its maximum (360) the shutter is completely open, and the motion blur will cover
the whole movement between two frames. If the value is 180, the length of the blur
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will be half of the movement between frames, and if the value zero (the Default value)
there will be no blur, and all samples will be in the same position. Since the blur is
created by the offset of the samples, it is necessary that the parameter Samples is
not at x1, as there would not be samples for the Shutter to work correctly; high
values are recommended.
Background:

Folder that contains the different options for the background image.
Background
[Input1 (Input1 / Solid)]
Defines whether the first input of the effect is used as background. In this case, the
background will not function as a layer, since it cannot be manipulated, because it is
set as a two-dimensional background of a three-dimensional composition. If the value
is set asSolid, the first input of the effect will be the first manipulable layer, and have
a solid background definable via the usual parameters.
Red; Green; Blue, Alpha
[0; 0; 0; 0 (0 / 100)]
Defines RGBA value of the solid color.

Shadow:

Folder that contains the parameters that generate a shadow projected by all layers on the
background (this effect needs the Background option in the On position).
This shadow is a two-dimensional projection of the total off the masks of the layers
repositioned, with parameters of two-dimensional offset, focus, opacity and color.
OffsetX;Y
[2; -1 (-100/100)]
Specifies two-dimensional offset of the projected shadow.
Intensity
[0 (0/100)]
Specifies opacity as a percentage of the shadow.
BlurType
[Box (Box, Gauss)]
Specifies the type of blurring applicable to the shadow.

SGO Mamba 2.0.1 © 2014 SGO

192

FX

BlurRad
[0 (0/100)]
Specifies the quantity of blur applicable to the shadow.
Spread
[0 (0/200)]
Extends the opacity of the shadow from its interior. This parameter acts together with
BlurRad.
Red; Green; Blue
[0;0;0 (0/100)]
Specifies the color of the shadow.
Camera:

Dropdown folder that contains folders with parameters that control the camera.
Position X; Y; Z
[0; 0; 500 (-1.000.000 / 1.000.000)]
Three-dimensional coordinates of the camera position.
This parameter can also be changed through its manipulators.
With the camera in orbit view mode, the manipulator specifies a circular movement of
the position coordinate around the target coordinate, simulating an orbital movement
that keeps the lens pointed towards the point specified by the target. In dolly camera
view mode, the manipulator moves the coordinate along a straight line joining the
target to the position, thus simulating a forward or backward camera travel.
With the manipulator in move camera view mode, it moves both coordinates at the
same time, simulating a camera travel in the plane perpendicular to the view.
Target X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional coordinates of the point towards which the camera lens is pointed.
The position of the objective is specified by the three-dimensional alignment of the
camera, thus permitting for example that the camera is kept pointed at a particular
layer by copying its position parameters to the target.
With the camera manipulator in rotation mode, it specifies a circular movement of the
target coordinate around the position coordinate, simulating a panning movement of
the camera objective.
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Camera Roll
[0 (-1.000.000 / 1.000.000)]
Specifies a rotation angle of the camera on its depth axis, determining the inclination
of the horizon.
Camera FOV
[22.6 (0 / 180)]
Specifies the Field Of View of the camera.
This field is measured in degrees with higher values representing wide-angle lenses
and lower ones zoom lenses.
Camera InterOcular
[0 (0 / 100.000)]
This attribute is applicable to stereoscopic images. It modifies the values of interaxial
separation of the stereoscopic image. The higher the value of Camera InterOcular, the
more exaggerated will be the stereoscopic effect.
Ambient:

Ambient R; G; B
[33; 33; 33 (0 / 100)]
Specifies a color for ambient lighting that will affect all the layers, regardless of their
position or alignment. Specifying minimum lighting of any color for all three-dimensional
scenes avoids totally darkening the polygons not affected by the lights. The default
value complements the default light to maintain the layers of the three-dimensional
composition illuminated so that their original colors or brightness do not change.
Light_1:

Folder containing the parameters of light created by default. Lights created later are added
subsequently, as an identical folder with its own automatically incremented number. The
creation, copying, and deletion of lights is controlled from the command tab located in
Mamba->TimeSpace Editor->Mamba->Main Tabs->Parameters->Folder.
Position X; Y; Z

[0; 0; 200 (-1.000.000 / 1.000.000)]
Three-dimensional coordinates of the light position.
Target X; Y; Z
[0; 0; 100 (-1.000.000 / 1.000.000)]
Three-dimensional coordinates towards which the camera objective is pointed.
This parameter does not affect lights specified by the type parameter with its value
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set to 1.
Color R; G; B
[100 (0 / 100)]
color of the light. The default color is white.
Intensity
[67 (0 / 1.000.000)]
Intensity of the light, in percentage values. The RGB value of the color is multiplied by
this parameter.
Type
[Directional (Directional / Point / Spot)]
Type of light. The three types are:
Directional: Directional light. This type of light produces parallel rays in the direction
specified by the straight line joining the Position and Target coordinates, as the real
information provided by the three-dimensional coordinates is of little relevance. The
intensity of this type of light does not decay with distance: the values of the Decay,
Spread and Falloff parameters are ignored.
Point: Point light. This type of light is created from an emission point in threedimensional space specified by the Position coordinate, emitting spherically-shaped
light: the Target coordinate and the Spread and Falloff parameters are ignored. The
light intensity decays with distance according to the value specified by the Decay
parameter.
Spot: Spotlight. This type of light is created from a point in three-dimensional space
specified by the Position coordinate, emitting spherically-shaped light, although limited
by a cone oriented towards the position specified by the Target coordinate. The
appearance of the cone is specified by the Spread and Falloff parameters. The light
intensity is maintained constant in the range of distance specified by the Target
coordinate, and after that, it begins to decay with distance depending on the value
specified by the Decay parameter.
Cutoff
[90 (0 / 90)]
Specifies a cutoff limit of the light cone for lights of type 2.
Exponent
[32 (0, 128)]
Specifies the light intensity concentration in the center of the cone for lights of type
2.
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Decay
[0 (0 / 2)]
Specifies a decay exponent of the light intensity depending on distance.
Depending on the distance between the layers and the positions of type 1 and 2
lights, the light intensity drops, affected exponentially by this parameter, whose
default is 0 (zero), inhibiting the distance decay. A value of 1 indicates decay
proportional to the distance, and a value of 2 indicates decay proportional to the
square of the distance, emulating in the later case the behavior of a real light. This
parameter also permits decimal values for setting intermediate values.
Axis_1:

Folder containing the information of a first transformation axis which affects the second
transformation axis and all the layers and ambient lights of the three-dimensional scene, via
position, rotation, size and pivot coordinates.
Position X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional position coordinates.
Rotation X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional rotation coordinates.
Size X; Y; Z
[100; 100; 100 (0 / 1.000.000)]
Sizes as percentage values.
Pivot X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Specifies a offset of the rotation and scaling pivot, which by default is centered.
Axis_2:

Folder containing the information of a second transformation axis which affects all the
layers and ambient lights of a three-dimensional scene, by position, rotations, size and pivot
coordinates.
Position X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional position coordinates.
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Rotation X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional rotation coordinates.
Size X; Y; Z
[100; 100; 100 (0 / 1.000.000)]
Sizes as percentage values.
Pivot X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Specifies a offset of the rotation and scaling pivot, which by default is centered.
Layer_1:

Dropdown folder containing the parameters of the layer created by default. Layers created
later will be added here as an identical folder, recognizable by its incremental number.

Layers are generated automatically each time we connect a node to Comp3D. These layers
are not deleted if the nodes are disconnected later, so care must be taken if other nodes
are reconnected, since the effect will apply the values of of previous layers.
If control layer transformation is needed, the number of layers should correspond to the
inputs of the effect, bearing in mind the Backgr and Disp Enable (displacement map layer)
parameters of each layer, as they may require inputs in addition to those specified by the
number of layers of the effect. The creation, copying and deletion of layers is controlled
from the command tab located in Mamba->TimeSpace Editor->Mamba->MainTabs->
Parameters Panel->Folder.
Note: If the number of inputs is greater than the number of layer controls created within
the effect, the last layer transforms all the inputs at the same time, as if it were a single
input with all the images pre-composed in it.
Folder containing the information for transformation of the layer, with its position, rotation,
size and pivot coordinates.
Position X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional position coordinates.
Rotation X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Three-dimensional rotation coordinates.
Size X; Y; Z
[100; 100; 100 (0 / 1.000.000)]
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Sizes as percentage values.
Pivot X; Y; Z
[0; 0; 0 (-1.000.000 / 1.000.000)]
Specifies a offset of the rotation and scaling pivot, which by default is centered.
Parameter folder specifying attributes, which affect the behavior of the layer in a threedimensional scene.
Attributes Subdiv
[3 (1 / 7)]
Specifies the polygonal subdivision index that constitutes the layer.
A high index increases the number of polygons that make up the layer, achieving
greater detail in deformation effects. The repositioning of the polygons make the
three-dimensional deformations visible, therefore, the more polygonal subdivisions in
the layer, the better reproduction quality of these deformations, although the
increased complexity of the process should be noted.
Attributes DispMap
[Off (Off / On)]
Specifies the luminance of the input according to the current corresponding layer as
its displacement map. The default setting of this parameter is 0, without assigning any
displacement map.
A displacement map is an image which, based on the luminance values of its pixels,
moves the polygons that conform a three-dimensional object in depth. In this effect,
the objects are the layers, made up of polygons, which can be displaced in the depth,
or Z, axis.
Attributes Blending
[Normal (Normal / Premultiplied / Blending Modes)]
Specified the mode in which the layer is blended with respect to the one behind it.
Normal. Specifies the composition mode in the layer as normal for occlusion. The
resulting color is the original color of the layer; this mode ignores the hidden color.
Premultiplied. Specifies the composition mode in the layer as without multiplication of
the alpha channel.
This is recommendable for images or sequences derived from 3D or graphics that have
been created over a black background, which do not need to be multiplied by their
alpha channel before being added to the composition since this has been done
previously in the previous program.
Blending Modes. Specifies modes of composition in the layer according to variants
widely used in other image composition systems. These modes are: Darken, Multiply,
Color Burn, Linear Burn, Lighten, Screen, Color Dodge, Linear Dodge, Overlay, Soft
Light, Hard Light, Vivid Light, Linear Light, Pin Light, Difference, Exclusion, Hue,
Saturation, < /text>Color and Luminosity.
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Attributes Specular
[0 (0 / 1.000.000)]
Specifies the specularity of the surface of the layer.
The higher the value of this parameter, the more the brightness produced by the
lights of a three-dimensional scene will be reflected.
Attributes Gloss
[20 (1 / 1.000.000)]
Specifies the gloss of the surface of the layer.
The higher this value, the more the intensity of the gloss produced by the scene lights
will be concentrated.
Attributes Blend
[100 (0 / 100)]
Specifies the composition opacity of the layer in a three-dimensional scene,
respecting its transparency values specified in the optional alpha channel.
Dropdown folder that contains the three dimensional deformation parameters of the layer.
These deformations are processed in the same order as they appear in the effect.
Folder containing the parameters that specify the offset of the polygons of the layer in the
Z axis.
Ampl
[10 (-100.000 / 100.000)]
Specifies the amplitude range of the displacement map, permitting negative values to
interpret the map inversely. Its units reflect the distance of the maximum offset in the
local coordinate Z of the edited layer. This parameter will not reflect changes if the
displacement map if this is not activated by the DispMap parameter.
Zero
[50 (-100.000 / 100.000)]
Specifies the value of the offset range in its position in the original plane of the layer.
If this parameter is set at 100, the white value of the displacement map is specified at
the original position of the plane of the layer, thus only displacing the polygons that
are affected by lower values, with 0 being equivalent to black. The parameter accepts
values outside the range of the displacement map (0 to 100) by the use of
extrapolation.
BlurR
[1 (0 / 100.000)]
Specifies a reduction of detail in the displacement map using a blur filter calculated in
32 bits.
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Normally, a displacement map contains details that sharply displace the polygons of a
layer. On the one hand, this produces the original contrast of the input specified as
the displacement map, and on the other by the 256 maximum luminance levels of the
video images. To smooth this contrast, a blur is used, but with 32 bits, to generate in
this way more than 4 billion levels interpolated by the filter.
Folder containing the parameters that specify a cylindrical three-dimensional deformation for
the X and Y axes of the layer, that make spherical or toroidal deformations possible when
combined.
CilAng
[0 (-100 / 100)]
Specifies the vertical cylindrical deformation by a percentage value. The deformation
can be negative, inverting the cylinder face.
CilCuad
[0 (0 / 100)]
Specifies gradually the formation of four right-angles in the vertical deformation,
changing the appearance of the cylinder outline into a square.
TorAng
[0 (-100 / 100)]
Specifies the horizontal cylindrical deformation by a
deformation can be negative, inverting the cylinder face.

percentage

value.

The

TorCuad
[0 (0 / 100)]
Specifies gradually the formation of four right-angles in the horizontal deformation,
changing the appearance of the cylinder outline into a square.
TorRad
[0 (-100.000 / 100.000)]
Sets a radius for the deformation obtained by the TorAng parameter. The setting of
this radius permits spherical or toroidal deformations to be achieved.
Folder containing the parameters that specify three-dimensional deformation in the form of
horizontal or vertical waves.
X-Ampl
[0 (0 / 100.000)]
Specifies the offset amplitude for the waves in the horizontal axis of the layer.
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X-Shift
[0 (0 / 100.000)]
Specifies a offset of the wave position in the horizontal axis of the layer.
X-Num
[2 (0 / 100.000)]
Specifies the number of waves in the horizontal axis of the layer.
Y-Ampl
[0 (0 / 100.000)]
Specifies the offset amplitude of the waves in the vertical axis of the layer.
Y-Shift
[0 (0 / 100.000)]
Specifies a offset of the wave position in the vertical axis of the layer.
Y-Num
[2 (0 / 100.000)]
Specifies the number of waves in the vertical axis of the layer.
Folder containing parameters that allow the surface of the layer to be cropped at the four
sides of a frame.
Left
[0, (0 / 100)]
Left edge as a percentage of the image width.
Right
[100 (0 / 100)]
Right edge as a percentage of the image width.
Up
[100 (0 / 100)]
Top edge as a percentage of the image height.
Down
[0 (0 / 100)]
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Bottom edge as a percentage of the image height.
Folder that contains parameters that deform the layer by repositioning its four corners. This
function permits CornerPin tracking in any layer from the Motion Tracker.
Positioning of the corners of this effect can be made in Tracker mode. After the tracking
has been applied to the effect, the offset parameters of each corner can optionally be
adjusted.
Note: this distortion is two-dimensional, within the original plane of the layer without threedimensional deformations. The distortion is applied equally to color, its mask and
displacement map if available.
UpLeft-X; Y
[0; 100 (-10.000 / 10.000)]

Position of the top left corner.
UpRight-X; Y
[100; 100 (-10.000 / 10.000)]

Position of the top right corner.
DownLeft-X; Y
[0; 0 (-10.000 / 10.000)]

Position of the bottom left corner.
DownRight-X; Y
[100; 0 (-100.000 / 100.000)]
Position of the bottom right corner.
Use and C omments

The units of this effect are not always expressed in percentage values.
The rotations are expressed in degrees, as with a camera shutter.
In the case of Position Y, a value of 200 is equivalent to placing a layer exactly above its
original position, this value being the equivalent to the distance specified by a value of 100
in Y.
The Position Z parameter behaves in a similar way to the previous one: specifying a value of
200 moves forward a distance equivalent to a value of 100 in Y.
However, in the case of Position X, a value of 266 is equivalent to placing a layer exactly to
the right of its original position, this value being the equivalent to the distance specified by
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a value of 100 in X.
This is because the values of Size are percentages, but in order to respect the appearance
specified in Mamba Setup->Render Format->Aspect Ratio, the anamorphism is
respected without converting the position units into percentages.
The values of Crop are also specified as percentages, although the Crop of this effect not
only crops the surface of the layer, but also resets its edges, which is taken into
consideration when the deformations are applied. If no deformations are applied, Crop will
behave like the other effects of the system. But cylindrical deformations are made by joining
the opposite edges, and in this case Crop resets the edges of the rectangle of the layer.
Thus, if a layer has been deformed to a spherical shape and the values of Crop are
modified, the edges will be reset without changing its spherical shape since these are joined
by the deformation, but the image area that is enclosed in the deformation of the layer will
be reset.
The following example shows that crop has removed the black bands in the foreground
image, but when a cylindrical deformation is applied, the new borders have been joined to
form the cylinder.

With respect to rescaling and repositioning images that do not need composition (basically,
conversion of formats), Fx->Mamba->Framing is often the most suitable, since it give
greater quality, speed and has a specialized manipulator to help with cropping, scaling and
positioning calculations
For tracking and stabilizing, the use of Comp3D, is recommended, preferably applying the
tracking coordinates in Axis_1, leaving the later deformations in the hierarchy of the effect
without change: for example, the layers in the Z axis could be moved to simulate the
parallax of a camera, thus scaling the tracking coordinates.
Displacement maps are images in which only the luminance information is important. In
accordance with the luminance of the image pixels, the polygons that constitute the plane
of the layer will be displaced in the depth axis of the object. If the offset needs fine detail,
the polygons that constitute the layer must be increased, by using the Subdiv parameter. In
the example, any image can be used as a solid white displacement map.

Excess detail in the displacement map can be softened with the Blur parameter. Also,
negative values of the Ampl parameter can be specified, reversing the offset direction.
Displacement maps are applied before the other three-dimensional deformations, and they
can be combined with cylindrical or wave deformations simultaneously.
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The animations of positions of composed layers in this effect are made by specifying
keyframes. Between these keyframes are the intermediate positions, which are calculated
by interpolations. Several samples can be taken from any position by increasing the Samples
parameter, improving the quality of the result of the effect. But a frame is really a fraction
of time, and in that small time range the samples can be specified to be taken from different
positions, if the layer is moving. The Shutter parameter specifies a time range (between 0
and 360) within the same frames so that the samples are made in movement.

It is important to note that the render speed of this effect is closely linked to parameters
that increase the resulting image quality, such as the Samples and RenderMd options and
the layer parameter Subdiv, all of which should be carefully set at the minimum values that
give the desired quality, since the misuse of these values can markedly reduce system
performance.
The three-dimensional space created by this effect is very large but finite, and a layer can
even be enlarged or reduced to the point of leaving the space, resulting in total or partial
disappearance of the layer that exceeds this limit. A layer can also totally or partially go
past the camera position. For this reason, it is recommended that the size and its position in
the depth axis are clearly differentiated, since, if an image is to be enlarged, the position
value in the Z axis can be increased, although this method is no more convenient than
increasing the size values.
When a virtual perspective with a multi-layer composition is to be created, first maintain a
common scale, specifying as a first step the sizes of each layer as if they were all in the
same plane. Then position the layers in the depth axis. This way, when the camera is
moved, a perspective with a consistent parallax is achieved.
The following image contains the deformation values for creating different primitive forms:
Comp3D has a special manipulation mode in the Visual Editor, which permits the specifying
of positions, rotations and sizes for the layers, lights and camera, and m for interactive
repositioning (dragging the image) the transformation pivot of each layer.
It is also advisable to know about the operation of the ActualPixels manipulator (1:1), which
helps deal with images of size different from the work format. In order to work with this
type of image, it is important to remember that the first layer must as large as the work
format (MambaSetup->RenderFormat->RenderFormat->X/Y) since this gives the size
reference on which the other layers are made up. If there is no background image, include
an effect without n put as first layer (a Solid, for example), whose output will provide this
size reference to begin composing.
Also, remember that when including layers of nonstandard size, a red frame will appear when
selecting them, indicating that the complete frame is viewed but that a decision regarding
its rescaling is pending. In the situation in which we see (the complete image, it does not
have to match the output of the TimeSpace monitor (this will trim them to the standard size
in case of no action being taken). This warning will disappear once any value of
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transformation is established, (by pressing the ActualPixels (1:1)),
From Version 3.0, the tracking software in 3D Boujou can export its result to Mamba
environment. Boujou generates an environment with a Comp3D where the camera layer is
animated according to 3D tracking done in an original camera. This allows automatic to
integration of new image layers within another image (the one from the original camera),
without having to animate them manually. To do this, Boujou provides an animation of the
Comp3D camera, so that it moves the same as the camera that recorded the original
images.
It is possible to edit the colors of the lights by using the color Chooser manipulation mode,
and selecting in advance the folder containing the light to be edited.
When using Corner parameters, image movements can be extracted with manipulation mode
Tracker, using four trackers, one for each corner of the image.

Even if not using motion tracking, this mode is helpful for positioning graphically four corners
for specifying transformation, and Move must be applied to the tracking coordinates
whenever it is necessary to refresh the position.

HaloC omp

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Compose->HaloComp
Composes a layer with a background, adding a luminous halo created from a copy of its
mask to the foreground.
I/O

Inputs
Double input: The first input will be the background and the second the foreground,
using the alpha channel of the latter to generate the halo.
Inputs
Image: second input composed on the first, with a luminous halo around it.
Alpha: No change.
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Parameters

Blur
[2 (0 / 100)]
Halo blur. The copy of the mask of the foreground generated by the halo should be
blurred so as to give it the appropriate look.
Inside
[50 (0 / 100)]
Sets the percentage level of mixing of the halo in the interior of the mask.
Higher values indicate greater visibility of the halo in the foreground interior.
Red; Green; Blue
[0; 0; 0 (0 / 100.000)]
Specifies a gain correction of the halo color.
Values higher than 100 are allowable, increasing the halo potential.
Use and C omments

This effect can be simulated by combining other effects of the system, although it is faster
to work with this effect, since it has all the parameters necessary in one single effect.

Feedback

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Compose->FeedBack
This effect is not in itself an image process, but rather one of the system tools.
It sends the input to memory and to the output of all the Feedback effects without input,
either evaluated by the monitor, or in the frame being processed in a render.
I/O

Inputs
Can be single input (image with or without alpha channel) or without inputs.
Inputs
No input:
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Image: The image in memory.
Alpha: The mask in memory.
Single input:
Image: The input image.
Alpha: The input mask.
Parameters

None.
Use and C omments

This effect allows the creation of instances of one part of the flow in different branches of
the same flow tree to which they belong, without needing to evaluate them repeatedly.
When the Feedback effect has no input, its output shows the last input that was read (of
the same effect clip or another Feedback effect), thus for example permitting lengthening
the duration of the result of a shorter effect, which has been memorized by the Feedback
input and will be repeated during all the remaining duration of the Feedback clip as long as
there is no new input.

Scope

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Compose->Scope
This effect is useful for grouping together nodes that are not otherwise related to each
other, and use it as a preset
It can also be used to force the conversion of an image to a specific internal format in order
to control quality.
I/O

Inputs
Multi-input: Image with or without alpha channel.
Inputs
Image: No changes, unless the input is YUV, in which case it is converted to RGB.
Alpha: No change.
Parameters

Format
[NO CHANGE (NO CHANGE / YUV422 / RGB8B / RGBA8B / RGB10B / RGBA16B / HW-HDR)]

Defines the output of the effect.
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C onnect

This is not strictly speaking an effect, but rather node composition tool. It links nodes
manually, especially those to be used as multiple inputs to feed various branches of a tree
node. Mamba does not possess by default any node that itself has various outputs, so that
in order to generate these outputs we must use this tool.
The Links can be arranged either manually or automatically (just like other nodes), so it is
not necessary to have a node selected in order to place the Link in the editor (see Basic
operations with Nodes in Node Graph Editor). Links can also be created by holding down
<ALT> while leftclicking on the output icon of the node to which we want to connect the
Link.
Dummy C lip

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Compose->Dummy Clip
This effect is not in itself an image process, but rather one of the system tools.
Dummy is a type of clip that is used in a group as a replacement for a layer, which may be
outside the group as an input to the group, or also in combination with the Dummy Comp
effect.
When a set of effects of the same duration are grouped with a Dummy, the group will
change into a template group, which as compared with other groups, has a scope for
placing inputs.
These inputs will be evaluated instead of the Dummy clips within the template group,
activating the use of a template.
Another way to activate the use of a template is by using the Dummy Comp effect,
without the need to group.
Dummy clips have a number corresponding to the input number of the template group that
will be assigned as its replacement.
In order to assign an identifying number to the Dummy clip, a number should be entered
into the calculator, with the Use button active, and then press the button in the gallery of
effects that adds a Dummy in the TimeSpace. The number in the calculator will appear in
the Dummy clip that is created.
The Dummy clip identifying numbers correspond to the inputs of the template group in the
following order:
Dummy 1: first input.
Dummy 2: second input.
Dummy 3: third input, and so on successively.
Bear in mind that the identifying numbers of Dummy clips should consist of a successive
numbering starting with 1. Otherwise it is impossible to assign the inputs correctly to the
template group.
Within a template group, several Dummy clips can coexist with the same identifying
number, thus working as instances of the same template group input, which is only
evaluated once, sent to memory and then replaces all the Dummy clips with the same
identifying number, in this case resulting in similar behavior to the Feedback effect.
Each Dummy clip evaluated without having an assignment produces an image that
symbolizes its number with squares specified by its index similar to the numbers on a dice,
with a different color for each identifying number, so that there is a reference to the clip
and the lack of an input in the template group can be detected.
The following example shows the steps to follow to construct an effect template.
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In the example, it can be seen that the same input will be repeated three times in the
original tree. This repetition can be avoided by using the assignments generated by Dummy
clips.
In other systems, the vertical flow of the first two steps of the example could be shown in
the following way:

Remember that, in order to create a template group, it is necessary to group aligned clips of
the same duration, with at least one Dummy clip inside the group. Otherwise the template
group is not created and a normal group is specified instead.
However, once the template group is created, it is possible to navigate in it and modify the
duration of the clips. When exiting the group, Mamba will ask if any additional actions should
be taken first, or if all the durations of the clips in the group should be adjusted to the
original duration.
When the duration of the template group is specified again in the TimeSpace, the duration
of all the clips inside the group will also be specified again.
The template groups can be combined in an infinite number of ways, and a template group
can be used as the input of another.
This means that this effect can be used to create templates from any stack of effects,
creating groups that can be stored for later use, thus optimizing tasks that repeatedly use
the same stack of effects preconfigured by the user. These can be modified at any time.
A more complex flow will be used as another example, also using the Dummy Comp effect:
This flow is also shown on the right in a one-dimensional diagram, since it does represent
the duration of each process, to understand how the Dummy effect creates instances in
another part of the flow. The blue lines indicate the assignments in the first flow, and the
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green lines those in the second.

Boolean

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Boolean

The effects of the Boolean menu add Boolean operations to clips.
C hannels

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Boolean->Channels
Reassigns or combines the RGB and Alpha channels that come from the same or different
images by using Boolean operations.
C lip naming system

The majority of the parameters of this effect are expressed with words to make their
interpretation easier. These values are not usually animated, as they express modes.
Certain combinations of parameters defines standard functions that the system recognizes.
These standard functions (such as assigning an external mask) automatically modify the
name of the effect being viewed in the TimeSpace (for example, Channels automatically
changes to ExternalKey when the external mask is defined).
If the values detected by the system in order to change names are found to be animated, it
is viewed as the name of the combined parameters specified in frame 0.
This effect can be accessed from the effects gallery, via presets with associated hotkeys
and its own button within the gallery, but in reality only this effect is invoked as it brings
together many possible functionalities.
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Parameters

This effect has four dropdown folders, one for each channel (red, green, blue and alpha). It
also has a mode folder described below.
Mode
[SW (SW, HW, HW-HDR)]
Defines the processing mode of the effect.
SW specifies that the calculation is done by software.
HW specifies that the calculation is done by hardware, in 8-bits color depth per
channel.
HW-HDR specifies that the calculation is done by hardware, in 16-bits color depth per
channel. (HDR stands for “High Dynamic Range”). This mode is recommended for
images that have more than 8 bits per channel, such as those obtained from a film
scanner.
Note: the default option (HWare) is recommended as modern graphics boards are
optimized for calculating depth at 16 bits per pixel color.
The folders of the four channels contain identical parameters, with differing default
values in order initially to maintain the input image without changes. Below there is a
description of the Red folder, since the only difference with the other folders (Green,
Blue and Alpha) is in its default value.
Red:

Along with Mode, this effect has four dropdown folders, one for each channel(red, green,
blue and alpha).
Its parameters are defined here using the red channel as an example (Red folder).
X
R1 (R1, G1, B1, A1, Luma1, R2, G2, B2, A2, Luma2)
Reassigns the channel that is interpreted as the current channel (in this example, red
channel). The default value specifies that the red channel is that of the first input).
R1 assigns the red channel of the first input as the current channel.
G1 assigns the green channel of the first input as the current channel.
B1 assigns the blue channel of the first input as the current channel.
A1 assigns the alpha channel of the first input as the current channel.
Luma1 assigns the luminance of the first input as the current channel.
R2 assigns the red channel of the second input as the current channel.
G2 assigns the green channel of the second input as the current channel.
B2 assigns the blue channel of the second input as the current channel.
A2 assigns the alpha channel of the second input as the current channel.
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Luma2 assigns the luminance of the second input as the current channel.
Operation
X Only (X Only, Only Y, Plus, Minus, And, Or, Xor, Min, Max, Diff)
Specifies the mathematical operation that combines the first assigned value (X) with
the second (Y).
Note: the second assigned value (Y) can also be multiple, so Y specifies the
combination of the inputs from the second on, so it is possible for example to add the
values of the multiple inputs to the first input.
X Only specifies that the current channel comes from the channel assigned by the X
entry, without changes.
Only Y specifies that the current channel comes from the channel of the entry Y,
without changes. In the case of multiple inputs, only the second input is taken in to
account.
Plus adds the values of the pixels of X and Y.
Minus subtracts the values of the pixels of Y from X.
And multiplies values of the pixels of X and Y.
Or specifies an Or operation with the values of the pixels of X and Y. This operation
inverts the values of the inputs before multiplying them, and then the result is
inverted again, thus functioning in an opposite fashion to And.
Xor specifies an Xor operation with the values of the pixels of X and Y. The Xor
combination is an operation that is achieved by combining with Or the result of the
two previous multiplication operations: multiplying the first by the second selection
and multiplying the second by the first selection.
Min specifies that the lowest value of pixels between X and Y remains in the results.
Max specifies that the highest value of pixels between X and Y remains in the results.
Diff specifies as a result the difference between the pixel values of X and Y.
Invert X
No (Yes/No)
Inverts the assigned values in the current channel.
Invert out
No (Yes/No)
Inverts the values of the result of the combination of the current channel.
Invert Y
No (Yes/No)
Inverts the assigned Y values in the current channel.
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Scale
[100 (–1.000.000 / 1.000.000)]
This parameter multiplies by percentage units the result of the combination of the
edited channel, scaling the final result of the specified mathematical operation.
Bias R;G;B;A
[0 (–1.000.000 / 1.000.000)]
This parameter adds a constant value (positive or negative) to the result of the
combination of the edited and scaled channel, behaving like an offset control of the
final result.
Thus the new value of the channel is the result of the mathematical operation, then
multiplied in percentage units by the Scale factor, then added to the Bias value.
I/O

Inputs
Multi-input: from one to unlimited inputs, with or without alpha channel.
Inputs
Image: Combination of the RGB channels.
Alpha: Mask altered by the combination.
Use and C omments

This effect has a very generic use, since it allows the combination of each channel
separately using mathematical operations, which makes it a very versatile effect both for
combining different images and for combining channels of different images.
For example, to restrict an effect to a single channel, the red, for example, Channels can be
used. The original image should be used as the first input, and then the same image with
filter as the second input, specifying in the effect parameters that the red channel should
come from the second input (R2).
Another common use is the one of the mathematical Diff operation to make a cut by
difference in static takes in which the camera does not move. Thus, we can insert an input
with a clean background and another one with a character moving on the same background,
and use the Diff operation to subtract the two images, obtaining the cut of the character.
Thus we obtain an image in which all the pixels are black except those corresponding to the
character. These pixels show a random color, which is why we have to process them later
(for example, by means of the Color Grade effect) to obtain a valid mask (well contrasted in
black and white) and to apply a slight blur effect smooth the edges.
The clip name system recognizes the following standard combinations: Add, Subtract,
Multiply, Or, ShowAlpha, InvertAlpha, ClearAlpha, ExternalKey.
Add

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Boolean->Add
Add combines the pixel values in an addition result.
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Although Or gives a similar visual result, Add is the most appropriate for composing light
sources, such as car headlights, or the sun in the sky for example. Since a source always
adds light to a scene, this effect behaves in an analogous way.

This effect is also often used for combining images representing masks.

Or

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Boolean->Or
Or inverts the input values before multiplying them, and the result is inserted again, thus
working in the opposite way to And.

Because of its behaviour, Or is the recommended operation for composing light reflected on
transparent objects, such as the reflection of a driver on a car windscreen, for example. It
is also highly recommended for use as a color corrector of the second input, which will work
as a composition control.

And

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Boolean->And
And (Multiply) combines the pixel values by multiplication. Bear in mind that the values of a
pixel are measured in percentage units, and so the units must be normalized to understand
that this is what is multiplied.
As an example, suppose that a pixel of the first input has a value of 80 (%). In normalized
values, this is equivalent to 0.8. The pixel of the second input that corresponds by its
position has a value of 50 (equivalent to 0.5 normalized). Then the value of the first is
multiplied by the second: 0.8 x 0.5 = 0.4.
The first input is then obscured by the second. If the normalized value of the second were
the maximum (1), the operation would be 0.8 x 1= 0.8. Therefore, this operation always
obscures the first input based on the values of the second. Because of its behavior, Multiply
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is appropriate for composing shadows.
In the example, it can be seen how the second input only adds darkness to the first input,
in this case emulating a tattoo. The second image of the example was made by deforming
an image with the Refract effect.

The use of a color corrector, which will work as a composition control, in the second input is
also recommended.
This effect is also often used to combine images representing masks, in this case obtaining
as a result the opacity intersection area of both masks.

Sub

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Boolean->Sub
Sub (Subtract) combines pixel values by subtraction. Its use is not specially recommended,
since there is no natural effect that is analogous to it.
Subtracting two identical images gives a black frame. For this reason, this effect is often
used to evaluate the differences between two images, and also to obtain masks by
difference.
This effect is also often used to combine images representing masks.
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Decode

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Decode

The Decode menu includes decodification effects in order to natively process different
image formats.
Arri Params

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Decode->Arri Params
This color correction effect is oriented for processing shapes from native images shot in Arri
Raw (.ari) format. This format is used for Arri cameras such as Alexa.
Since Arri Raw is a RAW format (ie, it contains the entirety of the image data captured by
the camera sensor), the ArriParams effect can modify the values of any of the parameters
established in the Arri camera during the shoot.
I/O

Inputs
Single input: image
Output
Image: color corrected image
Alpha: opaque mask
Parameters

ASA
[Source(Source/160/.../3200)]
Modifies the ASA value to be used.
Kelvin
[Source(Source/2.000/.../11.000)]
Modifies the Color temperature be used.
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Tint
[0 (-8/8)]
Works as a complementary white balance corrector, compensating the magenta and
green components derived from certain light sources such as fluorescents and sodium
lights.
Sharpness
[100 (0/300)]
Defines the sharpness level to be used in each pixel.
Color Space
[Wide
Gamut+LogC(Camera
Native+LogC/Wide
+Gamma 2.4/P3+Gamma 2.6/Film)]

Gamut+LOGC/ITU

709

Selects the desired color space as defined by ARRI.
Filter Chroma
[None, (None/3x3/5x5/7x7/9x9)]
Filters Bayer moire color artifacts on edges. The larger the value, the more thorough
the filter, but at cost of loss of color detail resolution.
The recommended value is 3x3.
It can be left Off if no undesired artifacts are observed.
R3DParams

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Decode->R3DParams
This color correction effect is oriented for processing shapes from native images shot in
REDCODE (.R3D) format. This format is used for RED cameras such as RED ONE and EPIC.
Since REDCODE is a RAW format (ie, it contains the entirety of the image data captured by
the camera sensor), the R3DParams effect can modify the values of any of the parameters
established in the RED camera during the shoot.
I/O

Inputs
Single input: image
Output
Image: image corrected de color.
Alpha: mask opaca.
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Parameters
Kelvin:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Value
[6500 (1700/100.000)]
Modifies color temperature. The default value corresponds to the temperature of
Daylight (6500K). The lower the value, the less "warm" the resulting image will be,
compensating, for example, for Tungsten light (3200K).
Generally its function is to compensate for the excess of "warmth" to achieve the
most neutral result possible.
Tint:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Value
[0 (-100/100)]
Functions as a complementary corrector of white balance. It compensates for the
magenta and green components found in certain light sources such as those derived
from fluorescent or sodium.
ExposureCompe:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Value
[0 (-7/7)]
Raises or reduces the luminosity in units of exposure range (ƒ-stops).
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Gain:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Red; Green; Blue
[1 (-10/10)]
Permits the individual adjustment of the gain of the RGB channels. The modification of
Saturation:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Value
[1 (0/4)]
Defines the intensity of color of the image.
Contrast:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Value
[0 (-1/1)]
Defines the value of contrast, raising or reducing symmetrically the values of white
and black while leaving the values medium (midtones) at around 50 percent.
Brightness:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
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Value
[0 (-10/10)]
Defines the brightness of the image.
DRX:

Use
[Source (Source/Value)]
Option for maintaining the values established in the camera during a shoot (Source) or
to modify them via Value.
Value
[0 (0/1)]
By modifying the value of DRX (Dynamic Range Extension), it is possible to increase
the dynamic range of the image to avoid clipping problems in bright lighting (highlights)
owing to overexposure of camera material. To obtain results, it is necessary for at
least one of the three color RGB channels not to have been overexposed (generally,
blue), since DRX uses this information to reconstruct the rest.
Shadow:

Use
[Source (Source/Value)]
Option for maintaining the values set in the camera during the shoot (Source) or
modify them via Value.
Value
[0 (-2/2)]
Defines the low values of the FLUT, that is to say, those close to black (shadows or
low light).
FLUT:

Use
[Source (Source/Value)]
Option for maintaining the values set in the camera during the shoot (Source) or
modify them via Value.
Value
[0 (-8/8)]
Defines the settings of the mid-tones.
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R3DParams:

ISO
[Source (Source / 50 / 80 / 100 / 125 / 160 / 200 / 250 / 320 / 400 / 500 /
640 / 800 / 1.000 / 1280 / 1600 / 2000 / 2500 / 3200 / 4000 / 5000 / 6400 /
12800)]
Like the parameter ExposureCompe, this modifies the gain values of the image in a
linear way, increasing or decreasing the value of white and maintaining the value of
black at 0%.
GammaCurve
[Source (Source / Linear / Rec.709 / REDspace / REDlog / PDlog 685 / PDlog
985 / CustomPDlog / REDgamma / SRGB / REDlogFilm / REDgamma2 /
REDgamma3)]
Defines the color space of the values of the gamma curve.
ColorSpace
[Source (Source / CameraRGB /Rec.709 / REDspace / REDcolor /
ImageColorSRGB / ImageColorAdobe1998 / ImageColorREDcolor2 / Unused /
ImageColorREDcolor3)]
Defines the color space of the image.
Detail
[Source (Source/Low/Medium/High)]
Defines the level of detail of the image.
OLPFCompensation
[Source (Source/Off/Low/Medium/High)]
Permits increase of the value clarity to compensate blur generated in a shoot by an
optical low pass filter.
Denoise
[Source (Source/Low/Minimum/Milder/Mild/Medium/Strong/Maximum)]
Defines the intensity of the denoise of RED.
reduce
[mConfig (mConfig/1:1/1:2/1:4/1:8)]
Defines the resolution relation with respect to original image. To respect the values
established in mConfig->Codecs, select the option mConfig.
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Bit Depth
[10 bit (mConfig / 8 bit / 10 bit / 12 bit / 16 bit / 16-HDR)]
Defines the bit depth of the image output. To use/restore the preset values in Mamba
Setup, select mConfig.
Track
Sets the Track to be used in the case of a file derived from a HDRx recording (allowing
us to capture 2 Tracks with different expositions, stored in the same .r3d file).
Use and C omments

Mamba's main color correction is the effect Color Grade (Mamba->TimeSpace Editor>Dashboard->Fx->Mamba->Color->Color Grade). Unless specifically indicated to use
the setting employed during the shoot, the recommended workflow is the effect R3DParams
in order to prepare material to be subsequently corrected with Color Grade.
Color Grade works with a bit depth values specified in the effect R3DParams. This allows
maximum manipulation of color if values of 16 bit or 16-HDR are defined in the Bit Depth
parameter
(TimeSpace
Editor->Dashboard->Fx->Mamba->Color->R3DParams>R3DParams).
However, in order to obtain the best results and optimize process times, certain
considerations must be taken into account to correctly define the bit depth:
The 8 bit option is only useful for comparing with other values, as it results in loss of
quality.
Generally, 10 bit is that which gives the best results.
The 12 bit option is only supported in those systems that have a RED ROCKET card.
The 16 bit-HDR option ignores most of the parameters of the REDRAW codec, allowing the
user to interpret the range, gamma, color space etc employed. This is the only mode that
produces an image with pixels with values above 100%.
The 12 bit and 16 bit modes are only useful when working within a linear color space
(instead of a "REDLOG" logarithmic color space, which is the most typical). It is
recommended to use these two options very carefully, as they will rarely produce an
improvement in the image quality, while they negatively affect the performance of the
system. Their use must be for specific reasons, and never "just in case".
The R3DParams effect can modify the decompression parameters of the original .R3D file,
even after a color correction has been done, as they remain editable at all times.
Before starting a color correction with Color Grade, it is recommendable to set the
parameters of R3DParams with the aim of obtaining the best dynamic range possible and a
neutral color temperature. Generally, this can be achieved by modifying the values of
ExposureCompe, Gain and ISO (with the help of a vectorscope in W-Luma mode), to widen
the dynamic range and set the Kelvin parameters to compensate the color temperature
(with the help of the vectorscope in Vscope mode). If the material from the shoot presents
overexposure problems, these can be adjusted with the DRX option to obtain results that
are within legal values for the image (Mamba->TimeSpace Editor->Dashboard->Fx>Mamba->Color->R3DParams->DRX->Value).
Another point to bear in mind is the sharpness of the corrected image. As R3DParams has a
native compensation for the optical low pass filter (OLPF) housed in al camera sensor, it is
best first to correct the sharpness of a R3D image with this parameter before using the
effect Sharpen. If the correction with 3RDParams is not sufficient, Sharpen should then be
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used.
On workstations with reduced processing capacity, it may be useful to work in lower
resolution (at least temporarily) to ease the post-production process. Via the parameter
reduce
(Mamba->TimeSpace
Editor->Dashboard->Fx->Mamba->Color>R3DParams->R3DParams->Reduce) it is possible to reduce the maximum theoretical
resolution (1:1) to a half (1:2), to a quarter (1:4) or to an eighth (1:8). At any time
subsequently this can be returned to the original state, usually to obtain the final render.
From Mamba Setup it is possible to redefine all the R3D parameters by overwriting the
values set of the shoot. For example, if a High OLPF compensation is required on all the .R3D
files, this can be done via Mamba Setup (Mamba Setup->RED) instead of modifying the
clips one by one. In this case, the values overwritten by Mamba Setup will be the new
Source values of R3DParams.
It is important to bear in mind that the majority of digital cameras (including RedOne and
Epic) use Bayer matrix sensors, in other words each element of the sensor (or resulting pixel
before processing the image) is only sensitive to one color component (R, G, or B, typically
distributed in a pattern with more elements sensitive to green than the other 2 colors).
Thus the effective resolution of the camera image is always less than a format with the
same resolution (but real RGB) in Mamba. There are also other factors that reduce the detail
that it will possible to obtain, such as the signal/noise ratio of the sensor, the compression
algorithms (JPEG2000) used by these cameras, exposure time, the lenses used, or a lower
resolution in the format delivered than was requested.
For this reason it is usually recommendable to work with a Reduce factor of 1:2, and not
increase it to 1:1 unless there is a specific reason to do so (and never "just in case"). Also,
if greater sharpness results from using 1:1 mode, the image should be magnified to check
that noise has not correspondingly increased, since in this case, quality is lost when the
image has movement, and especially in Stereo3D formats, where noise is especially
uncomfortable (since each noise element is visible in one eye and is not consistent).
The reverse may also happen, and that when changing to 1:1, the image is softened,
depending on the other parameters of the effect: a softer image can result if the the
blurring filters that use this codec are augmented. If it is desired that noise is eliminated it
is usually more effective to use Mamba's effects Blur and Denoise, as they give greater
control, quality and are much quicker to process.
Finally, it must be stressed that 1:1 mode mode should only be used to see greater detail,
and not to resolve problems of noise or sharpness.
Also bear in mind that que there is a macro in the editing panel to force this effect to reload
the metadata parameters of the R3D files and their associated RMD files, if they exist.
C anonRawParams

This decodifying effect is intended for native processing of images in RAW developed by
Canon (captured in .rmf). This format is used by cameras such as Canon C500.
As this is a RAW format (containing all the data of the image captured by the camera
sensor), the effect CanonRawParams may modify values of some parameters in order to
process and develop the final image.
I/O

Inputs
Single Input: image to be processed.
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Outputs
Image: color corrected image
Alpha: opaque mask.
Parameters

Sharpness
[100 (0/300)]
Sets the level of Sharpness to be applied to each píxel.
Color Space
[ACES A-D65 / ACES A-Tungsten / ACES C-D65 / ACES C-Tungsten / ACES DD65 / ACES D-Tungsten]
Sets the color space of the image.
Filter Chroma
[5x5 (3x3 / 5x5/ 7x7 / 9x9]
Filters color artifacts: the higher this value, the greater the degree of filtering applied
to the image, which causes loss of detail in the color.
PhantomParams

Ref.
Mamba:
>PhantomParams

TimeSpace

Editor->Dashboard->Fx->Mamba->Decode-

This decoding effect is oriented to the native processing of images recorded in .cine RAW.
This format is used by hight speed Phantom cameras.
Via the effect PhantomParams it is possible to modify the values of various of the data
parameters that come with the file, such as black point, and choose the quality or form of
debayer of the image.
I/O

Inputs
Single Input: image to be processed.
Outputs
Image: color corrected image
Alpha: opaque mask.
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Parameters

WhitePoint:

Use
[Source (Source /Value)]
Indicates whether the white point is from source or has been defined, as below.
Red Gain
[1 (0 /100)]
Defines the value of the white point in the red channel.
Blue Gain
[1 (0 /100)]
Defines the value of the white point in the blue channel.
Debayer:

Filter Chroma
[5x5 (3x3 / 5x5/ 7x7 / 9x9]
Filters color artifacts created by the Bayer pattern. The higher the value, the more
the image is filtered, with the resulting loss of detail in the color.
Correct:

Gamma
[1.7 (1 / 10)]
Defines the gamma value of the image. Lower values set a darker color, so the color
correction lifts the brightness of the image.
Gain
[100 (0 / 3200)]
Adjusts the gain of the image. The modification of these parameters increases or
decreases the white value, scales the midtones y and fixes the black value at 0%.
Saturation
[100 (0 / 1000)]
Defines the intensity of the color of the image.
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Debayer

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Decode->Debayer
This effect converts a RAW image derived from the codecs of certain cameras based on
Bayer-type sensors in an image with RGB color space.
When converting by means of hardware, using the GPU, Debayer decodes codecs such as
Phantom Cine (from Phantom cameras) and Weisscam in real time .
Other cameras with Bayer sensors (such as RED and ARRI) may have their own specialized
effect of transparent supports available from codec libraries such as ffmpeg. Thus, this
effect should only be used with cameras specifically supported by the effect, although this
is an area that is constantly evolving. Supports are constantly added for new cameras and
new specialized effects are created for others so this documentation may be obsolete. We
recommend consulting SGO in case of doubt.

I/O

Inputs
Single input: RAW image derived from cameras supported by the effect.
Inputs
Image: Image in RGB color space.
Alpha: Opaque mask.
Parameters
Debayer:

Pattern
[Auto (Auto / GRGR / RGRG / GBGB / BGBG)]
Specifies the disposition of the R, G and B filters in the fabric of the Bayer mosaic to
be converted.
Filter Luma
[Type 3 (None / Type 1 / Type 2 / Type 3]
Filters the jigsaw artifacts of luminance created by the Bayer pattern. The higher the
value, the more the image is filtered. If the image is reduced in resolution, it is
recommendable to set this parameter at None, and set a high value for Tap in the
Framing tab.
Filter Chroma
[5x5 (3x3 / 5x5/ 7x7 / 9x9]
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Filters the color artifacts created by the Bayer pattern. The higher the value, the
more th image is filtered with a resulting loss of detail in color.
Flop
[No (No / Yes]
Allows the application of a predefined rotation of 180 degrees in Y.
BlackPoint:

Red
[0 (0 /100)]
Sets the value of black in the red channel.
Green
[0 (0 /100)]
Sets the value of black in the green channel.
Blue
[0 (0 /100)]
Sets the value of black in the blue channel.
Note: These can also be set via the manipulator Set Color in the Visual Editor (Visual
Editor->Dashboard->Set Color).
WhitePoint:

Red
[0 (0 /100)]
Sets the value of the white point in the red channel.
Green
[0 (0 /100)]
Sets the value of the white point in the green channel.
Blue
[0 (0 /100)]
Sets the value of the white point in the blue channel.
Note: These values can also be set via the manipulator Set Color in the Visual Editor
(Visual Editor->Dashboard->Set Color). It is normally recommended to use it to do a
white balance (clicking Pick Color in a "neutral" area of the image) and then adjust the
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luminance manipulator to establish the white point.
Correct:

Gain
[100 (0 / 3200)]
Sets the gain of the image. The modification of these parameters increases or
decreases the white value, scales midtones and fixes the value of black at 0 percent.
Gamma
[1 (1 / 10)]
Sets the gamma value of the image. Lower value define a darker color, so the color
correction lifts the brightness of the image, and vice versa.
Saturation
[100 (0 / 1000)]
Sets the intensity of the color of the image.
Use and C omments

To convert .cine archives, derived from Phantom cameras, it is recommendable to use the
following settings:
In the group WhitePoint, set Red at 75, Green at 100 and Blue at 75.
In the group Correct, set Gamma at 1.7 and Saturation at 150.

HDRMerge

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Decode->HDRMerge
This decodification effect is designed to combine 2 exposition levels of a single image (via
Track in R3DParams), resulting in an image with shadows and bright lights exposed
precisely.

I/O

Inputs
Double input: A pair of images that will be used to create a new image that will
maintain the desired final exposure, combining the shadows of one of the inputs and
the bright lights of the other. The first input should always correspond to Track 1 of
the R3DParams and it will normally this which has a correct exposure in the shadows
(even if the bright lights are burnt); the second input should correspond to Track 2,
underexposed in order to preserve detail in the bright lights.
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Output
Image: Final image with greater depth of color in bits than either of the two original
exposures; this allows for a subsequent etalonage in which shadows can be lifted
without introducing much noise, and preserving detail in the high lights. If the
parameter Show->Mask is selected, the effect will show the mask of the
combination.

Parameters

ExpositionRatio
[3 (0/100)]
This value represents the ratio of the codified values of the normal and the
underexposed versions of the same image. If the values are linear, this value
corresponds to the ratio of the exposition time; however, for logarithmic scales, which
are more usual, this value is more similar to the difference between f-stops.
Clip
[90 (0/100)]
The values of the first input (Track 1, normal exposure) which are above this
percentage are considered "burnt" and will be replaced by pixels corresponding to
second input.
Transition
[20 (0/100)]
For values below the threshold defined in Clip, a transition zone can be defined to
avoid the banding that may be caused by an abrupt transition. It is recommendable to
set this value temporarily at 0 (zero) to make the transition visible and then reset the
value of ExpositionRatio until the separation of the dark and light zones is less visible.
Once the desired for ExpositionRatio is found, Transition should be set as desired.
Show
[Merge (Mask/Merge)]
The user can choose between showing the combined result of the effect (Merge) or
the mask of the combination (Mask). The mask is not in this case a simple grayscale
image, since the combination is done independently for each channel (R,G,B).
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Color

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color

The Color menu includes color correction effects. Furthermore, it contains the effects of
format conversion and parameters settings for depth of color.
C olor Grade

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Color Grade
Mamba's color corrector contains all the features of high-end color correction systems ,
such as high dynamic range (HDR) processing, support for control surfaces (Tangent
Devices), integrated functions of Pan&Scan (Rescale) and LUTs 3D applications. It can do
all this in realtime hardware processing in 4K, 2K and HD SDI dual link formats, with output
to YUV, RGB 10bit, and even HDR color spaces.
This effect corrects color in a structure of nodes or layers (called Vectors), basing each
new step on three simultaneous chain-linked instants.
Thus, different color corrections can exist within the same Color Grade effect, each working
independently (ie, adding to a previous correction, if one exists) or in relation to others
(taking as reference, and even recovering, previous corrections).
Within each node or layer, which have the functions as a new step in the final correction of
the image, we find the following corrections ordered in the within the effect:
The first correction (Primary) redefines white points, gamma value and and black towards
any new RGB value, and controls for color printer lights that modify these parameters.
The second correction (Bands) processes the result of the first, subdividing the total range
of luminance into five definable bands, for each band to be corrected individually later; it
also has controls for tone, saturation and contrast (HSL), and masters for the three
luminance ranges.
The third correction (Fixed Vectors) corrects the tone, luminance and saturation of the six
principle areas of the color spectrum (red, green, blue, cyan, magenta, yellow) separately
via six independent vectors.
Also, at the start of each Vector there is a tab that allows the defining of a color Range by
means of HSL controls and masks, for the corrections to work only on the given selection,
and also to be able to recover previous colors and modify them with the current correction.
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I/O

Inputs
Input simple: image with or without alpha channel. The alpha channel can be used to
mask the color correction carried out.
Double input: image with or without alpha channel. The second input is usually used
to generated a mask to be applied to the first input.
Outputs
Image: color corrected, and optionally, rescaled, image.
Alpha: without changes, and optionally with the mask generated by one of the free
vectors.
Parameters
Select:

The first six folders of Color Grade correspond to the first tab Select of its manipulation
panel.
These parameters define the source of the color selector or keyer, as well as the
mode and origin of the recovery tool for recovering any color.
Key Source
[Base (Source / In2-In5 / Previous / Base / V2-V48)]
Selects the source for the color selection to be used for defining the mask that the
various parameters and corrections of a given vector will affect. Base makes reference
to the first layer of the effect, Source makes reference to the original input, In2
makes reference to the second input of the effect, Previous makes reference to the
previous vector or layer (ie, the complete correction up to that point), or any previous
vector, or one of the other four inputs available to the color corrector.
Key Channels
[All (All / Red / Green / Blue/ Alpha)]
Defines the channels that will be used to make the color selection.
Recover Mode
[None (None / Inside /Outside)]
Activates and defines the mode for recuperating color in a given vector. The default
setting is None, in which setting no recuperation is carried out. Inside or Outside
defines that the selection made is replaced by the set of colors corresponding to the
mask created by the selection, whether by the mask itself (Inside) or the inverted
mask (Outside).
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Recover Source
[Base (Source / In2 / Previous / Base / V2-V48)]
Defines the source of the set of colors to be recovered when Recover Mode is active.
Base makes reference to the first layer of the effect, Source makes reference to the
original input, In2 makes reference to the second input of the effect, Previous makes
reference to the previous vector or layer (ie, the complete correction up to that
point), or any previous vector.
This folder defines the values that restrict the color selection to be used as a mask of
the vector or to recover colors, either from previous vectors or from the source image
or a second input.
Select HS mode
[All Hues ( All Hues / Proportional HS / Simple HS )]
Selection mode that will be used to define the color mask.
The default setting is All Hues, which automatically selects the whole image, and
allows quick navigation to other tabs (Primaries, Bands and FixedVectors) so any value
in the whole image can be modified with no specific selection made.
Proportional HS defines the selection based on proportional values of saturation in
each pixel.
Simple HS define the selection simply, without taking into account the individual value
of each pixel.
Select H source
[0 (-100.000 / 100.000)]
Defines the value of hue that to be corrected. The units of hue are expressed in
degrees, referring to the angle of a chromatic circle.
Select H tolerance
[5 (0/ 180)]
Defines an interval of values of hue close to Select H source that will be totally
included in the correction.
Select H soft[0 (0/ 90)]
Defines a range of values of hue close to those included by Select H source in an
anticlockwise direction, which will be decreasingly included in the correction.
Select H soft+
[0 (0/ 90)]
Defines a range of values of hue close to those included by Select H source in a
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clockwise direction, which will be decreasingly included in the correction.
Select S toler[0 (0/ 100)]
Defines the threshold of the interval of saturation where the correction will be applied.
Select S soft[0 (0/ 100)]
Defines a range decreasing from the threshold of the interval of saturation where the
correction will be applied.
Select S toler+
[0 (0/ 100)]
Defines the end final of the interval of saturation where the correction will be applied.
Select S soft+
[0 (0/ 100)]
Defines a range decreasing from the end of the interval of saturation where the
correction will be applied.
Select L toler[0 (0/ 100)]
Defines the threshold of the interval of luminance where the correction will be applied.
Select L soft[0 (0/ 100)]
Defines a range decreasing from the threshold of the interval of luminance where the
correction will be applied.
Select L toler+
[0 (0/ 100)]
Defines the end of the interval de luminance where the correction will be applied.
Select L soft+
[0 (0/ 100)]
Defines a range decreasing from the end of the interval de luminance where the
correction will be applied.
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Folder that contains the values of the windows used to restrict the correction or selection
to a specific part of the image.
Window CenterX; Y
[0; 0 (-100.000 / 100.000)]
Defines the offset from the center of the window that restricts the correction.
Window Angle
[0 (-100.000 / 100.000)]
Defines the angle of the window that restricts the correction.
Window Width
[100 (0 / 100.000)]
Defines the width of the window that restricts the correction.
Window Height
[100 (0 / 100.000)]
Defines the height of the window that restricts the correction.
Window Soft
[0 (0 / 100.000)]
Defines a range of transparencies for the edges of the window that restricts the
correction.
Window Type
[None (9 modes)]
Defines the type of window that restricts the correction.
None: Defines that there is no window of restriction.
Line: Defines a window that divides the screen with a straight line like a wipe. The
correction is restricted to one half of the screen.
InvLine: Works like the mode Line, but with the area of restriction inverted.
Ellipse: Defines an ellipse-shaped window inside which the correction is restricted.
InvEllipse: Works like the mode Ellipse, but with the area of restriction inverted.
Shape: Activates the window as a vectorial shape previously defined in the tab Shape.
InvShape: Works like the mode Shape, but with the area of restriction inverted.
Rectangle: Defines a rectangular window inside which the correction is restricted.

SGO Mamba 2.0.1 © 2014 SGO

234

FX

InvRectangle: Works like the mode Rectangle, but with the area of restriction
inverted.
Offset X Left; Right
[0; 0 (-100.000 / 100.000)]
Offset values added between the position of the window in the left and right images
when working in stereo.
Folder that contains the values and parameters for combining and further restricting the
selection defined in the current vector or layer.
Ext Key Source
[Base (Source / In2 / Previous / Base / V2-V48)]
Defines the source of the channel with which the combination of the current mask or
vector is to be made. Base makes reference to the first layer of the effect, Source
makes reference to the original input, In2 makes reference to the second input of the
effect, Previous makes reference to the previous vector or layer (ie, the complete
correction up to that point), or any previous vector.
Ext Key Channel
[Alpha (Red / Green / Blue / Alpha)]
Defines the selected source channel, with which to operate for combining with the
selection of the current vector.
Ext Key Mode
[None (None / And / Inv And / Or / Inv Or )]
Operation mode for the selected source channel with the current selection or mask of
the vector. If None is selected, none of the previous parameters are activated.
Other operations are defined in Ref. Mamba: TimeSpace Editor->Dashboard->Fx>Mamba->Boolean->Channels.
Folder that contains the parameters for dealing with and modifying the behavior of the
defined mask and its inversion in mode Outside.
Key Filter
[0 (0/ 100.000)]
Defines a spatial blur of the area defined by the previous parameters, softening the
mask generated by the qualifiers, and thus avoiding the appearance of noise when
applying the correction.
Key Tolerance
[0 (0/ 100.000)]
Defines the opacity of the mask: 0 (zero) defines a totally opaque mask; and 100 is
transparent.
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Key Softness
[100 (0/ 100.000)]
Controls the range of soft transparencies from total transparency defined parameter
tolerance to total opacity. Low values define less range of intermediate transparency.
Key Export
[Off (Off / Inside /Outside)]
Allows the export of the defined mask, or its inversion, as alpha channel.
Key Inv Mode
[Inv Mask (No Inv/ Inv HSL / Inv Mask)]
Mode in which the mask inversion will operate, when mode Outside or Grade Outside
is in use.
The default mode is Inv Mask, which takes as the inversion of the mask (o Outside)
the inverted values of HSL and everything outside any window that defines the area
to be treated.
Inv HSL defines the inversion of the mask or selection (or Outside) with the inverted
values of HSL outside any window that defines the area to be treated.
No Inv defines the inversion of the mask (or Outside) as the same values of HSL
defined for the selection outside any window that defines the area to be treated.
Prop Grade Gain
Internal value that defines the saturation gain to show the mask in Highlight mode.
Key Correct (A, B) Mode
[(

Grow/ Shrink / Fill Holes / Sparkles / Median)]

Defines the extra correction filters for finetuning the selected mask.
Key Correct (A, B) Rad
[0 (0/ 100.000)]
Defines the value of the selected correction filter.
Key-Key
Internal curve that represents the curve of contrast of the selection mask.
Output modes and options for the selection.
Output Mute
[Off (Off / On)]
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Activates and deactivates the disabling of the vector.
Output Channels
[RGB ( - / B / G / GB / R / RB / RGB / UV / Y / YUV)]
Output channels of the selected vector.
Output Legalize
[Off (Off / On / Whites / Blacks)]
Option for legalizing luma. The default value is Off; for legalizing the total luma range
(whites and blacks) select the option On; for one of the extremes select Whites or
Blacks.
Output Blend
[100 (0/ 100.000)]
Defines the opacity of the correction in a given vector.
Blur Gamma
[0 (0/ 100.000)]
Gamma value applicable to the blur via the tab Select to produce a Glow effect.
Blur Knee
[1 (0.000/ 1)]
This function is to avoid over-increase of values close to black in the gamma curve.
Blur Mode
[Normal ( Normal / Under / Over)]
Allows the choice of the kind of application of blur. Normal blurs the whole image and
then recomposes it over the mask created (the key), pushing external colors inwards.
Under applies the blur before the correction is done and crops it over the mask. Over
does so after the correction, and so affects areas outside the mask.
Grade Inside:

The Grade Inside folder contains the values for modifying the effect Color Grade for an
image defined by the selector or for the whole image if All Hues is selected.
Folder that contains parameters for the primary correction, which can be used for making
initial adjustments of black and white points, and also for a primary correction similar to that
of a telecine.
WhitePt R; G; B
[100; 100; 100 (0 / 200 )]
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Defines the RGB value that will be corrected to white. Lower values define darker
colors as white, so the color correction lifts brightness in the image if this value is
decreased, and viceversa.
Gamma R; G; B
[50; 50; 50 (-50 / 150 )]
This parameter is a gamma value expressed in non-conventional units.
BlackPt R; G; B
[0; 0; 0 (-100 / 100 )]
Defines the RGB value that will be corrected to black. Higher values define lighter
colors as black, so the color correction darkens the image if this value is increased,
and viceversa.
Folder that contains parameters for advanced correction, which divides the total luminance
range into 5 definable bands, so that each band can be corrected individually, and provides
three additional HSC controls.
HSC/Hue
[0 (-100.000 / 100.000)]
Redefines the initial value of hue. The units of hue are expressed in degrees, referring
to the angle of a chromatic circle.
HSC/Sat
[100 (-100.000 / 100.000)]
Redefines initial saturation.
HSC/Cont
[100 (-100.000 / 100.000)]
Redefines initial contrast.
White/ R; G; B
[0 (-100.000 / 100.000)]
Corrects color affecting only colors defined as white tonal range.
Highlights/ R; G; B
[0 (-100.000 / 100.000)]
Corrects color affecting only colors defined as tonal range of highlights.
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Highlights/HSC
[0 (-100.000 / 100.000)]
Corrects hue, saturation and contrast affecting only colors defined as tonal range of
highlights.
Midtones/ R; G; B
[0 (-100.000 / 100.000)]
Corrects color affecting only colors defined as mid-tonal range.
Midtones/ HSC
[0 (-100.000 / 100.000)]
Corrects hue, saturation and contrast affecting only colors defined as mid-tonal
range.
Shadows/ R; G; B
[0 (-100.000 / 100.000)]
Corrects color affecting only colors defined as tonal range of shadows.
Black/ R; G; B
[0 (-100.000 / 100.000)]
Corrects color affecting only colors defined as black tonal range.
Black/HSC
[0 (-100.000 / 100.000)]
Corrects hue, saturation and contrast affecting only colors defined as black tonal
range.
Ranges/Lo/Lo_Limit
[0 (0 / 100 )]
Defines a percentage value of brightness which is considered the end of the black
tonal range.
Ranges/Lo/Lo_Slope
[250 (0 / 100.000)]
Defines a slope value for the tangent of the curve of separation for the bands in their
lower zone, which, together with the parameters of the folder Hi defines the three
central bands.
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Ranges/Hi/Hi_Limit
[100 (0 / 100 )]
Defines a percentage value of brightness which is considered the end of the white
tonal range.
Ranges/Hi/Hi_Slope
[250 (0 / 100.000 )]
Defines a slope value for the tangent of the curve of separation for the bands in their
higher zone, which, together with the parameters of the folder Lo defines the three
central bands.
Folder that contains parameters for a secondary correction (correction by predefined color
vectors), of the primary and secondary colors: red, green, blue, cyan, magenta and yellow.
Red R; G; B
[100; 0; 0 (-100.000 / 100.000)]
Defines RGB gain for colors reds.
Green R; G; B
[0; 100; 0 (-100.000 / 100.000)]
Defines RGB gain for greens.
Blue R; G; B
[0; 0; 100 (-100.000 / 100.000)]
Defines RGB gain for blues.
Cyan R; G; B
[100; 0; 0 (-100.000 / 100.000)]
Defines RGB gain for colors close to cyan.
Magenta R; G; B
[100; 0; 100 (-100.000 / 100.000)]
Defines RGB gain for colors close to magenta.
Yellow R; G; B
[100; 100; 0 (-100.000 / 100.000)]
Defines RGB gain for yellows.
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The parameters related to the Curves panel are internal Mistika parameters, although they
can be used to reset the different curves from here.
R-R
Reed channel curve.
G-G
Green channel curve
B-B
Blue channel curve
L-L
Luma curve
S-S
Saturation curve
L-S
Saturation curve proportional to luma
H-H
Tones curve
H-S
Saturation curve relative to tones
H-L
Luma curve relative to tones
These are the parameters which serve focus or blur the image depending on the mode
selected in Output.
Blur Rad
[0 (0/ 100.000)]
Radius of the application of the effect.
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Blur Blend In
[0 (0/ -100.000)]
Amount of focus or blur of the effect. Negative values indicate focus (sharpen) and
positive values indicate blur.

This contains the different mutes for disabling the correction of that part of the corrector in
the image.
Mute Primary
[Off (Off / On)]
Activates/deactivates the of the subtab of Primary of the selected vector in the
image.
Mute Bands
[Off (Off / On)]
Activates/deactivates the of the subtab of Bands of the selected vector in the image
Mute Fixed
[Off (Off / On)]
Activates/deactivates the of the subtab of Fixed of the selected vector in the image
Mute Curves
[Off (Off / On)]
Activates/deactivates the of the subtab of Curves of the selected vector in the image
Grade Outside:

The Grade Outside folder contains the values for modifying the effect Color Grade for an
image defined by the inversion of our selection, set in active mode in Color Grade>Select->Key->Key Inv Mode. The folders and values are the same as those found in
Grade Inside.
Manipulators:

This manipulator panel is especially designed for RGB color correction effects, and simulates
the operation of traditional telecine systems. This panel is activated when selecting an
Color Grade effect.

The panels have manipulators of the following type: Knob, Qualifier (Wheel & Slider) and
Trackball.
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Knob
A relative knob is a kind of button which is depressed and moved right to increase and
left to decrease the value it controls.
Absolute Knob also shows an absolute value over the parameter that is being
manipulated, and has a small reset button below. The background color indicates a
negative (red) or positive (green) value. The value can also be edited, dragging it
vertically.
The knobs present in the corrector can control tone, saturation, contrast, and
brightness, color suppression, mask filter, level.
Command Button
This button runs a specific command when clicked, but without the option of adjusting
the magnitude of the indicated effect.
Wheel Qualifier
This qualifier allows selection of a range of Hue by means of four manipulators like
clock hands, which define a portion of a color wheel.
With the primary button, the central value of Hue is defined, turning the pointers to
the value of hue desired (corresponding to the Select H source parameter).
Holding down <Ctrl> at the same time defines a symmetrical inclusion tolerance in the
value, which translates in the manipulator as an increasing angle centered at the
previous pointer. It is also possible to manipulate this directly with the secondary
mouse or tablet button (corresponding to the Select H tolerance parameter).
Holding down <Alt> at the same time defines an asymmetric decreasing tolerance (
soft) which appears as two new pointers beside the previous symmetrical tolerance. It
is also possible to manipulate this directly with the third mouse or tablet button
(corresponding to the Select H Soft- and Select H Soft+ parameters).
Slider Qualifier
This qualifier allows the additional isolation of the color range to be corrected,
according to its saturation or luminance value. Two sliders exist in this corrector, the
upper one defines saturation values, and the lower one luminance.
The main button defines the total range to be included, by pressing the sides of the
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slider and moving it laterally (corresponding to the type of parameter Select S toler
and Select L toler).
Pressing <Alt> at the same time defines a decreasing range of tolerance (soft)
towards the interior of the selection. This range is shown as slope within the
manipulator. It is also possible to defines this directly with the secondary mouse or
tablet button (corresponding to parameter Select S soft and Select L soft).
Note: Each slider has two sides. The right represents the higher limit, and the left the
lower limit. Each limit can defines its soft value independently.
Trackball
Trackballs are more complex manipulators which control sets of RGB parameters.
Each trackball has common characteristics.
Ball
The central ball specifies a correction vector that indicates the saturation level with
its radius, and the selected hue with its angle. The ball is manipulated by pressing and
dragging it with the left mouse button.
Ring
The peripheral rings act on the luminance of the affected range, and are used for
specifying the luminance level of the effected zone.
Each ring is manipulated by pressing and rotating it round the ball while holding down
<Alt>, or directly with the secondary mouse or tablet button. Rotating clockwise
increases luminance, while anticlockwise reduces it.
Color Reference
Color Reference enables viewing of the correction defined in the ball for mid-gray
tones.
RR
Resets the trackball ring to its default position. When a color correction is animated,
this button will add a keyframe with the default value to the parameters corresponding
to the restarted ring.
RB
Resets the trackball to its default position. When a color correction is animated, this
button will add a keyframe with the default value to the parameters corresponding to
the restarted ball.

Panels:

The Color Grade correction panel has six subpanels with different manipulators for each
layer or vector: Select, Primary, Bands, Range, Fixed and Grade Setup.
In this new corrector, the significant novelty and advantage is the functioning mode or
workflow. The corrections are not now restricted to certain primary and secondary
adjustments, which were much more limited.
With Color Grade, each Vector acts as a complete correction, with a further step that acts
as a primary correction, secondary correction, recovery of lost ranges or simply generating
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masks and creating advanced image effects.
Select
In this first panel of Select, the range of colors to be worked on is defined (or in its default
setting, the whole image). Also, by means of several manipulators and tools, more accurate
masks can be generated, selections of specific parts of the image can be made, and also
image effects and filters can be created. There also exists a range of possibilities for mixing
channels and combining them with selections defined by the user to achieve greater control
over the area to be worked on.

The first group of manipulators described here is that which qualifies the colors to be
corrected. To use the Wheel Qualifier, activate either mode Proportional or Simple
Hue-Sat in the controller Hue-Sat Mode.
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Hue-Sat Mode
Sets the correction to be restricted to the range of colors qualified according to hue
and, optionally, as proportional to the saturation value. If this button is off, the
correction will not be restricted by the qualifiers of hue and saturation, although it can
be restricted by the luminance qualifier and by Windows and Shapes, as described
below.
Hue Pick
This button selects a value of hue for the Select H Source parameter from the image.
Hue Reset
Returns the hue qualifiers to their default values.
Wheel Qualifier
Four pointers are drawn on the qualifier in the form of a color wheel; the pointers are
manipulated directly on the color wheel, in order to define the range of hue to be
transformed by the color correction indicated in the same subfolder.
Initially only two pointers are seen; they turn together when clicked and dragged with
the main mouse button. These two pointers represent the hue values included in the
tolerance of the corrector (Select H Toler), forming a cone that is centered on the
source hue value (Select H Source). Together both pointers therefore represent the
combination of two parameters that must be visualized together. When clicking on the
cone with the main button button, it can be turned towards other values. When
clicking on the cone with <Ctrl> simultaneously held down (or with the third button),
the angle of the cone increases.
Two other pointers outside the central cone represent a decreasing tolerance, which
is asymmetric, as these two pointers are manipulated separately. In order to turn
either of the two pointers, click in the margin of the desired central cone with the
main button and <Alt> at the same time (or with the secondary button), dragging the
pointer to the desired position.
Similarly, it is possible to isolate from these selected hue values a saturation and
luminosity range for these colors, with another two qualifiers:
Saturation Qualifier
This qualifier is a slider with the function of specifying the saturation range to be
transformed by the color correction indicated in the same subfolder. To its left there is
a reset button and an invert button, to invert the selected saturation range.
Luminance Qualifier
This qualifier is a slider with the function of specifying luminance range to be
transformed by the color correction indicated in the same subfolder. To its left there is
a reset button and an invert button, to invert the selected luminance range.
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Ext Key Mode
Activates the import of external keys (from other vectors or second inputs) in order to
combine them (or not) with the current selection. When some of the modes are in use
(And, Inv And, Or and Inv Or), the tabs of Ext Key Source (to select the source of
the channel) and Ext Key Channel (to select the channel to be imported) will appear.
Key Source
Indicates the source that will be used when defining the mask by HSL.
Key Channels
Defines the channels of the selected source that will be used to create the mask by
HSL.
Recover Mode
Activates the recovery mode for the interior or exterior of the mask created, in order
to make available areas of tones, ranges or parts of the image that have been lost in
previous vector corrections, or to use them as a second input. When active, the tab
Recover Source will be visible (to select the source from which the recovery will be
made).
Key Correct
Activates different mask correction modes, which may reduce (Shrink), increase
(Grow), fill spaces between mask (Fill Holes), eliminate small isolated flashes outside
the main mask (Sparkles), or apply a median blur filter (Median).
Export Key
Applies the selection of the qualifiers as mask in the output of the effect in the alpha
channel. This generated mask may be edited with the manipulators of Mask Toler and
Mask Soft, in a similar way to that of Pick Key for Greenscreen elements and so on.
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Highlight Selection
Activates a temporary viewing mode, highlighting the range of color according to the
mode we have selected in Grade Setup: saturated colors, in white and black or over
black. This button is very useful for distinguishing in the processed image the total
effect of the range included in the correction of the active vector (this function
highlights only the vector being edited).
Outside Mode
Defines the inversion mode for the mode Outside of Color Grade. According to the
selection made, the 'inverse' of the mask will vary, following different parameters.
Blending Mode
Chooses the way the current vector blends or adds to the image derived from the
previous vector. All the blend modes are defined and coincide with those found in the
effect Comp3D.
Clamp
Option for legalizing luma. By default this is Off; when On it can be used to legalize
the whole range of luma (Whites and Blacks) or only the two extremes.
Output Channels
Output channels of the selected correction.
Blend
Opacity of the selected mask.
Key Blur
This last parameter is a post-process that is applied to the generated mask by the
qualifiers, softening the selection by means of a spatial filter that blurs the restriction
generated, hiding the generation of possible noise that may be highlighted by the
applied correction. It is recommended to use this parameter in all cases, but always
after defining the best mask possible with the tolerance and softness parameters of
the qualifiers.
The second group of manipulators described are those which define the correction
applied within the range of colors defined by the qualifiers, or by Windows as
described below.
Key Tolerance
Defines the opacity of the mask; 0 is totally opaque, 100% transparent.
Key Softness
Controls the range of soft transparencies soft from total transparency defined by the
tolerance parameter towards total opacity. Low values define a low range of
intermediate transparencies.
Blur Blend
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Value that indicates the amount of focus/blur for the image. Negative values act as
focus, positive values as blur.
Key Curve
Allows the individualized creation of of a luma curve for the selection of the mask, in
order to better and more quickly redefine the area of the desired selection.

Line
Restricts the correction by dividing the screen with a line, specifying half as an
excluded area. This line can be manipulated interactively, through the visual
manipulator.

To move it, hold down the main button; to rotate it, hold down <Alt> at the same
time.
The line has a cross at the center that indicates the rotation pivot point. It is also
possible to manipulate a gradient (softness) that extends from the edge of the defined
window, by clicking the main button and holding down <Shift>. The limit of softness is
viewed as a second line.
Ellipse
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Restricts the correction to within an ellipse, which can be manipulated interactively,
through the visual manipulator.

To move it, hold down the main button; to rotate it, hold down <Alt> at the same
time. To scale the ellipse, hold down <Crtl> at the same time.
The ellipse contains a guideline with a cross at the center that indicates the rotation
pivot point. It is also possible to manipulate a gradient (softness) that extends from
the edge of the defined window, by clicking the main button and holding down
<Shift>. The limit of softness is viewed as a second line.
Rectangle
Restricts the correction to within a rectangle, which can be manipulated interactively,
through the visual manipulator.

To move it, hold down the main button; to rotate it, hold down <Alt> at the same
time. To scale the rectangle, hold down <Crtl> at the same time.
The rectangle contains a guideline with a cross at the center that indicates the
rotation pivot point. It is also possible to manipulate a gradient (softness) that
extends from the edge of the defined window, by clicking the main button and holding
down <Shift>. The softness limit is viewed as a second line.
Shape
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Restricts the vector correction to within the area defined by the shapes associated
with the free vector.
Shapes are created, modified, combined, and animated from the Shapes manipulation
mode. In this manipulation mode, the assignation of the shapes created to the six
different vectors is defined. In Shapes mode, all created shapes are seen together,
and when one shape is selected, its association is seen from the Vector attribute.
If the Shape window mode is selected from one of the color corrector manipulators,
the Visual Editor only shows the shapes assigned to the selected vector, hiding
shapes unassigned to the free vector being viewed, to help with editing.
Ellipse/Rectangle and Shapes contained by an effect can be animated and/or tracked.

Remember that both windows (Ellipse/Rectangle) and Shapes contained by an effect
can be animated and/or tracked.
Invert Window
A mode for inverting the modes of previous windows can be added to one of the four
previous restriction modes.
The following example shows an ellipse with Invert Window activated:
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Remember that the qualifiers can be combined with window to correct colors identified
by their values within specified areas.
Primary
The Primary panel is for the initial correction; it contains three trackballs, the panel
Printer Lights, and eight relative knob and buttons.

This first correction uses classical correction operations for controlling the black point,
the gamma value (standard gamma parameter) and the white point (multiplying all the
pixels by a constant value, also called Gain or Brightness).
On the left there is the Printer Lights panel, which allows us to modify each parameter
individually, according to the values of printer light in the logarithmic color space, as
well as other controls that do not pertain to these parameters but are located here
for ease of use.
In this panel, there are modification command buttons for simplifying the setting of the
different primary and secondary tones (R+,R-,G+,G-, etc); also there are modifiers for
Gain and contrast (All+,All-). The command buttons add or subtract a specific value
(defined in Printer Lights Steps); the relative knobs of Level and Cont allow the
modification of gain and contrast of each color, as well as two general relative knobs
(with white letters) which affect the three channels, thus simplifying the most
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common operations.
The Level-type controls (gain) add or subtract the same value for the Black Point and
the White Point, while the Cont (contrast) controls manipulate both points in opposite
directions, to increase o reduce contrast.
The buttons 1, 1/2 and 1/4 indicate at what magnitude the value defined in Printer
Lights Step will be used to modify the gain or contrast of any of the previously
indicated parameters (at the whole value, half or a quarter). B+W+, B+, W+. B-W+
allow the selection of the range over which the command buttons will operate:
B+W+
Values of printer lights in the logarithmic color space for the total gain (black and
white points).
B+
Values of brightness in Mamba parameters affecting the black point.
W+
Values of printer lights in the linear color space affecting the white point.
B-W+
Values of contrast in Mamba parameters affecting black and white points.
Below the Printer Lights panel there are two pick buttons which are used for selecting
a value in the image of the Canvas and redefining the black/white point.
Bands

After the first settings correction, the luminance range is divided into five bands,
definable by the user (the term "band" interpreted as a fraction of the luminance
range).
Each band has a trackball (Black, Shadows, Midtones,Highlights and White).
Additionally, there are four sets of HSC (hue, saturation and contrast) controls. The
first affects the whole range, the second, dark colors, the third, midtones and the
fourth, light colors.
Range
The five bands are defined through this subpanel.
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The subpanel is an image that has two control points with tangents.
The horizontal axis defines the input value (black to white, from left to right) already
transformed by the primary correction.

In order to modify the control points, press and drag them towards their edges. To
modify the tangent of these points, press the edge of the tangent.
The control point in the upper left (Lo) draws a curve that joins the lower right edge.
The control point of the upper right (Hi) joins a curve with the lower left edge. A third
curve without control points is drawn joining the lower edges.
These curves and their intersections define the five bands to be corrected by the five
trackballs.
The first band is defined from the left control point towards the left: this is corrected
by the Black trackball.
The second band is defined between the left control point and the first intersection of
curves: this is corrected by the Shadows trackball.
The third band is defined between first and the second intersection of curves: this is
corrected by the Midtones trackball.
The fourth band is defined between the second intersection and the right control
point: this is corrected by the Highlights trackball.
The fifth band is defined from the right control point towards the right: this is
corrected by the White trackball.
Vfix
This subpanel controls the secondary correction of the six fixed vectors: red, green,
blue, cyan, magenta and yellow.
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Each fixed vector has three sliders, controlling tone (hue), saturation and brightness
of each fixed vector.
This interface permits the crossing of vectors with each other, for example, defining
green as yellow and yellow as green at the same time, thus avoiding the need to use
masks for this type of complex correction.
Curves
The Curves subpanel allows us to work on a correction in great detail, whether it is
primary, using RGB curves, or secondary, carefully using any of them.
This subpanel is organized with 5 distinct tabs, each with different curves associated
to a specific correction. On the left there is a series of tools that are available in all
the tabs. To add points in the curves, either select from the tools on the left, or hold
down <Alt>+<Click> with the mouse over the area of the curve where a new control
point is required. To modify it, simply <Click> and drag the point.

Lo / Hi
Buttons for modifying zoom in the lower (Lo) or upper (Hi) part of the curve, allowing
greater, more detailed control over the points in this area.
Cx / Cy
Buttons that block horizontal (Cx) or vertical (Cy) offset of the points being modified.
Sm / Sh / CT / IT
Options that control the transition of the points of the curve, and also of their
tangents.
Pc0 / Pc1 / Pc3
These three functions have effect when a hue has been selected via Select, adjusting
the curves to the selected hue.
Pc0: adjusts without adding control points in the curves.
Pc1: adds a control point in the selected hue.
Pc3: adds a control point in the selected hue as well as one either side (in the
curves with Hue the distance between the points is16,66%, in others it is 20%).
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Add Pts / Rst Sel /Rst All
Options that, respectively, add points by default on the curves, return to the original
curve of the selected curve or return to the original curves of all the curves.
Gang RGB
Switches between the joint modification of the three RGB curves and if they are
deactivated, to one curve at a time.
RGB Tab
Curves that correspond to each of the three primary colors, representing their
complete range, from the lowest value, 0 (lower left corner) to their maximum value,
100 (upper right corner).
L-L S-S L-S Tab
Curves that correspond to the luma of the image (L-L), saturation (S-S) and Luma vs.
Saturación (L-S). These curves allow corresponding modification of the values of luma
based on the values of luma in the image (represented on the curve); similarly they
modify the saturation based on the saturation value of each pixel or modify the
saturation based on the levels of luma.
Hue-Hue Tab
Curve that modifies the tones of the image according to the tonal selection on the
curve.
Hue-Sat Tab
Curve that modifies the saturation of the image according to the tonal selection on
the curve.
Hue-Luma Tab
Curve that modifies the luma of the image according to the tonal selection on the
curve.
Setup
The last subpanel Setup has options that affect the behaviour of the interface.
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Ball Sensitivity, Ring Sensitivity, Knob Sensitivity, Jog Sensitivity
These define a scale in the drag sensitivity for the movement of the balls and of their
outer rings. The minimum value (1) specifies that the relation between drag and
modification of the parameter is 1:1, whereas higher values, for example be 1:8,
specify that the manipulator is less sensitive to the actual movement.
Draw Over
Activates the drawing of the manipulators in the Windows, which can be hidden by
deactivating this mode.
CP Panels Reset
Button for resetting Tangent Devices in cases of incorrect or suspended functioning.
Highlight Mode
Defines the viewing mode of the Highlight tool of the Color Grade subpanel Select.
These options can be used to choose if viewing the color selection is done over black
(On Black), contrasted in white and black (Display Key) or as the mode exists in the
RGBCorrect of saturation (Hi Saturate).
Printer Lights Step
Editable field that indicates the relationship between the values Printer Lights and the
primary color parameters of Mamba. This value should never be modified (default
value: 1.217).
Use and comments:

The Color Grade color corrector includes virtually all the functionality of all color correction
effects of the system, and can also carry out other functions related to the processes of
effects, generating masks or treating images.
Although it has many parameters, the corrector is easy to use, thanks to the number of
dedicated manipulators.
When the appropriate hardware is available, this effect carries out color corrections in real
time in HD RGB 4:4:4, 2K and 4K formats without compression.
The Primary correction is recommended for the first adjustment of values, in which white
point, black point, a gamma value and a contrast value are defined.
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The behavior of Primary is very similar to that of the primary color correction of telecine. It
is advisable to work generally with its special manipulator, the Trackballs. This is also useful
in white balancing, by selecting the white point with the Pick White function, and then
returning to Trackballs to make a Reset Ring of the White ball. This way, the hue of the
white color is compensated, without altering its value.

As well as applying a general correction of hue and saturation, it is recommendable to use
the correction Bands for a fine adjustment of luminance and color.
The main advantage of Bands correction is to be able to correct high and low lighting (
highlights & shadows), maintaining black and white values intact. This makes tasks of
colormetric balancing between different sequences easier, and also helps to enhance the
brightness of any intermediate luminance value, thanks to the fact that this correction also
allows the modification of the ranges that specify the bands.
The example below shows the original image and one corrected by bands. Neither Black nor
White values have been modified, whereas the Shadow, Midtones & Highlight values have
been tinted pink, orange and green respectively. This correction would not be possible using
only the primary correction.
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Additionally, the function of secondary correction has been added to the same group of
processes, through correction of fixed vectors.
The fixed vectors are modified through six groups of three HSB sliders dedicated to the
primary colors and their complements: red, green, blue, cyan, magenta and yellow.
The first subpanel Select has a range of tools. Any color range can be selected, qualified for
hue, saturation and contrast (HSL Qualifiers).
In addition, it is possible to create trackable basic geometric Windows such as lines, ellipses
and rectangles with the same corrector, and also to use vectorial forms generated within
the effect, via the Shapes manipulation mode, in which forms can be created which are
assignable to each of the vectors independently.
A typical use of the Qualifiers and the Mask Filter is the simulation of filters. For example, it
is possible to restrict the high values of luminance via the Luminance Qualifier and increase
the values of shadows in the result. Via the parameter Mask Filter the restriction generated
can be softened, thus obtaining a simulation of the Promist filter.
It also has parameters capable of applying Sharpening and Blur filters, with different modes
and variables, making possible such as Glow.
Another of the important characteristics is the option to recover range of colors lost either
through an extreme stylistic correction or simply because another input or previous stage is
required. With this goal, the combination of channels with previous Inputs and Vectors is
huge, as well as being able to define what and how much is recovered.
Even more importantly is the fact that once the selection has been carried out with
whichever image effect is chosen, or the recovery of ranges or a final mask final defined by
the combination of qualifiers, windows and channels, both internal and external can be
treated (by defining what is external) as a complete correction, using Primary, Bands and
Fixed Vectors.
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B/W

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->B/W
This is simply the RGBCorrect effect of the color correction, with a saturation value 0
assigned to its input.
Negative

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Negative
This is simply the color correction RGBCorrect effect, with default values that invert its
input colors.
C ineon C orrect/Export

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Cineon
This dropdown allows the direct selection of the same effect (Cineon) according to the
operation mode (Correct or Export).
I/O

Inputs
Single input: RGB image with optional alpha channel, supporting 10 bits per channel.
Inputs
Image: corrected color and gamma, at 10 bits per channel.
Alpha: Opaque mask.
Parameters
Mode:

Mode
[Correct/Export]
Correct mode carries out a conversion from standard Cineon to a linear color space.
Export mode carries out the inverse process, converting from a linear color space to
the standard Cineon from Kodak.
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ClipWhite
[Yes (No/Yes]
If activated, this option limits the white point (White) to those legally permitted.
Master:

Folder containing the parameters that globally influence the color correction. Work
with these parameters only when a global correction is necessary. For a correction
specifically in the RGB channels, it is advisable to use the folders described later.
White
[685 (-1023 /1023)]
Specifies the information for white in the image following Kodak Cineon standard.
Black
[ 685 (-1023 /1023)]
Specifies the information for black in the image following Kodak Cineon standard.
G-Cor
[ 1 ( -100 / 100 )]
Specifies the global value of the gamma function. It is set in accordance with the final
destination. The default value is “1” for a linear output. Values less than “1” indicate a
logarithmic output.
G-film
[ 0.6 ( -100 / 100 )]
Specifies the value for the original density of the film. “0.6 is the default value in
accordance with the Kodak Cineon standard.
Highlight
[ 0( -100.000 / 100.000 )]
Specifies a contrast range in bright lights.
Shadows
[ 0 ( -100.000 / 100.000 )]
Specifies a contrast range in shadows.
SoftClip
[ 0 (-100.000/100.000)]
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Specifies a range (as a percentage) of values around the white point (White
parameter) that must be compressed in a brightness range of the output image.
The main function of this parameter is to avoid the loss of detail in bright areas of the
image. In logarithmic formats obtained by means of film scanner, there can be great
differences in density for brightness values that may appear the same. If this
technique is not employed, these values are united in a single value of maximum white
in the output image.
However, if the White parameter is increased in order not to lose the highest
brightness values, too much range value is dedicated to represent the brightness in
the resulting linear image.
If, on the other hand, this problem is resolved by the use of this parameter, we can
compress all the values of brightness with wide numerical differences in the logarithmic
space in a series of close but different linear values, thus maintaining the capacity to
recover detail subsequently when contrasting these zones.
White-RGB:

Folder in which information for white is specified independently in each color channel.
Red
[ 685 (-1023 /1023)]
Specifies the information for white in the red channel.
Green
[ 685 (-1023 /1023)]
Specifies the information for white in the green channel.
Blue
[ 685 (-1023 /1023)]
Specifies the information for white in the blue channel.
G-Cor:

Specifies the value of the original film density independently in each color channel.
Red
[ 1 ( -100 / 100 )]
Specifies the value of the original film density in the red channel.
Green
[ 1 ( -100 / 100 )]
Specifies the value of the original film density in the green channel.
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Blue
[ 1 ( -100 / 100 )]
Specifies the value of the original film density in the blue channel.
G-film:

Specifies the gamma value independently in each color channel.
Red
[ 1 ( -100 / 100 )]
Specifies the gamma value in the red channel.
Green
[ 1 ( -100 / 100 )]
Specifies the gamma value in the green channel.
Blue
[ 1 ( -100 / 100 )]
Specifies the gamma value in the blue channel.
Black-RGB:

Folder in which information for black is specified independently in each color channel.
Red
[ 685 (-1023 /1023)]
Specifies the information for black in the red channel.
Green
[ 685 (-1023 /1023)]
Specifies the information for black in the green channel.
Blue
[ 685 (-1023 /1023)]
Specifies the information for black in the blue channel.
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High-RGB:

Specifies a contrast range for bright lights independently in each color channel.
Red
[ 0 ( -100 / 100 )]
Specifies a contrast range for bright lights in the red channel.
Green
[ 0 ( -100 / 100 )]
Specifies a contrast range for bright lights in the green channel.
Blue
[ 0 ( -100 / 100 )]
Specifies a contrast range for bright lights in the blue channel.
Shad-RGB:

Specifies a contrast range for shadows independently in each color channel.
Red
[ 0 ( -100 / 100 )]
Specifies a contrast range for shadows in the red channel.
Green
[ 0 ( -100 / 100 )]
Specifies a contrast range for shadows in the green channel.
Blue
[ 0 ( -100 / 100 )]
Specifies a contrast range for shadows in the blue channel.
Soft-RGB:

Specifies which values of white that exceed the range are compressed within the output
independently in each color. The compression is carried out by specifying a percentage
value of the whites which are required to be recovered for the image (see the SoftClip
parameter for more information).
Red
[ 0 ( -100 / 100 )]
Specifies which values of white in the red channel that exceed the range are
compressed within the output.

SGO Mamba 2.0.1 © 2014 SGO

264

FX

Green
[ 0 ( -100 / 100 )]
Specifies which values of white in the green channel that exceed the range are
compressed within the output.
Blue
[ 0 ( -100 / 100 )]
Specifies which values of white in the blue channel that exceed the range are
compressed within the output.
Use and C omments

Unlike other conversion effects, CineonCorrect has the SoftClip parameter, which is
especially for carrying out a compression of brightness when changing to linear, largely
avoiding loss of visual detail.
In this case, the parameters are based on the standard Cineon of Kodak.
For manual corrections, the use of the Color Grade corrector is recommended, together with
the suitably calibrated LUT, although this effect is more adapted for "automatic"
conversions of logarithmic film images to linear formats of video, in which it is normally
necessary to set the SoftClip parameter to compress the brightness in the linear range
possible in video.
Because it relies on this SoftClip parameter, an inverse effect does not exist for returning
from linear to logarithmic, which is why this effect is only recommended for work flows that
do not require later reversion to a logarithmic space. For cases in which a reversible
conversion is needed, the use of LogCorrect and LogExport effects that can work in an
reverse direction is recommended.
When a logarithmic image needs to be converted to a linear space, to show the image in a
linear monitor, but whose final result to be maintained as in logarithmic (as is the case of
film formats), it is not this effect is not recommended: the LUT of the Color Grade or
3DLUT effects are much more appropriate. The CineonCorrect effect is only suitable when
the resulting images are to be used in linear format (video etc), and if, in addition, a
standard conversion corresponding to Cineon is used. In cases in which we are not
restricted to a standard, or if the grading is to be done within Mamba itself, it is
recommendable not to use this effect, but rather to use the Color Grade color corrector to
do both processes (transfer to linear and color correction) in one.
Log

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Cineon
This dropdown allows the direct selection of the color correction according to the operation
mode (LogCorrect or LogExport).
LogC orrect

Ref.
Mamba:
>LogCorrect

TimeSpace

Editor->Dashboard->Fx->Mamba->Color->Log-

This correction effect is intended for color corrections on images of 10 bits per RGB channel
in a logarithmic color space, typically .dpx or Cineon files.
The LogCorrection effect applied to a sequence of these characteristics will act as a LUT
(Look Up Table) on the sequence, correcting the color by transforming the logarithmic
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nature of the original color into linear.
I/O:

Inputs
Single input: image in RGB 10 bit format Log.
Inputs
Image: color corrected image, at 8 bits per channel.
Alpha: Opaque mask.
Parameters:

Parameter folder that globally influences color correction.
White
[ 100 ( -100.000 / 100.000 )]
Specifies the global luminance value to be corrected to white. Lower values specifies a
darker color as a white point, so the color correction increases the selected value to white,
and vice-versa.
Gamma
[ 1 ( -100 / 100 )]
Specifies the global gamma value. Higher values increase the contrast, and vice-versa.
Black
[ 0 ( -100.000 / 100.000 )]
Specifies the global luminance value to be corrected to black.
Higher values specify a lighter color as a black point, so the color correction decreases the
selected value to black, and vice-versa.
Folder of parameters that defines the RGB value to be corrected to white. Lower values
define a color as darker than white, so the color correction raises the selected values
towards white, and vice versa.
Red
[0 (-100.000 / 100.000 )]
Defines the information of white in the red channel.
Green
[0 (-100.000 / 100.000 )]
Defines the information of white in the green channel.
Blue
[0 (-100.000 / 100.000 )]
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Defines the information of white in the blue channel.
Folder of parameters that defines the gamma value. Lower values define a color as darker,
so the color correction raises the brightness of the image, and vice versa.
Red
[0 (-100.000 / 100.000 )]
Defines the value of gamma in the red channel.
Green
[0 (-100.000 / 100.000 )]
Defines the value of gamma in the green channel.
Blue
[0 (-100.000 / 100.000 )]
Defines the value of gamma in the blue channel.
Folder of parameters that defines the RGB value to be corrected to black. Higher values
define a color as lighter than black, so the color correction lowers the selected values
towards black, and vice versa.
Red
[0 (-100.000 / 100.000 )]
Defines the information of black in the red channel.
Green
[0 (-100.000 / 100.000 )]
Defines the information of black in the green channel.
Blue
[0 (-100.000 / 100.000 )]
Defines the information of black in the blue channel.
Use and Comments:

This effect internally carries out a LookUp Table (LUT) and a linked color correction before
converting the image to linear RGB 8 bits.
Therefore, the values of global parameters of the Master folder are those which we must
define first according to the data we have for the material to be processed, which is
needed to return the images to a linear color space. Then we can correctly do the color
correction via the other parameters, taking advantage at all times of the depth of color of
the original images.
The correction possibilities of this effect are very similar to those of the effect Color Grade,
which offers greater performance, so LogExport has a limited usefulness. It is usually only
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used when we need to convert to linear format following certain known gamma values (for
example, the standard Cineon), with the possibility of carrying out the inverse conversion
via the effect LogExport to return to a logarithmic space at a later time.
For RGB values, percentage ranges have been preferred, maintaining coherence with other
values in Mamba. The normal range in Cineon is from 0 to 1023, so simply divide by 10.23 to
obtain values in a range of 0 to 100 or multiply by 10.23 for the reverse calculation.
The Knee parameter has not been included here since its function is to compress the extra
range over the level of white for special effects, such as light flare in bright areas. Even so,
it is possible to achieve the same effect, by simply duplicating the material with LogCorrect
and using the white value in the black value field. This produces an image that only
contains whites that are outside the range of a normal image. Then simply use a Blur effect
in second sequence and use Add to add it to the previous.
LogExport

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Log->LogExport
This effect converts an image in linear color space to an image in 10bit logarithmic color
space with headroom, preparing it to be exported to logarithmic DPX formats. To do so, use
a LUT (LookUp Table) which can be defined via parameters.
I/O:

Inputs
Single input: image with HDR support.
Inputs
Image: color corrected sequence at 10-bits.
Parameters:

Parameter folder that globally influences color correction.
White
[ 100 (-100.000 / 100.000 )]
Specifies the global value of the image brightness. Higher values increase the image
brightness, and vice-versa.
Gamma
[ 0 (-100 / 100 )]
Specifies the global gamma value but in inverted values. Lower values increase the
image contrast, and vice-versa.
Black
[ 0 (-100.000 / 100.000 )]
Specifies a new global pedestal for image brightness.
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Defines the brightness of the image based on RBG values. Higher values raise brightness of
the image, and vice versa.
Red
[0 (-100.000 / 100.000 )]
Defines the information of white in the red channel.
Green
[0 (-100.000 / 100.000 )]
Defines the information of white in the green channel.
Blue
[0 (-100.000 / 100.000 )]
Defines the information of white in the blue channel.
Defines the value of gamma but in inverse RGB values. Lower Values lift the contrast of the
image, and vice versa.
Red
[0 (-100.000 / 100.000 )]
Defines the value of gamma in the red channel.
Green
[0 (-100.000 / 100.000 )]
Defines the value of gamma in the green channel.
Blue
[0 (-100.000 / 100.000 )]
Defines the value of gamma in the blue channel.
Defines a new level of brightness of the image based on RGB values.
Red
[0 (-100.000 / 100.000 )]
Defines the information of black in the red channel.
Green
[0 (-100.000 / 100.000 )]
Defines the information of black in the green channel.
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Blue
[0 (-100.000 / 100.000 )]
Defines the information of black in the blue channel.
Use and Comments:

The list of LogExport parameters is the same as that of the LogCorrection effect. However,
its purpose is the opposite. Whereas LogCorrection Gamma corrects the image gamma
making it linear, LogExport. Gamma inserts Gamma factor in the image making it
logarithmic.
A Black value of 10 in LogCorrection lowers the brightness pedestal. However, in LogExport,
the Black parameter raises this pedestal, so that equal LUT values in both effects cancel
each other out.
Remap

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Remap
Resets the colors of an image by examining the color of a line of a second image. The line of
the second image shows from right to left the colors that correspond to the luminance
values of the modified image in order from black to white.
I/O

Inputs
Double input: The first is the image to be modified, and the second contains the line
to be examined to respecify the colors.
Inputs
Image: Image with modified colors.
Alpha: Opaque.
Parameters

Line
[50 (0 / 100.000)]
Selects the horizontal line to be examined to reset the colors.
This value is a percentage, indicating by default the horizontal center line of the
image. Every 100 parameter units, it returns to the bottom line of the image.
Cycle
[0 (0 / 100.000)]
Specifies a offset from the origin of the line exploration.
The line is always read from left to right, and even though an offset is specified, the
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line exploration is completed in a cyclical manner, reading what is necessary for
completion by returning to left edge of the frame and then continuing until it reaches
the point of origin. The default value indicates that the line starts to be examined at
the left edge of the image; 50 specifies a start from its center (50%); a value of 100
returns to its left edge.
In Alpha
[No (No /Yes)]
Restricts the influence of the color correction to the area specified by the levels of
the alpha channel.
Use and C omments

The parameters of this effect can be animated, generating psychedelic color effects.
The uses of this effect are varied. One classic use is to color the image of the first input
with a color palette that the user can specify in the second input, obtaining for example
images that simulate a heat detector, or for 0coloring black and white images.
In the following example, different palettes are used. The first simulates gold, and the
second a heat detector.

Another useful application of this effect is to correct mask edges. If a black and white
image representing a mask (which can be obtained with the ShowAlpha effect) is positioned,
it can be blurred (with the Blur effect, for example) and inserted as the first input of this
effect. As second input, a horizontal Wipe can be specified (the first Wipe of the wipe
library) and by controlling its Grade and Soft parameters the white surface of the first input
could be shrunk or gently softened, or the outline of the mask border achieved.
In the following example, a blurred mask with two different color maps is used. The
objective of the first map is to shrink the opaque surface of the mask, and that of the
second to obtain the mask border.
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This effect is also useful fir achieving a comic-book style image.
Legalize

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->Legalize
Prevents values outside the RGB color space and limits abrupt chroma transitions that may
create illegal peaks in YUV422.

I/O

Inputs
Single input: Image with/without alpha channel.
Outputs
Image: legalized image.
Alpha: alpha of the input.
Parameters:

422 Cleanup
[ Off (Off / On )]
Prevents values outside the legal RGB value of scope when sub sampling from RGB444 to
YUV422.

SGO Mamba 2.0.1 © 2014 SGO

272

FX

Folder of parameters that define the compression and its softness in the range of shadows
in the image.
Knee
[64 (64 / X )]
Defines the point in the luma curve from which the shadows will be softened and
compressed to legalize the whole range.
Peak
[0 (-X / X)]
Defines the amount of softness for the compression of the legalizer.
Folder of parameters that define the compression and its softness in the range of high lights
in the image.
Knee
[940 (X / 940 )]
Defines the point in the luma curve from which the high lights will be softened and
compressed to legalize the whole range.
Peak
[0 (X /X )]
Defines the amount of softness for the compression of the legalizer.
RGB Levels

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->RGB Levels
This effect allows the user to switch between the two standards of video signal, ie. video
and data, which are normally associated with the terms YUV, RGB, analog and digital. All
automatic conversions carried out by Mamba between RGB and YUV are done with the
proportion 1:1, so the operator has absolute control when changing between these
standards.
I/O

Inputs
Single Input: Image with or without alpha channel.
Outputs
Image: image with the signal converted to the selected range.
Alpha: alpha of the input.
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Parameters

Mode
[Video->Data (Video->Data /Data->Video)]
Switches between modes of conversion for legal video and data.
Use and C omments

Switching between different color ranges not only means that it is necessary to match the
files used within the environment, but it also means there may be confusion with different
standards within each one. Therefore, Mamba simplifies the functioning of this type of
conversion, making it possible always to work internally at 16 bit RGB , by default importing
and capturing all the video clips without applying any conversion, allowing the operator to
evaluate each video clip.
So, in a single workspace we may find image clips that are "video", using the values in a 8bit
representation scale, between 16-235, and at the same time other there may be other
image files working as "data", ie from 0 to 255. The basic reason for this kind of change is to
have a common black point for all the files, avoiding having some at 0 and others at 16. So,
when capturing the video, Mamba always works in extended range (capturing all the
information it finds on the tape) without fixing a a black point to the video standard,
allowing th operator to do this. If there are digital files received as "data" which we know
should be in "video", the inverse correction can be applied.
RGB to XYZ

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Color->RGB to XYZ
This effect converts and image in RGB space to an image in "XYZ" space following the DCI
(Digital Cinema Initiatives) norms.
I/O

Input
Single input: Image RGB space with alpha channel.
Output
Image: Image in XYZ space.
Alpha: Alpha of the input.
Parameters
Mode:

Unit
[1 (1/10.000)]
Specifies in which units the values of the following files are interpreted.
Note: The following files contain the group of parameters that determine the matrix of
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the transformation from RGB to XYZ.
Reference:

Xr
[0.680 (0/10.000)]
Xg
[0.265 (0/10.000)]
Xb
[0.150 (0/10.000)]
Yr
[0.320 (0/10.000)]
Yg
[0.690 (0/10.000)]
Yb
[0.060 (0/10.000)]
White:

x
[0.314 (0 / 20000)]
and
[0.351 (0 / 20000)]
Y(Cd)
[48 (0 / 10.000)]
Gamma:

In
[2.6 (0/10.000)]
Out
[2.6 (0/10.000)]
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Use and C omments

The commonest use of this effect is to obtain images in XYZ space used by certain
professional digital projectors.
The default values are the commonest for a nominally calibrated projector. During the
installation of the projector the manufacturer can provide optimum calibration values, since
these can depend on environmental factors.
Once the values have been set, it would be most common to do a render of the results to
TIFF in 16bits (to deliver in DCM) or j2k (for subsequently producing a DCP).
The default parameters meet the common standard for conversions between RGB and XYZ
for Digital Cinema, so they should not be modified except when the client provides specific
calibration values, taken with a spectrometer.
Keyer

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer

This menu includes tools relating to obtaining the alpha channel from and image and
posterior composing.
Blue Screen, Green Screen

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer->Blue Screen,
Green Screen
Although Bluescreen and Greenscreen are two separate effects, their parameters are
identical. For this reason, only Bluescreen is described here, and the description of
Greenscreen can be obtained by substituting blue for green.
This effect is specialized in generating an alpha channel from images recorded on a blue
background, although it also permits composition in a mixed cut mode.
This effect can be used in three ways, depending on the number of Inputs.

SGO Mamba 2.0.1 © 2014 SGO

276

FX

I/O

Inputs
Single input: Extracts an alpha channel from the blue color.
Double input: Extracts an alpha channel from the comparison of blue colors of the
two inputs.
To obtain a more optimized mask, insert the background image without character to
crop as a second input.
Triple input: Extracts an alpha channel from the comparison of blue colors of the
second and third inputs, and then composes the second input on the first, adding an
additional fine control for edges and transparencies.
Inputs
Single input:
Image: Image with suppressed cropping color.
Alpha: Mask extracted from the image.
Double input:
Image: Image composed on the background.
Alpha: Mask extracted from the image.
Parameters
Key:

Folder containing parameters that specify the cut values.
Toler
[0 (-100 / 100)]
Specifies the total transparency threshold in the alpha used for composing.
Soft
[100 (0 / 100)]
Controls the range of smooth transparencies obtained from the total transparency
specified by the tolerance parameter towards absolute opacity. A low value specifies
a small range of intermediate transparencies.
PreBl X ; Y
[1 (0 / 100)]
Specifies a horizontal and vertical blur value for the proxy image used for mask
extraction.
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This parameter is very useful since it rounds the outline of the mask extracted, due to
the fact that the blur filter associates the RGB values of neighboring pixels, smoothing
the color transition of between the background and the figure before the mask is
extracted.
Spill:

This folder contains parameters to suppress the blue spill that might remain in foreground
after the mask has been extracted.
Pass>R ; Pass>G
[-50 (100 / 100)]
Tolerance of color suppression.
The tolerance is adjusted asymmetrically, referencing two angles forming a cone
centered in the blue vector in a chromatic circle. Pass>R specifies the suppression
tolerance towards the angle of the red vector, whereas Pass>G specifies the
suppression tolerance towards the angle of the green vector.
Red; Green; Blue
[0 ; 0 ; 0 (100 / –100)]
Specifies a new color for the suppressed ranges.
The default value specifies medium grey, thus achieving the desaturation of the edge
color.
The cancellation values of the suppression, in the case of blue, are –50; -50; 50 for
RGB respectively.
Lum
[0 (-100 / 100)]
Modifies the pixel luminance level of that made by the color suppression.
Shrink
[0 (0 / 10.000)]
Shrinks the opaque surface of the mask already generated in the alpha channel.
EdgBld
[0 ( 0 / 2)]
Copies the RGB values of the nearest
semitransparent alpha channel pixels.

pixel with an opaque

alpha

to

the

By this means, this parameter pushes the color surface towards the edges, since they
are usually semitransparent in the alpha channel.
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Transp:

Folder containing parameters for fine control of transparency composition.
This folder should be ignored when not using this effect with triple input, since the
transparencies are composed in the first input by using a mask of the difference between
the second and third.
Remove
[2 (0 / 100)]
Transparency mixing control. High values suppress mixing.
OfsCor
[50 (-200 / 200)]
Adds saturation to the transparencies, since transparencies do not originally have
saturation.
Positive values will tint the transparencies towards the complementary color of the
edges, whereas negative values the will tint towards the color of edges.
Smth X; Y
[1 ; 1 (0 / 9)]
Specifies a blur of the individual transparencies in each axis, to smooth them.
Crop:

Folder containing parameters that permit cropping the alpha channel of the inputs with the
four sides of the frame.
Left
[0 (0 / 100)]
Left edge as a percentage of the image width.
Right
[100 (0 / 100)]
Right edge as a percentage of the image width.
Up
[100 (0 / 100)]
Top edge as a percentage of the image width.
Down
[0 (0 / 100)]
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Lower edge as a percentage of the height of the image.
Use and C omments

This effect is the most suitable for cropping bluescreens or greenscreens. When double or
triple input is used, the extraction of a high quality mask is guaranteed.
A shot of a figure walking on a green background can be seen in this example, with no
camera movement. The foreground clip that has the figure to be composed in Foreground is
used as the first input, and the second input is the empty set without the figure (Screen).
When there are two inputs, the effect generates a mask from both inputs and then runs a
Difference mathematical operation for both generated masks. The result is the removal of
the imperfections due to bad on-set lighting, since this is suppressed in the comparison
between background and background with figure, thus extracting a clean mask of the
figure. In this case, it can also be seen that even the shadow cast by the character is
included in the mask, thanks to the high selection range in the histogram.

In some cases, it is difficult to obtain the background image (Screen) without the figure
being included, because there are camera movements in the shot. In these cases, it is very
helpful to work with Motion Control systems to make an additional pass of the empty
background. When a motion control camera is not available, the construction of a “proxy”
background in movement can be attempted with its virtual reconstruction, with the help of
the ScreenBuild effect, or by animating parts of the original background by using the
tracking tools. In the final instance, an empty background can be artificially specified by
inserting a Solid effect as second input, specifying its color with the Color Chooser, carrying
out a Pick Color from the original background.
It is important that the background set is the purest possible blue (or green). The Color
Chooser can be used to analyze the background color. Frequently it will be seen that the
color tends to be lightly tinted towards cyan. This problem should be corrected before
applying this effect, to obtain the widest possible tolerance histogram.
When this effect uses three inputs, it makes the final composition over the desired
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background, adding additional processes in order to work with transparencies. Other
composition effects, such as Comp3D or HaloComp, do not carry out this additional process
for transparencies.
The effect parameters should be set in the same way as when using two inputs, but in
addition, the parameters of the Transp folder, which control the process of composition of
transparencies, are used. The composition method of transparencies is different and totally
independent from that of the composition of the foreground, using a calculation that
considers only the luminance of the transparencies. The two processes, divided into layers
composed on a grey background, are shown in the following image. The combined result of
both processes takes maximum of the useful image information in order to create the mask,
being especially visible in transparent details, such as shadows.

This effect, when used with triple input, provides an exceptional transparency background,
which can be very useful for preserving fine details of the figure to be extracted, such as
for example transparencies of hair or glass (for example, car windows), projected shadows,
and above all, contact shadows. Contact shadows are one of the classical problems in a
composition: they are the kind shadow which an object or character produces in contact
with the background set (for example, the floor), and which, when it is extracted and added
to the composition, helps to integrate the composed figure on the new background, and
avoid having the foreground “float” over the background.
External Key

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer->External Key
Assigns the luminance of a sequence to the mask of another one.
I/O

Inputs
Double input: The first is the image to be composed and the second the image that
to be assigned as the external mask, interpreting its luminance as the alpha channel.
Inputs
Image: Image of the first input.
Alpha: Luminance of the second input.
Parameters

Invert
[No (No / Yes)]
Inverts the transparency and opacity values of the assigned alpha channel.
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Use and C omments

This effect is limited to assigning (either normally or inverted) the luminance of the second
input as the alpha channel of the first. Thanks to its simplicity, its calculation is faster than
other more elaborate effects that can cover the same functionality, such as the Channels
effect. Its uses can be very diverse. Since this effect is a mask assigner and not a mask
extractor, its use is valuable for assigning a mask previously extracted from image to
another image, or assign any mask to an image to be able to work with effects that
function on the basis of the mask information or that can limit its functionality to the mask,
such as color correctors or spatial filters.

In this example, the original image and the mask assigned by this effect can be seen. The
mask was previously extracted from the small image that accompanies the mask with a
Greenscreen effect, and then the ShowAlpha effect shows the generated mask in
grayscale, so that the ExternalKey effect can reassign the mask. The following four images
show different possible uses of this external mask assignment.
The first example is simply the composition of the original image on a different image using
an external mask, using the Comp3D effect.
The second example is the LiquidBump effect. This effect must have an alpha channel to be
able to function and generate a relief and refraction at the edges of the mask, as well as to
be able to specify an interior color and a projected shadow.
The third example consists of adding a color correction with the Mode->InAlpha parameter
activated, and restricting the correction to the area delimited by the mask opacity. In this
case, the correction darkens the image in the mask.
The last example is the Comp3D effect for composing the image on itself, but specifying a
projected shadow with the parameters of the Shadow folder.

RGB Key

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer->RGB Key
Effect for the extraction of masks from an RGB value.
I/O

Inputs
Single input: Image from which an alpha channel will be generated.
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Double input: The first input is the image to be composed; the second image is the
one from which the mask will be extracted.
Inputs
Image: Input image.
Alpha: Mask extracted from the image.
Parameters

Toler
[0 (-100 / 100)]
Specifies the total transparency threshold of the alpha to be
composition.

used for the

Soft
[100 (0 / 100)]
Controls the range of smooth transparencies from the total transparency specified by
the tolerance parameter towards absolute opacity.
Lower values specify a small range in intermediate transparencies.
Red; Green; Blue
[0; 0; 0 (0 / 100)]
Specifies the color RGB selected to generate a mask.
Invert
[No (No / Yes)]
Inverts the transparency and opacity values of the alpha channel.
Use and C omments

Although this effect is not the most suitable for creating a mask (since Color Key can use a
single or multiple selection), it has the distinction of being able to animate a selected color
as a mask generator, since its parameters are the ones that specify that color.
C olor Key

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer->Color Key
Effect that extracts a mask with a color selection, which should be done exclusively with
Mamba->Visual Editor->Manipulators Tabs->Pick Key. This color selection cannot be
animated.
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I/O

Inputs
Single input: Image from which an alpha channel will be generated.
Inputs
Image: Input image.
Alpha: Mask extracted from the image.
Parameters

Toler
[0 (-100 / 100)]
Specifies the total transparency threshold of the alpha to be
composition.

used for the

Soft
[30 (0 / 100)]
Controls the range of smooth transparencies from total transparency specified by the
Tolerance parameter towards absolute opacity.
Lower values specify a small range in intermediate transparencies.
Invert
[No (No / Yes)]
Inverts the transparency and opacity values of the alpha channel.
Use and C omments

This effect allows the selection of a number of arbitrary colors for specifying a mask, which
is very useful in cases where objects or people that were not specially registered for that
purpose have to be cutout.
In this example, the background color (red) is chosen to generate a mask. This effect is
only a mask extractor, and has no parameters to improve the extracted mask, so that we
recommend treating the generated mask with other effects, such as Shrink, Blur (in the
mode RGB-InA) or VectorPaint for example. In the example image, the mask obtained
requires a correction, since the color selected for the mask is noticeably affecting its
borders.
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Color selection is accumulative, and any combination of colors can be selected to generate
a mask. In some cases, where a cutout figure is desired in the image, it may be more
beneficial to select the colors of the figure instead of the background colors.
This effect is also very useful for generating masks that restrict the action of another
subsequent effect. In this example, the mask was extracted from the skin by selecting the
colors of the face and inverting the mask with the Invert parameter, and finally applying a
blur filter trough the generated mask (for example, the Blur (Type Gauss) effect, with its
RGB-InA parameter activated).

In cases of material with a blue or green background, we recommend using the effects that
are specialized for this purpose: BlueScreen and GreenScreen.
Luma Key

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer->Luma Key
Generates a mask from the selection of low, medium and high of luminance values of the
image.
I/O

Inputs
Single input: Image from which an alpha channel will be generated.
Inputs
Image: Input image.
Alpha: Mask extracted from the image.
Parameters

Low
[100 (0 / 100)]
Specifies the intensity of the mask in areas of low luminance.

SGO Mamba 2.0.1 © 2014 SGO

285

FX

Mid
[100 (0 / 100)]
Specifies the intensity of the mask in areas of medium luminance.
High
[100 (0 / 100)]
Specifies the intensity of the mask in areas of high luminance.
Use and C omments

We recommend this effect for extracting masks from an image through its luminance,
ignoring saturation and hue. The masks obtained with this effect can be improved with the
Shrink, Blur (in the mode RGB-InA) or VectorPaint effects.
In most cases, the Boolean operations made by the And, Or, Add, Subtract or Channels
effects, combined with color corrections are more recommendable than composing with
masks, although this effect permits the selection of luminance ranges to mask color
corrections of spatial filters with the InAlpha parameter.
In the following example, this effect is used in combination with Blur to simulate an image of
mist on the original landscape.

In this case, the parameters were specified as follows: Low: 100; Mid: 0; High: 0.
Then a Blur (Type Gauss) is applied with the RGB-InA parameter activated. A blur is thus
obtained in the low luminance values of the image, maintaining the details in the medium
and high values, giving a misty sensation to the image, since the blur reduces the contrast
in the dark areas, but detail is maintained in the bright ones
Keyer Tools

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Keyer->Keyer Tools
This dropdown permits the selection of the tools Stroke, Edge Build and Screen Build.
Stroke

Ref. Mamba: Fx->Mamba->Keyer->Keyer Tools->Stroke
Adds a stroke (line) of color from the outline of a mask. This line can be drawn outside or
inside the outline specified by the alpha channel. In order to view this effect correctly, it is
necessary to compose the result on a background.
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I/O:

Inputs
Single input: Image with alpha channel.
Inputs
Image: Image composed with the stroke color.
Alpha: Original mask added to the mask of the generated stroke.
Parameters:

Red; Green; Blue
[100; 100; 100 (0 / 100)]
Specifies the color of the stroke in RGB values.
Side
[0 (0 / 100)]
Position value of the stroke.
Positive values increase the thickness of the stroke outside the original mask, whereas
negative values make the thickness of the stroke grow inwards. A value of zero
specifies that the stroke should have no thickness, making it invisible.
Use and Comments:

This effect is normally used as a graphical tool to add an edge to composed images. This is
especially useful for composing text, since the letters can be outlined any edge color,
making them easier to read.

Bear in mind that the stroke generated by the effect is achieved by shrinking or growing the
mask, and therefore if high values of the Side parameter are specified, the generated line
will have geometrical borders that are not rounded.
If it is necessary to smooth the generated edge, a Blur (Type Gauss) effect should be
added on top of the Stroke effect to blur the outside of the line.
Edge Build

Ref. Mamba: Fx->Mamba->Keyer->Keyer Tools->Edge Build
Improves the color of the pixels in the transparent area of a mask.
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I/O:

Inputs
Single input: Image with alpha channel.
Inputs
Image: Image with improved edges.
Alpha: Mask without changes.
Parameters:

None.
Use and Comments:

This effect copies the RGB values of the nearest pixel with opaque alpha to the
semitransparent alpha channel pixels. In this way, this effect pushes the color surface
towards the edges of the mask, since they are usually semitransparent in the alpha
channel.
In the example below, the difference between expanding the color with this effect instead
of shrinking the mask can be seen. Shrink may possibly remove the undesired edges, but at
the cost of shrinking the mask by modifying the outline of the composed figure. However,
EdgeBuild keeps the mask intact, only affecting the color of the image outline and not the
shape of the layer outline.

In this image the way the effect works, by expanding the image color, instead of shrinking
the mask as with Shrink, can be seen in detail.

Screen Build

Ref. Mamba: Fx->Mamba->Keyer->Keyer Tools->Screen Build
Reconstructs the background color in the areas specified by its mask.
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I/O:

Inputs
Single input: Image with alpha channel.
Inputs
Image: Image with background reconstructed.
Alpha: Opaque.
Parameters:

Grow
[0 (0 / 1.000)]
Mask expansion value.
Blur
[0 (0 / 10.000)]
Specifies an image blur with the Blur (Type Gauss) filter.
Use and Comments:

This effect acts on the RGB channels of the image, filling the internal areas specified by the
mask with an averaged color. The Grow and Blur parameters permit setting of the areas
occupied by the figure in the mask with either expansion or blur, replacing them with an
average color from the surrounding image, with the intention of regenerating the original
background.

For this effect to function reasonably well, it is necessary to maintain the original color of
the background intact, avoiding the color suppressors that may be running during mask
generation, since the main purpose of this effect is to reconstruct the original background
of the set for later use as a second or third input of the Bluescreen or Greenscreen effects.
Spatial Key

This effect allows advanced selections to be made of elements in a scene, based on
multilayer information in EXR format (previously generated in a CGI program), and also based
on Parallax information calculated by the Stereo3D effect. Normally in Mamba these
selections are stored as masks in the Alpha channel.
The layers that Mamba detects in an EXR are: IDs, position layer (XYZ information), depth
layer (Z-axis information), and diffuse reflection (according to the normals of the object).
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Ext Key

Allows the layers of the clip to be exported as a Key. When more than one layer is used,
Mamba adds them to each other to generate a common mask for the selected layers.
Normally in Mamba the selection carried out is stored as information in the Alpha channel. <
%PRODUCT> allows the combination of up to 6 information layers contained in the EXR. The
name of these layers depends on the EXR file in question and on the nomenclature used by
the CGI program used to export the file.
Object ID

Allows the selection of certain objects in an image based on their numerical ID as stored in
the Index Object of the EXR file. This ID is set in the external program that generated the
file, and as a general rule, a unique number for each object of the scene is set.
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Parameters:

Layer
Defines the layer the effect will use to make the selection. This layer is set
automatically using the tool Pick Object ID if and when the EXR file contains a
recognizable layer as an ID index.
Object ID
Shows the ID number associated to the selected object.
Use and comments:

To be able to select an object by means of its ID, it is only necessary to have the option
Pick Object ID, in the Multilayer tab of the Visual Editor (found on the right of the effect)
active; then select the desired object in the image in the Visual Editor (Evaluation Zone).
At this time, in Layer, the name of a layer automatically selected by Mamba should appear;
if not, the user must select one manually.
Once the object has been selected, this selection is maintained throughout the whole clip,
whether or not the object goes outside the edges of the image or if another object passes
in front of it. The ID that defines this object is unique, so there is no chance of any
alteration happening in the selection, thus opening up a whole range of possibilities in both
composition and in Color Grading.
Position

Allows the selection of a group of objects based on their XYZ position. The coordinates and
the information relative to their position must be included in the EXR file being used.
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Parameters:

Layer
Defines the layer the effect will use to make the selection. This layer is set
automatically using the tool Pick Position if and when the EXR file contains a
recognizable layer as position coordinates.
Shape
Allows the selection the shape of the selection mask. There are two options:
Sphere
The mask will be a circle.
Square
The mask will be a square.
Center X
Shows and allows the selection of the X position of the mask.
Center Y
Shows and allows the selection of the Y position of the mask.
Center Z
Shows and allows the selection of the Z position of the mask.
Size X
Allows the size of the mask to be adjusted in the X-axis.
Size Y
Allows the size of the mask to be adjusted in the Y-axis.
Size Z
Allows the size of the mask to be adjusted in the Z-axis.
Size
Allows the size of the mask to be adjusted by the same amount in all axes.
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Softness
Sets the amount of softness of the mask used.
Use and comments:

To be able to select a group of objects in an image based on their position it is only
necessary to have the option Pick Position, in the Multilayer tab of the Visual Editor (found
on the right of the effect) active; then select the desired object in the image of the Visual
Editor (Evaluation Zone) to set the initial coordinates. At this time, in Layer, the name of a
layer automatically selected by Mamba should appear; if not, the user must select one
manually.
From this point the user can configure the mask by means of its parameters. Unlike
selection by ID, when selection by position is used, we do not isolate whole objects, but
rather the areas found at the chosen coordinates. The risk of using this type of selection is
that, depending on the size of the mask used, fragments or small groups of pixels located in
the same position as the areas we wish to isolate may sometimes be introduced. In this
case, we can adjust the softness of the mask, or combine the Alpha that results from this
operation with a secondary manual selection via manual masks, or by using Color Grade.
Depth

Allows the selection of a group of objects based on their Z position. The information of the
Z-axis or Depth Map must be included in the EXR file being used. This data can also be
generated from a stereoscopic image by calculating Parallax.
Parameters:

Layer
Defines the layer the effect will use to make the selection. This layer is set
automatically using the tool Pick Depth if and when the EXR file contains a
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recognizable layer as a Depth Map.
Shape
Allows the selecting of the depth mask that is to be used. The following options are
available:
Select Distance
Selects the objects found at the depth defined by the user in an EXR file.
Off Focus Distance
Selects the inverse of the previous mask.
Select Parallax
Selects the objects found at the depth defined by the user in a Stereo3D clip.
Off Focus Parallax
Selects the inverse of the previous mask.
Depth Z
Allows the adjustment of the position of the selection mask in Z.
Size Z
Allows the adjustment of the size of the selection mask in Z.
Softness Z
Sets the amount of softness of the mask used.
Use and comments:

To be able to select a group of objects by means of their Z-axis position, it is only
necessary to have the option Pick Object Depth, in the Multilayer tab of the Visual Editor
(found on the right of the effect) active; then select the desired object in theimage in the
Visual Editor (Evaluation Zone) to define its depth coordinates. At this time, in Layer, the
name of a layer automatically selected by Mamba should appear; if not, the user must
select one manually.
Once the initial depth of the mask is set, its size and softness can be adjusted. Unlike
selecting by position, in a Depth Map the size of the mask in X and Y axes cannot be
adjusted, since it uses the whole range of coordinates in both planes. The advantage is
that the selection in Z is cleaner, as it does not introduce areas or groups of unwanted
pixels that later have to be eliminated.
Possible uses:
Although the possibilities of these selection tools are infinite, thanks to the possibility of
combining them with other masks or effects in Mamba, perhaps the Depth Map effect is its
most obvious use. Thanks to Spatial Key the workflow is very simple:
1- Selection mask
Import the EXR clip and add the effect Spatial Key. With the tool Pick Depth choose
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the desired depth for our mask. Adjusting the parameters of the effect, we can adjust
the size and softness of the selection. The resulting mask is stored in Alpha.
2- Using the selection mask with Gaussian Blur effect
Next, add a Blur effect and configure it as we wish, not forgetting to to set the
parameter Mode as RGB-InA. This way, a selective blur effect is applied based on the
mask done with the Spatial Key tool.
Directional Light

Allows the selection of areas of reflection of the diffuse component of an image based on its
normals, and the alteration of these position in order to relight a scene. This information
must be included in the EXR file being used.
Parameters:

Layer Set
Sets which layer the effect will use to make the selection. This layer is set
automatically using the tool Pick Direction if and when the EXR file contains
information about the normals of the objects in the scene.
Tilt
Simulates the position of direct light as if it were a virtual sun.
RollZ
Allows the rotation of the zone of light incidences around an object in the Z-axis. If
there are numerous objects in the scene, their shadows and light incidences will also
logically rotate.
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Use and comments:

To be able to select the areas of light sources of an image by means of the normals of the
objects that compose it, it is only necessary to have the option Pick Direction, in the
Multilayer tab of the Visual Editor (found on the right of the effect) active; then select the
position of the light incidence of a group of objects in the scene in the image in the Visual
Editor (Evaluation Zone) to define its light incidence. At this time, in Layer, the name of a
layer automatically selected by Mamba should appear; if not, the user must select one
manually.
The most obvious use of this tool is the possibility of re-lighting a scene, and completely
change the lighting information of the scene. For example, it allows us to use the same 3D
environment at different times of the day, without needing to carry out different renders in
the CGI program from which the EXR comes.
Another use is the quick and easy selection of of light incidences in a 3D scene, allowing us
to calibrate the intensity of light and shadow with the Color Grade tool.
Integration with C olor Grade

The Spatial Key effect is especially useful in color correction as it allows much more precise
selections than can be made with manual masks. As a result of this Mamba integrates the
functionalities of Spatial Key in Color Grade, so that the user does not need to use Spatial
Key separately, and the selections made are imported automatically as External Keys to be
used as masks (see Color Grade for more information).
In this case, the parameters of each of the selection options explained above can be
viewed within the parameters folder of the color vector on which we wish to work. The
automatic selection is done, however, via the Multilayer tab of the Dashboard of the Visual
Editor. When using the effect Spatial Key separately, Mamba opens the Visual Editor with
the Multilayer tab already activated since it the only one relevant to this effect. However,
with Color Grade the default tab is that of the color correction panels, as the Multilayer tab
is a secondary selection function.

Thus, when we want to use the automatic selection tools of Spatial Key with Color Grade it
is only necessary to follow the following workflow:
1- Import an EXR or Stereo3D clip.
2- Apply a Color Grade to it and in the Visual Editor, select the Multilayer tab.
3- Use the automatic selection tools.
4- If we wish to adjust the mask, open the parameters folder of the chosen color vector,
and find the Multilayer subfolder. Depending on the tool used (Object ID, Position, Depth or
Positional Light), we will have to open different options. The remaining parameters are
common to those already explained in Spatial Key.
Bear in mind that when working in Color Grade, it automatically imports the selection made
using External Key, so that if we activate the Alpha of the image, we cannot see the
selection; for this reason, we should activate Highlight in the color vector. Practical
examples of each of the selection option follow below:
Object ID
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Following this workflow, we use the Pick Object ID tool in the Multilayer tab and select one
of the elements in the scene. Returning to the Grade tab and changing the Gamma, we can
see that the selected object automatically changes color. If we activate Highlight we can
see the selection more clearly.

Position
In this second case, the automatic selection is not enough, so we have adjusted the mask
via the parameters in the Multilayer folder of the vector in which we are working. Again, if
we activate the Highlight function we can see the selection more clearly.

Depth
This case is similar to the previous one, but as explained above, the depth selection does
not take into account the X and Y axes, but uses the full range of objects of those
coordinates, so that the intensity of the selection in those axes is the same. Only in Z is
there any alteration.

Directional Light
In this final example we can see the Highlight in the selection of the areas of light
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incidence, and the color adjustment done in these areas.

Alpha

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Alpha

The effects of the menu Alpha contain tools for manipulation of the channel alpha.
Note: the effects Grow, Shrink, Blur Alpha and ForeBlur are not documented here as they
are variations of eh effect Blur Filter.
Show

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Alpha->Show
More than an effect, ShowAlpha is a tool that changes the alpha channel to a grayscale,
thus permitting working with this channel as if it were an ordinary image. In this way, the
alpha channel of a clip can be separated so as to be able to use it as an external mask of
another one for example, obtain the silhouette of a cutout to be able to apply filters inside
it, use it as a displacement map, etc. In order to see examples of the use of this effect, see
the "Uses and Comments" of the ExternalKey effect.
C lear

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Alpha->Clear
The standard ClearKey is useful for preventing an unnecessary mask from interfering in the
input of subsequent effects.
For example, there are some processes which need a mask in order to work, although the
original mask is maintained intact in the output (HaloComp or Bump for example). This could
be a problem if rescaling the resulting image with a 3DComp is required, since the effect
respects the mask of the layer and composes it on the background of the effect. To avoid
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this problem, add a ClearKey to the result of the process working with mask, and later apply
a 3DComp.
The standard ExternalKey is limited to assigning (either normally or inverted) the luminance
of the second input as the alpha channel of the first. Its uses are diverse. Since this
standard is not a mask extractor, but rather an assigner of masks, it is useful for assigning
to an image a mask that has been previously extracted from a different image, or to assign
any mask to an image to be able to work with effects that work based on the information of
the mask or that can limit their effect to within the mask, such as color correctors or spatial
filters.

In the example, the original image is seen, and then the mask assigned by this effect. The
mask was previously extracted from the small image that accompanies the mask using the
Greenscreen effect, and later, a ShowAlpha standard shows in grey scale the mask
generated, so that the ExternalKey standard can reassign the mask. In the four following
images, different possible uses of this kind of assigning of external masks can be seen.
The first example simply composes the original image over a different image using a external
mask, using the 3DComp effect.
The second example is the use of LiquidBump. In this effect, an alpha channel is obligatory
to function and generate relief or refraction at the edges of the mask, as well as to specify
an interior color and a projected shadow.
The third example shows the addition of a color correction with the InAlpha activated,
restricting the correction to the area marked by the opacity of the mask. In this case, the
correction darkens the image within the mask.
The final example shows the use of the 3DComp effect for composing an image on top of
itself, whilst specifying a projected shadow via the parameters of the Shadow folder.
Invert

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Alpha->Invert
In order to simplify certain tasks, InvertAlpha has been included as a parameter in some
effects that are capable of assigning mask.
Remember that Mamba assigns an opaque alpha channel to the images without a mask by
default. Thus, if the image does not have a mask, application of InvertAlpha will result in a
completely transparent alpha channel.
This process is especially useful for making the alpha channel of a background in a
composition transparent, and when a ShowAlpha is added on top of the composition, the
sum of the alpha channels of the composed layers will be seen as foreground.
Three images are show in the following example. The first has not mask, so Mamba will add
an opaque value by default.
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If the images in this example were composed with a 3DComp effect to be able to modify
their size and placement, the resulting mask would be white, since the background of the
composition has an opaque mask assigned by default.
To obtain the mask of the layers modified by the 3DComp effect, it is necessary to invert
the default mask of the background image.

Crop

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Crop

The menu Crop includes two tools for cropping the image.
C rop

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Crop->Crop
Resets the edges of the input to the four sides of the frame, applying an RGB color outside
the new limits, with a constant mask value.
I/O

Inputs
Single input (with or without alpha information).
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Inputs
Image: Cropped on four sides by the specified color value.
Alpha: Mask cropped on four sides with the newly specified transparency value.
Parameters
Modes:

Mode
[RGBA (RGBA / RGB / A)]
RGBA applies the effect in the RGB and alpha channels.
RGB applies the effect only in the RGB channel.
A applies the effect only in the alpha channel.
Crop:

Left
[0, (0 / 100)]
Left edge as a percentage of the image width.
Right
[100 (0 / 100)]
Right edge as a percentage of the image width.
Up
[100 (0 / 100)]
Top edge as a percentage of the image height.
Down
[0 (0 / 100)] Bottom edge as a percentage of the image height.
Color:

Red; Green; Blue
[0; 0; 0 (0 / 100)]
Specifies the color to be applied from its new edges.
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Alpha
[0 (0 / 100)]
Specifies the opacity level to be applied from its new edges.
Use and C omments

This effect is useful for easy redefinition of the borders of a layer, although this effect
exists as a parameter in many mask extraction and composition effects, such as Bluescreen,
Greenscreen and Comp3D.
The redefinition of borders is useful in cases where undesired areas of the mask of a layer
are to be removed, produced, for example, by having undesired objects in the background,
or if the set does not fill the complete image.

Another example is the removal of the black borders generated in some video formats by the
lack of signal from the mask, or when viewing the movie camera window.
The four edges can be specified from the Visual Editor by using the crop manipulators,
dragging them from their default position the original borders of the frame. The color can be
specified with the color Chooser, to use the effect for coloring an area of the frame.

It is possible to apply tracking coordinates to each edge of Crop.
C rop Expand

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Crop->Crop Expand
Crops the input alpha channel on the four sides of the frame, filling the discarded image
area with an expansion of the color of the pixels in the new edge.
I/O

Inputs
Single input (with or without alpha information).
Inputs
Image: Cropped on four sides by the expansion of the pixel values in the newly
specified edge.
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Alpha: Mask cropped on four sides of the frame.
Parameters

Left
[0 (0 / 100)]
Left edge as a percentage of the image width.
Right
[100 (0 / 100)]
Right edge as a percentage of the image width.
Up
[100 (0 / 100)]
Top edge as a percentage of the image height.
Down
[0 (0 / 100)]
Bottom edge as a percentage of the image height.
Use and C omments

This effect has a similar use to the effect Crop, with the additional function of expanding
the color of the pixels in the new edge.

Deform

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Deform
The effects that modify the forms of images.
Note: The effects Distort, Bump and LiquidBump, are not documented here since they are
variations of the Refract effect.
Warper

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Deform->Warper
Permits the deformation of images with an advanced control based on a wipe that can be
animated.
This effect has two different typical uses:
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Warping: complex deformation of an image.
Morphing: complex transition based on a change of shape (metamorphosis).
I/O

Inputs
Single input: Image with or without alpha channel for warping.
Double input: Images with or without alpha channel for morphing.
Inputs
Image: Warping or morphing of the images.
Alpha: Warping or morphing of the masks.
Warper Editor

This effect has its own interface (Warper Editor) in which the deformation grid is controlled.
Access to the interface is in Mamba->Visual Editor->Dashboard->Warper.

To explain the functioning of this effect, the section of "Uses and Comments" has a simple
example of morphing between two fixed images of an apple and a pear.
The interface is divided into four areas: Canvas, Keyframe Slider, Quick Access and
Dashboard.

Canvas:

The Canvas is located in the upper part of the interface. It where the image to be deformed
is viewed and where the positions of the points that form the grid are defined.
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Inactive Canvas is the area that exceeds the image resolution for which the system is
configured. Mesh points can be located in this area, although the result of the deforming will
not be seen, as it will exceed the limit of the frame.
Meshes are made up of horizontal (Row) and vertical (Column) lines of a number defined by
the user.
The intersections of the lines define control points, Mesh Points. Each control point has a
definable position and tangents (Tangent) for defining angles of tension in the lines that
meet.
The part of the mesh that delimits a rectangle joining four points is a Cell. Within each Cell,
a common polygonal subdivision is defined, allowing greater flexibility for distortions.
The polygonal subdivision is definable from the parameters of the effect, although it is not
visible from the manipulators. However, a viewing aid is available which shows a fixed
subdivision (Draw Patches) which is useful for orienting the user in the polygons within a
Cell. This is important since a Cell is a rectangle which, in its interior, especially when
editing tangents of a Mesh Point, can contain polygons with an irregular distribution.
Keyframe Slider:

The Keyframe Slider allows the addition of keyframes and specify their values according to
their position in time. In the case of animations, whether they are warping or morphing, at
least two keyframes are needed. in the case of a morphing, each source must be animated
independently.

The keyframes that the mesh contains are viewed in the Keyframe Slider. To move a
keyframe, select it with the mouse cursor while holding down <Ctrl>. Its temporary value
within the effect thus changes.
If the effect Warper is to be used to carry out a warping effect (whether animated or not)
the interface automatically deactivates Source, viewing and control modes in the Canvas
and the Dashboard. If, on the other hand, a morphing effect is to be carried out, the
Warper Editor works in two image modes: Source and Destination. Source keyframes will be
red triangles in the upper margin, and Destination keyframes will be green triangles in the
lower margin. In the whole interface, Source is identified by red and Destination in green.
The white diamond indicates the currently viewed frame.
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Quick Access:

Quick Access is an access bar for frequently used commands. It has two basic functions for
controlling viewing: zoom and playback. There is also the button Exit, which returns the
user to Visual Editor.
Dashboard:

In the lower area is the Dashboard, which possesses different groups of functions,
described below:

Drag Mode
Activates and deactivates this editing mode for editing points. This mode facilitates
the location of mesh points, since various points can be dragged simultaneously,
according to the radius of influence defined.
Drag rad
Permits the definition of a value to the radius of a stroke for dragging the points of a
grid according to the direction of the stroke.
Source controls the origin position of the mesh.
Show Image
Shows the origin image in the Canvas, corresponding to the first input of the effect.
Show Mesh
Shows the origin mesh, in red. Both for warping and morphing, the shape of the origin
mesh must replicate the origin image.
Reset Key
Eliminates the modifications of position of the Mesh Points, returning the mesh to the
standard position.
Delete Key
Deletes the keyframe present in the current frame.
Bring Key
Pastes a copy of the position of the current frame of the opposing source, creating a
keyframe.

SGO Mamba 2.0.1 © 2014 SGO

306

FX

Clear All Keys
Deletes all keyframes of the current source.
Bring All Keys
Pastes a copy of all the keyframes of the opposing source, making both sources
identical. This function eliminates all previously established keyframes of Source, and
so this action requires confirmation to be activated.
Destination controls the destination position of the mesh.
Show Image
Shows the destination image in the Canvas, corresponding to the second input of the
effect. If the effect has only one input, Destination is viewed as first input.
Show Mesh
Shows the destination mesh, in green. In cases of morphing, the shape of the
destination mesh must replicate the destination. In the case of warping, the shape of
the destination mesh is irrelevant.
Reset Key
Eliminates the modifications of position of the Mesh Points, returning the mesh to its
standard position.
Delete Key
Deletes the keyframe present in the current frame.
Bring Key
Pastes a copy of the position of the current frame of the opposing source, creating a
keyframe.
Clear All Keys
Deletes all keyframes of the current source.
Bring All Keys
Pastes a copy of all the keyframes of the opposing source, making both sources
identical. This function eliminates all previously established keyframes of Destination,
and so this action requires confirmation to be activated.
If both buttons of Show Image are active, the result of the effect in the current
frame is shown, indicated by the slider.
If both buttons of Show Mesh are active, the result of the interpolation of the mesh
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between Source and Destination is shown, as a blue mesh.
Note: there is no function that allows the copying of a keyframe of the mesh to
another position in time in the same source. However, there is a trick for achieving the
same result via Bring Key:
Copy the keyframe to the other source (Bring Key)
Move the copied keyframe to the new destination position.
Use Bring Key again in the other direction to bring the keyframe to the previous
source, and then delete the intermediate copy.

View controls the viewing of components of the mesh.
Draw Points
Activates the viewing of control points of the mesh.
Draw Lines
Activates the viewing of mesh lines.
Draw Thicker
Activates the viewing of a black frame round the lines of the mesh, to make viewing
easier.
Draw Tang
Activates the viewing of the tangents of the control points of the mesh.
Draw Patches
Activates the viewing of an orientative subdivision of the cells of a mesh.
Dim Other
Makes the viewing of the unselected part of the mesh semitransparent, thus helping
concentrate attention on the points being edited.
Undim All
Undoes Dim Other, making the viewing of the whole mesh opaque.
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The Edit functions modify parts of the mesh.
Select All
Selects all Mesh Points of the visible mesh.
Select Row
Selects other points in the horizontal line that pertain to the selected points.
Select Column
Selects other points in the vertical line that pertain to the selected points.
Add Line
Duplicates the selected line. After clicking this button, the position of the new line
must be defined by clicking in another part of the mesh. The temporary state of the
line without a defined final position is shown in white, for ease of identification among
the lines of the mesh.
Delete Line
Deletes the selected line of the mesh.
Reset Tang
Resets the default values of the tangents of the selected points. The edited tangents
are yellow, while those with default values are the same color as the mesh.
Key has two buttons.
Auto Fix
Automatically adds a keyframe in the TimeSpace each time a modification in the grid
of the Canvas is done.
Add Key
Manually adds a keyframe in the current frame.
File has three buttons.
Save Mesh
Saves the source position that is viewed as a grid, making possible the future of this
in other Warper effects.
Load Mesh
Loads one source position of the grid.
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New Mesh
Defines a new grid, defining the subdivision of the frame by number of vertical and
horizontal cells.
Note: the extension of the grid file is .msh. The grid files are deposited in the OUTPUT folder
of the current project.
Parameters

Grade
[0 (0 / 100)]
Evolution of the interpolation of the mesh position sources.
A value of 0 indicates the Source position; a value of 100 indicates the Destination
position.
Mix
[0 (0 / 100)]
Evolution of the mixing of distorted inputs.
A value of 0 indicates the image of the first input; a value of 100 indicates the image
of the second input. If there is no second input, this parameter will be ignored.
Subdiv
[10 (0 / 128)]
Polygonal subdivision of the mesh cells.
Dir
[0 (0 / 1)]
Reverses the direction of the mesh position sources, interchanging Source and
Destination.
Use and C omments

This effect has two typical uses: transformation between two images for a transition (
morphing) or distortion of an image (warping), which can have multiple uses.
Warping can be used to distort an image arbitrarily, and we recommend the use of Drag
mode in the additional interface in this case.
It is also the ideal tool for correcting perspectives. To do this, only a few mesh lines should
be used, in order to match the image escape lines with the Source, and then correct them.
In this case, we recommend aligning the Source Mesh Points in the inactive area (outside of
the image), thus making it possible for a few lines to control the perspective of the image to
be corrected.
This tool is ideal when it is necessary to distort a texture to cover a figure in an image, as
Source can be specified as a flat mesh, and Destination as the shape of the figure, and
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thus give texture to the desired figure. A typical example of this is the replacement in postproduction of the label of a cylindrical container, such as a bottle. Other effects, such as
CornerPin, cannot distort the image adequately, since they do not have control points with
tangents.
Another common use, whether for warping or morphing, is the joining of cuts from different
takes to produce a single longer sequence, when it is not possible to shoot as a single shot.
An example might be a shot that appears to enter from outside a window to inside in single
take without cuts.
To explain a simple method of creation of Morphing, a basic example of transformation
between static images of an apple and a pear will be used.
Start by selecting a viewing mode of the Source image and the Source mesh.
Next, specify a new subdivision of the mesh with the number of cells.
Pressing the New Mesh button will cause a dialog to appear, in which subdivisions in X and Y
will each be specified to have a value of 1.

To add horizontal and vertical lines, it is recommendable to duplicate those already created.
To do this, use the commands Select Row and Select Column or select an area by dragging
the mouse. Once selected, the lines can be duplicated via the command Add Line. By means
of this method, we can locate the lines in the best places in order to wrap the image with
them.
To carry out this adjustment, it will be necessary to move the Mesh Points to locate them
on the shape of the figure and fix the points of the interior of the figure simulating the
image's volume. To do this, it is best to edit the tangents of the points, activating their
visualization via the command Show Tangents.
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The mesh should cover the image, simulating the parallels and meridians of a globe.
Once the mesh has been situated in Source, select the image and mesh view Destination.
Then bring the shape of the opposite mesh with Bring Key.

If the grid is not very visible, its black border can be activated with Show Thicker.

Once the opposing mesh is obtained, the mesh points of the target image should be
readjusted. In this example, the shape of the apple can be seen superimposed on the image
of the pear.
When adjusting the points, try to reassign their positions to more coherent places that can
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be considered of similar meaning. For example, the points that surrounded the apple stalk
should be placed around the pear stalk, the points of the apple outline in the pear outline,
and the interior points in such a way as to resemble the shape of the pear.

The mesh is correctly placed on the image target. But the polygonal subdivision in each cell
is poorly distributed, so that it does not correspond to the image volume.
Show Patches should be activated as a viewing guide for the adjustment of the interior of
each cell. Then adjust the tension of the tangents to improve the distribution of the patch.
This same should also be done with the Source mesh.
When the tensions of the tangents have been adjusted, the functioning of the effect can
be checked.
To do this, the view of both images should be activated, and the current frame then moved
with the slider.
If there are anomalies, the mesh can be adjusted by viewing the average degree of
interpolation. This is very useful for interactively viewing the changes in the mesh caused
by interpolation of the effect, especially to adjust the points that are in the outlines of the
figures. Bear in mind that in order not to create unwanted keyframes, the Auto Fix mode
should be turned off, thus making sure that all the changes will be applied to the original
mesh in the first frame.
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To adjust the internal points of the figure, it is very useful to be able to see the warping
that is produced in each image separately. To see the warping of a single image, the value
of the Grade parameter should be reset.
This way we can view how the texture is adjusted in the deformations produced by the
effect. To adjust the texture, its tangents should be used.

The end result of the effect is, in sum, two contrary deformations that are mixed together
with a fade.

The progress of the fade is set in the Mix parameter, and the evolution of the deformation is
set via the Grade parameter.
We recommend experimenting with these parameters (accelerating and decelerating their
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curves) since when the fade is less visible, the impression of metamorphosis of the effect is
better.
The invert parameter is recommended to return to a previous warp. For example, if a copy
of the same Warper is placed on top of the warping made, but with the invert parameter
with a value of 1, the deformation will be reversed, since it will be applied inversely.
The higher the value of the subdiv parameter, the better the deformation will react to the
tension and angle of the tangents. Subdiv does not specify a global polygonal subdivision for
the whole image, but only for the internal subdivision of the cell, and for this reason the
number and size of the mesh cells should be borne in mind.
Subdivision with excessive values can slow the render time, and we recommend adjusting
the parameter unit by unit, and always viewing the image result. After a certain value it will
be seen that more subdivision does not improve the quality of the deformation, and this
subdivision threshold gives the optimum value.
For standard resolutions, a good generic value is 10, whereas for high definition a value of
25 is generally recommended.
In cases where the inputs of the effect are images in movement, the position of the points
of the mesh should be adjusted in each frame, generating keyframes both in source and in
destination.
This the reason that morphing between images in movement is much more complicated to
configure than morphing between static images.
Refract

Ref.
Mamba:
(Relief)

TimeSpace

Editor->Dashboard->Fx->Mamba->Deform->Refract

The parameter Refract generates a distortion in the image via the interpretation of the
borders of a refraction map, resulting in an effect to refraction.
I/O

Inputs
Single input: Image with alpha channel. The alpha channel will be used as a relief
map.
Double input: The first input (with or without alpha channel) is the image to be
distorted, and the second input is the relief map. Thus the alpha channel of the
second input is preserved,
Inputs
Image: Distorted image.
Alpha: No change, or eroded by refraction, as specified in RebuildK parameter.
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Parameters
DisplaceMap:

Folder containing the parameters that specify the sense of height of the effect.
Blur
[1 (0 / 100.000)]
Blurs the distortion map before being applied. The result of this blurring reduces the
details of the refraction and magnifies the edges of the relief.
ClampLo
[0 (0 / 100)]
Lower limit of the generated relief. Visually, this means a threshold is created, giving a
sensation of lifting slightly from the relief.
ClampHi
[100 (0 / 100)]
Upper limit of the generated relief. Visually, this means a cut that creates a plateau
sensation.
Amplitud
[100 (-100.000 / 100.000)]
Specifies the simulated height of the relief effect. This means, visually, a greater
contrast of light and shadow affecting the edges created by the distortion map, and
also the amount of refraction generated.
Liquid
[Off (Off/On)]
Activates a liquid-style refraction mode. Visually, this means a feedback of specified
refraction.
RebuildK
[Off (Off/On)]
Specifies that the alpha channel of the out put of the effect is placed in the
refraction map modified by the same erosion as the generated refraction.
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Mode:

Folder that contains the parameters that specify the render mode of the effect.
Mode
[Hware (Hware/Sware)]
Specifies the processing mode (hardware graphic or just software).
Distort:

Folder that contains the parameters that specify the applied refraction.
DirX ; Y
[0;0 (-100.000 / 100.000)]
Amount of horizontal and vertical distortion.
Zero
[50 (-100.000 / 100.000)]
Distortion map value that specifies X and Y without distortion.
Refract
[0 (-100.000 / 100.000)]
Amount of refraction applied (visible at the edges of the relief). To make these
borders bigger, increase the Blur parameter)
Angle
[0 (-100.000 / 100.000)]
Specifies a rotation angle for the interior of the refraction.
Antialias
[x1 (x1, x2, x3, x4, x8, x15, x24, x66)]
Number of sample for the refraction effect. High values specify greater quality
samples, noticeably improving the resulting image quality, visible in the details.
Ambient:

Folder that contains the parameters that specify ambient light.
Intensity
[100 (0 / 100.000)]
Intensity of the ambient light.
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Red
[100 (0 / 100.000)]
Defines the value in the red channel of the ambient light.
Green
[100 (0 / 100.000)]
Defines the value in the green channel of the ambient light.
Blue
[100 (0 / 100.000)]
Defines the value in the blue channel of the ambient light.
Diffuse:

Folder that contains the parameters that specify the appearance of the lighting generated
by the effect .
OffsetX
[26,430 (-100.000 / 100.000)]
Position of the virtual light of the effect. This parameter can be defined with the 2D
manipulation mode.
OffsetY
[73,570 (-100.000 / 100.000)]
Position of the virtual light of the effect. This parameter can be defined with the 2D
manipulation mode.
Intensity
[0 (0 / 100.000)]
Intensity of the virtual light of the effect.
Red
[100; 100; 100 (0 / 100.000)]
Defines the value in the red channel of the ambient light.
Green
[100; 100; 100 (0 / 100.000)]
Defines the value in the green channel of the ambient light.
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Blue
[100; 100; 100 (0 / 100.000)]
Defines the value in the blue channel of the ambient light.

Specular:

Folder that contains the parameters that specify the specularity of the processed image.
Gloss
[24 (24 / 100.000)]
Specifies the gloss the processed image.
The higher this value, the more the intensity of the gloss produced by the virtual
lights will be concentrated.
Intensity
[0 (0 / 100.000)]
Intensity of the specularity of the processed image. The higher this value, the more
the brightness produced by the virtual lights will be reflected.
Red
[100 (0 / 100.000)]
Defines the value in the red channel of the color of the specularity of the processed
image. This parameter colors the brightness produced by the virtual light.
Green
[100 (0 / 100.000)]
Defines the value in the green channel of the color of the specularity of the processed
image. This parameter colors the brightness produced by the virtual light.
Blue
[100 (0 / 100.000)]
Defines the value in the blue channel of the color of the specularity of the processed
image. This parameter colors the brightness produced by the virtual light.

SGO Mamba 2.0.1 © 2014 SGO

319

FX

Image:

Folder containing the parameters that transform the image before being processed by the
other parameters of the effect.
Zoom
[100 (-100.000 / 100.000)]
Amount of zoom of the image.
Anamorp
[0 (-100 / 100)]
Defines the anamorphic aspect of the applied effect.
The default value indicates that the filter will act symmetrically between the vertical
and horizontal axis. Positive values restrict the action of effect the vertical axis
gradually, while negative values restrict it to the horizontal.
OffsetX
[0 (-100.000 / 100.000)]
Amount of horizontal offset applied to the original image.
OffsetY
[0 (-100.000 / 100.000)]
Amount of vertical offset applied to the original image.
Perspective:

This attribute is applicable to stereoscopic images.
InterOcular
[0.2 (0 / 100.000)]
Modifies the values of the interaxial separation of the distortion applied to the
stereoscopic image. The higher the InterOcular value, the more exaggerated the
stereoscopic effect will be.
Use and C omments

This effect is accessed via the effect buttons Refract, Distort, Bump and LiquidBump.
This effect has many possible applications, such as to simulate refraction or reflection. The
refraction map, in contrast to distortion or other maps, is interpreted according to the
detected edges of the image, and not the luminance values of its pixels, so the color of the
image is also taken into account. A solid color as a distortion map produces no distortion,
whatever the color, since it is the contrast between the pixels that is evaluated in
refraction map.
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The results of this effect can also be combined with other effects to simulate reflection, for
example.

This effect is very useful for creating metallic materials for logos etc.

This effect is also useful for distorting reflections or shadows added to a composition,
copying the relief onto which they are projected
In this example, it can be seen how the Refract effect can be useful in copying the relief of
a background (even in movement) and applying the distortion for the shadow projected to
integrate the character onto the new background. in this example, the same background
image is used as both refraction map and shadow mask.
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The effect can also be used to copy the relief of surfaces where it is necessary to apply a
reflection. In this example, it is necessary to add a reflection of a composed character,
since the wet ground reflects people walking on it, as can be seen in the background shot.
This reflection must be distorted to match the roughness of the ground. In this example,
the same background image is used for the refraction map of the reflection.

The DirX; Y parameters distort an image using a distortion map horizontally and vertically
independent.
Following the luminance of the pixels of the distortion map image, the pixels of the distorted
image are moved horizontally or vertically, as defined in the parameters of the effect.
This allows it to be used, for example, to distort projected shadows or reflections that need
to copy the visible roughness of a surface, such as water, floors, leaves etc.
Although the parameter Refract can achieve a similar result (and sometimes better), Distort
also has a different distortion map for each axis.
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In this example we see the usefulness of the distortion parameter DirX, working just
horizontally. The distortion map that is used simulates the split focus ring of a stills camera
viewfinder. If the parameter OffsetX is animated between positive and negative values, we
see that the image distorts as if through a stills camera lens being focussed.

The distortion map has a mid-grey background, which will not distort the image since the
Zero parameters of the effect are at 50, while the black distorts in a direction the opposite
to white.
This effect is also generally useful for assigning a material to a layer, for example text
generated with the effect Title or a logo.
This effect can later be composed thanks to the fact that the deformations of the edge of
the layer are also reflected in the alpha output channel, via the parameter RebuildK.
By properly controlling the parameter Refract, materials similar to water or glass
simulated, and with negative values, metal or mirrors can be simulated.

can be

This effect is also generally used for adding relief to the edges of a layer, for example text
generated with the effect Title or a logo.
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In this example, the alpha channel assigned to the image functions as a distortion and relief
map.

Negative values invert the direction of the relief. By controlling the height of the relief with
the parameters ClampLo and ClampHi, it is possible to create bevelled edges. Because the
alpha channel is conserved intact in the output of the effect, it is possible to compose the
processed layer over other images.

Twirl

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Deform->Twirl
Creates a spiral-shaped distortion based on a definable center.
I/O

Inputs
Single input: Image with or without mask.
Inputs
Image: Distorted image.
Alpha: Distorted mask.
Parameters
Twirl:

Ang
[0 (-100.000 / 1.000.000)]
Spiral distortion angle.
NRad
[50 (-100.000 / 1.000.000)]
Specifies the value of the radius between the center of the spiral and its first torsion
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ring. When this parameter is animated, the spiral created by the effect rotates.
Move X; Y
[50; 50 (-100.000 / 1.000.000)]
Center of the spiral as a percentage of the image.
Zoom
[100 (-100.000 / 1.000.000)]
Scale of the result of the effect.
Offset:

Folder containing two-dimensional image repositioning parameters.
Shift X; Y
[0; 0 (-100.000 / 1.000.000)]
Offset of the original position of the image on the spiral distortion.
Use and C omments

This effect is useful for making fast and simple deformations of images.

For more complex deformations, we recommend using the Warper effect.
Thanks to the spiral deformation of the effect, it is possible to create spirals that can be
animated, based on distorting a simple mesh that divides the image into black and white
halves.

In these examples, the NRad parameter acts on the rotation of the spiral. In the "Spiral"
example, the rotation of the spiral will produce a psychedelic effect as a result. A part of
the periphery of the spiral can be seen in the "Waves" example, and when the parameter
NRad is animated, the waves will be seen to advance as a result.
This effect can be used as an interesting deformation for application to any mesh; for
example, curving stripes.
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Another powerful effect for generating waves is the effect Wave.
Kaleido

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Deform->Kaleido
Generates a kaleidoscopic effect in the image, cutting it into reflective triangles.
I/O

Inputs
Single input: An image with or without mask.
Inputs
Image: Image with kaleidoscopic effect.
Alpha: Mask with kaleidoscopic effect.
Parameters

Angle
[0 (0 / 100.000)]
Specifies a rotation angle for the kaleidoscope triangles.
Size
[20 (1 / 100)]
Size of the kaleidoscope triangles.
Use and C omments

The purpose of this effect is simply to simulate a rotating triangular kaleidoscope.
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Image

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image

Amongst others effects, this menu includes tools relating to Optical Flow (Motion
Estimation) technology, such as the modification of playback speed of a sequence or
restoring an image.
It also includes tools for drawing on an image or generating vectorial masks and adding grain
in the style of film.
Note: the effects Grow and Shrink are not documented here, since they are variations of
the Blur effect.
VectorPaint

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->VectorPaint
This effect permits freehand drawing or by using shapes and rotoscopes, including different
brushes, based on vectors that can be animated. It can be used in many types of tasks,
such as:
Freehand painting with brushes or geometric shapes.
Manual restoration of images, using Repair Mode (Motion Estimation) and with brushes such
as Clone and Reveal.
Creating masks, manually frame by frame or with the assistance of tracking tools.
Manual composition of parts of an image on another.
I/O

Inputs
Single input: Image with or without alpha channel.
Double input: Images with or without alpha channel for composing.
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Inputs
Image: Image with specified vectorial drawing (at 16 bits per channel color depth).
Alpha: Mask with specified vectorial drawing.
Parameters

These parameters simply possess the coordinates for the position of tracker animation.
PosX; PosY
[50; 50 (-10.000 / 10.000)]
Two-dimensional coordinates that can be pasted to the vectorial shapes that the
effect has.
Paint Editor

Ref. Mamba: Visual Editor->Dashboard->Paint
Paint is the extra interface of Vectorpaint in which vectorial shapes are drawn. Access to
the interface is in Mamba->Visual Editor->Dashboard->Paint.

The use of vectors for painting on the image and the alpha channel maintain intact the
original source files, allowing a non-destructive functioning. The vectorial information of the
brushstrokes is stored as data, thus avoiding the modification of the original or the
obligatory creation of a new file.
Thus the brushstrokes pertain to the clip of the effect, and can be applied to any other
clip, moving or copying this effect in the TimeSpace Editor.
To illustrate the normal functioning of this effect, an image of a face on a red background
will be used as input. In the examples where the image mask is seen, a mask extracted by
the selection of the red background is used. In examples where a second input is seen,
noise generated by the Noise effect is used as the background.
The Paint interface is divided into four areas: Canvas, Quick Access, Keyframe Slider and
Dashboard.
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Canvas:

The Canvas is located in the upper part of the interface. It is where the image is viewed
and where the positions of the vectors are defined.

Keyframe Slider:

The Keyframe Slider allows the addition of keyframes and the specifying of their values
according to their positioning in time. In the case of an animation, at least two keyframes
are necessary.
In this frames grid, the keyframes added to the selected shape can be seen as green
triangles. These keyframes can be moved in time, thus redefining their temporal value. The
white triangle indicates the current frame within the ruler. The grey box of the white
triangle indicates the current frame. To move a keyframe, select it with the mouse cursor
while holding down <Ctrl>. This changes its temporal value within the effect.
The Position Box allows the user to jump directly to the desired frame by the introduction
of the corresponding value.
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Fields activates the vector draw mode by fields for interlaced images. Each field of a frame
can have different vectors. Interpolation of the vectorial animations is also done with fields.
This mode should be specified before beginning to draw on the image, since any subsequent
change of mode can provoke temporary disorder in the location of the vectors already
generated.
The Back button returns the user to the Visual Editor.
Quick Access:

Quick Access is an access bar to frequently used commands.

Hide
Gives the option of hiding the Dashboard for better viewing and working on the
Canvas, once the tool and its parameters are selected.
Zoom In; Zoom Out; Zoom Center; Zoom Reset
Modifies the viewing size of the Canvas. They also control the zoom via the central
mouse wheel.
Go to Header
Establishes the first frame of the effect as a new position.
Prev K
Establishes the frame immediately prior to the current one containing a defined
keyframe as a new position.
Prev F
Establishes the frame immediately prior to the current one as a new position.
Play F / Stop
Controls the frame to frame playback of the effect.
Next F
Establishes the frame immediately after the current one as a new position.
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Next K
Establishes the frame immediately after
keyframe as a new position.

the current one containing a defined

Go to Tail
Establishes the last frame of the effect as a new position.
Dashboard:

The Dashboard operates in the modes Paint, Text and Setup, which can be accessed via
their corresponding Options Tabs.

The submode Paint Editor works with three principal modes (Paint, Select and Transform)
whose activation displays or hides specific command groups.
View
Image activates viewing of the input image of the effect.
Alpha activates viewing of the alpha channel of the effect.
When Image is also active, the alpha channel is superimposed on the image in a
definable color (blue by default).
The value box Display controls the opacity of the mask superimposed ion the image.

Image
Mix Frames activates mixed viewing, useful for comparing two images while working on
the effect.
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FG sets the image to be mixed in the viewing of the original image as the foreground
(or the second input if there is one).
If BG is active, the mixed image is the background (first input).
The Mix values box controls the mix level between the original image original and the
image specified to be mixed.

The Offset values box indicates the number of frames of temporary offset for the
image specified to be mixed.

Alpha
The command Clear alpha eliminates any mask that the input may possess, replacing it
with a transparent mask. Once the original mask original of the input is eliminated, a
new mask can be drawn.
The mode Composite is used so that the effect functions like a composition effect in
both its inputs at the same time. Thus, this mode is ignored if the effect has only one
input.
This mode is recommended in cases where it is necessary to create masks of an image
but view the result of the composition, allowing the user to paint interactively in the
alpha channel while viewing the final composition.
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Color
Pick Color allows the defining of a paint color by copying the color of an image's pixel,
selected by clicking this button.
Above this button a box shows the current color.
Pick Alpha allows the defining of the alpha channel level for the paint by copying a
pixel value from the selected mask.
Above this button a box shows the current level, representing a transparency over
black of the defined color for tinting the viewing of mask.
The sliders and buttons of the Color Chooser define the paint color. The tabs
represent available palettes: RGB, HSL, Color Wheel (Hex) and a library of definable
colors (Lib). It is also possible to change the viewing mode by activating the button
WYSWYG. The button Pick Color of the Color Chooser, unlike the button Pick Color at
the head of the group, works when holding the mouse button until the cursor is over
the chosen color and then releasing it.
Apply
This group allows the defining of which vectorials or shapes are to be applied in the
image channels (Apply Image), in the alpha channel (Apply Alfa) or in both. The
Pressure box defines the level of opacity of the brush. The box Level defines the level
of opacity of the brush applied in the alpha channel.
Stencil
The Obey button specifies that the paint applied to the image only affects the
transparent areas of the alpha channel, protecting the opaque areas of the same from
being painted. In other words, it activates the use of the alpha channel as a mask.
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Brush
The size of the brush is defined from the values box Brush Size or by pressing
<Ctrl>+<Shift> with the mouse cursor over the image (only when the Paint mode is
set as brush).
The default command Soft activates a brush with soft edges. If the button Hard is
active, the brush will have hard edges.
The default brush is Paint.
Paint paints on the image with the color specified in the Color Chooser and on the
alpha channel with the level specified in the box Level (Alpha) of the group Apply.

Tint paints by modifying the hue and saturation of the image according to the value
specified in the Color Chooser, ignoring the brightness of the selected color.
Tint is not applicable to the mask.

Lighten lifts the brightness of the colors of the image without bleaching them, ignoring
the value specified in the Color Chooser.
In this mode the value specified in the Pressure box alters the intensity of brightness.
Lighten is not applicable to the mask.
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Darken darkens the brightness of the image by half with each brushstroke, ignoring
the value specified in the Color Chooser. Unlike painting in black paint with Paint, the
same brushstroke cannot accumulate the effect of repeated strokes.
Darken is not applicable to the mask.

Drag pushes the pixels of the image and the mask in the direction brushstroke, with
the force equivalent to the speed of the brushstroke.
In this mode the value specified in In this mode the value specified Pressure box
scales the force of the stroke Pressure box scales the force of the stroke.

Extend paints on the image and mask with the color and level of mask of the pixel
where the stroke begins, ignoring the value specified in the Color Chooser and the
Level (Alpha) box of the group Apply.

Blur gently blurs the pixels of the image and mask.
In this mode, the value specified in the Pressure box scales the force of the blurring.
Reveal Fore paints on the original image, reverting the actions of other strokes in
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other modes. If the effect has two inputs, Reveal Fore specifies that it will paint with
the first input.
Reveal Back is a brush designed to work with two inputs. In this case, Reveal Back will
paint by composing the background (first input) over the foreground (second input). If
the effect has only one input, Reveal Back behaves identically to Reveal Fore.

Clone Fore paints with an offset copy of the original image. To select the origin of the
offset, select one point of the image while holding down <Alt>. Then choose the
destination of the offset by drawing directly on the image.
If VectorPaint has two inputs, Clone Back will copy the background (first input) on the
foreground (second input). If the effect has only one input, Clone Back behaves
identically to Clone Fore.

Distort applies a distortion in the image and mask according to the direction of the
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stroke, with the size of the brush being the limit of the action. In this mode, the brush
is viewed mush larger than the defined size. The speed of the stroke defines the
amount of distortion applied.
In this mode the value specified in the Pressure box is ignored, as the size of the
brush is more important.

Repair with virtual Frame is an image restoration mode. The brush uses motion
estimation techniques to reconstruct the areas where it is applied. Thus, when
drawing on damaged areas of a frame, tracking of the same pixels in the previous and
subsequent frames is carried out without taking the current frame into account, which
normally permits the reconstruction of the area below the brush. This mode can only
work if there is only one input in VectorPaint.
Mode
The work mode of the interface is defined with Mode.
Brush activates the creation of brushstrokes on the image. In this mode, the vectors
are hidden.
Select activates the mode allows the selection of vectors, showing the points and
vectorial lines that make up shapes and brushstrokes.

Transform activates the vectorial shape manipulator once it has been selected.
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This manipulator is a rectangular box with small square manipulators in its corners and
midpoints of each side. When the side manipulators are pressed, rescaling in the axis
dividing the square is activated.
When the corner manipulators are pressed, rescaling of the selected shapes is
activated. To rotate a shape, click on any manipulator while holding <Alt> at the
same time to set the angle of rotation.
When clicking inside the manipulator without touching the small squares or the
keyboard, the manipulator will move the selected shapes.
Undo/Redo
Undo Point undoes the creation of the last generated vectorial point.
Redo Point redoes the last vectorial point undone by Undo.
Last Shape undoes the creation of the last generated vectorial shape.
Grid
Snap activates the mesh magnet. When moving a shape, the only possible positions
will be the mesh intersections, and drawing will only be possible along the mesh lines.

Creation
Rectangle specifies the creation of rectangles. If regular rectangles are required, hold
<Shift> while defining the rectangle.
Circle specifies the creation of circles. If regular circles are required, hold <Shift>
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while defining the circle.
Poly Line specifies the creation of polygonal shapes by means of control points that
are set with each click on the image.
Curve Line specifies the creation of rounded shapes by means of Bezier-type control
points created with each click on the image.
Modify
Insert inserts control points in any vectorial line.
Add continues adding points after the last point created, thus modifying the selected
shape.
Type of points
Sharp eliminates the tangents of the selected control points. When dealing with a
shape, it will become a polygon.
If Smooth is active the shape or line created will be formed by B-Splines. As there is
less control of the tangents than the Bezier-type splines, manipulation and work with
B-Splines is easier. Furthermore, the precision of B-Splines is usually sufficient when
adjusting a shape.
If Connected Tang is active the shape or line created will be created with Bezier-type
splines whose nodes can be modified together.
If Independent Tang is active the shape or line created will be created with Beziertype splines whose nodes can be modified independently.
Edit shapes
Cut moves the selected vectorial shape to the clipboard.
Copy makes a copy of the selected vectorial shape on the clipboard.
Paste pastes a copy of the selected vectorial shape on the clipboard in the current
frame.
Del deletes the selected vector.
Shape attributes
Close closes the selected vectorial shape, joining its first and last points with a line.
Fill fills in closed vectorial shape. When Fill is active, the vector ignores the size of the
brushstroke, since the vector is only used only to limit the shape, in the paint mode
possessed by the vector.
Shadow creates a shadow by duplicating the result of the vectorial shape, and
assigning color opacity and offset values.
Soft activates a pair of tangents (called Radials) in each control point of the selected
shape, which define a gradient of opacity towards the inside or outside of the shape,
commonly known asSoftness.
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Softness
These two boxes allow the setting of the gradient value for opacity. Softness has
both an interior and exterior limit, which are viewed as cyan-colored lines that join the
ends of the radial tangents.

The radial tangents can be edited like any tangent and also via the manipulators Width
and Offset.
Width is a Knob-style box which when dragged sideways increases or decreases the
length of the radial tangents of the selected control points, proportionally to the
internal and external radials. This allows the level of Softness to be set easily.

Offset is a Knob-style box which when dragged sideways increases or decreases the
length of the radial tangents of the selected control points, inversely proportional
between the internal and external radials. This button allows the internal and external
offset of Softness to be set easily.

Shadow attributes
Offset X and Offset Y define the offset of the generated.
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Opacity defines the opacity of the shadow as a percentage.

Select shapes
Current frames selects all the shapes found in the current frame.
All Frames selects all the shapes found in all the frames of the effect.
File
Load opens a dialog box for loading a vectorial shape into the effect .
Save opens a dialog box for saving the selected vectorial shape with the extension .
shp.
Shapes Order
The dropdown Order contains three commands:
Forward moves the selected shape one plane forward or backward, according to the
drag movement of the button (up/down).
Backward sends the selected shape behind all other shapes.
Front brings the selected shape in front of all other shapes.

Tangents reset
The dropdown Tangent contains three commands:
Reset All resets all default values of the tangents or radials of a control point.
Reset Radials assigns default values to the tangents of the selected control points,
without changing the radials.
Reset Radials Angle assigns default values only to the angles of the radials, without
changing the tangents or the length of the radials of the selected control points.
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Add key
Selected Shapes adds a keyframe to the selected shapes in their current position. A
keyframe is only assignable to a whole shape, and so it is impossible to assign
keyframe to only one control point. Shapes that possess keyframes will be visible
throughout the duration of the effect.
All Shapes adds a keyframe to all the shapes found in the current frame.
Edit key
Cut Key moves the current keyframe of the selected shape to the clipboard.
Copy Key copies the current keyframe of the selected shape to the clipboard.
Paste Key pastes the keyframe found in the clipboard to the selected shape.
Delete Key deletes the keyframe assigned to the selected shape in the current frame.
Animation
Copy Tracks pastes the tracking coordinates that the parameters of the effect
possesses to the selected shape, incrementally to the values of the keyframes in the
shape.
Tracking can only be pasted in the keyframe of a shape once. Tracking cannot be
pasted in a shape that does not have at least one keyframe. This process is explained
at the end of this chapter.
Delete Anim deletes all the keyframes that the shape has in the duration of the
effect. To delete all keyframes, select the shape in one of its keyframes.
The shape will now exist only in the frame where it was originally created, with its
original shape.
Shape animation
Time Editor edits animation curves.
Text opens a window for creating text vectorials, enabling selection of font, alignment,
kerning, etc, as with the Title effect.
These vector texts are created as vectors when the Convert To Shape button of the Text
interface is pressed.
These vectors are identical to other vectors, and can be animated and specified in any
draw mode.
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Safe Area
The command View Safe Area activates the viewing of an indicator of a safe area.
The boxes X and Y define the values as percentages of the width and height of the
safety area.

Snap Area
The commands Snap X and Snap Y activate the viewing of a mesh that divides the
image. The values in X and Y define the number of divisions on each axis of the image.
The values set inOffset define the offset of the start of the mesh.
Vector Colors
The color boxes allow the user to define the colors of the different types of vectors in
order to avoid confusion with the colors of the image.
To change a color, first define it in the Color Chooser of Paint Editor (Paint Editor>Option Tabs->Paint->Color) and then click with the mouse cursor over the color
box to be modified.
The Reset Colors button returns the colors of the vector types to their the default
values.
Point defines the color of the control points of unselected vectors.
Select defines the color of the control points of selected vectors.
Shape defines the color of vectorial lines that join control points.
Key defines the color of vectorial lines that join control points that a keyframe has.
Transf defines the color of the manipulator Transf of the vectors.
Box defines the color of the band of selection.
Alpha defines the color that represents the alpha channel.
Pressure
By means of defining a curve in this graphic we can control the sensitivity of the
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Wacom-type graphic tablet.

Render
Auto Render manually activates the redesign of the of the effect of the vectors over
the input. On some occasions, if there are many vectors in a large image, the redesign
may be slow, in which case it is possible to detain the redesign via this option.
Shadows in Back specifies that all shadows of the vectorial shapes are drawn in the
background regardless of their order, thus avoiding one vectorial shape casting a
shadow on another.
Animation In Back specifies that que all animated shapes are drawn in the background,
so that unanimated shapes are drawn in front. If this function is deactivated, the
animated shapes are drawn in front of the unanimated ones.
Animation
The mode Auto Fix adds one keyframe for each change of position in the shapes.
Spline is an interpolation mode for the position of a shape. When it is deactivated,
interpolation of the position of the selected vectorial shape creates a straight path
between the keyframes that it possesses. When it is activated, the interpolation of
position creates a curved path between the keyframes it possesses.
Show Path shows the path of the movement between keyframes in the selected
shape.
Shapes
Auto Select is a mode that automatically selects the last vectorial shape generated.
Hide Tang hides the viewing of the tangents of the vector control points.
Composition
The command With CBlack specifies that the composition should be carried out
without multiplying the alpha channel over the foreground, since it pre-multiplied.
Cache
The command Use activates the memorization of the evaluations of each frame that
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has been modified, storing the resulting frame in a disk cache to avoid having to
redraw all the vectors each time we come to the same frame.
If the input of the effect changes, the cache is not automatically updated, so it must
be deleted (Clear) to avoid memorized frames from a previous input affecting the final
evaluation of the effect.
The cache is created in disk archives, in the directory defined inMamba Setup (
Mamba Setup->FilePaths->Paint tmp cache dir). It is important the locate this
directory in the quickest storage available, so the effect can perform in real time when
evaluated.
The command Clear deletes the cache where the evaluations of the effect are stored.
Time Editor:

Time Editor is a curves editor that contains the parameters of the selected animated
shape. To return to Paint Editor select the Time Editor button.

Folder that contains the parameters that defines some properties of the brush used in the
selected shape.
Size
[12 (1 / 256)]
Defines the size of the brush.
Opacity
[100 (0 / 100)]
Defines the pressure of the stroke.
Level
[100 (0 / 100)]
Defines the mask level of the drawn line.
Red; Green; Blue
[100 (0 / 100)]
Defines the color of the line.

SGO Mamba 2.0.1 © 2014 SGO

FX

345

Folder that contains the parameters that control the appearance of the shadow of the
selected vectorial shape.
DX; DY
[10 (-100.000 / 100.000)]
Defines a horizontal and vertical offset of the shadow.
Red; Green; Blue
[0 (0 / 100)]
Defines the color of the shadow.
Opacity
[100 (0 / 100)]
Defines the intensity of the shadow.
Start
[0 (0 / 100)]
Defines the start of the line drawn.
The value of the parameter is expressed as a percentage value of the total length of
the line.
Length
[100 (0 / 100)]
Defines the length of the line drawn.
The value of the parameter is expressed as a percentage value of the total length of
the line.
Active
[1 (0 / 1)]
Activates or deactivates the drawing of a line.
The value 0 deactivates the influence of the line in the image.
The following image shows how the parameters Length and Start work.
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Bear in mind that in some cases, many parameters will have no effect, since each shape
obeys the attributes it has, if it has fill, shadow its paint mode, etc.
For example, a change of brush size makes no sense in a filled shape, nor the color of a line
if the paint mode is Drag.
Use of Motion Tracking with VectorPaint

Carry out this task by following the following steps:
Assign the effect VectorPaint to a clip.
From the Visual Editor select the Tracking tab (Mamba->Visual Editor->Manipulators
Tabs->Tracking) and carry out a motion tracking from a point in the usual way.
Apply the motion tracking via the button Move (Mamba->Visual Editor->Manipulators
Tabs->Tracking->Apply->Move). We will note that the parameters PosX and PosY of the
VectorPaint are now animated, although they are not yet assigned to any shape.
Go to Paint Editor (Mamba->Visual Editor->Manipulators Tabs->Paint). Select the
shape to be animated, activating the mode Select double-clicking over it.
If the shape has no keyframe, at least one must be created in order to create its animation
curves. To do so, click the button Add key->Selected shapes.
Click the button Animation->Copy Tracks, which will copy (in the Manipulators Tabs of
the Visual Editor) the animation that we have in PosX and PosY to the selected shape.
Note that the shape now moves in the desired way.
Although it is the most direct way, it is not necessary for the motion tracking operation to
be carried out from the effect VectorPaint. It is possible to access and use the tracking
interface from any effect that allows it (such as Comp3D and Color Grade). In this case,
after operating in the Tracking interface, it should be accessed via the VectorPaint effect in
order to apply the motion tracking to the PosX and PosY parameters of the effect.
Timewarp

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Timewarp
Effect that modifies the reproduction speed of a sequence, generating intermediate frames
through Optical Flow (Motion Estimation) algorithms. The main purpose is to produce high
quality Slow motion effects.
In spite of its name, this effect should not be confused with the Timewarp groups, which
carry out classic accelerations and slow-motions. This effect provides much greater realism,
but is not an editing function as the others are, but rather an effect that requires a
considerable amount of manual work.
If applied to make a clip longer, remember that the effect clip will have to have a greater
duration than its input clip. For example, if a Speed parameter value of 25% is set, the
duration of the effect will have to be forced so that it lasts four times the length of the
original clip (if we want to see it complete).
I/O

Inputs
Single input: Image with or without alpha channel.
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Inputs
Image: Image sequence with speed altered by the effect.
Alpha: Opaque mask.
Parameters
Timewarp:

Dropdown folder containing the parameters that control the reproduction speed of the
sequence.
Note: the user must choose which of the two parameters is to be used. Only one of the
two should be used, and that which is not used should have a value of zero.
Time-Time
[0 (0 / X)]
Parameter which indicates the number of the original frame viewed as current frame .
Speed
[100 (0 / 1.000.000)]
Parameter as a percentage which scales the reproduction.
Optical Flow:

Dropdown folder containing the parameters that control the Optical Flow logarithm.
MinLevel
[1 (0 / 8)]
Factor that divides in half the drag resolution. The higher the number, the less the
resolution, thus accelerating the calculation speed of the effect.
Levels
[7 (1 / 8)]
Refines the direction of the vectors of movement.
Iterations
[25 (0 / 1.000)]
Revision of movement in areas with little detail.
Smoothness
[10 (0 / 1.000)]
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Softens the direction of crossed vectors, making them more parallel.
Display:

Dropdown folder containing the parameters that control viewing mode of the Optical Flow
logarithm.
Mode
[Warp (MixFrames / Warp / Vectors / Slopes)]
Provides different output modes, which mainly help in adjusting other parameters.
MixFrames obtains new frames by mixing previous and following frames (instead of
using Motion Estimation techniques, and is useful for comparing with a traditional
timewarp or if we have too many artefacts that cannot be corrected). Warp is the
most usual mode and is that which will produce the best results via Motion Estimation
techniques; Vectors show tracking for each pixel, and Slopes show the amount
movement of each pixel by means of different colors.
One use of Vectors and Slopes is to analyze what is happening in areas that produce
artefacts: if we observe sudden, unexpected changes in direction of the vectors or in
the amount of movement, increase the Softness parameter or vice versa,
respectively.
Sometimes, Slopes modes can be used to obtain masks close to objects that are
moving at a different velocity to that of those around them, by means of their
posterior extraction with a vector of the Color Grade effect.
VecsScale
[1 (0 /100)]
Softens the direction of crossed vectors, making them more parallel.
Deinterlace:

Drop-down folder that contains the parameters of the mode for treating interlaced material.
In a Timewarp effect, the fields of an interlaced sequence can generate complete frames,
therefore, the deinterlace mode uses the effect of its own parameter internally.
Mode
[Default (Default/Adaptive)]
Defines the deinterlace mode. The Default value defines the deinterlace mode by
current interpolation, while Adaptive mode defines interpolation in which values are
explored diagonally, giving better visual results.
Note: This parameter only works in cases in which the render is done by fields. In
progressive mode render, the value of this parameter is ignored.
Use and C omments

As in all the effects that use Optical Flow, pay attention to objects that get hidden behind
other objects, crossed trajectories, and dynamic changes in light.
To deal with this type of sequence, the Parameters must be set evaluating the behavior of
the vectors, using the Vector viewing mode, with a high VectScale value.
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Denoise

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Denoise
High quality effect that reduces image noise or grain via Optical Flow (Motion Estimation)
algorithms.
It is also suitable for reducing cine image grain, electronic video camera noise, and noise
produced by image compression algorithms common in all types of cameras and VTRs
(mpeg2, mpeg4, etc.).
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image sequence with reduced noise or grain.
Alpha: Compositing mask.
Parameters
Denoise:

Dropdown folder containing the parameters that control application of grain remover.
Scope
[3 frames (none, 3frames, 5frames, 7frames, 9frames, 11 frames)]
Parameter that indicates the number of frames included the Optical Flow algorithm.
The higher the number, the greater the noise reduction, but with the increased
possibility problems of accuracy.
Mode
Temporal (Temporal, Spatial, Combined)
Noise reduction modes.
Temporal applies Optical Flow to detect noise and remove it, using images distorted
by the Optical Flow algorithm.
Spatial applies a spatial filter to remove noise, similar to a Median filter.
Combined combines both modes a mask generated by the Mask parameter. This mode
is recommended in the majority of cases, once the correct mask is created properly.
Spatial
[0.050 (0/100)]
Spatial filter application radius for noise removal (not visible in Temporal mode).
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Mask:

Folder that contains the parameters that modify the mask, where the Spatial filter can be
combined with the Temporal filter.
NGamma
[1 (0/100)]
Specifies a grey value as a start point for mask generation.
Filter
[0.2 (0/100)]
Specifies a blur value prior to the extraction of the mask, reducing detail.
Level
[0 (0/100)]
Specifies a transparency in the generated mask.
Scale
[40 (0/100.000)]
Scale of opacity values in the generated mask.
Optical Flow:

Dropdown folder containing the parameters that control viewing mode of the Optical Flow
logarithm.
Note: This algorithm automatically generates a mask at the intersections of crossed
vectors, which will vary when editing these parameters. The Mask parameters function as
post-process from the mask generated by Optical Flow.
MinLevel
[1 (0 / 8)]
Factor that divides in two the drag resolution. The higher the value, the lower the
resolution, accelerating effect calculation speed (with a value of 0, the Optical Flow
carries out tracking of all the pixels of the image). Higher values drag areas whose size
is specified by this number of pixels.
Levels
[7 (1 / 8)]
Refines the direction of movement vectors.
Iterations
Revision of movement in areas with little detail.
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Smooth
[10 (0 / 1.000)]
Softens the direction of crossed vectors, making them more parallel.
Use and C omments

As in all the effects that use Optical Flow, pay attention to objects that get hidden behind
other objects, crossed trajectories, and dynamic changes in light.
To adjust the parameters of the effect correctly, it is necessary to follow the order of the
procedure detailed below.
In Temporal mode, specify the Optical Flow parameters (the parameters that are most
sensitive to editing are Smooth and MinLevel), with the aim of reducing to a minimum the
deformation generated in cases of crossed trajectories. The example shows the typical
problems of occlusion (similar objects crossing one beyond the other) in Optical Flow, since
the original image is a sequence in which the character moves from left to right of frame,
“dragging” the foreground character.

Specify the mask using the Show Alpha mode of the Visual Editor. The mask gives the
impression of seeing the outline of the figures, although in reality what is drawn are the
areas where crossed movements are detected. So, the outlines of one figure are visible
during a movement, and do not remain still.
First specify an NGamma value which makes the noise homogeneously visible in the light
and dark areas of the image. Then defines the Level parameter to exclude from the mask
areas of little occlusion, since Optical Flow will probably not generate occlusion errors in
these areas. To make the mask areas larger, edit the parameters Scale and Filter.
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Once the mask containing the occlusion errors generated by Optical Flow is defined, modify
the parameter Mode to Combined. Finally, specify Spatial at a low value to equalize both
combined modes and to make the transition between one mode and the other via the mask
is not apparent.

Then adjustments of any type can be made to the parameters, especially Level and Scale,
viewing the final result in order to hide the occlusion problems by expanding the mask that
combines the spatial filter with the temporal.
The Spatial filter itself never manages to remove noise whilst conserving detail that the
Temporal filter recognizes, so the combination of both methods gives the best results. In
the example that follows, a detail is exaggerated from the previous image to better view the
difference between the application of the spatial filter and the combined.
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This effect is recommended for treating material before extracting masks, doing chroma key
processes, secondary color corrections, or simply reducing grain in 16 mm film material. It is
also useful for eliminating noise from video with gain problems.
It is also very useful for improving the precision of Motion Tracking, in cases of annoying
vibrations of tracked areas.
The default parameters usually give good results.

Grain

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Grain
Adds grain noise to the image.
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I/O

Inputs
Single input. If the input contains alpha information, the noise pattern can be
adjusted to this area of the image.
Inputs
Image: The noise pattern acting on either the entire image, or restricted to the
opaque area of the mask.
Alpha: Unmodified.
Parameters

Repeat
[1 (1 / 100.000)]
Number of frames in which the random position of the grains will be repeated.
Rad
[3 (1 / 100.000)]
Radius of the spherical points applied to the image.
Gain
[100 (-100.000 / 100.000)]
Multiplies the brightness of the image by a percentage value before processing the
grain.
This luminance correction is useful to compensate the loss of brightness caused by
the amplitude of the grain.
Ampl
[30 (0 / 100.000)]
Applied amplitude of the granulated noise.
Gamma
[0 (-100 / 100)]
Specifies gamma correction for the granulated noise. Higher values specify greater
transparency from the center of the grain, and vice-versa.
In Alpha
[No (No /Yes)]
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Restricts the influence of the effect to the area specified by the alpha channel levels.
Use and C omments

The purpose of this effect is simply to add grain to the image to simulate a photographic
emulsion.
In many cases of composition, it is necessary add grain to layers originally without it to
integrate them with film material, or even video (although in this case it will be noise rather
than grain), as for example the replacement of the contents of an current poster with a
digital file.
In this example, as the logo is a synthetic image it has no grain, which should be added to
integrate it better with its background.

FrameRepair

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->FrameRepair
Effect that is used to eliminate hairs, dust or other small foreign bodies that often appear in
images. It uses Optical Flow (Motion Estimation) algorithms.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image sequence with repaired “drops”.
Mask: Mask showing where the repair takes place.
Parameters
FrameRepair:

Dropdown folder that contains the parameters that control the frame repair application.
Mode
RepairF(Off,RepairF,RepairB,DirtMaskF,DirtMaskB,RepairFB,DirtMaskFB,
RepairDirt,Composition)
Except for the Composition mode, the other modes can be considered “modes for
adjusting other parameters", in other words, they can be used during the setting of
other parameters, but ultimately, Composite is what is used to the final render.
Exceptions are indicated at the appropriate time.
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Off: effect off.
RepairF: in this mode, the Optical Flow (henceforth OF) is calculated between the
previous frame and the posterior frame to the current. The result of this effect is to
recreate the present frame, (the original current frame will not enter into the process)
applying OF as Warper to the previous frame. As well as the current image created, a
mask is calculated which indicates the areas of the image in which the OF has had
tracking problems, normally caused by occlusions in the movements in the sequence.
Note: with all values at their default settings, the FrameRepair effect in RepairF
mode, is that which is used internally when the Repair option in VectorPaint is
activated. If the user needs to modify the values of Repair, instead of using the Repair
option in VectorPaint, FrameRepair can be used, applied to a copy of the input of
VectorPaint as a SECOND input in VectorPaint. The Reveal Back brush acts exactly like
the Repair option, while giving full control over the recreation process values for the
current frame, which can be used to patch up the current damaged frame.
RepairB: Identical to RepairF, except that it interchanges the two frames used for
calculation, the next and the previous. The OF calculation is not a symmetrical
process, since in one direction the calculation may be able to create objects that are
being hidden better, while in the other direction it may be the objects that are being
revealed that are easier to calculate.
DirtMaskF: Calculates the OF between the current frame and the next obtaining a
mask that indicates areas where tracking problems exist. This mode only serves to
show an intermediate phase of the process of automatic repair.
DirtMaskB: Similar to DirtMaskF, using the current frame and the previous one.
RepairFB: Gives a result by combining the modes RepairF and RepairB. The combined
mask generated can be interpreted as “areas of complex movements" which cannot be
repaired automatically. Also, a Grow process is applied to the mask, specified by the
parameter of the same name, with the purpose of adding a safety margin to the areas
of complex movements.
DirtMaskFB: Gives a combined mask from the modes DirtMaskF and DirtMaskB, which
indicates areas of possible defects.
RepairDirt: As an image, this returns the image recreated the same as inRepairFB, as a
morphing between the previous and posterior frames to the current one. As a mask, it
returns a combined mask from the previous phases: areas detected in RepairFB as the
areas of complex movements subtracted from areas detected in DirtMaskFB (possible
defects). Ideally, this mask only contains areas of defects in the image.
Composition: The final result of the automatic repair: it is composed of the image and
mask resulting from the RepairDirt phase over the original image, only patched in areas
of defects.
DistBck
[1 (1/100.000)]
Offset, in frames, from the previous frame with which the repair or Dirt is to be done.
DistFwd
[1 (1/100.000)]
Offset, in frames, from the next frame with which the repair or Dirt is to be done.

SGO Mamba 2.0.1 © 2014 SGO

357

FX

Mask:

Folder that contains the parameters that modify the mask, to defines the areas of the
image that are to be used to carry out the morph between frames.
NGamma
[1 (0/100)]
Specifies a grey value as start point for the mask generation.
Filter
[0.2 (0/100)]
Specifies a blur value before the extraction of the mask, reducing detail.
Level
[0 (0/100)]
Specifies a transparency threshold in the generated mask.
Scale
[40 (0/100.000)]
Scales the opacity values of the generated mask.
Grow
[0.5 (0/100.000)]
Increase in the edges of the mask.
Optical Flow:

Dropdown folder that contains the parameters that control the Optical Flow algorithm.
Note: this algorithm automatically generates a mask at the intersections of crossed
vectors, which will vary when editing these parameters. The Mask parameters function as a
post-process of the mask generated by Optical Flow.
MinLevel
[1 (0 / 8)]
Factor which divides by two the resolution of the tracking. The higher the value, the
lower the resolution accelerating the calculation speed of the process (if the value is
at 0, the Optical Flow carries out the tracking of all the pixels of the image). Higher
values track areas specified by this number of pixels.
Levels
[7 (1 / 8)]
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Refines the direction of the movement vectors.
Iterations
[100 (0 / 1.000)]
Revision of movement in areas of little detail.
Smooth
[10 (0 / 1.000)]
Smooths the direction of crossed vectors, making them more parallel.
Use and C omments

As in all the effects that use Optical Flow, pay attention to objects that get hidden behind
other objects, crossed trajectories, and dynamic changes in light.

To adjust the parameters of the effect correctly, it is necessary to follow the order of the
procedure detailed below.
Look for a frame that contains a hair, scratch or other localized interference. The example
shows a single frame that contains a hair over the model's left arm.
In RepairF mode, specify the Optical Flow (the parameters that are most sensitive to editing
are Smooth and MinLevel) with the aim of reducing to a minimum the deformation generated
in cases of crossed trajectories.
Specify the mask using the Show Alpha mode of the Visual Editor. The mask gives the
impression of seeing the outline of the figures, although in reality what is drawn are the
areas where crossed movements are detected. So, the outlines of one figure are visible
during a movement, and do not remain still.
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First specify an NGamma value which makes the noise homogeneously visible in the light
and dark areas of the image. Then defines the Level parameter to exclude from the mask
areas of little occlusion, since Optical Flow will probably not generate occlusion errors in
these areas. To make the mask areas larger, edit the parameters Scale and Filter.

Once the mask is specified, it is selected in RepairDirt mode and the mask that is not
considered interference disappears, leaving, in the example, just the mark off the hair over
the model's arm.

Once this has been viewed, go to Composite mode and activate the image in the Visual
editor. Finally, the result - the result of the morph between the previous and subsequent
frames to the one with the problem - substitutes the marked area with the mask.
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Reverb

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Reverb
Generates an echo of the image, with a definable duration.
I/O

Inputs
Single input: Image with or without mask.
Inputs
Image: Image with echo.
Alpha: Mask with echo.
Parameters

Reverb
[0 (0 / 100)]
Specifies the mixing level with the previous images.
Use and C omments

Reverb is an accumulative effect. It cannot be seen in a single static frame before
rendering, since it must be evaluated sequentially. Therefore, if the monitor cursor is
dragged randomly over the frames, anomalous results can occur.
It is not possible have more than one Motion Blur effect in the same node tree. If more than
one of these effects is grouped in the samenode tree, it is necessary to render to calculate
each effect. As with Feedback, the results of this effect depend on the temporary order in
which they are being evaluated, so that the result will be different for normal and reverse
playback.
Bullet Time

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Bullet Time
The Bullet Time effect allows the creation of digital cameras located between real cameras
around a scene. This allows smooth rotations around a scene on shoots with multiple
cameras.
The effect also includes a Timewarp in order to accelerate, slow down or stop time at the
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same time as performing the effect.
I/O

Inputs
Multiple inputs: Each input will be one of the cameras located around the scene. The
result improves with more inputs.
Inputs:
Image: Final sequence with desired movement, regarding both positioning around the
scene and time.
Alpha: opaque mask.
Parameters
Bullet Time:

Dropdown folder that contains the parameters that control the playback speed of the
sequence.
Note: the user must decide which of the first parameters to use (Time-Time or Speed).
Only one must be used; the other parameter must be set at zero.
Time-Time
[0 (0 / X)]
Parameter that indicates the number of the original frame that is currently being
viewed.
This is useful for slowing down or accelerating by simply mapping the time.
Speed
[100 (0 / 1.000.000)]
Parameter in percentage that scales playback speed.
This is useful for slowing down or accelerating by indicating a velocity.
Angle
[0 (-1.000.000 / 1.000.000)]
Parameter in degrees that indicates the value of the angle for positioning the camera,
allowing the camera to be rotated around the scene.
The effect supposes that the cameras are located equidistant around the scene
covering 360º, so that:
- 0º is the first camera
- any value greater than that will be interpolated towards the second, third, fourth
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cameras etc (as many as are desired) and from the last camera we return to the first
when reaching 360º.
The range is greater than 0 to 360 in order to allow repeating the circling around the
scene continuously as many times as required.

Optical Flow:

Dropdown folder that contains the parameters that control the algorithm of Optical Flow.
MinLevel
[1 (0 / 8)]
Factor that divides in half the drag resolution: higher values indicate lower resolution,
thus accelerating the speed of calculation of the effect.
Levels
[7 (1 / 8)]
Refines the direction of movement vectors.
Iterations
[25 (0 / 1.000)]
Reviews movement in areas with little detail.
Smoothness
[10 (0 / 1.000)]
Smoothes the direction of crossed vectors, making them more parallel.
Display:

Dropdown folder that contains the parameters that control viewing modes of Optical Flow.
Mode
[Warp (MixFrames / Warp / Vectors / Slopes)]
Provides various output modes, which mainly help when adjusting other parameters.
MixFrames obtains new frames by mixing previous and following frames (instead of
using Motion Estimation techniques, and is useful for comparing with a traditional
Timewarp or if there are too many artefacts que that cannot be corrected). Warp will
be the usual mode of use and will be the one that obtains the best results through
Motion Estimation techniques. Vectors shows the tracking vectors of each pixel.
Slopes represents the amount of movement of each pixel using different colors.
One practical use of Vectors and Slopes is to be able to analyze what is happening in
areas that produce artefacts: if abrupt and undesired changes happen in the direction
of the vectors (or in the amount of movement), we should increase the Softness
parameter, and vice versa.
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Sometimes, Slopes mode can be used to obtain masks close to objects that are
moving at a speed to what is around them, through their subsequent extraction using
a free vector of the Color Grade effect.
VecsScale
[1 (0 /100)]
Increases/decreases the size of the vectors viewed when Vectors is selected in the
Mode parameter.
Deinterlace:

Dropdown folder that contains the mode parameter for treating interlaced material. In a
Timewarp effect, the fields of an interlaced sequence can generate whole frames, so the
Deinterlace mode that the effect uses internally has its own parameter.
Mode
[Default (Default/Adaptive)]
Defines the deinterlace mode. The Default value defines a deinterlace mode by
sequential interpolation, while the Adaptive value defines an interpolation mode that
explores the values diagonally, producing better visual results.
Note: this parameter only works in cases where the render is run by fields. Render in
progressive mode ignores the value of this parameter.
Use and C omments

The main use of this effect is to create the sensation of time stopping and the camera
revolving around the action. These visual effects can be managed independently.
JellyTime receives a variable number of sequences of images as its input. Each sequence
comes from a camera within a group of equidistant cameras that complete a full circle of
360º around the scene.
Via the Optical Flow (Motion Estimation) algorithm, Mamba calculates the frames missing in
the movement between consecutive cameras.
As in all effects that use Optical Flow, pay attention to occlusions of objects, crossing
paths and drastic light changes.
To manage this type of sequence, set parameters, evaluating the behavior of the vectors,
using the viewing mode Vectors, with a high value set for VecsScale.
Optical Motion Blur

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Optical Motion Blur
Effect that simulates motion blur, based on Optical Flow (Motion Estimation) algorithms.
I/O

Inputs
Single input: image with or without alpha channel.
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Inputs
Image: image sequence with speed altered by the effect.
Alpha: opaque mask.
Parameters
MotionBlur:

Dropdown folder that contains the parameters that control the intensity and quality of the
blur trail.
ShutterTime
[40 (0 / 1.000.000)]
Parameter that defines the exposition time to be generated by Optical Flow. The value
is in milliseconds.
Quality
[1 (1 / 10)]
Sample rate of the render process. Higher values set higher numbers of samples,
notably improving mage quality.
Optical Flow:

Dropdown folder that contains the parameters that control the Optical Flow algorithm.
MinLevel
[1 (0 / 8)]
Factor que that divides in half the drag resolution: higher values set lower resolution,
accelerating the speed of calculating the the effect.
Levels
[7 (1 / 8)]
Refines the direction of the movement vectors.
Iterations
[25 (0 / 1.000)]
Reviews movement in areas with little detail.
Smoothness
[10 (0 / 1.000)]
Smoothes the direction of crossed vectors, making them more parallel.

SGO Mamba 2.0.1 © 2014 SGO

FX

365

Display:

Dropdown folder that contains the parameters that control viewing modes of Optical Flow.
Mode
[Warp (MixFrames / Warp / Vectors / Slopes)]
Provides various output modes, which mainly help when adjusting other parameters.
MixFrames obtains new frames by mixing previous and following frames (instead of
using Motion Estimation techniques, and is useful for comparing with a traditional
Timewarp or if there are too many artefacts que that cannot be corrected). Warp will
be the usual mode of use and will be the one that obtains the best results through
Motion Estimation techniques. Vectors shows the tracking vectors of each pixel.
Slopes represents the amount of movement of each pixel using different colors.
One practical use of Vectors and Slopes is to be able to analyze what is happening in
areas that produce artefacts: if abrupt and undesired changes happen in the direction
of the vectors (or in the amount of movement), we should increase the Softness
parameter, and vice versa.
Sometimes, Slopes mode can be used to obtain masks close to objects that are
moving at a speed to what is around them, through their subsequent extraction using
a free vector of the Color Grade effect.
VecsScale
[1 (0 /100)]
Increases/decreases the size of the vectors viewed when Vectors is selected in the
Mode parameter.
Deinterlace:

Dropdown folder that contains the mode parameter for treating interlaced material. In a
Timewarp effect, the fields of an interlaced sequence can generate whole frames, so the
Deinterlace mode that the effect uses internally has its own parameter.
Mode
[Default (Default/Adaptive)]
Defines the deinterlace mode. The Default value defines a deinterlace mode by
sequential interpolation, while the Adaptive value defines an interpolation mode that
explores the values diagonally, producing better visual results.
Note: this parameter only works in cases where the render is run by fields. Render in
progressive mode ignores the value of this parameter.
Use and C omments

This effect is especially useful for combining real images (generally with some motion blur)
and CGI. It is also possible to set motion blur values in a stereo clip in order to correct
differences that material from a shoot might have.
As in all effects that use Optical Flow, pay attention to occlusions of objects, crossing
paths and drastic light changes.
To manage this type of sequence, set parameters, evaluating the behavior of the vectors,
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using the viewing mode Vectors, with a high value set for VecsScale.
Filter

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter

The effects the Filter menu contain image alteration tools based on spatial algorithms,
corrections of RGB values and luminance.
Glint

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Glint
Adds a blurred version of the image in its horizontal, vertical and diagonal axes, simulating
flashes of light in a camera lens.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with glints.
Alpha: No change.
Parameters
Intensity:

Folder containing the parameters controlling the intensity of the glint.
Global
[0 (-100.000 / 100.000)]
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Global intensity of the glints in the image. This value multiplies the local values of each
direction by a specified percentage.
Horizontal
[200 (-100.000 / 100.000)]
Intensity of the horizontal glint.
Vertical
[200 (-100.000 / 100.000)]
Intensity of the vertical glint.
DiagUp
[200 (-100.000 / 100.000)]
Intensity of the diagonal glint coming from the top left corner.
DiagDwn
[200 (-100.000 / 100.000)]
Intensity of the diagonal glint coming from the bottom left corner.
Glint:

RadImg
[3 (0 / 100)]
Radius of the glint affecting the image.
Chroma
[0 (-1.000 / 1.000)]
Specifies a coloring of the glint, simulating a chromatic aberration produced by a lens.
RadAlpha
[3 (0 / 100)]
Radius of the glint affecting the alpha channel.
AddImg
[100 (0 / 100.000)]
Adds the original image to the effect.
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Use and C omments

This effect is frequently used to simulate the behaviour of direct incidence of light sources
on a camera lens. Normally, concentrated light emanating from a spotlight in complete
darkness (such as the headlamps of a car at night) produce a glint with geometrical forms in
the lens. In video cameras, these glints are cross-shaped, sometimes diagonal or even starshaped, depending on the type of lens. Certain lower quality optics can even produce visible
chromatic aberrations, which can be simulated with the Chroma parameter.
Glint is the ideal effect to obtain this type of glint, be controlled with the intensity
parameters for each direction of the glint. Bear in mind that the result of the effect will be
the sum of the intensities of each direction, and negative values may be specified for any
intensity parameter, which are totaled to the Global parameter.
If only the image of the glint is wanted, without being composed over the original image,
simply set the AddImg parameter to zero.
In the following example, the action of the effect on an image can be seen.

C rystallize

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Crystallize
Forms a mosaic of irregular polygons, with or without an edge, colored by the predominant
values in the original image.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Mosaic image.
Alpha: Mosaic mask.
Parameters

Size
[5 (0 / 100)]
Specifies the size of the polygons.
Borders
[0 (0 / 50)]
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Specifies shrinkage of the polygon surfaces, thus creating a black border between
them. This shrinkage also affects the mask.
Seed
[0 (0 / 100.000)]
Seed for the random positioning of the mosaics.
This parameter can be animated so that the positions of the mosaics are moved
randomly.
Use and C omments

This effect has the simple purpose of simulating an image constructed from irregular
mosaics, and also the control of border size for simulating of stained glass images.

QuadTree

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->QuadTree
Forms a mosaic of different-sized rectangles of solid colors, based on copying similar colors
of neighboring pixels, controlled by a tolerance.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image formed by a mosaic of different-sized rectangles generated by the
effect.
Alpha: Edges of the rectangles generated in the mosaic.
Parameters

Toler
[20 (0 / 100)]
Modifies the difference tolerance between the pixels to be joined in a rectangular
mosaic of a single color. The higher the value, the greater the difference tolerated
between pixels that form part of the mosaic.
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Max Lev
[16 (0 / 16)]
Maximum level of detail allowed in the generation of subdivisions of the mosaic. The
higher the value, the greater the level of detail preserved in the image.
Invert
[No (No /Yes)]
Inverts the opacity values in the edges of the rectangular mosaics generated in the
alpha channel.
Use and C omments

This effect is used to simulate images derived from highly compressed file formats.
The mask generated by the effect can also be used to add a rectangular grid adapted to
the image to the original one, thanks to its “technological” look.
In the following example the result of the effect can be seen in both the image and the
alpha channel.

MosaicTiles

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->MosaicTiles
Creates the effect of small tiles on an image, similar to an image created by mosaics.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image modified by tiles.
Alpha: No change.
Parameters

Repeat
[1 (1 / 100.000)]
Number of frames in which the random position of the tiles will be repeated.
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In Alpha
[No (No /Yes)]
Restricts the influence of the effect to the area specified by the alpha channel levels.
Use and C omments

This effect is used to add tiles to an image, simulating a mosaic.
In the following example the result of the effect can be seen.

Dither

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Dither
Produces a random change of position of the image pixels.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with the pixels moved to the new position.
Alpha: No change.
Parameters

AmountX
[0 (-10.000 / 10.000)]
Specifies the maximum horizontal distance by which the pixels will have their positions
interchanged.
AmountY
[0 (-10.000 / 10.000)]
Specifies the maximum vertical distance by which the pixels will have their positions
interchanged.
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Repeat
[1 (1 / 100.000)]
Number of frames in which the position change pattern is repeated.
In Alpha
[No (No /Yes)]
Restricts the influence of the effect to the area specified by the alpha channel levels.
Use and C omments

Dither is a basic effect that moves pixels from their original positions, mixing them randomly.
Its usefulness is related to adding noise to the image without changing its color palette,
since the same pixels create noise when they are mixed up.
Another possible use is to add a Dither effect to a mix with the Amount parameters
animated to dissolve and restore an image, for example, during a transition.
In the following example, the results of using different parameter values can be seen.

C ontrast Band

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Contrast Band
Specifies a subdivision of the image luminance range to increase the contrast in each
subdivision.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Contrasted image depending on the specified bands.
Alpha: No change.
Parameters

Bands
[1 (1 / 256)]
Specifies the number of subdivisions or bands applied to the levels of the RGB
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channels.
Grade
[100 (-10.000 / 10.000)]
Increase of contrast applied to each band.
By Luma
[No (No /Yes)]
Specifies whether the effect works based on luminance rather than RGB values.
In Alpha
[No (No /Yes)]
Restricts the influence of the effect to the area specified by the alpha channel levels.
Use and C omments

The contrast generated in this effect with the parameter ByLuma set to 0 is applied to
each RGB channel, and acts in a very different way to the contrast control of a color
corrector based on luminance contrast. One possible use is for increasing the contrast of an
image of a cloudy day so that it appears sunny. Since the contrast of this effect increases
at the same time as the saturation, the skin color of people in the scene will be increased,
together with the contrast. Negative values of the Grade parameter are useful for creating
very simply images that simulate a heat detector. For example, setting the Grade parameter
to –200 and Bands to 3, and adding a blur -with Blur (Type Gauss) for example- to the
input image before ContrastBand, gives an acceptable effect. In the following example the
results of different parameter values can be seen. A gradient from black to white can be
seen below each image, representing the result of the effect on the luminance of each
example.

Spot Poster

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Spot Poster
Creates a posterizing effect, by randomly selecting areas with a selection tolerance.
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I/O

Inputs
Single input: Image to be processed.
Inputs
Image: Modified image.
Alpha: Opaque mask.
Parameters

Toler
[20 (0 / 100)]
Posterizing tolerance. Higher values include areas limited by their details, whereas
lower values restrict the posterizing action.
Size X; Y
[20; 20 (0 / 100.000)]
Specifies the maximum horizontal and vertical size of the posterizing areas.
Seed
[0 (0 / 100.000)]
Seed for the random pattern for specifying the zone selection.
Use and C omments

The result of this effect is very similar to Posterize, with the difference that it also randomly
selects areas using a tolerance which allows the effect to maintain frame areas that have
detail.

FlareFx

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->FlareFx
This effect allows the generation of different types of optical effects in the image, such as
glows, rainbows, lens flares, light rings, and optical effects of stars with any number of
points. It has noise parameters to make the effect more or less irregular.
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I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Sequence with applied the effect.
Alpha: Mask with the flare effect.
Parameters
Origin:

This group represents the original position of the optical effect. It contains the following
parameters:
CentX
[50 (-1.000 / 1.000)]
X position of the origin.
CentY
[50 (-1.000,1.000)]
Y position of the origin.
Dest.:

This group represents the target position of the optical effect. It contains the following
parameters:
CentX
[50 (-1.000, 1.000)]
X position of the target.
CentY
[50 (-1.000, 1.000)]
Y position of the target.
Glow:

This group represents the glow effect to be generated in the image. This effect comprises a
ring of light around the origin of the effect.
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Color Red; Color Green; Color Blue
[100; 50; 50 (0 / 100)]
RGB Components of the color of the effect.
Glow Active
[No (No / Yes)]
Specifies if the effect is activated.
Glow Intensity
[50 (0, 1.000.000)]
Intensity of the effect.
Glow Radius
[50 (0.001, 1.000)]
Radius of the effect.
Glow Decay
[2 (0.5, 1.000)]
Decay of the effect with distance.
Ray:

This group represents the ray effect to be generated in the image. This effect comprises a
star of light beams that radiate from the origin of the effect.
Color Red; Color Green; Color Blue
[100; 50; 50 (0 / 100)]
RGB components of the color of the effect.
Rays Active
[No (No / Yes)]
Specifies if the effect is activated.
Rays Intensity
[60 (0 / 1.000.000)]
Intensity of the effect.
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Rays Radius
[100 (0.001 / 1.000)]
Maximum radius of the effect. Represents the maximum distance from the origin
reached by the rays.
Rays MinRadius
[0.100 (0.001 / 1.000)]
Minimum radius of the effect. Represents the distance from the origin to where the
rays begin to appear.
Rays Rot.
[0 (-1.000.000,1.000.000)]
Rotation of the light rays.
Rays N.Spikes
[5 (1 / 100)]
Number of rays.
Rays Thickness
[20 (0.0001 / 100)]
Thickness of the rays.
Rays AngleNoise
[50 (0 / 1.000)]
Noise in the ray angles. Use this parameter to break up the uniform angular distribution
of the rays.
Rays LenNoise
[50 (0 / 100)]
Noise in the length of the rays. Use this parameter to break up the uniform length of
the rays.
Rays ThickNoise
[50 (0 /100)]
Noise in the thickness of the rays. Use this parameter to break up the uniform
thickness of the rays.
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Flares:

This group represents the lens flare effect. This effect comprises a series of flares that are
distributed along the line joining the origin and target of the effect.
Color Red; Color Green; Color Blue
[100; 50; 50 (0 / 100)]
RGB Components of the flare color.
There is one flare that has special treatment due to its impact on the result of the effect.
This is the one produced in the origin of the effect. Its parameters are in the First block and
are:
First Active
[Yes (No / Yes)]
Specifies if the effect is activated.
First Intensity
[100 (0 / 1.000.000)]
Intensity of the effect.
First Radius
[100 (0.001 / 1.000)]
Radius of the effect. Represents the distance between the origin and the point
reached by the rays.
Flares Active
[No (No / Yes)]
Specifies if the effect is activated.
Flares Intensity
[30 (0 / 1.000.000)]
Intensity of the effect.
Flares Radius
[20 (0.001 / 1.000)]
Maximum radius of the effect. Represents the maximum distance from the origin
reached by the flares.
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Flares Length
[150 (-1.000 / 1.000)]
Length of the line along which the effect is distributed. Represents the percentage of
the distance between the origin and the target.
Flares Rot
[0 (-1.000.000 / 1.000.000)]
Rotation of the flares.
Flares MinDecay
[0.05 (0.05 / 1.000)]
Minimum decay of the flares.
Flares MaxDecay
[1 (0.05 / 1.000)]
Maximum decay of the flares.
Flares N.Flares
[10 (1 / 100)]
Number of flares.
Flares N.Vertex
[0 (0 / 100)]
Number of sides of the flares. 0 sides represents circular flares.
Flares SizeNoise
[80 (0 / 100)]
Noise in the size of the flares. Use this parameter to break up the uniformity in the
size of the flares.
Flares HueNoise
[50 (0 / 100)
Noise in the tone of the flare color. Use this parameter to break up the uniformity in
the color of the flares.
Ring:

This group represents the effect of a ring of light around the origin of the effect.
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Color Red; Color Green; Color Blue
[100; 50; 50 (0 / 100)]
RGB components of the color of the ring.
Ring Active
[No (No / Yes)]
Specifies if the effect is activated.
Ring Intensity
[50 (0,1.000.000)]
Intensity of the effect.
Ring Radius
[70 (0.001 / 1.000)]
Radius of the ring.
Ring Size
[1 (0.1 / 1.000)]
Thickness of the ring.
Ring Decay
[1 (0.5 / 1.000)]
Decay of the ring towards its edges.
Rainbow:

This group represents a rainbow effect around the target of the effect.
Color Red; Color Green; Color Blue
[100; 0; 0 (0 / 100)]
RGB Components of the color of the ring.
Rainbow Active
[No (No / Yes)]
Specifies if the effect is activated.
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Rainbow Intensity
[50 (0 / 1.000.000)]
Intensity of the effect.
Rainbow Radius
[40 (0.001 / 1.000)]
Radius of the ring.
Rainbow Size
[5 (0.1 / 1.000)]
Thickness of the ring.
Rainbow Decay
[0.5 (0.5 / 1.000)]
Decay of the ring towards its edges.

FlareFx:

Intensity
[100 (0 / 1.000.000)]
Specifies the global intensity of the effect. Affects all types of optical effect.
Radius
[50 (0.01 / 100)]
Specifies the global radius of the effect.
Rot.
[0 (-1.000.000 / 1.000.000)]
Specifies the global rotation of the effects.
Seed
[0 (0 / 1.000.000)]
Specifies the value of the random seed used to generate the effect.
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Use and C omments

This effect is highly optimized for speed, and real-time can be achieved in modern
workstations.
Posterize

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Posterize
Simulates lower depth of color.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image degraded by a lower depth of color.
Alpha: No change.
Parameters

Depth
[8 (1 / 256)]
Specifies the depth of color by number of levels. The number of levels of an 8 bit
channel is 256, the maximum value of this parameter.
ByLuma
[No (No / Yes)]
Specifies whether the effect works based on luminance rather than chrominance
values.
InAlpha
[No (No / Yes)]
Restricts the influence of the effect to the area specified by the alpha channel levels.
Use and C omments

This effect simulates a lower depth of color for the video color depth, which has 256 levels.
This effect can be used to simulate deterioration of quality, or to make the images appear
colored as in a comic for example.
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Pointillize

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Pointillize
Paints circular spots of color on an image, which when joined form straight cuts, thus
achieving the appearance of an irregularly-shaped mosaic. The spots can be anamorphic
circles of any size, which can be rotated and controlled by a rotation map. The edges of
the spots generate an alpha channel mask offering possibilities for later use.
I/O

Inputs
Double input: The first is used as the background over which the circular spots will
be drawn. The second is used as a color map, so that the spots have the color of the
pixel that coincides with the center of the circular spot.
Triple input: The third additional input works as a rotation map, making the spots
rotate proportionally to the luminance of the pixel that coincides with the center of
the circular spot.
Inputs
Image: Color spots in the first input.
Alpha: Mask of the edges of the spots.
Parameters

Density
[100 (0 / 100.000)]
Specifies the density of the spots on the background image. High values increase the
number of spots, and vice-versa.
Size X; Y
[1; 0.5 (0 / 100)]
Horizontal and vertical sizes of the spots.
Angle
[0 (-100.000 / 100.000)]
Initial rotation of the spots, expressed in degrees.
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Bear in mind that the rotation will not be visible if the circular spots are regular, with
identical values of Size X; Y.
Seed
[0 (0 / 100.000)]
Seed for random positioning of the spots. This parameter can be animated so that the
position of the spots are moved randomly.
Slopes
[Luminance (Luminance / Contour)]
Permits varying the rotation of the brushstrokes by interpreting the rotation map
based on its luminance values (Luminance) or on outline detection (Contour). This
parameter is not used when the effect does not have a fourth input.
Blur
[0 (0 / 100)]
Blurs the fourth input, thus achieving smoother luminance transitions in the rotation
map, and less sudden rotation of the brushstrokes.
ColorVar
[0 (0 / 100)]
Specifies random variability for the brushstroke color.
Chain
[0 (0 / 1.000)]
Creates copies of the original brushstrokes in the form of a chain, joined from their
right-hand edge .
This parameter is ideal at high values, so that the brushstrokes behave like lines that
change direction depending on the rotation map.
SizeVar
[0 (0 / 100)]
Specifies a random symmetrical variability of the spot size.
E-Blur
[0 (0 / 100)]
Blurs the mask of the spot edges created in the alpha channel.

SGO Mamba 2.0.1 © 2014 SGO

FX

385

E-Gain
[100 (0 / 100.000)]
Multiplies the intensity of the mask of the spot edges created in the alpha channel by
the specified proportion.
Use and C omments

This effect is almost identical to Brush Stroke, except that Pointillize only works with an
internal circular brush, whose appearance can be specified.
This effect has several orthodox uses, inserting copies of the same clip in all its inputs. The
first frequent use is to generate an effect of irregular mosaics on an image, simulating
stained glass. To do this, specify large circles (Size X; Y), and high densities (Density).
Another use is to simulate a painted image. For this, specify high densities (Density) and try
different, preferably asymmetric, size values (Size X; Y). If there is a third input, the Blur
parameter can attenuate sudden changes of rotation of the spots, making them appear to
be continuous brushstrokes. The Chain parameter is also highly recommended for giving
brushstrokes longer tracks on the image. The colorVar parameter can also transform colors
randomly to give an impressionistic effect.
Another possible use is to compose the result of this effect on the original image. The mask
generated by the effect consists only of the edges of the spots. If high values of Size X; Y
and Density are specified, the composed borders give the sensation of looking at the
background image through broken glass.

Mosaic

Ref. Mamba: Fx->Mamba->Filter->Mosaic
Forms a mosaic of rectangles of the same size, colored by the predominant values in the
original image.
I/O

Inputs
Single input: Image with or without alpha channel.
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Inputs
Image: Color mosaic.
Alpha: No change.
Parameters

SizeX
[0 (0 / 100)]
Horizontal size of the mosaic. This parameter is expressed as a percentage of the
image height.
SizeY
[0 (0 / 100)]
Vertical size of the mosaic. This parameter is expressed as a percentage of the image
height.
InAlpha
[No (No / Yes)]
Restricts the influence of the effect to the areas specified by the alpha channel
levels.
Use and C omments

This effect is typically used in television to prevent recognition of an area of the image, for
example, a product name or the face of a protected witness. For this purpose, the InAlpha
parameter can be used, which will restrict the action of the effect to the area of mask
opacity.

Outlines

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->OutLines
Combines an original image with an unfocussed copy with the Difference operation.
I/O

Inputs
Single input: Image with or without alpha channel.
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Inputs
Image: Image resulting from the comparison.
Alpha: No change.
Parameters

Blur
[1 (0 / 100)]
Blurs the copy of the image to be combined with the Difference operation.
Gain
[100 (-100.000 / 100.000)]
Multiplies the luminance of the resulting image by the specified percentage.
Use and C omments

This effect normally is used to obtain an image of the outline of figures that can be
distinguished in an image.
This effect can be simulated with other effects, by combining a Blur (Type Gauss) with
Channels.

Band Dither

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Band Dither
This effect reduces banding problems that can exist in images.
Banding is an artifact that can appear in images that have deteriorated as a result of digital
processes, seen as recognizable color bands in areas where there should be a subtle grading
between colors.
The Band Dither effect makes these bands less conspicuous, softening their edges by
randomly intermixing pixels of adjacent areas, thus breaking up the regularity of the bands.
The human eye is much more tolerant of noise (such as dithering), and considers it as
something natural in the image, compared with bands of isolines, which seem very unnatural
to an observer.
The difference between this effect and normal Dither is that is capable of detecting the
true borders belonging to image details and differentiating them from the banding, so that
the latter can be removed without affecting the borders. The Cutoff parameter should be
adjusted to do this.
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I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image without banding.
Alpha: Mask without banding.
Parameters

Amount
[2 (0 / 100)]
Specifies the maximum pixel intermixing distance for adjacent bands when dithering
the effect.
Cutoff
[3 (0 / 100)]
Specifies the application tolerance of the effect depending on contrast.
If the tolerance is low, only pixels of similar values will be affected, thus preventing
the effect having influence on important details of the image. If the tolerance is
greater, pixels that with greater mutual contrast will also be affected.
Seed
[0 (0 / 100.000)]
Seed for noise generation.
This can be animated if necessary to simulate moving noise in static images of
computer graphics, usually to integrate them better with sequences from video or cine
sources.
Use and C omments

Bear in mind that the reduction of banding originally contained in an image can only be done
with the use of random noise, which in some cases can become markedly visible. For this
reason, the parameters of this effect should be carefully specified, since there are no
values that can be recommended for all possible cases.
In the first image
detail in which its
image shows the
affecting only the

of the example below, the original image is shown, and in the second a
banding can be seen, in the form of recognizable green bands. The third
suppression of this defect, leaving intact the character’s details and
bands.
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Note: Although the effect removes the banding correctly, the image in the example could
still show banding depending on the type of printing or graphics mode employed to see it,
given that many of these modes and compression formats for documents can cause
deterioration of color quality.
Enhance

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Enhance
Enhances contrast in a detail size range.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Blurred image.
Alpha: Opaque mask.
Parameters

RadL
[0.5 (0 / 100)]
Lower limit of the detail range, specified by the minimum detail radius to be enhanced.
RadH
[1 (0 / 100)]
Upper limit of the detail range, specified by the maximum radius of the details to be
enhanced.
Ampl
[100 (-1.000 / 1.000)]
Amount of enhancement to be applied to the range. Negative values blur details within
the range.
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Use and C omments

This filter is ideal for enhancing contrast in image areas without detail, thus balancing the
areas of contrast in the entire image.
If the RadL parameter value is higher than the RadH, the effect will invert its range, and
therefore its application will be reversed, similar to using the Ampl parameter with negative
values.
If the range specifies low levels of detail, for example with RadL set to 0 and RadH to 0.3,
the effect will enhance the details in exactly the same way as the Sharpen effect with its
Amount parameter set to 0.3. The difference compared with Enhance is that the latter has
a parameter specified by an action threshold set by a detail size that can be adjusted with
the RadL parameter.
A typical use of this effect is to compensate for the contrast normally found in the details
of images obtained by video cameras. If Enhance is applied with its default values, average
detail values are emphasized.
By experimenting with the parameters of Enhance, the optical filters that are often used in
telecines can be simulated.
The following example shows the results of using different parameter values.

Brush Stroke

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Brush Stroke
Paints color brushstrokes with a definable shape on an image. The size, appearance and
rotation can be modified, and a rotation map can also be used.
I/O

Inputs
Triple input:
The first is used as the background upon which the brushstrokes will be drawn.
The second is used as a color map, giving the brushstrokes the color of the pixel that
coincides with the center of the brushstroke.
The third input specifies (via its luminance) the shape of the brushstroke, which has
the color specified by the color map.
Quadruple input: The fourth additional input is used as a rotation map, making the
brushstrokes rotate proportionally to the luminance of the pixel that coincides with the
center of the brushstroke.
Inputs
Image: Image with the applied effect.
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Alpha: Opaque mask.
Parameters

Density
[100 (0 / 100.000)]
Specifies the density of the brush strokes on the background image. High values
increase the number of brush strokes, and vice-versa.
Size X; Y
[1; 0.5 (0 / 100)]
Resets the horizontal and vertical size of the brush strokes.
Angle
[0 (-100.000 / 100.000)]
Initial angle or rotation of the brush strokes, expressed in degrees.
Seed
[0 (0 / 100.000)]
Seed for the random positioning of the brush strokes. This parameter can be animated
so that the positions of the brush strokes are moved randomly.
Slopes
[Luminance (Luminance / Contour)]
Permits the rotation of the brush strokes to be varied by interpreting the rotation map
based on its luminance values (Luminance) or on outline detection (Contour). This
parameter is not used when the effect does not have a fourth input.
Blur
[0 (0 / 100)]
Blurs the fourth input, thus achieving smoother luminance transitions in the rotation
map, and less sudden rotation of the brush strokes.
ColorVar
[0 (0 / 100)]
Specifies a random variability of the brush stroke color.
Chain
[0 (0 / 1.000)]
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Creates copies of the original brush strokes in the form of a chain, joined at their
right-hand side.
This parameter is ideal set at high values, so that the brush strokes behave as lines
that change direction based on the rotation map.
SizeVar
[0 (0 / 100)]
Specifies a random symmetrical variability in the brush stroke size.
Use and C omments

The most common use of this effect is to simulate impressionist painting styles.
The brushstrokes act as bitmaps colored by a color map that can control the appearance of
the brushstrokes by their luminance, and so the position of these brushstrokes can also be
controlled, making a mask or color correction in order to select color ranges in the image
that will be the color map. Thus we can add star-shaped brushstrokes, for example, and
add definable glints to highlights. This possibility in BrushStroke allows us to add bitmaps in
selected pixels.
The rotation map also allows us to use this effect as a simple way of rotating brushstrokes
in accordance with the luminance of the fourth input. If the fourth input is assumed to be a
Circle effect with Rad and Soft values of 25, the distance of the brushstrokes to the
center of the circle provokes a proportional rotation, behaving in a similar way to an
expression specifying that the nearer the brushstroke to the center of the circle, the
greater the rotation.
In the example, the results of different parameter values can be seen.
In certain cases, different rotation and color maps are used, which will appear as small
images to the left of each image. The effects in which no parameter value exists are to be
interpreted as keeping the value of the previous example.
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Rain Fx

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Filter->Rain Fx
This effect creates the appearance of raindrops on water which evolve with time, producing
the corresponding waves, and giving the sensation of rain in the input image. The raindrop
areas can be generated either with random shapes, or based on input images. Effects of
ship's wakes or other effects of waves on liquids can also be generated by using the
animation present in the inputs.
I/O

Inputs
Multi-input: With or without alpha channel.
The first input is the one applied to the effect.
The remaining inputs will be used to generate drops using the luminance of each
frame. (The light areas in each frame produce new impacts).
Inputs
Image: Sequence with the effect applied.
Alpha: Texture of the distortions in water.
Parameters

Drip Rad
[0.1 (0 / 50)]
Specifies the radius of the random drops generated by the system as a percentage of
the image width.
Life
[1 (0,01 / 100)]
Specifies the life of the drop to the time of its disappearance. Higher values increase
the life of the drops.
A value close to 0 will cause the drop to disappear almost as soon as it falls.
This value is not measured in frames.
Hits
[0 (0 / 1.000)]
Specifies the number of drops that fall per frame. A value of less than 1 produces a
single drop every few frames.
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Depth
[60 (-100 / 100)]
Specifies the force with the drops fall. A negative value means that the drops lift the
water, instead of sinking it.
Seed
[0:100.000 (0 / 100.000)]
Specifies the seed for the generation of random numbers.
Refr.
[0 (-100 / 100)]
Specifies the refraction factor of the water. Negative values change refraction to
reflection.
AntiAlias
[0 (0 / 7)]
Specifies the number of multiple samples to be made for antialiasing the effect.
The greater the value, the greater the antialiasing.
Obey Msk
[No (No / Yes)]
Restricts the influence of the effect to the area specified by the alpha channel levels.
Use and C omments

If the effect only has one input, this will cause the raindrops to fall on it.
If it has more than one input, the second and further ones will be used for the creation of
additional drops, by making the luminance of each pixel produce a drop. With these
additional images it is possible to make the drops fall in the desired place, or achieve the
effect of a trail produced by an object in movement and making the drops are move
following any path.
Very interesting drop effects can be achieved by applying the Bump effect to the output of
this effect.
Important note: The result of the Rain Fx effect is an effect with feedback. In other
words, each image depends on the result of the previous one. Thus the result seen in a
frame during playback, will not be the same as the one seen if the frame is accessed
directly to the frame without carrying out playback. In addition, when playing in reverse,
the distortion map of the water is reset, so that, to remove the distortion map at any time
to clean up the image, simply go back a frame in the clip.
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Generate

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image

The Generate menu collects together a wide variety of “generating” effects for creating
new entities not existing in the input images, such as text, noise, degrades, etc.
Title

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Title
Generates texts by means of a vectorial plane that can be animated.
I/O

Inputs
This effect can function without input, generating a white text on black, or a solid
color with the text generated in the alpha channel
Single input: Image. The alpha channel will be replaced by the image of the
generated text or will be superimposed by the generated text, according to the Apply
parameter. This effect can therefore be used directly to generate text and compose it
on an image, since it can apply the text on the input of the effect (specifying the
Apply parameter in Image value).
Inputs
Without input:
Image: color image of the generated text depending on the Apply parameter.
Alpha: Opaque mask or with generated text depending on the Apply parameter.
Single input:
Image: Image without changes or with superimposed text depending on the Apply
parameter.
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Alpha: Opaque mask or with image of the generated text depending on the Apply
parameter.
Title Editor

Ref. Mamba: Visual Editor->Dashboard->Title
This effect has an extra interface extra (Title Editor), in which texts are written. It is
accessed via Mamba->Visual Editor->Manipulators Tabs->Title.
This interface is divided into two zones: Input Area and Attributes.
Input Area
This is where the texts to be generated are written.
To use characters pertaining to the language used (accents, monetary symbols etc),
configure the keyboard via the OS application Keyboard Layout.
Attributes
This area has different sets of buttons that define the characteristics of the texts created.
To change the attributes of a character or paragraph already typed, simply highlight the
text, select Attributes, and define the new value.
Current Font
This box indicates the name of the current font or typeface.
Font List
This list allows the font to be set. The selection mode is direct by clicking with the mouse
over the name of the font to be used.
To install fonts in the system, consult the appendix of this document.
In all cases, once the fonts are loaded in the correct place, refresh the list of fonts by
clicking Reload Font List. Unlike versions prior to v2.0, this list of fonts shows the name of
the font and not the name of the file containing the font.
Font Size
Value defining the size of the font. Bear in mind that the size of all fonts can be modified
with the zoom parameters of this effect.
30, 50, 70 and 100 are quick access buttons to predefined values.
Kerning
Value defining the space between characters.
Normal, Medium and Wide are quick access buttons to predefined values.
Leading
Value defining the space between text lines.
Normal, 1.2 and 1.5 are quick access buttons to predefined values.
Slant Angle
Value defining the inclination of the characters.
Oblique defines the default value.
Normal defines no inclination.
Align
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Set of buttons that define the alignment of characters to different margins of the image.
Left aligns the text to the left.
Center aligns the text to the center.
Right aligns the text to the right.
To the right of the Input Area there is a set of buttons for animating and storing the texts
created.
Roll Up and Roll Down
Set of buttons that define Roll animations in the values of the parameters of the effect,
affecting all texts generated.
Roll Up defines an upward roll, as seen in the final credits of movies.
Roll Down defines a downward roll of the text.
The box OffsetX defines an additional offset value at the start of the Roll movement.
Crawl
Set of buttons that define Crawl animations in the values of the parameters of the effect,
affecting all texts generated.
Crawl Left defines a text animation moving right to left, as seen in the final credits of TV
programs or legal texts superimposed in TV commercials.
Crawl Right defines a text animation moving left to right.
The box OffsetY defines an additional offset value at the start of the Crawl movement.
File
Set of buttons for saving and loading text in the interface.
Load Text opens a dialog box to load texts without attributes that have previously been
saved by the same effect or external text processing applications. This function can only
load ASCII type unformatted text.
These files must have the .txt extension
Save Text opens a dialog box to save texts typed in Input, ignoring their attributes. These
files will have the .txt extension and will be saved by default in the Output folder.
Load Formatted opens a dialog box to load texts with attributes that have previously been
saved by the same effect.
Save Formatted opens a dialog box to save texts typed in Input, ignoring their attributes.
These files will have the .ftxt extension and will be saved by default in the Output folder.
Back closes the Title interface.
Parameters
Color:

Parameters that defines the color and opacity values of text.
Red; Green; Blue
[100; 100; 100 (0 / 100)]
Specifies the color of the text. This color is unique for all fonts generated by the
effect.
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Level
[100 (0 / 100)]
Specifies the opacity of the generated text (alpha channel value), assigning a single
opacity value for all the text generated by the effect.
Title:

Parameters that defines disposition of text.
Rot X; Y; Z
[0; 0; 0 (–900.000 / 900.000)]
Specifies the amount of rotation in each axis. The center of rotation is determined by
the Center parameter.
Wide
[3 (1,33/ 10.000)]
Specifies the leakage of the distortion of the vectorial plane where the text is
generated. The leakage is only visible if the vectorial plane is rotated in X or Y.
Zoom X; Y
[100; 100 (–100.000 / 100.000)]
Specifies the scale (amount of zoom). The scaling center is determined by the Center
parameter.
Move X; Y
[0; 0; 0 (–900.000 / 900.000)]
Specifies the amount of offset in each axis. The position of the axes X and Y are can
be specified with the 2D manipulation mode.
Cent X; Y
[50; 50 (–10.000 / 10.000)]
Specifies the position of the centers of rotation and scaling.
Samples
[4 (1 / 32)]
Number of samples in the render processes.
High values specify greater number of samples, noticeably improving the image quality
of the result, very visible in the details of the font, edges and in text that has been
reduced in size.
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ArcsDiv
[1 (1 / 10)]
Specifies into how many segments the curves of vectorial text are subdivided. The
greater the number of segments, the smoother the curves.
Reveal
[100 (0 / 100)]
Sets the percentage of hidden/visible text. A value of 0 totally hides the text and 100
totally reveals it. The text can be viewed gradually by animating this parameter.
GapsX
[0 (–900.00 / 900.000)]
Scales the kerning parameter (space between letters) respecting the alignment of
each line.
GapsY
[0 (–900.00 / 900.000)]
Scales the parameter of leading (space between lines).
Size
[100 (–900.00 / 900.000)]
Scales the parameter of size (size of letter) without altering the kerning (space
between letters).
Angle
[0 (–900.00 / 900.000)]
Scales the parameter of Angle (inclination between letters).
Apply
[Image (Image/Mask)]
Defines the channel where the text is generated.
Image: The text is generated in the channels of the image (RGB). If the effect has
one input, the text is drawn on the image. If the effect has no input, it is drawn on a
black background.
Mask: The text is generated in the alpha channel, without altering the channels of
the image.
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Use and C omments

All the texts generated by Title are written in a plane that can be positioned in a "three
dimensional space" via animable parameters, and can be scaled without losing quality thanks
to the vectorial typefaces.
Note that the processing speed of this effect is very closely linked to parameters that
increase the resulting image quality, such as Samples and ArcDiv for example; we
recommend that these are carefully set to the minimum values that give the desired quality,
since misuse of these values can slow down the performance of the effect.
The effect generates fonts without texture, so that they can be used with other effects.
Some examples of textures generated in combination with other effects of the system are
shown below:

Solid

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Solid
Generates an image with a single color.
I/O

Inputs
None.
Inputs
Image: Assigned color.
Alpha: Opaque mask.
Parameters

Red; Green; Blue
[0; 0; 0 (0 / 100)]
Specifies the RGB value of the solid color.
Format
[HDR-HW (RGBA8b / YUV422 / RGB10b/ HDR-HW)]
Specifies the color space used to generate that which will generate the solid color.
This may be YUV 422, RGB.
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The RGBA8b space assigns 8 bits or RGB 10 per channel and additionally 8 bits for the
alpha channel. The other two modes do not generate alpha.
Alpha
[0 (0 / 100)]
Specifies the alpha value of the solid color (only available in RGBA8b and HDR-HW
formats)
Use and C omments

The purpose of this effect is simply to create a solid color.
This effect has no field. To defines the color use the panel Set Color (Visual Editor>Manipulators Tabs-Set Color), activated by doubleclicking on the effect in the
TimeSpace.
Grade

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Grade
Generates a color gradient from all of the four corners of an image.
I/O

Inputs
None.
Inputs
Image: color gradient from the four corners.
Alpha: Opaque.
Parameters

Mode
[HDR-HW (SW-RGBA8b /HDR-HW )]
SW specifies that the calculation is done by software.
HW-HDR specifies that the calculation is done by hardware, in 16 bits color depth per
channel (HDR stands for High Dynamic Range). This mode is recommended fro images
that have more than 8 bits per channel, typically those obtained from a film scanner.
UpLeft R; G; B
[100; 100; 100 (0 / 100)]
Specifies the color of the top left corner.
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UpRight R; G; B
[100; 100; 100 (0 / 100)]
Specifies the color of the top right corner.
DownLeft R; G; B
[100; 100; 100 (0 / 100)]
Specifies the color of the bottom left corner.
DownRight R; G; B
[100; 100; 100 (0 / 100)]
Specifies the color of the bottom right corner.
Use and C omments

This effect has no field. To defines the use Set Color (Manipulators Panels), activated by
doubleclicking on the effect in the TimeSpace.
The purpose of this effect is simply to create a color gradient from the four corners.
Remember that all four corners can be colored with the same color, by selecting the
subfolder of each corner and using Copy Curve and Paste Curve in the Parameters Panel.
(Mamba->Parameters->Clipboard->Copy Curve/Paste Curve)

C ircle

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Circle
Generates white circles on a black background, of sizes that can be specified, with control
of the smoothness of their edges.
This effect is used to generate WipeCircle of the Wipe Library (Mamba->TimeSpace
Editor->Dashboard->Edit->Wipes); as such, its description and parameters are the
same as WipeCircle.
This effect is easy to combine with other effects. Its uses can be different and varied.
It can basically be used as a mask, or a rotation, distortion, blur or displacement map for
different effects that use these types of map.
Stripe

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Stripe
Generates patterns of bands, with control of the smoothness of their edges, width and
spacing between them.
This effect is used generate the wipes of the Wipe Library (Mamba->TimeSpace Editor>Dashboard->Edit->Wipes); as such, as such, its description and parameters are the
same as WipeStripe.
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This effect is easy to combine with other effects. Its uses can be different and varied.
It can basically be used as a mask, or rotation, distortion, blur or displacement map for
different effects that use these types of map.
Wave

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Wave
Generates an image of concentric waves.
I/O

Inputs
None.
Inputs
Image: Pattern of concentric waves.
Alpha: Opaque mask.
Parameters
Wave_1:

Dropdown folder that contains the parameters of the default wave. The layers created later
are added to this one, as an identical folder identified by its number that is increased as
they are created. Creation, copying and deletion of layers are controlled from the
commands tab located in
Mamba->TimeSpace Editor->Mamba->Main Tabs>Parameters->Folder.
CentX; Y
[50; 50 (-100.000 / 100.000)]
Position of the wave generator, in percentage values of the image size.
WLen
[20 (0,001 / 100.000)]

Length of the waves.
Phase
[0:400 (-100.000 / 100.000)]
Evolution of the waves. This parameter should be animated so that the generator
sends the waves from its center towards the periphery.
Ampl
[100 (-100.000 / 100.000)]
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Specifies the amplitude of the waves. The greater the value, the greater the contrast
between the generated waves.
Decay
[65 (0 / 1.000.000)]
Specifies the decay of the amplitude as a function of the distance of the wave from
its generator.
Count
[100 (0 / 1.000.000)]
Specifies the maximum number of wave phases that the effect will generate.
Use and C omments

This effect is easy to combine with the other effects. Its uses can be widely different and
varied.
It can basically be used as a mask, or as a rotation, distortion, blur or displacement map for
different effects that use these types of map.

Noise

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Noise
Permits generating noise animated with a color option.
I/O

Inputs
None.
Inputs
Image: Noise pattern in black and white or color.
Alpha: Opaque mask.
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Parameters

Seed
[0 (0 / 100.000)]
Seed of the random generation of noise. Can be animated if necessary to simulate
noise in movement.
Rad X ; Y
[0 (0 /100.000)]
Specifies the average horizontal and vertical radius of the noise.
Qual
[2 (0 / 3)]
Specifies the filtering quality of the effect.
Color
[No (No / Yes)]
Pan X; Y
[0; 0 (-100.000 / 100.000)]
Specifies the offset of the noise. This parameter can be manipulated with the Set Pos
mode.
Cycle
[0 (-100.000 / 100.000)]
Specifies the evolution of the noise, producing a gradual change of the positions of
the spots generated by the effect.
Mode
[Normal (Normal / Plasma)]
Specifies type of noise required: normal or plasma.
Use and C omments

This effect is a tool that is very easy to combine with other effects. Its uses can be widely
different.
It can be used basically to generate a smoke or steam texture, as a rotation, distortion,
refraction, blur or displacement map for different effects that use these types of map.
Simulation of textures and materials can be attained by manipulating its parameters and
combining it with other effects.
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In the first image of the following example, color corrections, offset maps and threedimensional lights are used within the Comp3D effect to simulate clouds and seas. In the
second image, the same effect is used, but to imitate wood. In the third image, the Blur
(Type Grow) effect is used to Blur (Type Schrink) the red channel and enlarge the green
channel of the image produced with Noise, with its Mode parameter set to No.

If the Cycle parameter is animated, noise evolution is achieved, which is useful for imitating
the behaviour of waves or steam.
Fractal

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Image->Fractal
Generates an image of animable fractal noise, optionally in color.
I/O

Inputs
None.
Inputs
Image: Noise pattern in black and white or color.
Alpha: Opaque mask.
Parameters

Seed
[0 (0 / 100.000)]
Seed for the random generation of noise. It can be animated if necessary to simulate
noise in movement.
Levels
[8 (4 / 16)]
Number of noise levels. The more levels, the greater the size of the noise pattern.
Decimal values are allowable, which specify mixing from one level to the next.
Decay
[2 (1 / 6)]
Decay of the visibility of noise details. The lower the value, the more noise detail is
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viewed.
Contrast
[200 (-100.000 / 100.000)]
Control of the noise contrast.
Color
[No (No / Yes)]
Option to obtain noise in random colors.
Pan X; Y
[0; 0 (-100.000 / 100.000)]
Specifies the noise offset. This parameter can be manipulated with the Set Pos mode.
Cycle
[0 (-100.000 / 100.000)]
Specifies the progress of the noise, producing a gradual change of the positions of the
marks generated by the effect.
Mode
[Normal (Normal / Plasma)]
Specifies type of noise required: normal or plasma.
Use and C omments

This effect is a tool that is very easy to combine with other effects. Its uses can be widely
different.
It can basically be used to generate a smoke or steam texture, as a rotation, distortion,
refraction, blur or displacement map for different effects that use these types of map.
Unlike Noise, this effect generates synthetic noise which thanks to its reproduction method
hides its cyclical pattern, making it less recognizable.
In the first image of the following example, color correction is used to simulate marble. In
the second image, LiquidBump is used to simulate mercury. In the third image, two Fractal
effects are combined with And, one to generate the basic color texture (with the Color
parameter set to Yes) and the other to simulate the shape of a nebula.
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Mandelbrot

Ref. Mamba:TimeSpace Editor->Dashboard->Fx->Mamba->Image->Mandelbrot
Generates an algorithmic Mandelbrot-type texture.
I/O

Inputs
None.
Inputs
Image: Mandelbrot image.
Alpha: Opaque mask.
Parameters
ShadeCount:

Folder that contains the parameters that specify the base color from which the Mandelbrot
will be generated.
Red;Green;Blue
[64; 64; 64 (1 / 512)]
RGB value of the base color.
Box_1:

Dropdown folder that contains the parameters of the default viewing box. These boxes allow
the specification of which part of the Mandelbrot is to be viewed, in a similar way to a
magnifying glass.
Boxes that are created later will be added to this one, as an identical folder identified by its
number, which is increased as they are created. Creation, copying and deletion of boxes are
controlled from the commands tab located in Mamba->TimeSpace Editor->Mamba>Main Tabs->Parameters->Folder.
Left
[0 (0 / 100)]
Left edge of the viewing box as a percentage of the image width.
Right
[100 (0 / 100)]
Right edge of the viewing box as a percentage of the image width.
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Up
[100 (0 / 100)]
Top edge of the viewing box as a percentage of the image height.
Down
[0 (0 / 100)]
Bottom edge of the viewing box as a percentage of the image height.
Mandelbrot:

Iterations
[64 (0 / 256)]
Number of branches of the texture.
Box_#
[256 (0 / 256)]
Specifies which box will be viewed. Decimal values indicate a gradual change from one
box to the next.
Use and C omments

The purpose of this effect is simply to generate a Mandelbrot image from which a part of
the texture with the parameters of Box_1 can be selected, in order to amplify and visualize
it in detail. In addition, animations can be created with an the interpolation of different
Boxes, with the Box_#.parameter.
In the example, different levels of detail can be seen.
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Blur/Sharp

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Blur/Sharp

The menu Blur/Sharp contains spatial filters, blur filters and effects to increase the detail of
a image.
Blur

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Blur/Sharp->Blur
This effect views a clip name composed of its two first parameters, so this description
makes reference to the name of the effect according to its type and application mode.
It is an effect that applies spatial filters to any of the channels of the image (RGBA or
chrominance), blurring, shrinking or increasing its bright surface, optionally controlling the
radius of the application according to an attenuation map, and also , in "figure” mode for
clips that are composed in a prior process.
The effect can be accessed via the effects gallery, the hotkey presets and a specific
button within the gallery, but in fact only this effect is accessed since it brings together
many possible functions.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with the specified filter applied.
Alpha: Mask with the specified filter applied
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Parameters
Modes:

Folder that contains the parameters that specify the type of spatial filter and application
and calculation modes.
Type
Gauss, Box, Circle, Median, Grow, Shrink
Specifies the type of matrix applied as filter.
Gauss is a classic soft defocussing and blurring filter.
Box is a classic soft defocussing and blurring filter, quicker to calculate than Gauss,
but with a square matrix that is reconcilable with hight radius values.
Circle is a blurring filter that uses a circular matrix, with a slower processing time, but
is recommended for emulating camera blurs.
Median is a classic noise reduction filter.
Note: some graphics cards do not support the median-type filter, so in this case it is
recommendable to use Sware render mode.
Grow is a classic filter for expanding bright zones in the image channels.
Shrink is a classic filter for shrinking bright zones in the image channels.
Note: The type of matrix specified is viewed as the first part of the name of the
effect clip in the TimeSpace.
Mode
RGB, RGB-InA, Chroma, Chroma-InA, R, G, B, A, RGBA, Foreground, RGB-RadA
Specifies the application mode of the type of filter set.
RGB applies the filter to the RGB channels, leaving the alpha channel unchanged.
RGB-InA applies the filter to the RGB channels according to the opacity set by the
alpha channel, leaving the alpha channel unchanged.
Chroma applies the filter to
luminance values unchanged.

the chrominance values of each pixel, leaving the

Chroma-InA applies the filter to the chrominance values of each pixel according to
the opacity set by the alpha channel, leaving the luminance and alpha channel
unchanged.
R, G, B, A applies the filter only to red, green blue and alpha channels.
RGBA applies the filter to RGB and Alpha channels.
Foreground applies the filter to the RGB channel according to the opacity set by the
alpha channel, adding a “divide” function to de-premultiply the background figure,
leaving the alpha channel unchanged.
RGB-RadA

applies the filter to RGB channels, leaving the alpha channel unchanged,
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using the alpha channel the Radius parameter as attenuation map.
Note: The type of matrix specified is viewed as the second part of the name of the
effect clip in the TimeSpace. For example, a blur filter of Gaussian type only in mask
mode will be viewed as Gauss:A. A Box type filter applied in Foreground mode will be
viewed as Box:Foreground.
Render
HWare, Sware
Specifies that the processing will be calculated by software or hardware.
Note: the default option (HWare) is recommended as modern graphics boards are
optimized to work even in depth of up to 16 bits per pixel.
Radius:

Folder that contains the parameters that control the application radius of the specified
filter.
Radius
[0 (0 / 100)]
Controls the application radius of the specified filter.
Note: if an attenuation map (for example the alpha channel in RGB-RadA mode) is
used, this parameter specifies the maximum application radius.
Anamorph
[0 (-100 / 100)]
Specifies an anamorphic aspect to the matrix used by this effect.
The default value indicates that the filter acts symmetrically between the horizontal
and vertical axes. Positive values gradually restrict the action of the effect to the
vertical axis, whereas negative values restrict them to the horizontal axis
Units
[10.000 (1 / 1.000.000)]
Scales the value of the Radius parameter.
Note: this parameter should be used to find the best scale for the size of the image to
be processed, the Radius parameter is relative to image size, and a low radius value
for SD resolution might be much greater in HD. Use this parameter to reset the
parameter scale that specifies the radius. To use the scale in versions of Mamba
earlier than v4.0, the parameter should be set at 100.
Use and C omments

The Box spatial filter averages the pixel values with a square-shaped matrix of decreasing
radial influence. This results in the softening of the transitions between opposing values,
with an appreciable blurring of the outlines.
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In the following example, it can be seen that, when the Amount parameter of the effect has
high values, the square matrix that the filter uses for blurring becomes noticeable. With the
Anamorph parameter, the action of the filter can be gradually restricted to either of the 2
two-dimensional axes.

The Gaussian spatial filter averages the pixel values with a circular matrix of decreasing
radial influence. This results in the softening of the transitions between opposing values,
with an appreciable blurring of the outlines, similar to seeing an image through a misted
glass.
In the following example it can be appreciated that the Gauss filter, compared to the Box
filter, requires a lower Amount value to blur the image, and the shape of the matrix of the
filter is imperceptible. When the filter action is restricted entirely to a single axis by using
the Anamorphparameter, the result of the effect is almost identical to that of Box since in
the latter case it does not take advantage of the shape of the matrix of theGauss filter.

The Circle spatial filter averages the pixel values with a circular-shaped matrix. This softens
the transitions between opposing values, giving a visual result that enlarges and roughens
outlines, similar to defocussing. Thus this filter is the most appropriate for simulating camera
blurs.
In the following example, it can be seen that when the effect has high Amount parameter
values, the circular matrix used by the filter for blurring is clearly visible.
In RGB-RadA mode, the alpha channel is used as an attenuation map and does not defines a
level of opacity in the application of the filter, but rather attenuates the defocussing value
defined by the Radius parameter, and therefore it is not the same as using the Blur effect
with the RGB-InA mode activated..
In the following example both effects are compared.

The attenuation map can be generated for example with VectorPaint to simulate a reduction
of the depth of field. In the following example a practical use can be seen.
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The filters Grow and Shrink are basic filters which can be used to achieve various results.
One possible use is to control the brightness of an image modifying RGB channels by the
same small decimals values. High value make the filter's geometry visible in the image.

If channels are modified with different values, the result is a halo of the higher color
surfaces around the white surfaces. The third image shows the result subtracting from the
original image (with the Boolean effect Sub) a copy of the shrunk channels (as in the
second image above) to obtain an image of the edges.

The Gauss:Chroma spatial filter is recommended for applying to images derived from
compressed digital video formats or those with subsampling color to hide the damage
caused by compression which may be exaggerated by later color corrections. In the case of
needing to hide a problem of subsampling color (for example 4:2:2 digital betacam, or 4:1:1
DV), use this filter horizontally (with the anamorph parameter in -100).
Use of spatial filters only in the alpha channel are described below.
The Box:A spatial filter averages the pixel values with a square matrix of decreasing radial
influence. This results in the softening of the transitions between opposing values, with an
appreciable blurring of outlines.
The last image of the following example has a high blur value and an additional contrast, to
make the shape of the matrix used in the effect visible.

Bear in mind that a mask blur produces a symmetrical softening at its boundaries,
contracting and expanding the total opacity surface. This can be a problem in cases of
composition of cutouts made on greenscreens or bluescreens, since part of the original
background of the figure can leak into the composite layer.
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The following image demonstrates this problem:

To avoid this problem, shrink the mask (for example with Shrink:A) before applying the blur.
The Gauss:A spatial filter averages the pixel values with a circular-shaped matrix of
decreasing radial influence. This results in the softening of the transitions between opposing
values, with an appreciable roughening of the outlines, similar to seeing an image through a
misted glass.
The last image of the following Example has a high blur value and an additional contrast, to
make the shape of the matrix used in the effect visible.

The spatial filter in Foreground mode (for example Gauss:Foreground) is ideal for blurring
layers composed on a background or on other layers, virtually simulating depth of field in
the composition,
A simple sum of blur filters for alpha channel and image applied at the same time (Gauss:
RGBA for example) would create image imperfection at the edges, since the image blur would
associate the pixel colors of the original background with the pixels of the cutout figure.
Foreground is the mode for blurring foregrounds, since it affects all the canals of its input,
adding in the image an additional operation that prevents problems of invasion of the
foreground by the cutout figure.
In this example, the difference between blurring the image and mask and using this effect
can be seen. In the second image, the problem of foreground invasion by the cutout colors
is clearly seen, in this case as a gray border, creating a halo image around the composed
figure.

Shrink:A shrinks masks to exclude the borders of a character or object from a composition,
since the boundaries are usually the areas critical to the integration of images. In the
following example, although the extracted mask itself looks very good, it allows part of the
background of the original cutout to be seen in the borders of the composed figure, as a
very thin gray exterior line. The same layer with a little Shrink:A corrects this problem,
removing the exterior border of the mask opacity.
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This should only, however, be a last resort, since Shrink:A contracts the mask on the basis
of copying the values of neighboring pixel. Therefore, if this effect is misused, artifacts can
be generated in the composition, since the original shape of the mask is being modified and
an outline that does not correspond to the original geometry of the composite layer will be
made visible in the composition. This will be especially visible if the mask has areas of
internal transparency.
In this example, it can be seen that small shrinkage values do not substantially alter the
original shape of the mask, whereas high values deform and even break up the mask, in this
case separating the hand from the arm.

Thin masks (such as masks of hairs for example) are often most affected by misuse of this
effect, and other solutions should be sought to correct the mask, such as using the Remap
effect combined with other effects for example.
Very occasionally, an expansion of the mask may be required such as an outline with Grow:
A. A possible case would be expanding mask drawn with VectorPaint, but almost never will
the of a mask extracted with Bluescreen, be required, for example.
A useful example of mask expansion would be to enlarge text, although within certain
limitations, since a great degree of expansion would lead to a geometrical problem.

Note that with high values, Grow:A will make the text lose its original geometry, most
markedly in rounded forms of the letter “e”, where the generation of internal angles begins
to be noted.
To attain more rounded results, we recommend using the Remap effect combined with other
effects.
Dir Blur

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Blur/Sharp->Dir Blur
Makes a Directional type blur, in a specified direction. Its result is similar to the moved
image produced by a rapid camera pan.
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I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Blurred image.
Alpha: Blurred mask.
Parameters

Amount
[0 (0 / 100)]
Specifies the blur length.
Angle
[0 (–100.000 / 100.000)]
Specifies the angle of the blur direction.
Use and C omments

In addition to simulating the blurring of an image produced by a panning movement, this
effect can be used to create luminous rays, by combining the Boolean Add effect.

Radial Blur

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Blur/Sharp->Radial Blur
Makes a Polar type blur from a specified coordinate. Its result is similar to an image
movement produced by a rapid camera zoom movement.
I/O

Inputs
Single input: Image with or without alpha channel.
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Inputs
Image: Blurred image.
Alpha: Blurred mask.
Parameters

Zoom X; Y
[100; 100 (-100 / 100.000)]
Specifies an expansion or contraction produced by the filter, individually for the
horizontal and vertical axes.
Center X; Y
[50; 50 (-200 / 300)]
Sets the two-dimensional coordinate of the filter pole. These values are percentage
coordinates of the image size.
Angle
[0 (–10.000 / 10.000)]
Sets the rotation angle of the effect. The blur can be rotated with this parameter,
emulating a camera roll effect in the depth axis (roll).
Use and C omments

In addition to simulating the blurring of an image produced by a zoom or roll movement, this
effect can be used to create luminous rays, by combining the result of this effect with a
copy of the original clip with the Add effect.
The following example shows the results of using different parameter values.
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Slope Blur

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Blur/Sharp->SlopeBlur
Makes a Slope type blur, which blurs the image in the direction determined by the boundary
detection of a second input.
I/O

Inputs
Single input: The same input is used as the image to be processed and the blur map.
Double input: The first input is the image to be processed; the second is the blur
map.
Inputs
Image: Blurred image.
Alpha: Opaque mask.
Parameters

Blur
[0 (0 / 100)]
Blurs the blur map, softening it by expanding the boundaries that specify the stump
range.
Amount
[0 (0 / 100)]
Image blur level in the direction specified by the blur map.
Angle
[90 (-100.000 / 100.000)]
Specifies a rotation in the direction specified by the blur map.
Use and C omments

This effect, unlike other Blur effects, does not have an a natural optical equivalent. Its
results, when used with a single input and with high blur values, are somewhat similar to
what occurs when a painting is treated with a solvent.
It is useful for creating surreal or dream-like images.
In the following example, the results of different parameter values are shown, and also of
using the same image as a blur map or a different image.
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Sharpen

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Blur/Sharp->Sharpen
Sharpens detail in the image by increasing the outline contrast.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with enhanced details.
Alpha: No change or with enhanced details.
Parameters
Modes:

Folder that contains the parameters that specify the type of matrix and calculation mode to
be used.
Type
[Gauss / Box / Circle / Median]
Specifies the type of matrix to be applied as filter.
Gauss is a circular, unfocussed matrix.
Box is a square matrix.
Circle is a circular, sharp-focussed matrix.
Median is a low-pass-type matrix.
Note: some graphics boards do not support median filters, so in this case render in
Sware mode.
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Mode
[ RGB / RGB-InA / A]
Specifies the calculation mode of the set filter.
RGB applies the filter to the RGB channels, leaving alpha channel unchanged.
RGB-InA applies the filter to the RGB channels, with the opacity set by the alpha
channel, leaving alpha channel unchanged.
A applies the filter only to the alpha channel.
Render
[HWare, Sware]
Specifies that the processing will be calculated by software or hardware.
Note: the default option (HWare) is recommended as modern graphics boards are
optimized to work even in depth of up to 16 bits per pixel.
Radius:

Folder that contains the parameters that control the radius of the filter application.
Radius
[0 (0 / 100)]
Controls the radius of application of the specified the filter.
Anamorph
[0 (-100 / 100)]
Specifies and anamorphic aspect to the matrix that uses the effect.
The default value indicates that the filter acts symmetrically in the vertical and
horizontal axes. Positive values restrict the action of the effect to the vertical in a
gradual manner, while negative values restrict the action of the effect to the
horizontal.
Units
[10.000 (1 / 1.000.000)]
Scales the value of the Radius parameter.
Note: this parameter should be used to find the best scale for the size of the image
to be processed, the Radius parameter is relative to image size, and a low radius value
for SD resolution might be much greater in HD. Use this parameter to reset the
parameter scale that specifies the radius.
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Sharpen:

Folder that contains the characteristic parameters of this type of spatial filter.
Amount
[50 (0 / 100.000)]
Amount of contrast applied to the details.
Threshold
[0 (0 / 100)]
Threshold of details where the improvement is applied.
Use and C omments

One frequent use of this effect is to improve the definition of images.
It should be mentioned that it is not possible to focus an unfocussed image during postproduction. Existing detail can only be emphasized, even though it is not very sharp. When
the contrast of the detail is increased, the image noise also always increases. This increase
in noise will be more noticeable in image sequences than in a single frame.

Fields

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Fields

The menu Fields contains filters for the control of fields.
Interlace

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Fields->Interlace
Interlaces its two inputs, interpreting each as a field.
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I/O

Inputs
Double input: Image with or without alpha channel.
Inputs
Image: Two interlaced inputs.
Alpha: Two interlaced input masks.
Parameters

None.
Use and C omments

This effect has the simple purpose of interlacing its two inputs.
The example shows how the effect works with two very different inputs. The first input will
be inserted in the first field that is read depending on the standard specified in the system
configuration.

When rendering, it is essential to activate the Interlaced option, as otherwise the effect will
be ignored.
Mixed Field

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Fields->Mixed Field
De-interlaces its input, creating a de-interlaced frame containing a mix of the images of
both the original fields.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image without fields, with a mix of the two images of the original fields.
Alpha: Mask without fields, with a mix of the two masks of the original fields.

SGO Mamba 2.0.1 © 2014 SGO

424

FX

Parameters

Quality
[On (Off / On)]
Activates or deactivates a higher quality interpolation method, although processing
speed is lost.
Use and C omments

This effect is generically recommended for de-interlacing sequences with little movement,
since mixing of two very different fields can create an undesirable effect, similar to “filage”.
That said, field mixing gives a better result than line interpolation, which the lower stepping
of the diagonal lines in the de-interlaced image makes clear, and even noticeable with the
Quality parameter set to ON.
In the following example, three details are shown. The first is the original image. The
silhouette is fixed, and so both fields form the same image. The following images compare
this effect with InterpField, which uses a method of interpolation between the lines of the
same field. The result of MixedField is in this case notably better.

The following example shows that the Quality parameter noticeably increases the resulting
image quality, gaining sharpness when the parameter value is set to ON.

The precise interpretation of the Field parameter depends on the video format. The
consecutive field order varies between PAL and NTSC. The De-Interlace calculation always
corresponds to the temporary field order, not to the odd or even lines.
When rendering, it is essential to deactivate the Interlaced option, as otherwise the effect
will be ignored.
Interp. Field

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Fields->Interp. Field
De-interlaces its input, creating an image by interpolation between lines in the field that is
removed.
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I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with a field created by interpolation between lines, and with the other
field intact.
Alpha: Mask with a field created by interpolation between lines, and with the other
field intact.
Parameters

Field
[Field-0 (Field-0 / Field-1)]

Specifies the field to be extracted. A value Field-0 extracts the first field in time, whereas
the second is extracted with a value of Field-1.
Use and C omments

This effect is generally recommended to de-interlace sequences with a lot of movement. For
sequences with little movement, we recommend the MixedField effect.
The first example image shows that the two fields contain very different images, as occurs
in video sequences with a lot of movement. The interpolation filter achieves a better image
in these cases than the mix filter used by the MixedField effect, since mixing fields would
cause loss of sharpness.

The precise interpretation of the Field parameter depends on the video format. The
consecutive field order varies between PAL and NTSC. The De-Interlace calculation always
corresponds to the temporary field order, not to the odd or even lines.
When rendering, it is essential to deactivate the Interlaced option, as otherwise the effect
will be ignored.
Duplicate Field

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Fields->Duplicate Field
De-interlaces its input, creating an image by copying lines in the field that is removed.
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I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with a field created by copying lines from the other field, and with the
other field intact.
Alpha: Mask with a field created by copying lines from the other field, and with the
other field intact.
Parameters

Field
[Field-0 (Field-0 / Field-1)]
Specifies the field to be extracted. The value Field-0 extracts the first field in time
whereas the second is extracted with a value of Field-1.
Use and C omments

Generally, the InterpField effect achieves better image quality than this effect, although in
some special circumstances it may be necessary to copy the field without interpolation. In
the following example, three details are shown.
The first image is the original. The silhouette is fixed, and so both fields form the same
image.
The second image uses DuplicField.
The third has the effect InterpField applied, which uses a method of interpolation, resulting
in a notably better quality of image than that of duplication.

The precise interpretation of the Field parameter depends on the video format. The
consecutive field order varies between PAL and NTSC. The De-Interlace calculation always
corresponds to the temporary field order, not to the odd or even lines.
When making a render, it is essential to deactivate the Interlaced option, as otherwise the
effect will be ignored.
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E-2 Misc
Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Misc
The menu Misc contains various effects that do not belong to other groups.
Framing

Ref. Mamba: TimeSpace Editor->Dashboard->Fx->Mamba->Misc->Framing
This effect allows direct access to the Framing tab in the Visual Editor (Visual Editor>Dashboard->Framing) without needing to apply an additional effect (such as Color
Grade or Comp3D).
As well as the possibility of adjusting rescale and cropping values via its manipulators,
Framing offers parameters that are relative to the preparation of stereo clips and to the
management of different image resolutions in the same project.
For more information relating to the use of the manipulators in the Visual Editor, consult the
chapter dedicated to the Framing tab.
I/O

Inputs
Single input: image with or without alpha channel.
Inputs
Image: Cropped and rescaled; with the original resolution or with that corresponding
to the current project (depending on the parameter Result Size).
Alpha: Cropped and rescaled mask; with the original resolution or with that
corresponding to the current project
Parameters

Options

Mirror
[None (None / Horizontal / Vertical / Rotate]
Corrects the mirror effect in the stereo pairs deriving from mirror rig systems,
inverting the image la horizontally, vertically or both ways.
Result Size As
[Input (Input / Project]
Specifies the resolution of the output of the effect. The Input option sets the
resolution as the same as the original clip. The Project option sets the output
resolution as that of the current job (mConfig->RenderFormat ).
The Input option is especially useful, when the clip has a higher resolution than the
project and it is desirable to maintain this resolution to be applied to other effects
later, such as Comp3D and Color Grade which can work in full resolution and extract
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greater detail from the working resolution.
Quality
[Bilinear (Nearest / Bilinear / Bicubic / 7 Taps / 15 Taps)]
Specifies the quality of the rescale filter.
The qualities available are shown in the dropdown list of the parameter, from lower to
higher from top to bottom. It is recommendable to use the lowest quality that gives
appreciable improvements, since the higher the quality, the more calculation time is
required.
Roll

Roll
[0 (-100 / 100)]
Rotates the whole image around its center point.
Note: This parameter works in degrees, unlike the majority of Mamba parameters, which
work with percentage values.

Scale

Scale X; Y
[100; 100 (0 / 100.000)]
Specifies the percentage value of the output image size to which the original will be
rescaled.
Note: The percentage value is relative to the resolution of the output, not to the
original resolution of the file to be rescaled. To see the values in pixels, it is
recommended to use the manipulation mode User Resize and Offset in Pixels of the
Visual Editor->Framing manipulator.
Offset

Offset X; Y
[0; 0 (-100.000 / 100.000)]
Specifies a two dimensional offset of the output image, expressed in percentage units.
Note: The percentage value is relative to the resolution of the output, not to the
original resolution of the file to be offset.
To see the values in pixels, it is
recommended to use the manipulation mode User Resize and Offset in Pixels of the
Visual Editor->Framing manipulator.
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C rop

Crop Left; Right; Top; Bottom
[0; 100; 100;0 (0 / 100]
Specifies the cropping of an image from it four borders, coloring the cropped area
black and at the same time cropping the alpha channel.
Note: The percentage value is relative to the resolution of the output, not to the
original resolution of the file to be cropped. To see the values in pixels, it is
recommended to use the manipulation mode User Crop in Pixels of the Visual Editor>Framing manipulator.
GLSL

This effect allows the application of GLSL code and controls its parameters via the Mamba
interface.
This code is supported natively by Nvidia GPU and is implemented via the three floating
variables in each of its 5 parameters.
The intention of this is to permit the programming of user effects that can be processed at
great speed or in real time.
I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with changes specified by the GLSL parameters.
Alpha: Mask with changes specified by the GLSL parameters.
Parameters

GLSL C ode

GLSL Code
Allows the selection of the source code to be applied. These codes must be installed
in the directory /home/Mamba/Mamba-ENV/etc/GLSL.
If the directory does not exist, it must be created.
Parameters: paramX

This folder contains a group of 5 parameters each with 3 different values. all of these
parameters can be specified via the application of source code.
The use of these parameters allows the direct implementation of effects processed by the
GPU.
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paramX.r; paramX.g; paramX.b
[0; 0; 0 (0 / 100.000)]
Value fields for the selected source code.
LUT 3D

This effect allows the application of LUTs 1D and LUTs 3D directly to a clip in real time.
Unlike the 3DLUTs of RGBCor effects (which all use the same 3DLUT), this effect allows us
to apply different LUTs to each type of clip.
It also allows advanced combinations of LUT1D and LUT3D.
We normally only need to apply one of the three possible LUTs, but up to three LUTS can
be combined at the same time in various ways. IF they are defined, the three LUT are
applied in the order that they appear (LUT 1D a, Lut 3D, LUT 1D b) (see Use and Comments
section for more information).

I/O

Inputs
Single input: Image with or without alpha channel.
Inputs
Image: Image with the color values processed and modified by the LUTs.
Alpha: Unchanged.
Parameters

Input

Scale
[1 (-100.000 / 100.000]
Specifies the value of the gain of the input.
Offset
[0 (-100.000 / 100.000]
Specifies a displacement of the luminance values of the input.
Gamma
[1 (-100 / 100]
Specifies the value of the gamma curve of the input.
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Use
[Direct (Direct / Inverse]
Specifies whether the input parameters are applied directly or inversely. Inverse mode
is normally only used when using the effect to reverse the application before in the
same LUT n a different effect
Lut 1D a

Dropdown LUT File which allows the selection of the LUT 1D file to be applied before the
application of the LUT 3D.
The LUT files must be installed within the directory /home/Mamba/Mamba-ENV/etc/1DLUTS.
Lut 3D

Dropdown LUT File which allows selection of the LUT 3D to be applied.
The LUT files must be installed within the directory /home/Mamba/Mamba-ENV/etc/3DLUTS.
Lut 1D b

Dropdown LUT File which allows the selection of the LUT 1D file to be applied subsequently
to the application of the LUT 3D.
The LUT files must be installed within the directory /home/Mamba/Mamba-ENV/etc/1DLUTS.
Output

Scale
[1 (-100.000 / 100.000]
Specifies the value of the gain of the output.
Offset
[0 (-100.000 / 100.000]
Specifies a displacement of the luminance values of the output.
Gamma
[1 (-100 / 100]
Specifies the value of the gamma curve of the output.
Use
[Direct (Direct / Inverse]
Specifies whether the output parameters are applied directly or inversely. Inverse
mode allows the reversal of the effect of the application of the Lut 1D to which it was
applied before the LUT 3D.
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Use and C omments

The effect LUT 3D allows the application of a correction via 1D LUTs before and after the
application of a LUTS 3D.
The order of the process is the same as that of the folders of the parameters, that is to
say: the Lut 1D a correction will be applied to the result of the Input correction parameters,
and so on up to the Output parameters.
The default format for these files is .itx. This format is compatible with other systems such
as Lustre (16bit), Nucoda, Nuke, Quantel, Shake, SRW and Blackmagic HDLink.
The Input and Output groups of parameters allow additional corrections to be carried out
before and after applying the main LUT. For example, if the effect is applied to a clip whose
color space is logarithmic, it is possible to change the value of Gamma in the input of the
effect (Input) to linear, via, for example, a LUT1D, since LUTs 3D are more accurate when
working in a linear space. Once the LUT 3D is applied, it is possible to reverse the
conversion of Gamma in the output (Output) to be able to return to the original color space
. To do so, we directly invert the original LUT1D without needing to have a file with it.
Layer Route

The effect Layer Route works in a similar way to the effect Channels, but in this case using
the layers contained in the relevant EXR clip as interactive elements. Depending on the EXR
file used, the number of layers can vary, as can their names, since these are characteristics
that are generated when the file is created.

I/O

Inputs
Single Input: EXR image
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Inputs
Image: any of the information layers contained in the RGB channels of the EXR file.
Alpha: any of the information layers contained in the Alpha channel.
Parameters

Layer Set:
Allows the selection of the layer to be used as general information for the clip.
Layer to R
Allows the selection of the layer to be used as information for the red channel of the
clip.
Layer to G
Allows the selection of the layer to be used as information for the green channel of
the clip.
Layer to B
Allows the selection of the layer to be used as information for the blue channel of the
clip..
Layer to A
Allows the selection of the layer to be used as information for the alpha channel of
the clip.
Use and comments

As with the effect Channels, this effect can have multiple uses. The most obvious is for
viewing. Since Mamba does not have a viewing mode where the different layers of an EXR
can be analyzed visually, this effect allows us to reinterpret them in RGBA in order to work
directly with them.
It is also possible to have an information layer that is different in each of the channels, and
perform general operations between them with effect such as Channels, Color Grade or
directly with Comp3D for compositing.
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F-1 Known Bugs
Detailed below are explained different known bugs in Mamba:

- Problem with time-dependent effects: some effects like those which use OpticalFlow to
generate the result, can't be connected to a clip at the same time (using a second input
from the clip). For example, you can not connect a TimeWarp and a Denoise at the same
time using a second link for the Denoise effect. The second input won't offer any RGB or
Alpha information. In these cases, the solution is duplicate the clip and use it individually
with this kind of effects.

- Problem with two Spatial Key connected ath the same time: when you connect two
Spatial Key to one clip using two different links, the second input doesn't charge the EXR
layers, so the effect doesn't work. The solution is duplicate the clip and use it with the
Spatial Key individually.
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And to all those customers that kindly have given us pictures to illustrate this manual:

BTV Brighton & London:
BTV Post is a cutting edge facility house leading the way in HD and 3D. Blending creative
talent with advanced experience of technology, the company manages and delivers complex
workflows and projects to clients.
Das Werk Berlin:
PICTORION das werk GmbH is one of the leading post production groups in Germany. With
five offices across the country, they offer the complete range of digital post production
services. Their customers are advertising agencies, commercial and film producers, TV
broadcast stations and industrial enterprises.
Framestore London:
Framestire has been working in digital film and video for over 20 years, creating original and
astonishing work that has helped make it the largest visual effects and computer animation
studio un Europe.
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Hocus Focus Oslo:
Hocus Focus is a postproduction company located in Oslo. Established in 1999 and have
been using SGO Mamba from the very beginning. Hocus Focus Prime Focus is commercials,
documentaries, shorts and feature films.
Visor Studios Madrid:
With 25 years experience, Visor Studios is an excellent production boutique, to tailor and
make reality any project in time and with the best quality of service.
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G-1 Glossary of Terms
3:2 Pulldown: A process consisting of dividing the original movie frames into fields (one with
the odd lines and other with the even) to obtain 48 fields (2x24), with which to create the
60 fields per second that NTSC requires. This is done by repeating a field when necessary
(first every three frames, then every two, then three frames again and so on, and
alternating the field to be repeated between the odd and even ones).
Antialiasing: An effect that softens the edges of an image for removing the tooth effect.
High quality Antialiasing (as referred to in Mamba by the word “Antialiasing”) is not based on
smoothing the existing edge by using a simple blur of the mask edge, but rather it uses the
edges of polygonal or vectorial objects and is based on the calculation for each pixel of the
percentage of their area that would be included in the polygonal or vectorial object, so that
the pixel color is not simply that of the interior or exterior of the object, but one that
reflects this percentage. Antialiasing can be calculated with more or less accuracy,
depending on the number of samples of subpixels that are taken to calculate these
percentages.
Aspect Ratio: Relation between the height and width of an image.
Banding: Band effect that occurs because of problems of color depth when degrading
between neighboring colors in the color space. It can be eliminated by using the Bandither
effect.
C-Black: When processing images originating in computer graphics that were created on a
black background with a mask, the color of their edges tends towards black because of
antialiasing with the black background. This effect can be combated by using prior
multiplication of the mask by the image color before composing, a process which is called CBlack.
Cache: Provides fast access to information for speeding up viewing and calculation
processes.
Channel Alpha: Mask channel (see Mask).
ClipBox: When converting movie material to NTSC or PAL the original image is cut on the
left and right. This process is called ClipBox.
Chroma key: See Keying.
Animation curve: The curve resulting from the interpolation of the keyframes that specify
the animation of a parameter.
Dynamic Tracking: Process in which a VTR is capable of slowing down or accelerating the
video signal.
Drag & Drop: A quick and easy technique for copying of information from one part to
another part of the user interface. This tool works by selecting the object to be copied, and
with the left mouse button pressed, dragging it to the place where it is to be copied. Once
there, release the mouse button and the object will be copied to its target.
The Drag & Drop technique controls the type of object copied so that, if the position where
the object is released for copying does not accept objects of this type, the object is not
copied.
Foreground: The first (and frontal) element of a composition,
Keyframe: The Keyframe concept is used in animation. To animate a parameter in time, its
value must be specified at every instant. This could be done with an infinite list of
parameter values for every possible time value, but this would not be very practical.
Therefore, the values of the parameter at certain important control points of the animation
are specified, and the intermediate points are the calculated by interpolation. These control
point values, which determine the whole animation, are called keyframes.
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Keying: The process of generating mask information from the image contents.
Letterbox: When movie material is converted to NTSC or PAL, the material is scaled so as
to view the entire image at the desired size, with black bands that appear at the top and
bottom of the image. These black bands are called Letterbox.
LUT: See LookUp Table.
LookUp Table: These are color index tables used to extract the desired color from its
position in the table. This technique is used in color palettes to extract the RGB color of
each position in the color palette.
Mask: Grey tone image that specifies the intensity to be applied to an effect in each pixel
of the original image. Pixels that have a black mask are not affected by the effect, and the
intensity of the effect increases to 100% corresponding to the pixels of a white mask.
Morphing: Image interpolation or other warping techniques used on the original and target
images to achieve a more adequate transition.
Motion Blur: Blur effect produced in objects that move rapidly. This effect is produced as
the sampling of the capture system (video and movie cameras, etc) usually captures 24, 25
or 30 frames per second, so that each capture shows 1/24, 1/25 or 1/30 of a second. When
an object moves at high speed, it will move a considerable distance in these times, which
will produce a stump or blurring effect in them.
Motion Tracking: A technique permitting the specification of the path to be followed by
one or several areas of a sequence for its later use.
NTSC: Standard video signal used in America.
PAL: Standard video signal used in Europe.
Playback: Viewing of a video or audio sequence.
Postscript: Vectorial file format.
Point of control: See keyframe.
RGB: Abbreviation of Red, Green and Blue. Refers to a color specified by its primary color
components.
Shape: Also called vectorial objects or vector shapes. Vectorial figures produced with Paint
are included in this category.
VITC: Acronym of Vertical Interval Time Code. Represents a timecode storage system that
allows current timecodes to be read without needing to have the tape in Play.
Warping: Image deformation technique achieved by animation of the position of the pixels.
WYSIWYG: Abbreviation of “What You See Is What You Get”. Used on many occasions to
reflect that what is seen on the screen, is the end result that will be obtained.
YIQ: color space definition system used in the NTSC standard. The Y, I and Q components
are specified as follows:
Y = 0.299R+0.587G+0.114B
I = 0.74(R-Y)

0.27(B-Y)

Q = 0.48(R-Y) + 0.41(B-Y)
YUV: color space definition system used in the PAL standard. The Y, U and V components
are specified as follows:
Y = 0.299R+0.587G+0.114B
U = 0.493(B-Y)
V = 0.877(R-Y)
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Zbuffer: Map of depth of each pixel used to hide geometry that is not visible in 3D.
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